Create apps and visualizations
## 1 About this document

## 2 Creating apps

### 2.1 Foundations

- Data manager and Data load editor
- Data model
- Logical model
- Measures
- Dimensions

### 2.2 Structure and visuals

- Sheets
- Bookmarks
- Stories

### 2.3 Structuring an app using sheets

- Overview
- Creating a new sheet
- Changing the title and description of a sheet
- Setting a show condition for a sheet
- Changing the sheet thumbnail
- Changing the grid sizing of a sheet
- Customizing sheet size
- Changing the small screen layout
- Extending the sheet area
- Adding actions to sheets
- Copying, replacing and moving items on sheets
- Duplicating a sheet
- Adding actions to sheets

### 2.4 Managing apps

- Creating an app
- On-demand apps
- Styling an app
- Managing app reload tasks
- Converting a QlikView document into a Qlik Sense app
- Manually converting a QlikView document into a Qlik Sense app
- Changing the title and description of an app
- Changing the thumbnail of an app
- Duplicating an app
- Enabling apps for Insight Advisor Chat
- Disabling Insight Advisor in apps
- Deleting an app
- Uploading image files to media library
- Deleting image files from media library

### 2.5 Troubleshooting - Creating apps

- Images are not included in an app that has been moved from one Qlik Sense environment to another
- Images are not included in an app that has been moved from one Qlik Sense Desktop
installation to another .................................................................
The image I want to use does not seem to work .................................. 40
Using Insight Advisor impacts system performance ............................ 40
I cannot manage my app reload tasks in the hub .................................. 40
2.6 Optimizing app performance ......................................................... 41
   App complexity ........................................................................... 41
   App details .................................................................................... 41
   Monitoring your app ....................................................................... 42
   Large data volumes ....................................................................... 43
   Data model performance ................................................................. 44
   Sheet performance ......................................................................... 47
3 Visualizations ................................................................................. 51
   3.1 Understand the data sources of your visualizations ...................... 51
   3.2 Select visualization types that align with your purpose ...................... 52
   3.3 Update visualizations to improve how data is displayed ................. 52
   3.4 Data assets in visualizations ....................................................... 52
      Data assets ................................................................................ 53
      Expressions .............................................................................. 54
      Data types in visualizations ......................................................... 54
      Fields ...................................................................................... 55
      Dimensions .............................................................................. 65
      Measures .................................................................................. 68
      Reusing assets with master items ................................................. 77
      Using expressions in visualizations ............................................. 110
      Searching in the assets ................................................................ 125
      Designing visualizations with Direct Discovery ........................... 125
   3.5 When to use what type of visualization ....................................... 126
      Viewing comparisons ................................................................... 126
      Viewing relationships .................................................................. 127
      Viewing compositions .................................................................. 127
      Viewing distributions ................................................................... 128
      Viewing performances ................................................................... 128
      Viewing data ............................................................................... 128
      Viewing geography ..................................................................... 129
      What if no standard chart suits my purpose? .................................. 129
   3.6 Visualizations ........................................................................... 129
      Creating a visualization ............................................................... 129
      Reusing a visualization ............................................................... 130
      Which visualizations are available? ............................................ 130
      Bar chart .................................................................................. 133
      Box plot ................................................................................... 156
      Bullet chart ............................................................................... 166
      Combo chart ............................................................................. 168
      Distribution plot ....................................................................... 186
      Filter pane ............................................................................... 196
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gauge</td>
<td>202</td>
</tr>
<tr>
<td>Histogram</td>
<td>207</td>
</tr>
<tr>
<td>KPI</td>
<td>213</td>
</tr>
<tr>
<td>Line chart</td>
<td>218</td>
</tr>
<tr>
<td>Maps</td>
<td>234</td>
</tr>
<tr>
<td>Mekko chart</td>
<td>308</td>
</tr>
<tr>
<td>Pie chart</td>
<td>317</td>
</tr>
<tr>
<td>Pivot table</td>
<td>328</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>343</td>
</tr>
<tr>
<td>Table</td>
<td>357</td>
</tr>
<tr>
<td>Text &amp; image</td>
<td>380</td>
</tr>
<tr>
<td>Treemap</td>
<td>386</td>
</tr>
<tr>
<td>Waterfall chart</td>
<td>397</td>
</tr>
<tr>
<td>Button</td>
<td>405</td>
</tr>
<tr>
<td>Container</td>
<td>409</td>
</tr>
<tr>
<td>Reference lines</td>
<td>415</td>
</tr>
<tr>
<td>Custom tooltips</td>
<td>416</td>
</tr>
<tr>
<td>Null values in visualizations</td>
<td>418</td>
</tr>
<tr>
<td>Dashboard bundle</td>
<td>418</td>
</tr>
<tr>
<td>Visualization bundle</td>
<td>434</td>
</tr>
<tr>
<td>Changing a measure/label color</td>
<td>458</td>
</tr>
<tr>
<td>Changing background color</td>
<td>459</td>
</tr>
<tr>
<td>Alignment</td>
<td>462</td>
</tr>
<tr>
<td>Number formatting</td>
<td>462</td>
</tr>
<tr>
<td>Format pattern</td>
<td>463</td>
</tr>
<tr>
<td>Segment/card</td>
<td>463</td>
</tr>
<tr>
<td>Items per row</td>
<td>464</td>
</tr>
<tr>
<td>Borders</td>
<td>464</td>
</tr>
<tr>
<td>Value/Label layout and formatting</td>
<td>464</td>
</tr>
<tr>
<td>3.7 Creating and editing visualizations</td>
<td>495</td>
</tr>
<tr>
<td>Creating visualizations</td>
<td>495</td>
</tr>
<tr>
<td>Editing visualizations</td>
<td>496</td>
</tr>
<tr>
<td>Best practices for designing visualizations</td>
<td>497</td>
</tr>
<tr>
<td>Creating visualizations with Insight Advisor</td>
<td>500</td>
</tr>
<tr>
<td>Creating visualizations using Insight Advisor chart suggestions</td>
<td>508</td>
</tr>
<tr>
<td>Guidelines for visualizations, fields, and naming</td>
<td>509</td>
</tr>
<tr>
<td>Using alternate states for comparative analysis</td>
<td>515</td>
</tr>
<tr>
<td>Creating a visualization using a custom object</td>
<td>518</td>
</tr>
<tr>
<td>Copying a visualization from an existing visualization</td>
<td>519</td>
</tr>
<tr>
<td>Creating time-aware charts</td>
<td>520</td>
</tr>
<tr>
<td>Changing the data of a visualization</td>
<td>521</td>
</tr>
<tr>
<td>Changing the appearance of a visualization</td>
<td>526</td>
</tr>
<tr>
<td>Examples</td>
<td>541</td>
</tr>
<tr>
<td>RGB</td>
<td>543</td>
</tr>
<tr>
<td>ARGB</td>
<td>543</td>
</tr>
<tr>
<td>HSL</td>
<td>544</td>
</tr>
</tbody>
</table>
3.8 Troubleshooting - Creating visualizations

I cannot find the fields in the assets panel ......................................................... 557
My chart is not sorted correctly ........................................................................ 557
My calendar measures display incorrect aggregations in visualizations .......... 558
There are no time ranges to select in Create calendar measures .................... 558
My date field selected for calendar measures does not use the correct calendar 558
I cannot edit a variable value ........................................................................... 559
The map is placing the locations in my location field incorrectly .................... 559
No map is displayed ....................................................................................... 559
Error message: The data contains invalid geometries that could not be shown on the map.
Review your data for errors and try again .......................................................... 560
Error message: The following locations could not be found: <locations>. Review the values in your data and try again .............................................................. 560
Error message: The following locations could not be located: <locations>. Review the values in your data and try again .............................................................. 561
Error message: The following locations had more than one result: <locations>. Set a custom scope to clarify which locations to display ........................................ 561
Error message: Some lines could not be shown because of invalid data in the width expression. Review your data for errors and try again ........................................ 561
Error message: Some density points could no be shown because of invalid data in the weight expression. Review your data for errors and try again ........................... 562
I added an image background layer and cannot see my image ............................ 562
1 About this document

Visualizations are used to present the data that is loaded into the app. The selections you make in the app are reflected in all associated visualizations on all sheets.

Read and learn how to create and customize sheets and visualizations in your app. You will also learn about creating reusable master items, and about expressions in visualizations.

This document is derived from the online help for Qlik Sense. It is intended for those who want to read parts of the help offline or print pages easily, and does not include any additional information compared with the online help.

You find the online help, additional guides and much more at help.qlik.com/sense.
2 Creating apps

Qlik Sense apps contain data, and use visualizations to explore that data. Make discoveries by applying selections to visualizations.

The foundation of an app is the data model and load script. Measures and dimensions are reusable data items used to build charts. Sheets and stories display and organize your visualizations. Bookmarks are an easy way to save a specific selection state on a sheet.

Whoever creates an app is automatically designated as its owner. An app can be re-used, modified, and shared with others, depending on access rights. Different actions can be carried out depending on whether the app is published or not.

The .qvf file format is a proprietary format.

2.1 Foundations

Data manager and Data load editor

The Data manager lets you quickly add and transform data. You can also associate data tables. The Data load editor uses scripts to connect to a data source and retrieve the data.

Data model

Loaded data is structured in a data model. You can reload your data to build the data model that is best for your app.

Logical model

Qlik Sense uses a logical model to interpret relationships in your data model. The logical model is used by Insight Advisor when creating visualizations. There are two ways of logical models are created in Qlik Sense:

- Precedent based learning: With precedent based learning, the logical model is built by Insight Advisor based on how data sources are used in your app and based on user interaction with Insights charts.
- Business logic: With business logic, the app developer builds and customizes the logical model. This enables greater control for how Insight Advisor uses data when handling searches.

Measures

Measures are calculations used in visualizations. Measures are created from an expression composed of aggregation functions, such as \texttt{Sum} or \texttt{Max}, combined with one or several fields.
Dimensions
Dimensions are fields used in visualizations. Dimensions determine how the data in a visualization is grouped. For example: total sales per country or number of products per supplier.

2.2 Structure and visuals

Sheets
Sheets contain data visualizations, such as charts and tables. You create structure in your app by grouping visualizations on sheets. For example, you could have a sheet for North American sales, and a different sheet for Europe.

Bookmarks
Bookmarks are shortcuts to a certain set of selections and chart expansions.

Stories
Stories are based on snapshots of visualizations. You present your data by creating a story that guides you to new insights by combining snapshots of data at specific times and selection states.

In Qlik Sense Desktop, apps are typically stored in <user>\Documents\Qlik\Sense\Apps, as <Appname>.qvf, where <Appname> is the name of the app. If you rename an app in Qlik Sense Desktop, the .qvf is not updated.

2.3 Structuring an app using sheets
Sheets structure your ideas and purpose of your app. When you create a new app, it is good practice to first build a structure of empty sheets, where each sheet represents an idea or a goal. This gives a good overview of the app.

Overview
For example, you are creating an overview of your company's key metrics, sales, and margins by state, region, and product. Instead of having all this information in one place, you could structure it by having one sheet for each purpose.

Each sheet has a purpose and an idea of its own.
A sheet is where charts and tables for data visualization are placed. An app can include several sheets. The selections that you make affect visualizations, regardless of which sheets they are on.

An example of a sheet with boxes on the left to select and filter out the data to be presented in the visualizations on the right.

Creating a new sheet

You can create a new sheet from the app overview or from the sheet navigator.

💡 You access the sheet navigator from the sheet view by clicking on the toolbar.

Do the following:
2. Creating apps

1. From the app overview, click \(\text{☆} \) to view the sheets.
2. Click + or Create new sheet.
3. Give your sheet a title and add a description.
4. Click outside the text area to save the title and description.

A new sheet is created.

Changing the title and description of a sheet

You can change the title and description of your sheets. You can either use a fixed sheet title, or a dynamic sheet title based on an expression.

**Do the following:**

1. In the app overview, click \(\text{☆} \) to view the sheets.
2. Do one of the following:
   - If you are in grid view, click the sheet title followed by clicking \(\text{☆} \).
   - If you are in list view, click \(\text{☆} \).
3. Edit Title and Description.
4. Click outside the text area.

The changes you made are saved.

You can also change a sheet’s title and description in the Sheet properties panel.

Using a dynamic sheet title

You can set a dynamic sheet title based on an expression in the Title expression property of the sheet properties panel. You can use any valid chart expression. For more information, see Using expressions in visualizations (page 110).

If you set a dynamic sheet title, the fixed title (Title) is not used.

Setting a show condition for a sheet

You can set a condition in Show condition to show or hide a sheet in an app depending on if an expression evaluates as true or false. The sheet is only shown if the expression evaluates as true. Hiding a sheet does not hide or exclude data in an app.

For example, you could create a sheet that is only available if certain values are present in your data. Typically, you should use an if function.

Changing the sheet thumbnail

You can replace the default thumbnail, to make it easier to distinguish between sheets in the app overview and in the sheet navigator. You can use one of the default images, or an image of your own.

Note the following:
The following formats are supported: .png, .jpg, .jpeg, and .gif.

The optimal aspect ratio of a thumbnail is 8:5 (width:height).

You can only add or change the thumbnail of an unpublished sheet.

**Do the following:**

1. In the app overview, click to view the sheets.
2. Do one of the following:
   - If you are in grid view, click the sheet title followed by clicking.
   - If you are in list view, click.
3. Click on the default thumbnail.
   The Media library opens.
4. Click on a folder in the media library, for example In app or Default.
5. Select the image you want to use as a thumbnail for the sheet and click Insert.
6. Click to stop editing.

The image you selected is now used as a thumbnail for the sheet, and is visible in the sheet navigator and in the app overview.

![You can also change a sheet's thumbnail in the sheet navigator at the top right or in the Sheet properties panel.]

The following formats are supported: .png, .jpg, .jpeg, and .gif.

For Qlik Sense: You can upload images to the In app folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.

For Qlik Sense Desktop: You can place images in the following folder on your computer:
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Images will be available in the default folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, the images will be in the In app folder in the media library for the app.

**Changing the grid sizing of a sheet**

You can adjust the grid sizing of the sheet to be able to fit more visualizations on a sheet, or have more control over how visualizations are positioned. The grid displays when you are adding, moving, or resizing a visualization.

*Grid size can be changed in the Sheet properties pane*
Do the following:

- Change the Grid spacing setting in Sheet properties from Wide (the default option) to Medium or Narrow.

The sheet grid is now more dense and the grid squares are smaller.
Customizing sheet size

By default, Qlik Sense uses a responsive layout for sheets that adjusts the sheet to the dimensions of the user’s screen. You can set a custom width and height for the sheet if you want to use a non-responsive layout for your sheets. This ensures that your dashboard will be presented to users exactly as you created them, with no adjustments for responsiveness. You can set the height and width of a sheet anywhere between 300 pixels and 4,000 pixels.

When a sheet is using a custom size, you can change the grid spacing, but you cannot use **Extend sheet** to change the size.

**When a custom sheet is exported, the downloaded sheet is downloaded as a Responsive sheet. For optimal default sheet thumbnails, keep your custom size ratio to 8:5 (width:height).**

*Custom-sized sheets may have a lower quality PDF output if the sheet is too large to clearly display on a single PDF page.*

**Do the following:**

1. Change the **Sheet size** setting from **Responsive** to **Custom**.
2. Enter a width for the sheet in pixels.
3. Enter a height for the sheet in pixels.

Changing the small screen layout

By default, sheets are displayed in List view when viewed on small screens. You can change them to display as a grid. Sheets must be set to responsive layout to display as grid on small screens.

*A sheet viewed on a small screen in List view (left) and Grid view (right)*
Grid view shows a small preview of your visualizations. List view only shows the visualization titles.

**Do the following:**

1. Under **Sheet properties**, go to **Small screen layout**.
2. From the drop-down, select **Grid view**.

**Extending the sheet area**

You can extend the area of a sheet vertically if you need to add more visualizations than what can fit on a screen.

```
Downloaded extended sheets may have a lower quality PDF output if the sheet is too large to clearly display on a single PDF page.
```

**Note the following:**

- You need to activate **Extend sheet** under Sheet properties.
- Each extension adds 50% of the original sheet height.
- If you have visualizations that scroll, this can interfere with scrolling of an extended sheet. You should leave some empty space that allows for scrolling when you design the sheet.

You can extend the sheet in two different ways:
Do the following:

- Drag an object to the bottom of the sheet and drop it on the drop zone that appears.
- Toggle **Extend sheet** under **Sheet properties**.

The sheet is now expanded by 50% of the original height. You can scroll vertically in the sheet to access all content.

**Adding actions to sheets**

You can add actions to sheets that trigger when users navigate to those sheets. For example, you could automatically clear selections in the app when users navigate to a particular sheet.

For more information, see *Adding actions to sheets (page 16)*.

**Copying, replacing and moving items on sheets**

You can copy, replace, and move items on a sheet and between sheets. You can do this in the following ways:

- Using the edit bar on the sheet (ﬀ, 􀪁 and 􀪂).
- By right-clicking and selecting **Cut**, **Copy** and **Paste**.
- With the keyboard shortcuts Ctrl+C, Ctrl+X and Ctrl+V.

**Duplicating a sheet**

You can duplicate any sheet, regardless of whether it is a sheet that belongs to the app or a sheet you have created yourself. The purpose of duplicating sheets is to save time by reusing content, and to allow you to modify the duplicate so that it fits your needs better. A duplicated sheet contains the same visualizations as the original sheet, and is linked to the same master items. The duplicated sheet is a standalone sheet with no connection to the original sheet. Duplicated sheets appear under **My sheets** in app overview and in the sheet navigator.

You can duplicate a sheet in the following ways:

- Click **Duplicate** in the shortcut menu of a sheet in the app overview or in the sheet navigator.
- Click **Duplicate sheet** in the global menu in the app overview or in sheet view.

**Adding actions to sheets**

You can set actions to sheets that trigger when users navigate to the sheet. Sheet actions are useful when you want to assist app users with predefined selection or selection controls when they navigate to a sheet. For example, a sheet could automatically apply a bookmark or clear all selections when users navigate to the sheet.
Sheet actions can be configured in the properties panel. You can add multiple actions to a sheet. The actions are performed in the order they are listed under **Actions**. You can change the order of an action by dragging it.

*All expressions used in sheet actions are evaluated before the actions are performed. For example, you could not use an expression in an action that selects results from a previous action as the expression evaluates before the selection is made by the action.*

Sheet actions are not triggered if the sheet is an embedded sheet or in a mashup.

**Do the following:**

1. In sheet view, click **Edit sheet** in the toolbar.
2. Click **Actions** in the properties panel of the sheet.
3. Click **Add action**.
4. Select the action you want to use.
   For some actions you need to provide details for the action. For example, for the **Select values in a field** action, you need to select a field, and which value to select in the field.
5. Optionally, after **Label**, enter a name for the action.

**Available sheet actions**

You can add one or more actions to be performed when users navigate to the sheet. For some actions, you need to provide details for the action.

**Apply bookmark**

You can apply the selection that is defined in a bookmark that you choose.

**Move backwards in your selections**

You can move one step backwards in your selection history.

**Move forwards in your selections**

You can move one step forwards in your selection history.

**Clear all selections**

You can clear all selections in the app. You can optionally overwrite locked selections.

**Clear selections in other fields**

You can clear selections from all fields except the one you specify. You can optionally overwrite locked selections.

**Clear selections in field**

You can clear all selections from a field that you specify.

**Select all values in a field**

You can select all values in a field that you specify. You can optionally overwrite locked selections.
2 Creating apps

Select values in a field
You can select a list of values in a field that you specify. Separate the values to select with a semi colon. You can optionally overwrite locked selections.

Select alternatives
Select all alternative values in a field that you specify. You can optionally overwrite locked selections.

Select excluded
Select all excluded values in a field that you specify. You can optionally overwrite locked selections.

Select possible values in a field
Select all possible values in a field that you specify. You can optionally overwrite locked selections.

Toggle field selection
You can set the sheet to toggle between the current selection, and a selection that adds selections defined by a search string. You can use wild cards in the search string. If you want to define a list of values you need to use the format (A/B), where A and B are values to select.

Lock all selections
You can lock all selections in the app.

Lock a specific field
You can lock selections in a field that you specify.

Unlock all selections
You can unlock all selections in the app.

Unlock a specific field
You can unlock selections in a field that you specify.

Set variable value
You can assign a value to a variable.

2.4 Managing apps

Once you have created and built an app with the sheets and visualizations you want it to have, you may want to fine-tune it to make it easy and efficient to use, not only for yourself but also for other people.

You can, for instance:

- Apply app styling (logo and header)
- Create reusable master items (visualizations, dimensions and measures)
- Add bookmarks to keep track of important and interesting data selections and connections
Creating apps

- Enable apps for Insight Advisor Chat
- Disable Insight Advisor
- Change the app’s title and description, and also add a thumbnail to it
- Manage app reload tasks
- Publish your own apps
- Move your own published apps between streams

Creating an app

The first thing you need to do when building an app is to create an empty placeholder for it. You create the app placeholder from the hub.

Do the following:

1. Click Create new app in the hub.
2. Give your app a name.
3. Click Create.
   The app is created.
4. Click Open app.
   The app opens in the app overview.

The next step is to add data to the new app.

On-demand apps

On-demand apps enable you to load and analyze big data sources in Qlik Sense.

Trying to analyze an entire big data store at one time is highly inefficient. Nevertheless, to make representative visualizations, all the data must be discoverable. Qlik Sense on-demand apps give users aggregate views of big data stores and allow them to identify and load relevant subsets of the data for detailed analysis.

On-demand apps are made up of several building blocks or components, and some of those components are built by users with advanced scripting skills.

Generating an on-demand app

You generate an on-demand app when you have selected a manageable subset of data using an on-demand selection app. Any selection app that you are working with will contain one or more navigation links for generating on-demand apps in the App navigation bar.

The on-demand apps shown on the App navigation bar have completion indicators that start to turn green as you make selections in the selection app. Each on-demand app on the app navigation bar has a limit on the amount of data it can contain. When selections are made in the selection app, the completion indicator shows when the amount of data selected is within the bounds set for the on-demand app.
Once an on-demand app's indicator turns completely green, you can generate that app with the currently selected data. Or you can choose to open an instance of that app that was generated previously with another selection of data. Every on-demand app in the app navigation bar can be generated multiple times, and those generated apps remain accessible. When the maximum number of apps has been generated, you must delete an existing app before you can generate a new on-demand app. On-demand apps also may have an expiration time after which they are automatically deleted.

Anonymous users can only generate on-demand apps that are published automatically. Because anonymous users can only use published apps, they cannot use an on-demand app unless it is published automatically when it is generated. If an anonymous user attempts to generate an on-demand app that is not set for automatic publication, a message displays indicating that the user cannot generate an app from that particular on-demand app navigation point.

The maximum number of apps and the retention time are set on the on-demand app navigation link. The app navigation link is one of the building blocks of on-demand apps, and it is usually added by the creator of the selection app.

Do the following:

1. Open an on-demand selection app.
2. Select from the visualization objects in the selection app.
3. When the completion indicator on an on-demand app in the App navigation bar turns completely green, click the on-demand app. You can select an on-demand app in the App navigation bar to open its generation panel. There you can click the \( \text{constraint} \) to see the Constraint (maximum number of records allowed) and the number of records currently selected. You can also see the number of values selected for each field and any constraints on the fields. When on-demand apps are created, constraints can be placed on individual fields. For example, a field for Year might be limited so that no more than two values can be selected. When the number of records (Row count) currently selected is less than or equal to the maximum number of records allowed, the completion indicator turns completely green. An app cannot be generated, however, until all the constraints have been met. If the row count is within the constraint but one or more of the fields have not met the requirements of their constraints, the Generate new app button will not be enabled.

If you select Generate new app when constraints panel is open, you will not see the generated app. Click the \( \text{constraint} \) to close the panel, and you will see the new app listed if it generated successfully.

4. Click the Generate new app button to create a new instance of the on-demand app with the data currently selected. The new instance of the app is generated and appears in the generation panel above the Generate new app button.
To see more about the generated app, open its detail panel.

**Ox Sample Detail**
Detail metrics used in app generation. Now this will b...

**Ox Sample Detail_Airlines**
Sep 25, 2017, 4:32:13 PM

In this view, you can also rename the on-demand app. By default, on-demand apps are assigned the name of the navigation point from which they are generated, and the user's name is appended. For example, when the name of the navigation point is "Ox Sample Detail," the default name of the generated on-demand app would be "Ox Sample Detail_John-Doe" for user "John Doe." In the illustration above, the name of the on-demand app has been changed to "Ox Sample Detail_Airlines." You can rename an on-demand app even if it has been published.

On-demand apps generated by anonymous users are given default names indicating that they were generated by an anonymous user rather than a registered user. Anonymous users can change the names of generated apps just as registered users can change the names of their apps.

The **Apply** button applies the selections listed on the generated on-demand app's **Selections** tab to the selection app.
5. Select **Open app** from the ***> menu to open the generated app.

You can also reload data and regenerate an on-demand app. The **Reload** menu is available when the detail panel is open:

The selections on the **Reload** menu work as follows:

- **Reload**: reloads the data based on the current selections that have been made within the on-demand app.
- **Regenerate using current selections**: regenerates the on-demand app using the current...
selections that have been made within the selection app.

The Apply button on the Selections tab applies the on-demand app's selections to the selection app. The on-demand app's selections are those listed as Selections made when this app was generated. For more information, see the illustration above. This is the reverse of what is done when Regenerate using current selections is used.

- **Regenerate copy using the current selections**: generates a new on-demand app using the current selections that have been made within the selection app. The previously generated on-demand app remains in its current state.

Exploring a published on-demand app

Most users who use on-demand apps to explore big data sets access them as published apps. There are two points at which most users will use on-demand apps:

1. In a published on-demand selection app, where the user selects data and generates an on-demand app from the App navigation bar.
2. In a stream where a generated on-demand app is published.

Published on-demand apps have a preselected subset of data from a very large data source. You can explore that data through the visualization objects in the on-demand app. In that way, on-demand apps are like apps created with data from any other source.

You cannot change them after they have been published, though like other published apps, you can add private sheets and stories if you have the correct access rights. You work with published on-demand apps the same way you work in other published apps.

Styling an app

You can apply styling to your app to customize the app based on your company standards. The selected styling will be applied to all sheets in the app. Once the app has been published, you cannot change the app styling.

The following styling options are available:

- Changing the direction of the characters in strings of text or numbers.
- Changing the default app theme.
- Disabling the hover menu on all visualizations.
- Changing the background color for the sheet titles.
- Changing the sheet title font color.
- Adding and aligning an image, such as a logo.
More styling can be applied to an app by a developer through custom theme extensions. 

Tables support custom styling. Custom table styles override app style.

Opening app options
You can open the app options from anywhere in an unpublished app. It does not matter if you are exploring and discovering data, building a data model or working with data storytelling.

Do the following:

- In an unpublished app, click ⋯ and then click ⚙ to open app options.
- Click ✗ to close the app options.

If you are using a mobile device, the app options are not available.

As of Qlik Sense June 2018, app options is not available on a published apps even when having custom security rules defined with Update action on App resources.

Changing the reading order

Do the following:

1. In an unpublished app, click ⋯ and then click ⚙ to open app options
2. Under Appearance > Right-to-left, select On or Off.

If a visualization is shared using Qlik Sense Charts, changing the reading order in the app will also affect the reading order in the shared chart.

Changing the default app theme

In an unpublished app, the app theme can be set to one of the default Qlik themes using the App Theme drop-down menu. You can also apply any custom theme that you have created and installed.

The default Qlik themes are:

- Sense Horizon - This is the default theme when you create a new app.
- Sense Classic - Provides a more compact view of objects, and limits the space between them.
- Sense Focus - Adjusts the padding and spacing around objects as well as provides designated spaces for titles.
- Sense Breeze - Based on Sense Focus but with different color settings.
2 Creating apps

Do the following:

1. In an unpublished app, click ••• and then click ⚙ to open app options.
2. Select the theme to apply from the App Theme drop-down menu.

You cannot change themes in published apps.

Custom themes

You can also create custom themes based on your company standards. With themes you can precisely style an app by changing the colors, adding images and backgrounds as well as specifying the fonts, font sizes, font weights and font styles on a global or granular basis throughout your app. You can also define color palettes and customize the specifications for margins, padding and spacing.

For more information, see Sense for Developers: Custom themes.

Custom themes are not dependent on the app. This means that if you for example change the colors defined in a custom theme these will be updated in all apps using the theme, even if the app is published.

When you have created a custom theme, you store it in Qlik Sense as an extension. The JSON file and any additional resources, such as CSS files, are zipped and imported as an extension in the Qlik Management Console (QMC). This enables that security rules can be added in the QMC for controlling which themes specific users have access to.

Custom themes appear under Custom in the App Theme drop-down menu.

App theme drop-down menu
Disabling the hover menu
You can choose to disable the hover menu that appears on visualizations when users place their cursor over them. This will effect all visualizations in the app.

Do the following:

1. In an unpublished app, click *** and then click 🛠 to open app options.
2. Toggle **Disable hover menu for visualizations**.

You can disable the hover menu for a single visualization in edit mode.

Do the following:

1. In edit mode, select the visualization.
2. In the properties panel, go to Appearance > General.
3. Select **Disable hover menu**.

Changing colors
The sheet title background color can be set to a solid color or a gradient of colors by selecting two colors. The sheet title font can only be set to a solid color.

If you are using a mobile device, the sheet title background is displayed as one solid color even if two colors has been set.

When choosing colors, you have the following options:

- Choose a color from the default color palette.
- Set a Hex color by typing 6 characters in the # input field.
- Click the palette to show more color options:
  - Click the color wheel to select color.
  - Drag the slider to change the color saturation.

Choosing a color from the default color palette

Do the following:

1. Click ▼ in a color drop-down.
   The dialog opens and displays the default colors.
2. Click one of the colors in the palette.
   The color is selected.
3. Click outside the dialog.
   The dialog is closed.

Now you have set a color by selecting in the default color palette.
Typing a Hex color

**Do the following:**

1. Click ▼ in a color drop-down.
   The dialog opens and displays the default colors.
2. Type 6 characters in the Hex input field: #.
   The color is selected in the palette.
3. Click outside the dialog.
   The dialog is closed.

Now you have set a color by typing the 6 hexadecimal digits.

Using the advanced color options

**Do the following:**

1. Click ▼ in a color drop-down.
   The dialog opens and displays the default colors.
2. Click at the bottom of the dialog.
   The dialog changes and displays the advanced options.
3. Do one of the following:
   - Click in the color wheel.
     The color changes and the Hex color code updates accordingly.
   - Drag the slider.
     The saturation changes and the Hex color code updates accordingly.
   Either way a color is selected.
4. Click outside the dialog.
The dialog is closed.

Now you have set a color by using the color wheel and/or the slider.

*Color dialog with the advanced options and a blue color selected.*

Adding an image
You can add an image to the sheet title, such as a logo. The following formats are supported: .png, .jpg, .jpeg, and .gif.

**Do the following:**

1. Click the image placeholder next to **Image**.
   The **Media library** opens.
2. Click on a folder in the media library, for example **In app** or **Default**.
3. Select the image that you want to add to the sheet title.
   A preview of the image is shown.
4. Click **Insert**.
   The image is added.

Now you have added an image to the sheet title.

**Managing app reload tasks**
You can view and manage app reload tasks from the hub. You can manually start reload tasks from the hub.

Reload tasks are added in QMC for apps in the hub. To view the reload tasks for an app in the hub, right-click the app and select **Manage reload tasks**.
Manage reload tasks displays the following information and options:

- **Name**: Task name.
- **Enabled**: If the reload task is enabled or disabled. Disabled tasks cannot be managed or enabled from the hub.
- **Status**: Displays the current status of the task. You can click ![status_icon](image) to view a summary of the latest task execution. You can also click **Download script log** to download the script log.
- **Last execution**: Displays when the task was last executed.
- **Next execution**: Displays when the task is next scheduled to run.
- **Actions**: Management option for the task. You can click ![play_icon](image) to start tasks or click ![stop_icon](image) to stop tasks.

You can click ![refresh_icon](image) to refresh the task view.

Converting a QlikView document into a Qlik Sense app

If you have a QlikView document, you can reuse part of your work in Qlik Sense. The load script and data model can be used to create an app in Qlik Sense. Visualizations, dimensions and measures, however, have to be created in Qlik Sense.

After converting the document to an app, you may need to adapt the load script to be able to reload the script in Qlik Sense. In some cases, you may need to make some changes in the QlikView script before you convert the document.

Qlik Sense provides a tool to help convert a QlikView document (QVW file) to a Qlik Sense app. The tool converts visualizations, dimensions, measures, and variables. You must have access to the Dev Hub To use the QlikView to Qlik Sense converter.

Instructions for how to use the converter tool are provided on the Qlik Sense Developer site. For more information, see [QlikView converter](https://developer.qlik.com/docs/articles/convert-qlikview-app).

If you do not have access to the Dev Hub, you can convert a QlikView document manually.

We recommend that you make changes only in a duplicate of any app that you convert, so that your changes are not overwritten by a later conversion.

Manually converting a QlikView document into a Qlik Sense app

You can manually convert a QlikView document (QVW file) to a Qlik Sense app. If you have access to the Dev Hub, you can use the QlikView to Qlik Sense converter tool to simplify the process.

The QlikView to Qlik Sense converter is described on the Qlik Sense Developer site.
Prerequisites

- You need to have Qlik Sense Desktop installed to be able to convert a QlikView document into a Qlik Sense app.
- Your computer must have sufficient memory, at least 32 GB, when converting a large QlikView document.
- If the QlikView document contains hidden script or uses section access, you need to have full access to the hidden script and section access of the document.

Before converting the document

The Always One Selected Value property for QlikView list boxes or multi boxes must be disabled in order to clear selections in the Qlik Sense app. If your QlikView document contains hidden script or uses section access, you need to adapt the document before you convert it.

Converting hidden script tabs

When a QlikView document with hidden script is converted, the hidden script part will be disregarded and not included in the Qlik Sense script. If you want to convert the entire script, do the following before converting the document. This requires that you have access to the hidden script in the QlikView document.

Do the following:

1. Open the document in QlikView Script Editor.
2. Copy the code from the hidden script tabs and paste it into regular script tabs.
3. Save the document.

It is not possible to hide script code in Qlik Sense.

Removing section access code

A QlikView document with section access cannot be imported to Qlik Sense, as there are differences in format and supported functionality. You can still convert the document manually.

Do the following:

1. Remove the section access code in QlikView Script Editor before converting the document. This requires that you have full access to the script of the document.
2. Convert the document into an app.
3. Reapply section access in the Qlik Sense app. There are some differences that you may need to take account for:
   - User authentication is changed. The USERID field is now used to authenticate all users, and the NTNAME and PASSWORD fields are not supported anymore.
   - If you have access to the script, but not to the data, you can open the app without data and edit the script, including the section access.
Section access is applied using strict exclusion in Qlik Sense. This means that you can only see data that you have been specifically granted access to.

QlikView variables excluded from export

A number of variables are not exported from a QlikView document (QVW) as they are only relevant for QlikView or is handled differently in Qlik Sense.

The following variables are not exported from a QlikView document:

- All variables starting with `CD`
- All variables starting with `FLOPPY`
- `QvPath`
- `QvRoot`
- `QvWorkPath`
- `QvWorkRoot`
- `WinPath`
- `WinRoot`
- `ErrorMode`
- `StripComments`
- `ScriptErrorCount`
- `ScriptError`
- `ThousandSep`
- `DecimalSep`
- `MoneyThousandSep`
- `MoneyDecimalSep`
- `MoneyFormat`
- `TimeFormat`
- `DateFormat`
- `TimestampFormat`
- `MonthNames`
- `DayNames`
- `ScriptErrorDetails`
- `ScriptErrorList`
- `OpenUrlTimeout`
- `HidePrefix`
- `FirstWeekDay`
- `BrokenWeeks`
- `ReferenceDay`
- `FirstMonthOfYear`
- `CollationLocale`
2 Creating apps

- LongMonthNames
- LongDayNames

Converting the document into an app

**Do the following:**

1. Copy the QlikView document (qww format) to the directory where your apps are located. This is usually `\Documents\Qlik\Sense\Apps`, but the location of the Apps directory depends on where you installed Qlik Sense Desktop.
2. Start Qlik Sense Desktop.
   You now see the QlikView document as an app in the hub, with the name ending with (qww).
3. Click on the app to open it.

The app is saved into the Qlik Sense format (qvf file) in the folder where your QlikView document (qww file) was stored. Also, the QlikView document file (qww) is removed from the folder and automatically converted into a backup file (qww.backup) stored here: `\Documents\Qlik\Sense\Apps\Backup`.

You have now migrated a QlikView document into a Qlik Sense app. The app contains the data model, including the loaded data, and the data load script.

You can use the data model to build visualizations, copy it or import it into your server environment through the Qlik Management Console (QMC), but you need to adapt the load script before you can reload the data model.

You can also drag and drop a qww file from a folder onto the Qlik Sense Desktop hub, to open it as a Qlik Sense app. If the Qlik Sense app (qvf file) becomes stored in another folder than `\Documents\Qlik\Sense\Apps`, move it to the Apps folder to make it available from the hub.

Adapting the data load script in Qlik Sense

Qlik Sense and QlikView data load scripts are compatible in general, but there are some differences that you may need to take account for and adapt the script in the data load editor before you can reload data. You can adapt the script directly in Qlik Sense Desktop, or you can import the app into Qlik Sense and then adapt the script.

Change file path references to data connections

QlikView uses absolute or relative file paths which are not supported in Qlik Sense standard mode, so you need to use folder data connections to point to file locations instead.

**Do the following:**

1. Create folder data connections for all file paths that are used in the data load script.
   You need to check statements and functions that refer to files. **LOAD** statements are the most common ones, but there is a complete list available.
2. Replace all references to absolute or relative file paths in the script with `lib://` references to the data connections you created.

### Examples

<table>
<thead>
<tr>
<th>Original script in QlikView</th>
<th>Adapted Qlik Sense script</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>LOAD * FROM [C:\data\Tutorials source\Sales rep.csv];</code></td>
<td><code>LOAD * FROM [lib://Tutorials source/Sales rep.csv];</code></td>
</tr>
<tr>
<td>in this case, the Tutorials source folder data connection should be pointing to <code>C:\data\Tutorials source\</code>, or where the data is located if you have moved the app to another computer or a Qlik Sense server.</td>
<td></td>
</tr>
<tr>
<td><code>FileSize('C:\data\Tutorials source\Sales rep.csv')</code></td>
<td><code>FileSize('lib://Tutorials source/Sales rep.csv')</code></td>
</tr>
<tr>
<td>for each Dir in dirlist ('C:\data\Tutorials source*')</td>
<td>for each Dir in dirlist ('lib://Tutorials source/*')</td>
</tr>
</tbody>
</table>

### Handling features that are not supported or recommended

There are some features in QlikView that are not supported or recommended in Qlik Sense, for example:

- Input fields
- Message boxes
- Bundle and Info load
- ALL qualifier

We recommend that you check your script code against these lists of statements and functions that are not supported or recommended, and adapt the code according to recommendations.

### Installing custom connectors

If your QlikView document uses custom connectors to access data, you should be able to use them to load data in Qlik Sense as well without changes in the script. This requires that the same connector is installed on the Qlik Sense computer.

If you want to make any changes in the data selection by the custom connector, you need to install a version of the custom connector adapted for Qlik Sense.

### Changing the title and description of an app

You can change the title and description of your apps. When creating a new app, the name of the app is used as its title. When you change the title, the name of the app is not changed.

Do the following:

1. In the app overview, click 🖊 in the app details area.
2. Edit **Title** and **Description**.
3. Click ✔️ to stop editing.

The changes you made are saved.

You can only change the title and description of an unpublished app.

Changing the thumbnail of an app

You can replace the default thumbnail of an app with another thumbnail, to make it easier to distinguish between apps in the hub. You can use one of the default images, or an image of your own.

Do the following:

1. In the app overview, click 🖼️ in the app details area.
2. Click 📁 on the default thumbnail.
   The Media library opens.
3. Click on a folder in the media library, for example In app or Default.
4. Select the image you want to use as a thumbnail for the app and click Insert.
5. Click ✔️ to stop editing.

The image you selected is now used as a thumbnail for the app.

The optimal aspect ratio of a thumbnail is 8:5 (width:height).

The following formats are supported: .png, .jpg, .jpeg, and .gif.

For Qlik Sense: You can upload images to the In app folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.

For Qlik Sense Desktop: You can place images in the following folder on your computer: `C:\Users\<user>\Documents\Qlik\Sense\Content\Default`. Images will be available in the default folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, the images will be in the In app folder in the media library for the app.

You can only change the thumbnail of an unpublished app.

Duplicating an app

You can duplicate an existing app, to create a copy to develop further. You can only duplicate an app that you have created yourself unless your administrator has assign you a security role with duplication enabled.
2 Creating apps

If you have an admin role, giving you the administration rights needed, you can create duplicates of apps from the QMC.

**When you duplicate a published app, only the base sheets and stories will be included in the copy.**

Do the following:

- In the hub, long-touch/right-click the app you want to duplicate and select **Duplicate**. A toast notification is displayed for a while, at the bottom of the screen, when the duplication starts. A new toast notification will be displayed when the app has been duplicated and give you the possibility to update the app list. If the duplication fails, an error message will be displayed.

A copy of the app is created under **Work**. You can click the app to open it and start adapting it according to your preferences.

**Because of how the synchronization of data works in multi-node sites, apps containing images may display broken thumbnails or images inside the apps if opened right after being duplicated or imported. The broken images are restored when the synchronization is complete. To check if the images have been restored, refresh the browser window.**

Enabling apps for Insight Advisor Chat

You can enable apps to be available from Insight Advisor Chat in the hub.

When enabled, users with access to your app can search Insight Advisor using a chat-based interface.

**Insight Advisor Chat does not support apps that use Section Access.**

Do the following:

1. In your app, navigate to **App overview**.
2. Click 📋.
3. Select **Enable Insights for chat in hub**.
4. Reload your app.

Disabling Insight Advisor in apps

By default, Insight Advisor is enabled in apps. Disabling Insight Advisor both prevents users from accessing search-based analysis in **Insights**. It also prevents the Precedents Service from learning precedents from the app.
Do the following:

1. In your app, navigate to App overview.
2. Click 📊.
3. Select Enable Insights in app.

Deleting an app

You can delete an app that you no longer need.

- From the hub, you can only delete apps that you have created and that have not yet been published.

If you have published an app, the published version is locked and can only be deleted from the Qlik Management Console. The published version is a duplicate of the original app. The original version of the app can be deleted from your personal work in the hub.

Do the following:

1. Long-touch/right-click the app in the hub and select Delete.
   A confirmation dialog opens.
2. Click Delete.
   A toast notification is displayed for a while, at the bottom of the screen, when the app is being deleted. If the deletion fails, an error message will be displayed.

- You can delete a published app from the Qlik Management Console.

If an app is being deleted by someone else from the stream you are currently viewing, a toast notification will be displayed and give you the possibility to update the app list.

Uploading image files to media library

The media library contains the images you can use in your app: in text & image visualizations, on story slides, and as thumbnails for apps, sheets, and stories.

You can upload images to the media library. Because of limitations in the web browsers supported by Qlik Sense, it is recommended to keep the height and width as well as the file size of the images as small as possible. The maximum file size is 5 MB.

The following formats are supported: .png, .jpg, .jpeg, and .gif.

For Qlik Sense: You can upload images to the In app folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.
For Qlik Sense Desktop: You can place images in the following folder on your computer: 
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Images will be available in the default folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, the images will be in the In app folder in the media library for the app.

You can open the media library in several ways. Do one of the following:

- In the app overview, click ▼ in the app details area and click ▲ on the thumbnail.
- If you are editing a sheet, double-click the text & image visualization to open the editing toolbar and click ▲.
- In storytelling view, click ▼ in the story tools panel and drag Image onto the slide and then double-click inside the image placeholder.

The Media library dialog opens and now you can upload images.

Do the following:

1. Select Upload media.
2. Do one of the following:
   - Drop one or more image files onto the designated area.
   - Click the designated area to open the upload dialog, browse and select images, and click Open.

An upload indicator is displayed while the image file is being uploaded. You can cancel an ongoing upload by clicking on ✗ on the image.

You cannot upload a file if its file name already exists in the media library.

Now you have added images to the media library. Click the image and select ▶ to insert the image.

Deleting image files from media library

The media library contains the images you can use in your app: in text & image visualizations, on story slides, and as thumbnails for apps, sheets, and stories.

You can delete images from the media library.

You can open the media library in several ways. Do one of the following:

- In the app overview, click ▼ in the app details area and click ▲ on the thumbnail.
- If you are editing a sheet, double-click the text & image visualization to open the editing toolbar and click ▲.
- In storytelling view, click ▼ in the story tools panel and drag Image onto the slide and then double-click inside the image placeholder.
The **Media library** dialog opens and now you can delete images.

**Delete images using Qlik Sense**

**Do the following:**

1. Select the **In app** folder.
2. Select the file you want to delete.
3. Click 🗑️.
   
   A confirmation dialog is displayed.
4. Click **Delete**.

Now you have deleted images from the media library.

- You can also long-touch/right-click on an image file and select **Delete**.

- For **Qlik Sense**: You need to use the **Qlik Management Console** to delete images from the default folder, or other folders that were created from the **Qlik Management Console**.

**Delete images using Qlik Sense Desktop**

You can delete images from the default folder by removing the files from this location: `<user>\Documents\Qlik\Sense\Content\Default`.

The images in the **In app** folder are bundled images, saved in the qvf file together with the rest of the contents of the app. If a bundled image is no longer used in the app, the image will be deleted from the qvf file when saving the app.

**2.5 Troubleshooting - Creating apps**

This section describes problems that can occur when creating apps and visualizations in Qlik Sense.

**Images are not included in an app that has been moved from one Qlik Sense environment to another**

**Possible cause**

You have created an app in Qlik Sense and moved the app to another Qlik Sense environment.

When you move apps between Qlik Sense environments, images may not have been moved automatically. The images have to be handled manually, in different ways depending on between which environments the app has been moved.
Proposed action
Import the images from the Qlik Sense environment where the app was created to the target location using the Qlik Management Console.

Images are not included in an app that has been imported from Qlik Sense Desktop to Qlik Sense

Possible cause
You have created an app in Qlik Sense Desktop and imported the app to Qlik Sense.

When you move apps between Qlik Sense environments, images may not have been moved automatically. The images have to be handled manually, in different ways depending on between which environments the app has been moved.

Proposed action
Import the images from the images folder of the Qlik Sense Desktop app using the Qlik Management Console.

Images are included automatically only when you move an app from one Qlik Sense Desktop installation to another.

The default location of the images in Qlik Sense Desktop is
$user\Documents\Qlik\Sense\Content\Default.

If you have organized images in subfolders in the Content\Default folder in Qlik Sense Desktop, these have to be added manually to the app and its sheets, stories and text & image objects after importing the images.

Images are not included in an app that has been moved from one Qlik Sense Desktop installation to another

Possible cause
You have moved an app between Qlik Sense Desktop installations.

When you move apps between Qlik Sense environments, images may not have been moved automatically. The images have to be handled manually, in different ways depending on between which environments the app has been moved.
Proposed action

Do the following:

- Copy the images from the PC where the app was created and paste into the images folder of the target location.

The default location of the images in Qlik Sense Desktop is 
<user>\Documents\Qlik\Sense\Content\Default.

The image I want to use does not seem to work

Images are part of apps as thumbnails of the apps, sheets and stories, in the text & image object and in story slides.

Possible cause
You are using an image in a format that is not supported.

Proposed action

Do the following:

- Convert the image to one of the supported formats (png, jpg, jpeg or gif).

Using Insight Advisor impacts system performance

Insight Advisor uses master items as fields in recommended charts.

Possible cause

The charts generated by the Insights are choosing fields that end up with costly charts.

Proposed action

Do the following:

- Change what fields are exposed to published app users.

I cannot manage my app reload tasks in the hub

I want to view my app reload tasks in the hub, but do not see Manage reload tasks when I right-click an app.

Possible cause

The security rule HubSectionTask is disabled or you do not have read access to the HubSection_Task resource filter. Alternatively, you may not have read access to app reload tasks in the hub configured in QMC.

Proposed action

Contact a QMC administrator to get read access to HubSection_Task and app reload tasks in the hub.
2.6 Optimizing app performance

App performance can be improved with reduced app size, simplified data models, and strategic use of set analysis. This section will help you avoid performance issues by pointing out areas where performance can be impacted and how you can evaluate and monitor app performance.

App complexity

These are loose categories that can help diagnose issues. The most complex apps have the lowest performance.

Simple apps:

- Do not include complex set analysis or If() statements.
- Do not include large tables.
- Have a simple data model.
- Contain simple calculations.
- May have large data volumes.

Moderate apps:

- Have a data model with many tables, but follow best practices.
- Use set analysis and several If() statements.
- Have large or wide tables on sheets (15 columns or more).

Complex apps:

- Have a very complex data model.
- Connect to large data volumes.
- Contain complex calculations, charts, and tables.

You need to have access to reload the app to be able to evaluate performance.

App details

You need to consider your hardware environment in relation to app size, because it affects the performance of your Qlik Sense deployment. For example, if you do not optimize your apps, they may require more hardware resources.

Monitoring app size will help you:

- Understand current performance.
- Understand the performance impact of deploying a new app.
- Understand the performance impact of modifying an existing app.
- Resolve performance issues.
- Plan for future growth.
Qlik provides tools that can help you assess your apps. For more information, see: Performance and scalability in Qlik Sense Enterprise.

These are the basic app elements that can affect performance:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App disk size (MB)</td>
<td>You can find app size in the QMC. Go to Apps, and open the Column selector on the right hand side next to Actions. Click the radio button next to File size (MB). If you are using Qlik Sense Desktop, you can find app size in Windows Explorer. The default folder is %USERPROFILE%\Documents\Qlik\Sense\Apps. The Apps folder lists all app names and file sizes.</td>
</tr>
<tr>
<td>App size in RAM (GB)</td>
<td>You can determine an app's base RAM footprint by:</td>
</tr>
<tr>
<td></td>
<td>1. Restarting the Qlik Sense server.</td>
</tr>
<tr>
<td></td>
<td>2. Noting the current RAM usage.</td>
</tr>
<tr>
<td></td>
<td>3. Opening up the Qlik Sense app.</td>
</tr>
<tr>
<td></td>
<td>4. Recording the difference in RAM.</td>
</tr>
<tr>
<td></td>
<td>You can use the App Metadata Analyzer to find this metric if you are using Qlik Sense June 2018 or later.</td>
</tr>
<tr>
<td>App total rows (M)</td>
<td>You can use system fields to calculate total rows. Create a KPI with the measure Sum($Rows).</td>
</tr>
<tr>
<td>App total fields</td>
<td>You can use system fields to calculate total fields. Create a KPI with the measure Sum($Fields).</td>
</tr>
<tr>
<td>App total tables</td>
<td>You can use system fields to calculate total tables. Create a KPI with the measure Count(DISTINCT $Table).</td>
</tr>
</tbody>
</table>

Monitoring your app

The Qlik Management Console (QMC) provides apps for monitoring system performance and usage on Qlik Sense Enterprise on Windows:

- The Operations Monitor app provides information about hardware utilization, such as server memory and CPU usage, active users, and reload task activity. It also provides summary and detailed information about errors, warnings, and log activities in the Qlik Sense server environment.
- The License Monitor app tracks license usage, and facilitates monitoring changes to license allocation.
- The Log Monitor app presents nearly all log data available and enables trend analysis and troubleshooting.
- The Sessions Monitor app shows log data about usage of apps.
2 Creating apps

- The Reloads Monitor app presents detailed information about reload data, both from the QMC and apps open in the hub.
- The Sense System Performance Analyzer app displays Qlik Sense performance across all nodes.
- The Sense Connector Logs Analyzer app provides insights into usage and errors of specific Qlik connectors.
- The App Metadata Analyzer app provides a holistic view of all your Qlik Sense apps, including granular detail of an apps data model and its resource utilization.

Large data volumes

You can employ these architecture strategies when you are connecting to large data volumes.

Segmentation

You can segment QVDs by dimensions, such as time frame, region or aggregation level. For example, you can have:

- A QVD that contains data from the two most recent years.
- A QVD that contains historical data further than two years.
- A QVD that contains all data aggregated on a higher level. For example, per month instead of date, or per country instead of individual customers.
- One large QVD with all the data, which is only used by a small subset of users.

You can segment the apps in a similar way. Smaller apps will address the analytical needs of most users. This saves memory.

You can also have multiple apps focused on different regions. This way, users will not open an app with data that they are not interested in or do not have rights to access. Data that is not accessible via section access still affects memory.

On-Demand App Generation (ODAG)

Qlik Sense on-demand apps give users aggregate views of big data stores. They can identify and load relevant subsets of the data for detailed analysis.

From a user perspective, there are two apps:

1. A shopping cart with aggregated data.
2. An empty template app used to display detail.

The user makes selections in the shopping cart app. Once a threshold has been met, a custom LOAD script is created which populates the template app with the requested details.

Document chaining

Document chaining means that there is an aggregated app, which users consume regularly. If a user needs more detail, selections can be passed from the aggregated app to a detail app, so that they can view a lower level of granularity. This saves memory, because users are not loading unnecessary detail. Document chaining is supported via APIs.
Data model performance

These are indicators that can impact data model performance. Each one is a best practice that will improve app usability.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synthetic keys removed</td>
<td>Qlik Sense creates synthetic keys when two or more data tables have two or more fields in common. This may mean that there is an error in the script or the data model.</td>
</tr>
<tr>
<td>Circular references removed from data model</td>
<td>Circular references occur when two fields have more than one association. Qlik Sense will attempt to resolve these by changing the connection to one of the tables. However, all circular reference warnings should be resolved.</td>
</tr>
<tr>
<td>Appropriate granularity of data</td>
<td>You should only load data that is necessary. For example: a group of users only need data divided by week, month, and year. You can either load in the aggregated data or aggregate the data within the load script to save memory. If a user does need to visualize data at a lower level of granularity, you can use ODAG or document chaining.</td>
</tr>
<tr>
<td>QVDs used where possible</td>
<td>A QVD is a file containing a table of data exported from Qlik Sense. This file format is optimized for speed when reading data from a script, but is still very compact. Reading data from a QVD file is typically 10-100 times faster than reading from other data sources.</td>
</tr>
</tbody>
</table>
## Creating apps

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| **QVD files optimized on load** | QVD files can be read in two modes: standard (fast) and optimized (faster). The selected mode is determined automatically by the script engine. There are some limitations regarding optimized loads. It is possible to rename fields, but any of these operations will result in a standard load:  
  - Any transformations on the fields that are loaded.  
  - Using a `where` clause causing Qlik Sense to unpack the records.  
  - Using **Map** on a field that is loaded.  |
<p>| <strong>Incremental loads leveraged</strong> | If your app connects to a large amount of data from databases that are continuously updated, reloading the entire data set can be time consuming. Instead, you should use incremental load to retrieve new or changed records from the database.                                                                 |
| <strong>Snowflake model consolidated</strong> | If you have a snowflake data model, you may be able to reduce the number of data tables by joining some of them using the <code>Join</code> prefix or other mapping. This is especially important for large fact tables. A good rule of thumb is to have only one large table.                                                                                           |
| <strong>Tables that have a small number of fields are denormalized</strong> | If you have two tables with few fields, it may improve performance to join them.  |
| <strong>Denormalized lookup (leaf) tables with mapping loads</strong> | You should not use the <code>Join</code> prefix if you only need to add one field from a table to another. You should use the <strong>ApplyMap</strong> lookup function.                                                                                                                                               |</p>
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time stamps removed or decoupled from date field</td>
<td>Date fields can fill up space when the timestamp is present as the string representation is larger, and the number of distinct values is larger. If the precision is not necessary for your analysis, you can round the timestamp to e.g. the nearest hour using $\text{Timestamp(Floor(YourTimestamp, 1/24))}$ or remove the time component completely using $\text{Date(Floor(YourTimestamp))}$. If you want the timestamp, you can decouple it from the date itself. You can use the same Floor() function, and then create a new field with the extracted time by using something along the lines of: $\text{Time(Frac(YourTimestamp))}$.</td>
</tr>
</tbody>
</table>
| Unnecessary fields removed from data model       | You should only load necessary fields in your data model. Avoid using Load * and SELECT. Make sure you keep:  
  - Fields that are necessary for your analysis.  
  - Fields that are actually being used in the app.                                                                                                                                                                                                                                                                                       |
| Link tables avoided when dealing with high data volumes | You should use link tables where possible. However, if you are dealing with large data volumes, concatenated tables can out-perform link tables.                                                                                                                                                                                                 |
| Concatenated dimensions broken to new fields     | You should break apart concatenated dimensions into separate fields. This reduces the number of unique occurrences of values in your fields. This is similar to how timestamps can be optimized.                                                                                                                                                                                                 |
| AutoNumber used where possible                  | You can create an optimized load by loading your data from a QVD file first, and then using the AutoNumber statement to convert values to symbol keys.                                                                                                                                                                                                 |
| Data islands avoided                             | Data islands can be useful, but they usually affect performance. If you are creating islands for selection values, use variables.                                                                                                                                                                                                                |
### 2. Creating apps

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>QVDs are stored based on incremental timeframes</strong></td>
<td>You should store <strong>QVD</strong> in segments, such as monthly. These smaller monthly <strong>QVD</strong> can then support many different apps that might not need all of the data.</td>
</tr>
</tbody>
</table>

### Sheet performance

These are best practices that will improve performance of sheets and visualizations.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The If() function is avoided where possible</strong></td>
<td>If the If() function is used inside an aggregation function, it will operate at the record level and be evaluated many times.</td>
</tr>
<tr>
<td></td>
<td>For example, if you have 1000 records in an aggregation, an If() condition will be evaluated 1000 times. This could cascade rapidly if you nest statements. You should use set analysis instead. A set analysis filter is applied before the aggregation, resulting in a faster response. These responses can also be cached via set analysis, where If() cannot. You could also consider other functions and modifications to the data model.</td>
</tr>
</tbody>
</table>
### Action | Description
---|---
Fields from different tables inside an aggregation table are avoided where possible. | When an aggregation is evaluated, the calculation runs through two steps:
   1. The first step is finding the relevant combinations on which the calculation. This step is single-threaded.
   2. The second step is performing the calculation. This step is multi-threaded.
   The single-threaded part can affect performance considerably. One example is if you have multiple fields inside the aggregation, for example, Sum (Quantity*ListPrice). If Quantity is in the fact table, and ListPrice is in the master products table, the engine first needs to join the two tables to find the combinations before it can start to sum the product. The joining is the single-threaded part, and the summing is multi-threaded. If both fields are found in the same table, no join is necessary, and the aggregation is evaluated considerably faster.

Aggr() and nested Aggr() functions are used minimally | The Aggr() function greatly affects performance. Incorrect use can give inaccurate results. For example, in a table with dimensions that vary from the dimensions within the Aggr() function.

Set analysis is used where possible | You can use set analysis to define a set of data values that is different from the normal set defined by the current selections.

String comparisons avoided where possible | String comparisons are not as efficient as set analysis. For example, you should avoid Match(), MixMatch(), WildMatch(), and Pick(). Create flags in the script or use set analysis instead.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculation conditions are used on objects containing intensive calculations</td>
<td>You may have visualizations with many records when there are no selections. As a best practice, add calculation conditions to objects so that they only render after certain selections have been made. This stops the creation of very large hypercubes. For example: <code>GetSelectedCount([Country])=1 OR GetPossibleCount([Country])=1</code>. In this scenario, the visualization will not render unless the user selects a single country, or makes other selections where only a single country is possible.</td>
</tr>
<tr>
<td>Measures are pre-calculated in the script where possible</td>
<td>Any measure that is at the lowest level of granularity of the data model should be calculated in the script. For example, if in the same record in a table you have Sales and Cost, you could derive the margin by calculating <code>Sales - Cost AS Margin</code>. You can also aggregate other values in advance if you know that they will not vary based on selection, or that are bound to a different level of granularity.</td>
</tr>
<tr>
<td>Tables have less than 15 columns and have calculation conditions</td>
<td>A table with 15 columns could be considered wide. If your tables consist of many records, you should use calculated conditions on the table object so that it only renders after certain selections or criteria have been met. If your table is very wide, consider:</td>
</tr>
<tr>
<td></td>
<td>• Creating multiple smaller tables that show conditionally.</td>
</tr>
<tr>
<td></td>
<td>• Using methods to conditionally show columns.</td>
</tr>
<tr>
<td></td>
<td>• Keeping your tables limited to only what fields are necessary for your analysis.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sheets do not have an excessive number of objects</td>
<td>Objects are calculated when the user navigates to the sheet. Every time a user makes a selection on that sheet, each object will be recalculated if that current state does not exist in the cache. If you have a sheet with many charts, the user will have to wait for every object to calculate on nearly every selection. This puts significant load on the engine. As a best practice, follow the Dashboard/Analysis/Reporting (DAR) concept to develop a clean and minimal app.</td>
</tr>
<tr>
<td>Numeric flags are leveraged in the script for use in set analysis</td>
<td>Set analysis with flags can be more efficient than using string comparisons or multiplication.</td>
</tr>
<tr>
<td>Master items or variables used for expressions</td>
<td>Master items enable drag and drop of governed metrics and guarantee that expressions will be cached. For example, $\text{Sum}(\text{Sales})$ is different from $\text{SUM}(\text{Sales})$. Expressions are cached on spelling and case, and need to match verbatim in order to be reused.</td>
</tr>
</tbody>
</table>
Visualizations let you present data so that your app's users can interpret and explore it. For example, a bar chart that compares sales numbers for different regions, or a table with precise values for the same data. Good visualizations help you quickly and accurately interpret displayed data.

Visualizations are easy to add and customize. They can take the form of charts, such as bar charts, pie charts, tables, gauges, or treemaps. Each chart type has unique functionality. In the Qlik Sense Dev Hub, you can create custom objects. Qlik Sense automatically highlights items associated with your selections so you can as drill-down and filter.

*A sheet with four different visualizations*

3.1 Understand the data sources of your visualizations

You need to understand your data in order to design an effective visualization with a clear purpose. Ask yourself the following:

- What kind of data is it? Nominal, ordinal, interval, or ratio data?
- How do different parts of the data relate to each other?
- Can you organize the data in a way that makes it easy for you to create your visualizations?
What do you want to communicate with your data?

Are there dimensions or measures you will want to reuse in multiple visualizations?

You also need to understand your data in terms of fields, dimensions, and measures. These affect how your data is used in your visualizations.

3.2 Select visualization types that align with your purpose

Each visualization type has a specific goal. You need to think about the purpose of your visualization, and pick a visualization type that lets you explore your data for that purpose effectively.

For example: You want to show how a measure, quarterly sales, behaves over time. You should create a line chart, because one of its strengths is displaying how measure values change over time.

If you are unsure of what visualization types to use with your data, Qlik Sense offers two methods of creating visualizations with assistance:

- You can use Insight Advisor to let Qlik Sense analyze your data and generate visualizations based on your searches or selections. You can then choose to add these visualizations to your sheets.
- You can also create visualizations using chart suggestions by dragging a field onto the sheet from the assets panel and then dragging additional fields that you want in the visualization onto the first field. Qlik Sense then creates a suggested visualization based on the fields selected for the visualization.

3.3 Update visualizations to improve how data is displayed

As you create your visualizations, you can modify them to improve how data is displayed and highlighted within the sheet. You can also change the data, or switch the visualization type.

3.4 Data assets in visualizations

Visualizations use data in many different ways. How your data is comprised or created impacts your visualizations. Primarily, your data assets become dimensions and measures in your visualizations, defining the categories in your visualizations and the measurements of those categories. A field can be used to group data, or it can be transformed with an aggregate function to provide a measurement in data categories.

The types of data you have in your tables and fields also impacts whether they can be used as dimensions or measures, as well as what sorting options are most effective. For example, quantitative data and qualitative data have different recommended uses when they are used as either dimensions or measures.

In addition to providing the data to display, data assets can be used to control what data is displayed and how it is presented. For example, you can color a visualization using a dimension or measure not present in the visualization. For more information, see Changing the appearance of a visualization (page 526).

The assets panel contains the different data sources you can use in your visualizations.
3 Visualizations

Data assets

The following data assets are available when creating visualizations:

- Fields
- Measures
- Dimensions
- Master items

Fields

Fields hold the data loaded into Qlik Sense. Fields contain one or more values and correspond to columns in a database table. The field data can be qualitative or quantitative.

When creating visualizations, you use fields to create your dimensions and measures. You can also use fields in different ways when you add visualizations to your app. Some visualizations, such as tables, can present fields in an unmodified state.

Some fields require extra considerations, such as date or time fields.

For more information, see Fields (page 55).

Measures

Measures are the data that you want to show. Measures are created from an expression composed of aggregation functions, such as Sum or Max, combined with one or several fields.

For more information, see Measures (page 68).

Dimensions

Dimensions determine how the data in a visualization is grouped. For example: total sales per country or number of products per supplier. Dimensions display the distinct values from the field selected as a dimension. Dimensions can also be calculated using an expression.

For more information, see Dimensions (page 65).

Master items

Master items are dimensions, measures, or visualizations that can be reused in other visualizations and sheets in your app. Updating a master item updates every instance of it. This means you could have the same measure in 5 visualizations, and they would all update whenever the master item is changed.

Master items also have more design options available. You can, for example, assign colors to a master dimension's distinct values so that the distinct values are consistent across visualizations.

Master items also include special dimensions such as drill-down dimensions and calendar measures.

For more information, see Reusing assets with master items (page 77).
Expressions

An expression is a combination of functions, fields, and mathematical operators (+ * / =). Expressions are used to process data in the app in order to produce a result that can be seen in a visualization.

Expressions are used primarily to create measures. They can also be used to build calculated dimensions, or to set properties within different visualizations. For example, you can use expressions to define range limits for gauges, or reference lines for bar charts.

For more information, see Using expressions in visualizations (page 110).

Data types in visualizations

Different types of data have different properties; certain data may work better as dimensions, and some as measures. Similarly, as dimensions or measures, certain kinds of data may work better as a dimension in some visualizations better than others, or as a measure with certain aggregation functions.

The data in your fields can be quantitative or qualitative. Quantitative data values are measured numerically on an ascending scale. Quantitative data can be ratios or intervals:

- Ratio: Ratios are quantitative data that you can perform arithmetic operations on, such as cost or age. For example, you can sum sales values for the month to get totals.
- Interval: Intervals are quantitative data that you cannot perform arithmetic operations on. For example, you cannot calculate a sum of temperatures during the week, but you can calculate the average temperature per day, and the high/low for each day.

Qualitative data can not be measured numerically, but can be described through language. Qualitative data can be nominal or ordinal:

- Nominal: Fields with nominal data have distinct qualitative values, but without a set order. For example, product names or customer names are nominal data, as they have distinct values, but do not have a required order.
- Ordinal: Fields with ordinal data have qualitative values that have a ranked or positioned value. Ordinal data should be sorted by its order as opposed to alphabetically. For example, low, medium, high are ordinal values. Small, medium, and large are also ordinal values.

The following table contains a general overview of recommended visualization types and aggregation functions for data types. These recommendations should not be considered absolute.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Recommended aggregation functions</th>
<th>Non-recommended aggregation functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal</td>
<td>Count</td>
<td>Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Median</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sum</td>
</tr>
</tbody>
</table>
### 3 Visualizations

<table>
<thead>
<tr>
<th>Data type</th>
<th><strong>Recommended aggregation functions</strong></th>
<th><strong>Non-recommended aggregation functions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordinal</td>
<td>Count</td>
<td>Average</td>
</tr>
<tr>
<td></td>
<td>Median</td>
<td>Sum</td>
</tr>
<tr>
<td>Ratio</td>
<td>Count</td>
<td>Sum</td>
</tr>
<tr>
<td></td>
<td>Average</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Median</td>
<td></td>
</tr>
<tr>
<td>Interval</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Average</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Median</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td></td>
</tr>
</tbody>
</table>

### Fields

Fields hold the data that is used in Qlik Sense. Fields can be thought of as the data loaded from the load script.

Fields contain one or more values, called field values, and at the basic level, correspond to columns in a database table, but can also exist in more than one table. Field values consists of numeric or alphanumeric data. When loaded from the load script, fields can be represented as a table visualization.

Example of data in a load script:

```sql
Temp:
LOAD * inline [
    Customer Product UnitSales UnitPrice
    Imagine Film 4 16
    Imagine Film 10 15
    Imagine Shutter 9 9
    PhotoInc Shutter 5 10
    PhotoInc Lens 2 20
    PhotoInc Magnifier 4 25
    Gallery Film 8 15
    Gallery Lens 7 19
] (delimiter is ',');
```

The fields represented in a data model table after having loaded the data:
The same fields as columns in a table visualization on a sheet:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Product</th>
<th>UnitPrice</th>
<th>UnitSales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery</td>
<td>Film</td>
<td>15</td>
<td>8</td>
</tr>
<tr>
<td>Gallery</td>
<td>Lens</td>
<td>19</td>
<td>7</td>
</tr>
<tr>
<td>Imagine</td>
<td>Film</td>
<td>15</td>
<td>10</td>
</tr>
<tr>
<td>Imagine</td>
<td>Film</td>
<td>16</td>
<td>4</td>
</tr>
<tr>
<td>Imagine</td>
<td>Shutter</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>PhotosInc</td>
<td>Lens</td>
<td>26</td>
<td>2</td>
</tr>
<tr>
<td>PhotosInc</td>
<td>Magnifier</td>
<td>25</td>
<td>4</td>
</tr>
<tr>
<td>PhotosInc</td>
<td>Shutter</td>
<td>10</td>
<td>5</td>
</tr>
</tbody>
</table>

Date & time fields

If you are working with fields containing date or timestamp information in your app, you can define a number of related attributes of a date, for example, year or week, and use them in your visualization.

Creating date fields in Data manager

Date fields are created automatically for all data fields recognized as a date or a timestamp when you use Add data with data profiling enabled to build your data model in Data manager, or when you click Load data in Data manager.

- Date fields created in Data manager are automatically added to autoCalendar.

If the date or timestamp field is not recognized automatically, you can adjust the input format in the Data manager table editor. You can also set the display format to use in visualizations.

Which date & time fields are automatically recognized?

Date & timestamp fields will be recognized automatically based on your system locale settings. Additionally, the following formats are recognized:

- M/D/YYYY h:mm
- D/M/YYYY h:mm TT
- M/D/YYYY
3 Visualizations

- D/MM/YYYY
- YYYYMMDD
- YYYYMMDDhhmmss
- YYYYMMDDhhmmss.fff
- YYYYMMDDhhmmssK
- YYYY-MM-DD
- YYYY-MM-DDThh:mm:ss
- YYYY-MM-DDThh:mm:ss.fff
- YYYY-MM-DDThh:mm:ssK

**Date & time formats**

<table>
<thead>
<tr>
<th>Format specifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YYYY</td>
<td>Year</td>
</tr>
<tr>
<td>M, MM</td>
<td>Month</td>
</tr>
<tr>
<td>D, DD</td>
<td>Day</td>
</tr>
<tr>
<td>hh</td>
<td>Hour</td>
</tr>
<tr>
<td>mm</td>
<td>Minute</td>
</tr>
<tr>
<td>ss</td>
<td>Second</td>
</tr>
<tr>
<td>fff</td>
<td>Millisecond</td>
</tr>
<tr>
<td>TT</td>
<td>AM or PM</td>
</tr>
<tr>
<td>K</td>
<td>Timezone</td>
</tr>
<tr>
<td>T</td>
<td>Divider between date and time. T can not be replaced with another character.</td>
</tr>
</tbody>
</table>

Creating date & time fields in the data load script

If you use the data load editor to build your data model, you need to create a calendar template where you define which fields to derive in the data load script. The derived date & time fields will be generated when the script is run and data is reloaded.

Using date & time fields in your app

**Date & time fields in visualizations**

All date or timestamp fields in the assets panel **Fields** tab are marked with 🔑, and you can expand them to use the generated date & time fields. You can use them in visualizations, just like any other data field.

**Date & time fields in dimensions**

You can also use date & time fields when you create a dimension. The date & time fields are listed under the field that they have been generated from.

**Date & time fields in expressions**

You can use date & time fields in all expressions, for example when you create a measure. The date & time fields are named according to:
[field name].autoCalendar.[date & time field].

- [field name] is the name of the data field that was used to generate date & time fields.
- [date & time field] is the date & time field you want to use, for example, Year.

**Example:**

Date.autoCalendar.Year

**Date & time fields in calendar measures**

Calendar measures use date & time fields created in autoCalendar. Each of these date & time fields is calculated by a set analysis expression that determines whether or not data falls within the time-to-date period, or if dates are within a defined relative position to the current date. These date & time fields are relative and return results based on the current date. You can use these fields independently of calendar measures.

Calendar field date & time fields are formatted as follows:

[field name].autoCalendar.[date & time field]=[{value}]

- [field name] is the name of the date field used to generate date & time fields.
- [data & time field] is the name of the date & time field used, for example, InYTD.
- [value] is the value for the date & time field’s set analysis expression and determines which dates are included.

**Example:**

Date.autoCalendar.YearsAgo={1}

The following are the available date & time fields with sample values:

**InYTD**

This date & time field determines whether or not dates are within the year-to-date range or outside the year-to-date range.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.InYTD= {0}</td>
<td>Returns all dates that fall in the year-to-date time range. For example, if the current date was the 54th day of the year, the dates within the first 54 days of every year in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.InYTD= {1}</td>
<td>Returns all dates outside the year-to-date time range. For example, if the current date was the 54th day of the year, all the dates after the first 54 days of every year in the date field would be included.</td>
</tr>
</tbody>
</table>

**Years Ago**

This date & time field determines whether or not dates are from a specific year relative to the current date.
### Years Ago

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.YearsAgo={0}</td>
<td>Returns all dates from this year.</td>
</tr>
<tr>
<td>Date.autoCalendar.YearsAgo={1}</td>
<td>Returns all dates from last year.</td>
</tr>
<tr>
<td>Date.autoCalendar.YearsAgo={8}</td>
<td>Returns all dates from eight years ago.</td>
</tr>
</tbody>
</table>

### In QTD

This date & time field determines whether or not dates are within the quarter-to-date range or outside the quarter-to-date range, relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.InQTD=0</td>
<td>Returns all dates from all quarters that are within the quarter-to-date range. For example, if the current date was the 14th day of Quarter 1, the first 14 days of every quarter in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.InQTD=1</td>
<td>Returns all dates from all quarters that are outside the current quarter-to-date range. For example, if the current date was the 14th day of Quarter 1, all dates after the first 14 days of every quarter in the date field would be included.</td>
</tr>
</tbody>
</table>

### Quarters Ago

This date & time field determines whether or not dates are from a specific quarter relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.QuartersAgo=0</td>
<td>Returns all dates from the current quarter.</td>
</tr>
<tr>
<td>Date.autoCalendar.QuartersAgo=1</td>
<td>Returns all dates from the last quarter.</td>
</tr>
<tr>
<td>Date.autoCalendar.QuartersAgo=8</td>
<td>Returns all dates from eight quarters ago.</td>
</tr>
</tbody>
</table>

### Quarter Rel No

This date & time field determines whether or not dates are from a specific quarter relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.QuarterRelNo=0</td>
<td>Returns all dates from each instance of the current quarter. For example, if the current date was in Quarter 4, all dates from each Quarter 4 in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.QuarterRelNo=1</td>
<td>Returns all dates from the next quarter after the current quarter.</td>
</tr>
<tr>
<td>Date.autoCalendar.QuarterRelNo=8</td>
<td>Returns all dates from eight quarters ago.</td>
</tr>
</tbody>
</table>
### Visualizations

#### Example

| Date.autoCalendar.QuarterRelNo= {3} | Returns all dates from each instance of the quarter two quarters prior to the current quarter. For example, if the current date was in Quarter 4, all dates from each Quarter 1 in the date field would be included |

#### InMTD

This date & time field determines whether or not dates are within the month-to-date range or outside the month-to-date range, relative to the current date.

| Date.autoCalendar.InMTD= {0} | Returns all dates from all months that are within the current month-to-date range. For example, if the date was November 15, 2016, dates from the first 15 days of every month in the date field would be included. |
| Date.autoCalendar.InMTD= {1} | Returns all dates from all months that are outside the current month-to-date range. For example, if the date was November 15, 2016, dates after the first 15 days to the end of the month of every month in the date field would be included. |

#### MonthsAgo

This date & time field determines whether or not dates are from a specific month relative to the current date.

| Date.autoCalendar.MonthAgo={0} | Returns all dates from the current month. |
| Date.autoCalendar.MonthAgo={1} | Returns all dates from the last month. |
| Date.autoCalendar.MonthAgo={8} | Returns all dates from eight months ago. |

#### MonthRelNo

This date & time field determines whether or not dates are from a specific month relative to the current date.
### Visualizations

#### MonthRelNo

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.MonthRelNo={0}</td>
<td>Returns all dates from each instance of the current month. For example, if the current month was June, all dates in every instance of June in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.MonthRelNo={1}</td>
<td>Returns all dates from the each instance of the previous month. For example, if the current month was June, all dates in every instance of May in the date field would be included.</td>
</tr>
</tbody>
</table>

#### InWTD

This date & time field determines whether or not dates are within the week-to-date range or outside the week-to-date range, relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.InWTD={0}</td>
<td>Returns all dates from all weeks that are within the current week-to-date range. For example, if the current date was the third day of a week, dates from the first three days of every week in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.InWTD={1}</td>
<td>Returns all dates from all months that are outside the current month-to-date range. For example, if the current date was the third day of a week, dates from the last four days of the every week in the date field would be included.</td>
</tr>
</tbody>
</table>

#### WeeksAgo

This date & time field determines whether or not dates are from a specific week relative to the current week.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.WeeksAgo={0}</td>
<td>Returns all dates from the current week.</td>
</tr>
<tr>
<td>Date.autoCalendar.WeeksAgo={8}</td>
<td>Returns all dates from eight weeks ago.</td>
</tr>
</tbody>
</table>

#### WeekRelNo

This date & time field determines whether or not dates are from a specific week relative to the current date.
### WeekRelNo

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.WeekRelNo=0</code></td>
<td>Returns all dates from each instance of the current week. For example, if the current week was the second week of the year, dates from the second week of every year in the date field would be included.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.WeekRelNo=1</code></td>
<td>Returns all dates from each instance of the previous week. For example, if the current week was the second week of the year, dates from the first week of every year in the date field would be included.</td>
</tr>
</tbody>
</table>

#### Always one selected value

You can select the **Always one selected value** for a field in an app. The value specifies that one, and only one, value is always selected for a field. You can use this value to specify, for example, that one currency is always selected for a field.

Consider the following when using the **Always one selected value**:

- You can use the **Always one selected value** on one or more fields.
- You cannot clear the **Always one selected value** setting when viewing a sheet. You can, however, clear the setting by editing the sheet in your workspace.
- When you publish an app with the **Always one selected value** selected, the value is applied to all sheets in the app. The app consumer cannot clear the value.
- When you duplicate an app, the **Always one selected value** is duplicated with the app.
- When you export an app without data, the **Always one selected value** is not exported with the app.
- The **Always one selected value** is not supported for derived fields.

You can use the value with a default bookmark in to highlight specific selections for your app consumer.

**Set the Always one selected value**

**Do the following:**

1. Open a sheet in an app.
2. Click **Edit sheet**.
3. Click **Fields**.
4. Right-click a field, and then click **Field settings**.
5. In the window that opens, select the **Always one selected value** check box, and then save.
6. Click **Done** to finish editing. The value appears as a tab in the top toolbar. Unlike a bookmark, there is no option to clear the selection.

*The Always one selected value in the toolbar*
The **Always one selected value** defaults to the first entry in the field. In the example above, the value is applied to **Currency**. **CHF** is the currency that is selected by default. You or your app consumer can change this selection, in this case to a different currency.

7. To test that the **Always one selected value** is working properly, close and then reopen the app. The value should be shown in the top toolbar.

To remove the **Always one selected value** for a field, right-click the field in **Edit** mode, click **Field settings**, and deselect the **Always one selected value** check box.

**Always one selected value and default bookmark example: Controlling selections to guide app consumers to insights**

In this example, we set **Always one selected value** for a field. We then specify a default bookmark for the app. By specifying a default bookmark, and enabling **Always one selected value**, we control what our app consumers see when they open our published app.

1. Here is a sheet in our app before the **Always one selected value** and a default bookmark are applied. This should be the sheet that you want app consumers to see as a landing page when they open the app.

![Sheet before Always one selected value and default bookmark](image)

For the **Amount** measure in the chart above, we used this expression: `=sum(DISTINCT <Currency=>) Amount_LOCAL)* RATE`

2. To ensure that one, and only one, value is always selected for the **Currency** field, we edit the sheet, click **Fields**, and then right-click **Currency**.

3. We then select the **Always one selected value** check box and save.
4. When we close **Edit** mode for the app, the **Always one selected value** value appears as a tab in the top toolbar. The value defaults to the first entry in the field, in this case the value is **CHF**.

5. However, we want to show expenses in **Euro** when the app is opened. So we select **Euro** from the **Currency** field, and then click **Bookmarks** to create a new bookmark for **Currency("EUR")**. We then right-click the **Currency("EUR")** bookmark, and click **Set as default bookmark**.

Now, when we open the app, or publish the app for an app consumer, the app opens with one value selected, and the default bookmark is shown. The app is opened on the sheet of the bookmark instead of the app overview.
Dimensions

Dimensions determine how the data in a visualization is grouped. For example: total sales per country or number of products per supplier. You typically find a dimension as the slices in a pie chart or on the x-axis of a bar chart with vertical bars.

Dimensions are created from fields in the data model tables.

Example:

*Product Type* is a field in the *Product* table that is loaded into the app. The values of this field are the different types that products are grouped into.

You can, for example, create a bar chart to visualize the cost of each type, by adding the *Product Type* dimension to the chart. To complete the visualization, you must add a measure (in this case Cost), which is grouped by the *Product Type* dimension.

*Bar chart with the dimension Product Type and measure Cost.*

Field groups as dimensions

One main difference between Qlik Sense and many other database viewers and online analytical processing tools (OLAP systems), is that in Qlik Sense, you do not need to predefine any hierarchies in the input data. The unique internal logic of Qlik Sense gives you the complete freedom to access any field as a full dimension in any order you like.

For most purposes, the built-in functionality is fully satisfactory, but in some situations, a predefined hierarchy can help you to display data more efficiently. In Qlik Sense, you can achieve this by defining hierarchic groups of fields as drill-down dimensions.

Any fields or calculated dimensions can be grouped together.
Drill-down groups
When several fields form a natural hierarchy, it can make sense to create a drill-down group.

Example 1:

Organization: Company, Department, Employee

Example 2:

Geography: Continent, Country, State, City

When you use a drill-down group as a dimension in a chart, the chart uses the first field in the group's list of fields that has more than one possible value. If the currently made selections cause the field to have only one possible value, the next field in the list is used instead, provided that it has more than one possible value. If no field in the list has more than one possible value, the last field is used anyway.

In the first example above, Company will be used as chart dimension until a single company is selected. The chart will then show Department. If a single department is selected, the chart will switch to Employee.

As selections are reverted, so that more than one value becomes possible in the upper fields of the group's field list, the chart is automatically drilled back up.

Drill-up
The drill-up function is available in bar charts, pie charts, and line charts. Other visualizations reflect the changes made in the charts, but cannot themselves be used to drill up through the different dimensions.
When you drill down in a dimension group, breadcrumbs provide links back to the previous dimensions. Click the dimension that you want to drill up to.

In the following bar chart, the breadcrumbs Year > Quarter > Month enable drilling up.
Calculated dimensions

You can use expressions to create calculated dimensions. A calculated dimension consists of an expression involving one or more fields. All standard functions may be used.

For performance reasons, it is recommended to perform all calculations in the data load editor. When dimensions are calculated in the chart, Qlik Sense first calculates the dimension values, and then aggregates the measures for these calculated values, which affects the performance more than calculations in the load script.

There are cases when calculated dimensions are powerful in data analysis, for example, if you want to generate the dimensions values during analysis, when dimension values are dependent on the selections.

Calculated dimensions are also useful if you want to modify a field.

Once you have created a calculated dimension, you can use it as any other dimension.

Example:

You have a field called Calendar Month that includes each of the months of the year. In your app, you want include a table that shows the sales for each of the first 6 months of the year. For the rest of the months, you want to see a total. You can use an expression to create this calculated dimension.

Syntax:

If ([Calendar Month] < 7, [Calendar Month], 'Rest')
Measures

Measures are calculations used in visualizations, typically represented on the y-axis of a bar chart or a column in a table. Measures are created from an expression composed of aggregation functions, such as $\text{Sum}$ or $\text{Max}$, combined with one or several fields.

A measure must have a name, and may also be supplied with descriptive data such as description and tags.

**Example:**

You can, for example, create a bar chart to visualize the cost of each type, by adding the *Product Type* dimension to the chart, and the measure *Cost*, which is made from the expression $\text{Sum}(\text{Cost})$, that is the result of the calculation of the aggregation function $\text{Sum}$ over the field *Cost*. The results are grouped by the *Product Type* dimension.

*Bar chart with the dimension Product Type and the measure Cost.*

Modifiers

Measures are calculations based on fields, for example $\text{Sum}(\text{Cost})$. You can use modifiers to change how the measure is calculated over the available dimensions.

For example, you can have the values of a measure accumulate over one or two dimensions, or you can calculate the average of your measure over a specific number of steps.
Which visualizations have modifiers

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Accumulation</th>
<th>Difference</th>
<th>Moving average</th>
<th>Relative numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Combo chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Line chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Table</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Accumulation

The accumulation modifier allows you to accumulate the values of a measure over one or two dimensions. Accumulating values makes it easy to visualize how the effect of the measure builds up over a dimension.

In the following combo chart, the bars and lines accumulate over time.

* A combo chart where the line shows the accumulated profit margin and the bars show the accumulated sales figures.

Syntax:

```
RangeSum(Above($M,0,Steps))
```

Difference

The difference modifier allows you to visualize the difference between consecutive values of a measure over one or two dimensions. The difference modifier is useful when you want to visualize the change in direction of grouped data.

In the following bar chart, any drops in yearly profits over a 10 year period appear as negative bars.

* A bar chart showing the profit differences from one year to the next.
Syntax:

\$M \text{ - } \text{Above (\$M)}

Moving average

The moving average modifier allows you to see the average values of a measure over a specific period. You can use it to filter out the action from short-term value fluctuations. You can change the number of steps over which the averaging takes place, depending on how strongly you want your modifier to follow the changes in your data. A moving average is commonly used with time series data to highlight longer-term trends or cycles.

In the following line chart moving averages with two difference ranges are shown, one with a 20 step range, and one with a full range.

*A line chart showing the price of a product over a five month period.*
Visualizations

Syntax:

\texttt{RangeAvg(Above (SM,0,Steps))}

Relative numbers

The relative numbers modifier allows you to see relative percentages. You can use it to see the impact of specific selections, relative to the selection, relative to the total, or relative to other fields. You can change the basis upon which the relative number is calculated.

In the following table a column with sales of each year of a specific selection, and three columns with relative numbers are shown, one relative to current selection, one relative to total sales for all years, and one relative to the sales of each year.

\textit{A table showing different sales percentages relative to current selection, relative to total sales, and relative to each year's sales.}

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales</th>
<th>Percentage of this selection</th>
<th>Compared to total sales from all years</th>
<th>Compared to other products in the same year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td>$20,520,054</td>
<td>100%</td>
<td>20%</td>
<td>20%</td>
</tr>
<tr>
<td>2012</td>
<td>$8,796,082</td>
<td>40%</td>
<td>8%</td>
<td>21%</td>
</tr>
<tr>
<td>2013</td>
<td>$7,087,738</td>
<td>37%</td>
<td>7%</td>
<td>16%</td>
</tr>
<tr>
<td>2014</td>
<td>$4,621,314</td>
<td>23%</td>
<td>4%</td>
<td>21%</td>
</tr>
</tbody>
</table>

The following is an example of the syntax of the modifier relative to the total selection.

Syntax:

\texttt{SM / Sum( total Aggr( SM, dim ) )}
Trend lines
A trend line is a visual representation of the direction of values over a period of time. Trend lines show trends over time, by visualizing the direction of values and how fast the values change.

Which visualizations have trend lines

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Trend lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Yes</td>
</tr>
<tr>
<td>Line chart</td>
<td>Yes</td>
</tr>
</tbody>
</table>

When to use trend lines
A single trend line can be added to a chart to smooth out fluctuations in data, and to show any trends more clearly.

More than one trend line can be added to a chart, showing different types of trends or different values.

Types of trend lines

**Average**
An average trend line shows the average value of the data, for the time period being analyzed.

*A bar chart showing sales per month. An average trend line is shown with a dashed red line.*
### Linear

A linear trend line shows increase or decrease of values at a steady rate. Linear trend lines are usually used with simple linear data sets.

*A bar chart showing sales per month. An linear trend line is shown with a dashed red line.*

### Polynomial (second, third, fourth degree)

A polynomial trend line is a curved line used on fluctuating data.

The number of data fluctuations can determine the order of the polynomial. A second degree polynomial trend line has one hill or valley, a third degree polynomial trend line has up to two hills or valleys, and a fourth degree polynomial has up to three hills or valleys.

*A bar chart showing sales per month. Polynomial trend lines of second, third, and fourth degree are shown with dashed red, yellow, and green lines respectively.*
Exponential

An exponential trend line is a curved line used when data values rise or fall at increasingly higher rates.

A bar chart showing sales per month. An exponential trend line is shown with a dashed red line.
Logarithmic
A logarithmic trend line is a curved line used when the rate of change in data increases or decreases quickly, before leveling out.

A bar chart showing sales per month. A logarithmic trend line is shown with a dashed red line.
Power

A power trend line is a curved line used with data sets that compare measurements that increase at specific rates.

A bar chart showing sales per month. A power trend line is shown with a dotted red line.
Reusing assets with master items

When you create and build your visualizations, you can save assets to reuse in other visualizations and on other sheets. You can save visualizations, dimensions and measures, as master items in the assets panel. When your app gets published these master items will be available to others as ready-to-use visualizations, dimensions and measures.

Any updates you make to the master item are applied everywhere the master item is used. For example, you could use a master measure in as many of your visualizations as you like while only having to update it in a single instance to update all instances of the measure in your visualizations.

One of the purposes with creating and maintaining master items is for other users to explore their own ways and directions in the data, on top of what you have provided in the app as pre-made sheets with visualizations. The users will be able to create their own visualizations with your pre-made master dimensions and master measures, for example.

Reusing visualizations with a master visualization

You can create a master visualization to be able to reuse it. Users of a published app will have access to the master visualizations, but will not be able to modify them.

You can only create master visualizations when you are working with an unpublished app. Visualizations with Chart suggestions enabled cannot be made into a master visualization.
3 Visualizations

Do the following:

1. While editing a sheet, drag a visualization from the sheet to the master items.
   If you have given the visualization a title, this is automatically added as the name of the master visualization.
2. Add a name, or change the name if you want to.
3. Type a description for the visualization (optional).
4. Add tags (optional).
5. Click Add.

The visualization is now saved to the master items tab.

You can also add a visualization to the master items by long-touching/right-clicking it on the sheet, and selecting Add to master items.

Editing a master visualization

When you update a visualization in the master items, the changes will be reflected in all instances of the master visualization.

Do the following:

1. In sheet view, click Edit sheet in the toolbar. The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the visualization that you want to edit. The preview opens.
4. Click at the bottom of the preview.
   If the visualization is used on a sheet, a dialog is displayed to inform you that any changes to the master visualization will be applied to all its instances on the sheets.
5. Click OK. The visualization opens for editing.
6. Make the changes you want, and click Done in the upper right corner of the visualization to finish editing.

The visualization is updated and reflected in all its instances.

You can also edit a master item from its preview. You open the preview by clicking an item in the master items.
Visualizations

Reusing dimensions with master dimensions

When you are working with an unpublished app, you can create master dimensions so that they can be reused. Users of a published app will have access to the master dimensions, but will not be able to modify them.

You can create a master dimension in different ways.

Creating a master dimension from a field

When you are working with an unpublished app, you can create master dimensions so that they can be reused. You can create a master dimension from the Fields section of the assets panel.

Do the following:

1. Click Edit sheet in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to select the fields tab.
3. Click the field you want to use to create a dimension.
   The preview opens.
4. Click at the bottom of the preview.
   The Create new dimensions dialog opens with the field you selected. The field name is also used as the name of the dimension.
5. Select if the dimension is to be single or drill-down.
6. Edit the name if you want to.
7. Type a description for the dimension (optional).
8. If you want to specify a color, click in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
9. Add tags (optional).
10. Click Create.
11. Click Done to close the dialog.

The dimension is now saved in the Dimensions category in the master items, and you can use it in visualizations.

You can quickly add several dimensions as master items by clicking Add dimension after adding each dimension. Click Done when you have finished.
Do the following:

1. Click Edit sheet in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to select the master items tab.
3. Click the Dimensions heading to expand the category.
4. Click Create new.
   The Create new dimensions dialog opens.
5. Select if the dimension is to be single or drill-down.
6. Click a field on the left-hand side to select it.
   The name of the field is automatically added as the name of the dimension.
7. Change the name if you want to.
8. Type a description for the dimension (optional).
9. If you want to specify a color, click in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
10. Add tags (optional).
11. Click Create.
12. Click Done to close the dialog.

The dimension is now saved in the Dimensions category in the master items, and you can use it in visualizations.
Creating a drill-down dimension

When adding a dimension, you can select between creating a single or a drill-down dimension.

The following description explains how to create a drill-down group from the Create new dimensions dialog.

If selections cause the current drill-down dimension field to have only one possible value, the next field in the list is used instead.

Do the following:

1. Select Drill-down as dimension type.
2. Click at least two fields from the fields list on the left-hand side to insert them as the referenced fields.
   
   You can filter which table to select fields from in the drop-down list.
   
   You can rearrange the order of the fields you have selected by dragging them to new positions in the list of selected fields.

3. Type a name for the dimension.
4. Type a description for the dimension (optional).
5. If you want to specify a color, click ▼ in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
6. Add tags (optional).
7. Click Create.
8. Click Done to close the dialog.

The drill-down dimension is now saved in the Dimensions category among the master items.

When you click the dimension in the panel on the left-hand side, the preview displays the dimension type and which fields are included in the drill-down dimension.

The preview displays the dimension type and which fields are included in the drill-down dimension.
Creating a calculated dimension

You can create a calculated dimension from the Master items tab in the assets panel. The expression editor opens from the Create new dimensions dialog.

Do the following:

1. Click the Dimensions heading on the Master items tab to expand the category.
2. Click Create new.
   The Create new dimensions dialog opens.
3. Click $\text{\textit{fx}}$ in the Field text box to open the Add expression dialog.

You will now be able to add expressions in different ways, depending on your preferences and of different levels of complexity.

You can also add an expression by typing directly into the Field text box, but you will then not be provided with syntax highlighting and syntax check.

Using a common function

1. Select a field from the drop-down list.
2. Click the aggregation function you want to use.
3. Click Insert to insert the function and the field into the expression editor.
You can insert just a function or just a field by selecting only one of them.

4. Click Apply to close the Add expression dialog. Continue by adding the descriptive data for the dimension.

Adding an expression by typing

1. Type the expression directly in the expression editor. The field names you use in the expression are checked, and the syntax of the expression is validated.

As you type in the expression editor, the expression is validated continuously. If there is an error, you see a hint about what is incorrect. Additional error information may be available by clicking the icon next to the hint.

Each line in the expression editor is numbered and syntax highlighting is used.

2. Click Apply to close the Add expression dialog. For a measure, you continue by adding the descriptive data for the measure.

Adding an expression through the properties panel

You can add an expression to a visualization through the properties panel.

1. Open the sheet with the visualization that you want to edit.
2. Click Edit sheet to open the properties panel. (If it is hidden, click Show properties in the lower right-hand corner to open it.)
3. Click the visualization that you want to edit. The properties panel for that visualization is displayed on the right-hand side.
4. Under Data, click Add data and select Dimension. A dimension text box is displayed.
5. Type your expression. The expression must begin with an equals sign (=), otherwise the string will be interpreted as text.

Detailed syntax help

You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name.

This feature is supported only when using a computer with a keyboard.

Adding the descriptive data for the dimension

After having entered the expression, you need to add some descriptive information.

1. Type a name for the dimension.
2. Type a description for the dimension (optional).
3. Optionally, click in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

4. Add tags (optional).
5. Click Create.
6. Click Done to close the dialog.

The calculated dimension is now saved in the Dimensions category of the Master items, and you can use it in visualizations.

Editing a master dimension

When you update a master dimension, the changes will be reflected in all its instances, including all visualizations that use it.

Do the following:

1. In sheet view, click in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the dimension that you want to edit.
   The preview opens.
4. Click at the bottom of the preview.
   If the dimension is used on a sheet, a dialog is displayed to inform you that any changes to the master dimension will be applied to all its instances on the sheets.
5. Click OK.
   The Edit dimension dialog opens, where you update the field or expression, name, description and tags.
6. Click Save.

The dimension is now updated.

You can also edit a master item from its preview. You open the preview by clicking an item in the master items.

Deleting a master dimension or master measure

You can delete dimensions and measures from the master items as long as the app is not published.

If you delete a master dimension or master measure, the visualizations that use the deleted master item will not work unless you replace it with a new dimension or measure.

Do the following:
1. In sheet view, click Edit sheet in the toolbar. The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the dimension or measure that you want to delete. The preview opens.
4. Click at the bottom of the preview. A dialog is displayed stating that all visualizations that use the dimension or measure will stop working.
5. Click OK.

The dimension or measure is deleted from the master items, and all visualizations on the sheets that used the deleted item do not work anymore. You see the text **Dimension not found** or **Measure not found** on those visualizations.

* A visualization that is lacking both a dimension and a measure, both which have been deleted from the master items.

---

**Replacing an invalid dimension or measure**

When a dimension or measure has been deleted from the master items, all visualizations that reference to the deleted master item will not work anymore, until the missing dimension or measure is replaced.

Do the following:
1. In sheet view, click **Edit sheet** in the toolbar. The assets panel opens on the left-hand side. Click **prism** to display the master items.

2. Drag a dimension or measure from the **Dimensions** or **Measures** sections to the visualization on the sheet. The shortcut menu opens.

3. Select **Replace invalid dimension** or **Replace invalid measure**. The visualization is complete and works again.

### Reusing measures with master measures

When you are working with an unpublished app, you can create master measures so that they can be reused. Users of a published app will have access to the master measures, but will not be able to modify them.

A master measure is a combination of an expression and descriptive data, such as name, description and tags. You can create a master measure in different ways.

You can also create a master measure based on a measure created in a visualization. Under the measure in the properties panel of a visualization, click **Add new** under **Master items**.

### Creating a master measure from a field

When you are working with an unpublished app, you can create master measures so that they can be reused. You can create a master measure from the **Fields** section of the assets panel.

1. Click **Edit sheet** in the toolbar. The assets panel opens on the left-hand side.

2. Click **prism** to select the fields tab.

3. Click the field you want to use to create a measure. The preview opens.

4. Click **fx** at the bottom of the preview.

5. The **Create new measure** dialog opens with the field you selected as the name of the measure and as a part of the expression.

6. Click **fx** in the **Expression** field to open the **Edit expression** dialog.

7. Type the expression directly in the expression editor (the main window). The field names you use in the expression are checked, and the syntax of the expression is validated.

   **As you type in the expression editor, the expression is validated continuously. If there is an error, you see a hint about what is incorrect in the lower left-hand corner. Additional error information may be available by clicking the icon next to the hint.**

   Each line in the expression editor is numbered and syntax highlighting is used.
You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name, and only when using a computer with a keyboard.

8. Click **Apply** to close the **Add expression** dialog.
   Now you need to add some descriptive data for the measure.

9. Edit the name if you want to.

10. Type a description for the measure (optional).

11. If you want to specify a color, click ▼ in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field.
   - Click ⬇ at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

12. Add tags (optional).

13. Under **Number formatting**, you can choose:
   - Auto
   - Number
   - Money
   - Date
   - Duration
   - Custom
   - Measure expression

14. Click **Create**.

The measure is now saved in the **Measures** category in the master items, and you can use it in visualizations.

Direct Discovery fields are indicated by ◾️ in the **Fields** section of the assets panel.

Creating a master measure with a common aggregation function
When you are working with an unpublished app, you can create master measures so that they can be reused. You can easily create a measure using one of the most common aggregation functions by selecting the function and the field from drop-down lists.
3 Visualizations

Do the following:

1. Click Edit sheet in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to select the master items tab.
3. Click the Measures heading to expand that category.
4. Click Create new.
   The Create new measure dialog opens.
5. Click in the Expression field to open the Add expression dialog.
   You find drop-down lists for selecting a field and a common function on the right-hand side.
6. If you want to show fields from a particular table, select this table in the top drop-down list (optional).
7. Select a field from the Field drop-down list.
8. Select a function from the bottom drop-down list.

You can insert just a field by not selecting a function.

9. Click Insert to insert the field and the function into the expression editor.

You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name, and only when using a computer with a keyboard.

10. Click Apply to close the Add expression dialog.
    Now you need to add some descriptive data for the measure.
11. Type a name for the measure.
12. Type a description for the measure (optional).
13. If you want to specify a color, click in the color drop down and select a color through one of the following methods:
    - Click one of the colors in the palette.
    - Type a 6 character color code in the Hex input field.
    - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
15. Under Number formatting, you can choose:
    - Auto
    - Number
    - Money
3 Visualizations

- Date
- Duration
- Custom
- Measure expression

16. Click Create.

The measure is now saved in the Measures category in the master items, and you can use it in visualizations.

Creating a master measure by typing the expression

When you are working with an unpublished app, you can create master measures so that they can be reused. You can add complex expressions by typing the expression into the expression editor.

1. Click Edit sheet in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to select the master items tab.
3. Click the Measures heading to expand that category.
4. Click Create new.
   The Create new measure dialog opens.
5. Click in the Expression field to open the Add expression dialog.
6. Type the expression directly in the expression editor (the main window).
   The field names you use in the expression are checked, and the syntax of the expression is validated.

   As you type in the expression editor, the expression is validated continuously. If there is an error, you see a hint about what is incorrect in the lower left-hand corner. Additional error information may be available by clicking the icon next to the hint.

   Each line in the expression editor is numbered and syntax highlighting is used.

   You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name, and only when using a computer with a keyboard.

7. Click Apply to close the Add expression dialog.
   Now you need to add some descriptive data for the measure.
8. Type a name for the measure.
9. Type a description for the measure (optional).
10. If you want to specify a color, click ▼ in the color drop down and select a color through one of the following methods:
3 Visualizations

- Click one of the colors in the palette.
- Type a 6 character color code in the Hex input field.
- Click 🍇 at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

11. Add tags (optional).

12. Under **Number formatting**, you can choose:
   - Auto
   - Number
   - Money
   - Date
   - Duration
   - Custom
   - Measure expression

13. Click **Create**.

The measure is now saved in the **Measures** category in the master items, and you can use it in visualizations.

**Editing a master measure**

When you update a master measure, the changes will be reflected in all its instances, including all visualizations that use it.

Do the following:

1. In sheet view, click 📊 **Edit sheet** in the toolbar.
   The assets panel opens on the left-hand side.
2. Click 📊 to display the master items.
3. Click the measure that you want to edit.
   The preview opens.
4. Click 🌐 at the bottom of the preview.
   If the measure is used on a sheet, a dialog is displayed to inform you that any changes to the master measure will be applied to all its instances on the sheets.
5. Click **OK**.
   The **Edit measure** dialog opens, where you update the expression, name, description, color, and tags.
6. Click **Save**.

The measure is now updated.

💡 You can also edit a master item from its preview. You open the preview by clicking an item in the master items.
Using master measures in expressions
You can use master measures in expressions. You can use the master measure by itself, or use it to build a more complex expression.

When you type in the Expression editor, an auto-complete list of matching master measures opens.

**Master measure in Expression editor**

![Image of Expression editor with master measures]

**Example: Using a master measure in an expression**
This example creates a master measure, and then uses the master measure in a chart expression.

1. Create the master measure.
   i. Click **Master items** in the assets panel.
   ii. Under **Measures**, click **Create new**.

   ![Image of create new measure button]

   iii. In the **Create new measure** dialog box, enter a **Name** for the master measure, and then click **fx** to open the Expression editor.
iv. In the Expression editor, create the expression. You can type the expression, or use the options available in the expression builder panel. Insert the expression using the expression builder \textit{Count} (\textit{distinct item}), and then click \textit{Apply}. 

![Create new measure dialog box](image)
v. In the **Create new measure** dialog box, click **Create**.
Create measure

The new master measure is created.

New master measure
2. Use the master measure in a chart expression.
   i. Add a **KPI** chart to a sheet in an app.
      
      *New KPI*
      
      ![My new sheet](image)
      
      **First KPI**
      
      Add measure
      
      ii. Click **Add measure**, and then click $\alpha$ to open the Expression editor for the **KPI**.
iii. Type the master measure into the expression. As you type, you will get an auto-complete list of any available master measures. If required, the master measure can be used to build more complex expressions in the Expression editor.
iv. Close the Expression editor to view the KPI. You can change properties for the KPI, including the label, in the properties panel.
Assigning colors to master items

You can assign colors to your master items. Colors assigned to master dimensions and master measures persist across all instances of those master items in all visualizations.

If you change the color used for the master item, the color will be updated across all instances of that master item. Optionally, master item colors can be disabled for individual visualizations.

Visualizations use master dimension colors when Single color is selected in the Colors and legend section of the visualization properties panel. Master measure colors are used when Single color or Multicolored are selected in the Colors and legend section of the visualization properties panel.

By default, if a visualization's default Auto settings use the Single or Multicolored, master item colors will be applied automatically. If they do not, you must switch to Custom and select a supported setting. Master item colors can be disabled in individual visualizations.

In a visualization with colors specified for both master dimension and master measure, Qlik Sense defaults to the master dimension color. Master measure colors can be applied using the Use library colors drop-down and selecting Measure in the Colors and legend section of the visualization properties panel. In visualization with a mix of master measures with assigned colors and measures without assigned colors, the other measures will use the default palette colors.

Master dimensions can have colors assigned to their distinct values.
Master measures can have custom color gradients applied to their values in visualizations.

When assigning colors to your master items, you have the following options:

- Choose a color from the default palette
- Type a hexadecimal color code
- Choose a color using advanced color options

Assigning a color from the default color palette

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
2. Click to display the master items.
3. Select a master item from your library.
4. Click .
5. Click in the color drop-down.
6. Select one of the colors in the palette.
7. Click outside the dialog.
8. Click Save.

![The color dialog with the default color palette and a blue color selected.]

Assigning a color using a hexadecimal color code

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
2. Click to display the master items.
3. Select a master item from your library.
4. Click 🔗.
5. Click ▼ in the color drop-down.
6. Type a 6 character color code in the input field: #.
7. Click outside the dialog or press Enter.
8. Click Save.

Assigning a color using advanced color options

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
2. Click ☐ to display the master items.
3. Select a master item from your library.
4. Click 🔗.
5. Click ▼ in the color drop-down.
6. Click ☐ at the bottom of the dialog.
   The dialog displays the advanced options.
7. Select a color in the color wheel.
   The selected color changes and the Hex color code updates accordingly.
8. Optionally, adjust the color saturation using the slider.
   The saturation changes and the Hex color code updates accordingly.
9. Click outside the dialog.
10. Click Save.

The color dialog with the color wheel in the advanced options and a blue color selected.
3 Visualizations

Assigning colors to master dimension values

You can assign colors to the distinct values contained in a master dimension. This ensures that the distinct values of your dimensions use the same colors in all visualizations.

Colors assigned to values are used when you choose to color By dimension and have Library colors enabled. If you choose to color by Single color, the master dimension's color is used instead.

Assigning colors to master dimension values has the following limitations:

- A maximum of 100 colors can be assigned to a dimension's values.
- Dimension values cannot be longer than 1024 characters. Longer values are disabled in the list of values.
- Drill-down dimensions do not support assigning colors to dimension values.

Do not assign colors to master dimension values if you use section access or work with sensitive data, because the values might be exposed by the color configuration.

The Value colors section of Edit dimensions contains the options for assigning colors to a dimension's distinct values. You can search the list of values with Q.

Qlik Sense automatically applies an auto fill to your values to provide a default color. The auto fill is either a single color or a color scheme. Changing your auto-fill settings will not change colors you have assigned to values.

In addition to distinct values, you can set colors for the values classified as others in a visualization, that is, the collection of distinct values that fall outside the displayable values in a dimension. You can also set colors for null values.

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
2. Click to display the master items.
3. Select a master dimension from your library.
4. Click .
5. Click Value colors.
6. If you want to change the auto fill settings, set Auto fill to Custom, select the auto fill method, and either select a single color or color scheme.
7. Select a value and do one of the following:
   - Select a color in the color wheel, and optionally adjust the saturation slider.
   - Type a 6 character color code in the Hex input field: #.

Values assigned colors display the icon.
8. If you want to remove an assigned color, select the value and click .
9. Optionally, to assign a color to **Others** or **Null values**, click ![arrow-down](image) and do one of the following:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click ![color-wheel](image) at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

10. Click **Save**.

### Assigning colors to master measure values

You can assign a color gradient or segment scheme to a master measure, enabling you to color visualizations by measure, using colors other than the default color schemes.

If you choose to color by single color, the master measure's color is used instead of the color scheme.

To assign custom segment or gradient colors to the values in a master measure, do the following:

1. Access and enable segment colors.
2. Select the template scheme.
3. Select the segment format.
4. Optionally, add or remove limits.
5. Optionally, edit your segment limits.
6. Assign colors to your segments.
7. Save.

### Accessing and enabling segment colors

**Do the following:**

1. In sheet view, click ![edit-sheet](image) **Edit sheet** in the toolbar.
2. Click ![master-items](image) to display the master items.
3. Select a master measure from your library.
4. Click ![master-items](image).
5. Click on the **Segment colors** tab.
6. Set the **Segment colors** button to **Custom** coloring.

### Selecting the template scheme

The template scheme provides a default template to edit. You can choose from the default classes and gradients.

**Do the following:**

- Under **Select a template scheme**, select a template scheme.
Selecting the segment format
The segment format determines how colors will be applied. **Percentage** adds value classes based on where values fit into the percentile of their value. **Fixed value** uses defined values to set the limits of each segment.

**Do the following:**

- Set **Segment format** to **Fixed value** or **Percentage**.

Adding, editing and removing limits
By default, the number of segments depends on the scheme selected. You can create additional segments by adding limits. When a new segment is created a pointer marks the value of its limit.

**Do the following:**

- Click on the **Add limit** button to add a limit to the gauge.
- Use the slider to change the value of a limit. You can also type a value for the selected limit.
- Click on the **Remove limit** button to remove the selected limit.

Editing segments
By default, segment colors depend on the scheme selected. You can change the color of a segment and its ending.

**Do the following:**

- Click the segment to change colors.
- Select **Gradient** to use different shades of colors in the transition between segments for the selected limit.

Create calendar measures
To analyze data over relative time ranges, use calendar measures. For example, you might want to compare current year-to-date sales figures with figures from the same period the previous year.

Calendar measures aggregate data from a field over a time range, and are saved in the **Measures** category in the master items. Calendar measures comprise a field to be aggregated, an aggregation, a date field, and a time range for that date field that sets which data is included in the aggregation. You create calendar measures under **Fields** in the **Assets** panel, using the **Create calendar measures** dialog.

You can aggregate fields from tables loaded in **Data manager** or from a script in **Data load editor**, as long as the field is in the same table as the date field, or is in an associated table.

However, the date field must be from a table that has been loaded using **Data manager**, because calendar measures use expressions tagged as date & time fields that are declared in autoCalendar, and date fields are only mapped to autoCalendar when loaded in **Data manager**. Calendar measures support the following aggregations with the aggregated field: Sum, Count, Avg, Min, and Max.
Visualizations

Calendar measures do not support calendars created using the Data load editor. If you use calendars created using Data load editor and want to create calendar measures, you must load a table containing a date field using Data manager for use with your tables loaded using Data load editor.

If your date field is subject to more than one calendar and both calendars are qualified for use with calendar measures, then the first calendar loaded in the data load script is used in the calendar measures.

A calendar measure can use one of the following time ranges are available for use with calendar measures: weekly, monthly, quarterly, and yearly. Within each time range, different measures exist for periods such as current month, year-to-date, and current week last year. The following time ranges and measures are available for creating calendar measures:

### Calendar measures for time range Yearly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YTD</td>
<td>The year to date for all years.</td>
</tr>
<tr>
<td>YTD Current Year</td>
<td>The year to date for the current year.</td>
</tr>
<tr>
<td>YTD Last Year</td>
<td>The year to date for last year.</td>
</tr>
</tbody>
</table>

### Calendar measures for time range Monthly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTD</td>
<td>The month to date for all months and years.</td>
</tr>
<tr>
<td>MTD Current Month</td>
<td>The month to date for the current month.</td>
</tr>
<tr>
<td>MTD Last Month</td>
<td>The month to date for last month.</td>
</tr>
<tr>
<td>Current Month</td>
<td>All dates this month.</td>
</tr>
<tr>
<td>Current Month Last Year</td>
<td>All dates this month last year.</td>
</tr>
<tr>
<td>Last Month</td>
<td>All dates last month.</td>
</tr>
</tbody>
</table>

### Calendar measures for time range Quarterly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QTD</td>
<td>The quarter to date for all years.</td>
</tr>
<tr>
<td>QTD Current Quarter</td>
<td>The quarter to date for the current quarter.</td>
</tr>
<tr>
<td>QTD Last Quarter</td>
<td>The quarter to date for the last quarter.</td>
</tr>
<tr>
<td>Current Quarter</td>
<td>All dates in the current quarter.</td>
</tr>
</tbody>
</table>
3 Visualizations

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Quarter Last Year</td>
<td>All dates in the current quarter last year.</td>
</tr>
<tr>
<td>Last Quarter</td>
<td>All days for the last quarter.</td>
</tr>
</tbody>
</table>

Calendar measures for time range Weekly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WTD</td>
<td>The week to date for all weeks across all years.</td>
</tr>
<tr>
<td>WTD Current Week</td>
<td>This week to date for the current week.</td>
</tr>
<tr>
<td>WTD Last Week</td>
<td>The week to date for the last week.</td>
</tr>
<tr>
<td>Current Week</td>
<td>All dates this week.</td>
</tr>
<tr>
<td>Current Week Last Year</td>
<td>All dates this week last year.</td>
</tr>
<tr>
<td>Last Week</td>
<td>All dates last week.</td>
</tr>
</tbody>
</table>

Once created, calendar measures are treated identically to master measures. That is, calendar measures are reusable and editable while an app is unpublished. Users of a published app will have access to the calendar measures, but will not be able to modify them.

Creating a calendar measure from a field

On a sheet in edit mode with the **Fields** tab open, do the following:

1. Right-click a field and select **Create calendar measures**.
   By default, the field you right-clicked will be included as the **Aggregated field**.
2. Select a date field from the **Date field** drop-down list.
3. Select a field from the **Aggregated field** drop-down list.
4. Select an aggregation from the **Aggregation** drop-down list.
5. Select a time range from the **Time range** drop-down list.
   A list of the available measures displays under **Preview of measures**.
   You can toggle the display of the measures’ expressions by selecting the **Preview of measures** switch.
6. Select the calendar measures to add to your master items.
   By default, all measures are selected.
7. Click **Save to master items**.
8. Click **Close**.

Tagging master items

You can use tags to organize master items. You will find matches in tags when searching in the assets panel.
You can also tag master items with synonyms for Insight Advisor. Use the format `alt: <term>` in synonym tags. For example, `alt: cities`.

Each tag can contain a maximum of 31 characters, and each master item can have up to 30 tags.
Adding tags to a master item

You can add tags when creating or editing a master item.

*Adding tags while creating a new measure.*

![Edit measure form](image)

You can add tags by clicking ➕ or by pressing Enter.

Previewing tags

In the assets panel, tags are displayed when previewing dimensions, measures and visualizations.

The preview displays the dimension type, which fields are included in the drill-down dimension and tags.
Unlinking from a master visualization

If you want to make changes to a visualization that is linked to a master visualization, you must first unlink it from the master visualization. The visualization on your sheet is then independent with no connection to the master visualization in the assets panel.

Unlinking using 🔄

A linked visualization can be unlinked using 🔄 that is located in the top right corner of a linked visualization.

Do the following:

1. Click ✉️ Edit sheet.
2. Click 🔄 in the top right corner of a linked visualization on the sheet.
   A dialog is displayed that you are about to unlink from a master visualization.
3. Click OK.

The visualization on the sheet can now be edited and the changes will not affect any other visualizations.

Unlinking from the shortcut menu

A linked visualization can be unlinked from the shortcut menu.

Do the following:

1. Click ✉️ Edit sheet.
2. Long-touch/right-click a linked visualization on the sheet.
   The shortcut menu opens.
3. Select Unlink visualization.
   A dialog is displayed that you are about to unlink from a master visualization.
4. Click OK.

The visualization on the sheet can now be edited and the changes will not affect any other visualizations.
Deleting a master dimension or master measure

You can delete dimensions and measures from the master items as long as the app is not published.

If you delete a master dimension or master measure, the visualizations that use the deleted master item will not work unless you replace it with a new dimension or measure.

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the dimension or measure that you want to delete.
   The preview opens.
4. Click at the bottom of the preview.
   A dialog is displayed stating that all visualizations that use the dimension or measure will stop working.
5. Click OK.

The dimension or measure is deleted from the master items, and all visualizations on the sheets that used the deleted item do not work anymore. You see the text Dimension not found or Measure not found on those visualizations.

A visualization that is lacking both a dimension and a measure, both which have been deleted from the master items.
Replacing an invalid dimension or measure

When a dimension or measure has been deleted from the master items, all visualizations that reference to the deleted master item will not work anymore, until the missing dimension or measure is replaced.

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
The assets panel opens on the left-hand side. Click to display the master items.
2. Drag a dimension or measure from the Dimensions or Measures sections to the visualization on the sheet.
The shortcut menu opens.
3. Select Replace invalid dimension or Replace invalid measure.
The visualization is complete and works again.

Deleting a master visualization

You can delete visualizations from the master items as long as the app is not published.

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the visualization that you want to delete.
The preview opens.
4. Click at the bottom of the preview.
A dialog is displayed stating that wherever this visualization is used on sheets, there will be invalid instances of it.
5. Click OK.
The visualization is deleted from the master items, and on all sheets where this visualization was used, you see invalid visualizations. You now need to replace the invalid visualization with other ones, or delete the instances.

You can also delete visualizations from the preview that is displayed when clicking the visualization in the master items.

Replacing an invalid visualization on a sheet

The representation of the invalid visualization is there to tell you that there used to be a visualization at a certain location on the sheet, but the invalid visualization serves no purpose.

Do the following:
3 Visualizations

1. In sheet view, click Edit sheet in the toolbar.
   The assets panel opens on the left-hand side. Click 📊 to display the master items.
2. Drag a visualization from the master items to the location of the invalid visualization on the sheet.

The invalid visualization is replaced.

Deleting an invalid visualization
1. In sheet view, click Edit sheet in the toolbar.
2. Long-touch/right-click on the invalid visualization and select Delete in the shortcut menu.

The invalid visualization is deleted.

Using expressions in visualizations

Visualizations in Qlik Sense are built from charts, which in turn, are built from dimensions and measures, depending on the type of chart. Visualizations can have titles, subtitles, footnotes, and other elements to help convey information. All of the elements that make up a visualization can be simple: a dimension consisting of a field representing data, a title consisting of text, for example.

For visualizations that contain measures, the measures are aggregations based on fields. Specifically, the measures are calculations that span multiple records. For example \( \text{Sum(Cost)} \) means all the values of the field Cost are aggregated using the function Sum. In other words, \( \text{Sum(Cost)} \) is an expression.

What is an expression?
An expression is a combination of functions, fields, and mathematical operators (+ * / =), and other measures. Expressions are used to process data in the app in order to produce a result that can be seen in a visualization. They are not limited to use in measures. You can build visualizations that are more dynamic and powerful by using expressions for titles, subtitles, footnotes, and even dimensions.

This means, for example, that instead of the title of a visualization being static text, it can be made from an expression whose result changes depending on the selections made.

Where can I use expressions?
Expressions can be used in a visualization wherever the symbol \( fX \) is seen in the properties panel while editing a visualization. The \( fX \) symbol indicates an expression field. By clicking \( fX \), you enter the expression editor, which is designed to help you build and edit expressions. Expressions can also be entered directly into the expression field, without using the expression editor.

An expression cannot be saved directly as a master item, but if an expression is used in a measure or dimension, which is then saved as a master item, with its descriptive data, such as name, description, and tags, the expression in the measure or dimension is preserved.

Expressions are used both in scripts and in chart visualizations. They can be simple, involving only basic calculations, or complex, involving functions fields and operators. Expressions can be used in several different situations. The difference between measures and expressions is that expressions have no name or descriptive data.
In a script, an expression is evaluated as the script execution passes it by. In visualizations (including charts and tables), expressions are evaluated automatically whenever any of the fields, variables or functions that the expression contains change value or logical status. A few differences exist between script expressions and chart expressions in terms of syntax and available functions.

For detailed reference regarding script functions and chart functions, see the Script syntax and chart functions.

Working with the expression editor

You can enter the expression editor to add or edit an expression wherever you see the symbol \( \mathbf{fx} \) in the properties panel while editing a visualization. The \( \mathbf{fx} \) symbol indicates an expression field. Click \( \mathbf{fx} \) to enter the expression editor.

You can add expressions in two ways. Expressions can be created using the Fields, Functions, Variables, and Set expressions sections by making selections and inserting them into the expression field. You can edit the inserted expressions and add more complex expressions by typing directly into the expression field. You can undo an action by clicking the Undo button \( \leftarrow \).

Inserting an expression using Fields

You can insert an expression by making selections from the Fields section at the right-hand side of the expression editor dialog.

Do the following:

1. If you want to limit the available fields to those from a particular table in your data model, select a table from the Filter by table drop-down list.
2. Select a field from the Field drop-down list.
3. Select the aggregation function you want to use. The functions available are from the group of basic aggregation functions.
4. If you want to insert the current selection as a set expression in your aggregation, use the Set expression check box. The current selection is always based on the default state.
5. If you want to insert a Distinct or a Total clause together with the aggregation function, use the check boxes for each clause. Each clause can be used separately.
6. Click Insert to insert the field and the function into the expression field.

If you do not select an aggregation function, only the field will be inserted into the expression. Clauses can only be added if you select an aggregation function.
7. Click **Apply** to close the **Add expression** dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

 chunking a function using Functions

You can insert more than the basic aggregation functions by making selections from the **Functions** section at the right-hand side of the expression editor dialog.

1. If you want to filter the list of available functions, select a function category from the **Function category** drop-down list.
2. Select a function from the **Function name** drop-down list.
   You see a preview of the function.
3. Click **Insert** to insert the function and the first parenthesis into the expression field.
4. Type the rest of the expression in the expression editor according to the syntax.
5. Click **Apply** to close the **Add expression** dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Inserting a variable using Variables

You can insert a variable by making selections from the **Variables** section at the right-hand side of the expression editor dialog.

1. If you want system variables to appear in the list of available variables use the **Show system variables** check-box.
2. Select a variable from the **Variable** drop-down list.
   You see a **Definition** and **Value** of the variable, if available.
3. Click **Insert** to insert the variable into the expression field.
4. Click **Apply** to close the **Add expression** dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Inserting a set expression using Set expressions

You can insert a set expression by making selections from the **Set expressions** section at the right-hand side of the expression editor dialog.

1. Select whether to **Use current selections** or **Use bookmark**, as a set expression.
   You can only **Use current selections** if a selection has been made in the app. You can only **Use bookmark** if a bookmark is available. Use the **Bookmark** drop-down menu to choose between bookmarks.
2. If you have defined alternate states, you can change the alternate state which the set expression is based on. Select the alternate state from **Alternate state** drop-down menu.
3. Click **Insert** to insert the set expression into the expression field.
4. Click **Apply** to close the **Add expression** dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.
Adding or editing an expression by typing

Do the following:

1. Type the expression directly in the expression field. The field names you use in the expression are checked, and the syntax of the expression is validated.

   As you type in the expression editor, the expression is validated. If there is an error, you see a hint about what is incorrect. Additional error information may be available by clicking the icon next to the hint.

   When you type the name of a function in the expression, a tooltip appears that provides information to help you enter the function correctly, including argument names and qualifiers.

   The tooltip for some chart functions shows the ALL qualifier. It is recommended that you do not use the ALL qualifier. Instead, use the set expression \{1\}.

   Each line in the expression editor is numbered and syntax highlighting is used.

2. Click **Apply** to close the Add expression dialog. For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Auto-complete, evaluation and color coding

When typing in the expression editor, you get an auto-complete list of matching fields, variables and functions to select from. The list is narrowed down as you continue to type. The color coding helps you to see where fields, variables and functions are used in the expression.

The color coding applies both in the auto-complete list and in the expression itself.

You can verify that any dollar-sign expansions added in your expression give the correct result, by checking the expression evaluation, in the dollar-sign expansion preview.

Detailed syntax help

You can activate help mode by clicking the Help button 🥇. When active, all functions in the expression editor act like hyperlinks. Clicking on a function opens a browser tab to the online help section with the full description of how to use the specific function. When a function is clicked, help mode is exited.

References to fields, measures, and variables

An expression can contain references to fields, variables, and measures.

In most cases, expressions are aggregations, that is calculations that potentially can span multiple records. This means that all field references in an expression must be wrapped in an aggregation function. If no aggregation function is used, the Only() function is used.

When the name of a measure is used inside an expression, it is interpreted as an alias for the measure. This allows you to re-use an already defined entity. You can only re-use master measures and measures inside the same chart in this way.
You can define a measure recursively. In other words, the measure can contain a reference to itself. However, you should only do this in charts with few rows. Performance degrades if the chart has many rows. If there are hundreds of rows, the recursive definition will stop working altogether.

A variable can be used in two different ways in a direct reference or in a dollar expansion. If you use a direct reference, the variable value will be used in the calculation. If you use a dollar expansion, the entire dollar expansion will be replaced by the variable value before the expression is parsed. Therefore, the two different methods may return different results.

How names are interpreted
A name inside an expression can be a reference to a field, a variable, a function, or a measure. Depending on situation, the name is interpreted differently.

Example:
The string XXX represents a field, a variable, a function, or a measure. XXX will be interpreted as one of these depending on how you create the expression.

<table>
<thead>
<tr>
<th>Expression</th>
<th>XXX interpreted as</th>
</tr>
</thead>
<tbody>
<tr>
<td>XXX</td>
<td>measure, variable, or field</td>
</tr>
<tr>
<td>$(XXX)</td>
<td>variable</td>
</tr>
<tr>
<td>count(XXX)</td>
<td>field or variable</td>
</tr>
<tr>
<td>XXX()</td>
<td>function</td>
</tr>
</tbody>
</table>

You should not use the same name for a field and a variable (or a measure). But if you do and there is ambiguity, the following order of precedence is used:

- If the name is found inside an aggregation function, a field has precedence over a variable.
- If the name is found outside an aggregation function, a measure has precedence over a variable, which in turn has precedence over a field.

Rules for expressions
The following rules apply for chart expressions:

- If a field reference isn't wrapped in an aggregation function, the Only() function is used by the engine.
- All expressions return a number and/or a string, whichever is appropriate.
- Logical functions and operators return 0 for False, -1 for True. Number-to-string conversions and string-to-number conversions are implicit.
- Logical operators and functions interpret 0 as False and all else as True.
- Expressions that cannot be correctly evaluated, for example as a result of incorrect parameters or functions, return NULL.
Using functions in charts

A function is a type of procedure or routine that performs a specific task on data in apps. Qlik Sense contains several hundred ready-made functions that can be used in charts when creating visualizations. Functions can be, for example, mathematical, logical, can operate on financial or date and time information, can be used to manipulate strings, and other situations.

Functions can be grouped into the types:

- Aggregation functions, which use several records as input and produce a single value result.
- Scalar functions, which take a single input and produce a single output.
- Range functions, which produce a single value based on a range of input values.
- Range-producing functions, which are like range functions, but produce a range of values as output.

Many of the functions can be used in both chart expressions and scripts, but some are specific for chart expressions.

The following list shows some examples of functions:

- **Max**: an aggregation function that can be used in scripts and charts.
  For example: `Max(Sales)` calculates the highest value in the field Sales.
- **IF**: a conditional function that can be used in scripts and charts.
  For example: `IF(Amount>0, 'OK','Alarm')` determines if the condition 'is the value of Amount greater than zero?' is met. If it is, OK is written, otherwise Alarm is written.
- **Date#**: an interpretation function that can be used in scripts and charts.
  For example: `Date#(A)` takes the input value A and evaluates it as a date.

A few differences exist between script expressions and chart expressions in terms of syntax and available functions. The most important difference is the role of the aggregation functions and the use of field references. The basic rule is that any field name in a chart expression must be enclosed by exactly one aggregation function. An aggregation function can never have another expression containing an aggregation function as argument.

For detailed reference regarding script functions and chart functions, see the Script syntax and chart functions.

Set analysis and set expressions

Set analysis offers a way of defining a set (or group) of data values that is different from the normal set defined by the current selections.

Normally, when you make a selection, aggregation functions, such as **Sum, Max, Min, Avg**, and **Count** aggregate over the selections that you have made: the current selections. Your selections automatically
3 Visualizations

define the data set to aggregate over. With set analysis you can define a group that is independent of the current selections. This can be useful if you want to show a particular value, for example, the market share of a product across all regions, irrespective of the current selections.

Set analysis is also powerful when making different sorts of comparisons, such as what are the best-selling products compared with poorly-selling products, or this year against last year.

Let us imagine an example in which you start working in an app by selecting the year 2010 in a filter pane. The aggregations are then based on that selection, and the visualizations only show values for that year. When you make new selections, the visualizations are updated accordingly. The aggregations are made over the set of possible records defined by the current selections. With set analysis, you can define a set that is of interest to you and does not depend on the selections.

Creating set expressions

Before looking at the different parts of a set analysis example, there is a distinction that should be made between a set expression and set analysis:

Defining a set of field values is referred to as defining a set expression, whereas using set expressions to analyze data is referred to as set analysis. Consequently, the rest of this section focuses on the set expression and its components.

Here is a set analysis example: \( \text{sum} \left( \{\text{<Year=}{2009}\} \ \text{sales} \right) \), in which \( \{\text{<Year=}{2009}\}\) is a set expression.

There are two general syntax rules for a set expression:

- A set expression must be used in an aggregation function. In this example, the aggregation function is \( \text{sum}(\text{sales}) \).
- A set expression must be enclosed by braces, \{\}. In the example, the set expression is: \( \{\text{<Year=}{2009}\}\).

A set expression consists of a combination of the following parts:

- **Identifiers.** One or more identifiers define the relationship between the set expression and what is being evaluated in the rest of the expression. A simple set expression consists of a single identifier, such as the dollar sign, \{\}, which means all records in the current selection.

- **Operators.** If there is more than one identifier, an operator or operators are used to refine the set of data by specifying how the sets of data represented by the identifiers are combined to create a subset or superset, for example.

- **Modifiers.** A modifier or modifiers can be added to the set expression to change the selection. A modifier can be used on its own or to modify an identifier to filter the data set.

**Examples:**

**Example 1:**

\( \{\text{<Year=}{2009}\}\)
This set expression contains an identifier $, and the modifier <Year={2009}>. This example does not include an operator. The set expression is interpreted as: "All records in the current selection that belong to the year 2009".

**Example 2:**

$$\text{Sum}(({$<\text{Year}={2009}>外部}} + 1<\text{Country}={"Sweden"}>) \text{ Sales})$$

This set expression contains the identifiers $ and 1, the operator + and the modifiers <Year={2009}> and <Country={"Sweden"}>.

This set expression is designed to sum the sales for the year 2009 associated with the current selections and add the full set of data associated with the country Sweden across all years.

Set expressions can only be used in expressions for visualizations, not in script expressions.

Identifiers, operators and modifiers are described in more detail with in the following subsections.

**Identifiers**

Identifiers define the relationship between the set expression and the field values or expression being evaluated.

In our example $$\text{sum}(({$<\text{Year}={2009}>外部}} \text{ Sales })$$, the identifier is the dollar sign, $, and means that the set of records to be evaluated consists of all the records of the current selection. This set is then further filtered by the modifier part of the set expression. In a more complex set expression, two identifiers can be combined using an operator.

This table shows some common identifiers.

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Represents the full set of all the records in the application, irrespective of any selections made.</td>
</tr>
<tr>
<td>$</td>
<td>Represents the records of the current selection. The set expression $ is thus the equivalent to not stating a set expression.</td>
</tr>
<tr>
<td>$1</td>
<td>Represents the previous selection. $2 represents the previous selection-but-one, and so on.</td>
</tr>
<tr>
<td>$._1</td>
<td>Represents the next (forward) selection. $._2 represents the next selection-but-one, and so on.</td>
</tr>
<tr>
<td>BM01</td>
<td>You can use any bookmark ID or bookmark name.</td>
</tr>
<tr>
<td>MyAltState</td>
<td>You can reference the selections made in an alternate state by its state name.</td>
</tr>
</tbody>
</table>

This table shows some examples with different identifiers.
Examples with different identifiers

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>sum ((1) Sales)</td>
<td>Returns total sales for the app, disregarding selections but not the dimension.</td>
</tr>
<tr>
<td>sum (($) Sales)</td>
<td>Returns the sales for the current selection, that is, the same as sum(Sales).</td>
</tr>
<tr>
<td>sum (($1) Sales)</td>
<td>Returns the sales for the previous selection.</td>
</tr>
<tr>
<td>sum (BM01 Sales)</td>
<td>Returns the sales for the bookmark named BM01.</td>
</tr>
</tbody>
</table>

Operators

Operators are used to include, exclude, or intersect parts of or whole data sets. All operators use sets as operands and return a set as result.

This table shows operators that can be used in set expressions.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Union. This binary operation returns a set consisting of the records that belong to any of the two set operands.</td>
</tr>
<tr>
<td>-</td>
<td>Exclusion. This binary operation returns a set of the records that belong to the first but not the other of the two set operands. Also, when used as a unary operator, it returns the complement set.</td>
</tr>
<tr>
<td>*</td>
<td>Intersection. This binary operation returns a set consisting of the records that belong to both of the two set operands.</td>
</tr>
<tr>
<td>/</td>
<td>Symmetric difference (XOR). This binary operation returns a set consisting of the records that belong to either, but not both of the two set operands.</td>
</tr>
</tbody>
</table>

This table shows some examples with operators.

<table>
<thead>
<tr>
<th>Examples</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>sum( {1-$} Sales )</td>
<td>Returns sales for everything excluded by the selection.</td>
</tr>
<tr>
<td>sum( {$~BM01} Sales )</td>
<td>Returns sales for the intersection between the selection and bookmark BM01.</td>
</tr>
<tr>
<td>sum( -($~BM01) Sales )</td>
<td>Returns sales excluded by the selection and bookmark BM01.</td>
</tr>
<tr>
<td>sum( (&lt;=year=2009)&gt;1&lt;Country= {'Sweden'})) Sales )</td>
<td>Returns sales for the year 2009 associated with the current selections and add the full set of data associated with the country Sweden across all years.</td>
</tr>
</tbody>
</table>
Modifiers
Modifiers are used to make additions or changes to a selection. Such modifications can be written in the set expression. A modifier consists of one or several field names, each followed by one or several selections that can be made in the field. Modifiers begin and end with angle brackets, <>.

A set modifier modifies the selection of the preceding set identifier. If no set identifier is referenced, the current selection state is implicit.

This table shows some examples with modifiers.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>\text{sum}({$&lt;\text{OrderDate} = \text{DeliveryDate}&gt;} \text{Sales})</td>
<td>Returns the sales for the current selection where OrderDate = DeliveryDate.</td>
</tr>
<tr>
<td>\text{sum}({1&lt;\text{Region} = {\text{US}}&gt;} \text{Sales})</td>
<td>Returns the sales for region US, disregarding the current selection.</td>
</tr>
<tr>
<td>\text{sum}({$&lt;\text{Region} = &gt;} \text{Sales})</td>
<td>Returns the sales for the selection, but with the selection in \text{Region} removed.</td>
</tr>
<tr>
<td>\text{sum}({&lt;\text{Region} = &gt;} \text{Sales})</td>
<td>Returns the same as the example above. When the set to modify is omitted, $ is assumed.</td>
</tr>
<tr>
<td>\text{sum}({$&lt;\text{Year}=(2000), \text{Region}={U^*}&gt;} \text{Sales})</td>
<td>Returns the sales for the current selection, but with new selections both in \text{Year} and in \text{Region}.</td>
</tr>
</tbody>
</table>

Using variables in expressions
A variable in Qlik Sense is a container storing a static value or a calculation, for example a numeric or alphanumeric value. When you use the variable in the app, any change made to the variable is applied everywhere the variable is used. You can define variables in the variables overview, or in the script using the data load editor. You set the value of a variable using \textbf{Let} or \textbf{Set} statements in the data load script.

\textbf{When using variables in expressions, you can change the expression used in a range of charts simultaneously simply by editing the variable.}

You open the Variables overview by clicking \textbf{ } in the edit bar when editing a sheet.

\textbf{The Variables overview is not available in published apps. If you need to add or change variables in an published app, use the variable input control available with the Dashboard bundle.}

The following actions are available in the variables overview:

- Create a new variable.
- Edit the selected variable.
Delete the selected variable.

*If you want to edit or delete a variable that is defined in the script, you must edit the script.*

Getting an overview of all variables in an app
You can get an overview of all variables in an unpublished app.

**Do the following:**

1. When editing a sheet, click in the edit bar on the sheet to open the variables overview.
   The variables overview opens and displays a list of all variables in the app and their definitions (if any).
2. Select a variable in the list that you want to view details of.
   The variable expands and displays detailed information about the variable, if any: definition, description and tags.

*When a variable is created or edited, all fields except the name field can be left empty.*

**See also:**

*Working with the expression editor (page 111)*

**Creating a variable**

A variable in Qlik Sense is a named entity, containing a data value. When a variable is used in an expression, it is substituted by its value or the variable's definition. Variables are defined using the variables overview or in the script using the data load editor.

You can create a new variable from the variables overview, when editing a sheet in an unpublished app.

**Do the following:**

1. When editing a sheet, click in the edit bar on the sheet to open the variables overview.
   The variables overview opens.
2. Click **Create new**.
   The following input fields for the variable are displayed:
   - **Name** (mandatory)
   - **Definition**
   - **Description**
   - **Tags**
3 Visualizations

Press Esc or click ![cancel](image) if you want to cancel creating the new variable. If all input fields are empty, you can also cancel by clicking outside the new variable section in the variables overview or by clicking outside the variables overview window.

3. Type a name for the variable (mandatory). Use the following guidelines when choosing a name:
   - You cannot change the name once you have created the variable.
   - Use a letter as the first character, do not use a number or a symbol.
   - It is not recommended to name a variable identically to a field or a function in Qlik Sense. For more information, see How names are interpreted (page 123).
   - Some characters have specific uses in Qlik Sense expressions, therefore do not use the following characters when naming a variable: ` ( ) [ ] "`
   - The name must be unique. You are not allowed to name a variable identically to a reserved variable or a system variable. These variables are not listed in the variables overview, but if you are not allowed to use a certain name, even though you cannot find a duplicate in the variables overview, a reserved variable or a system variable already has this name.
   - A long name is not recommended. If a variable's name is too long, the name cannot be fully displayed in the variables overview.

4. Create a definition for the variable (optional). You can enter the expression editor by clicking ![expression](image). For more information, see Working with the expression editor (page 111).

   **Example:**

   Set the variable's value to today's date, presented as a number:

   `Num(Today())`

5. Type a description for the variable (optional).

6. Add tags by typing and click ![add tag](image) or press Enter (optional).

7. Save the variable by clicking ![save](image). You can also save by clicking outside the new variable's section in the variables overview or by clicking outside the variables overview window. The variable is added to the top of the list and marked with ![new](image).

The new variable is created.

**Editing a variable**

A variable in Qlik Sense is a named entity, containing a data value. When a variable is used in an expression, it is substituted by its value or the variable's definition. Variables are defined using the variables overview or in the script using the data load editor.

You can choose to edit a variable from the variables overview, when editing a sheet in an unpublished app.

**Do the following:**

1. When editing a sheet, click ![open variables overview](image) in the edit bar on the sheet to open the variables overview.

   The variables overview opens.
If you want to edit a variable that is defined in the script, you can either edit in the script, using the data load editor, or delete it from the script and then edit it in the variables overview.

2. From the list, select a variable that you want to edit and click 📊. The variable expands and displays the following:
   - **Definition** (if any)
   - **Description** (if any)
   - **Tags** (if any)

3. Edit the variable as desired:
   - You can open the expression editor and create the definition by clicking ✏️.
     For more information, see *Working with the expression editor* (page 111).
   - Cancel editing the variable, by pressing Esc.

   If you click the variable is deleted.

   - Add new tags by typing and and click ✈️️ or press Enter. Remove tags by clicking ✕️.

4. Save the changes by clicking 📊. You can also save by clicking outside the variable's section in the variables overview or by clicking outside the variables overview window.

The variable is updated.

Deleting a variable
You can delete variables, from an unpublished app, by deleting them from the variables overview.

Do the following:

1. When editing a sheet, click 📊 in the edit bar on the sheet to open the variables overview.
   The variables overview opens.
2. Select the variable you want to delete.

If you want to delete a variable that is defined in the script, you must edit the script. If you remove a variable from the script and reload the data, the variable stays in the app. If you want to fully remove the variable from the app, you must also delete the variable from the variables overview.

The details of the variable are displayed.
Deleting a variable cannot be undone.

3. Click 🗑️.
   A confirmation message is displayed, asking if you are sure you want to delete the variable.

4. Click OK.

The variable is deleted.

Examples of using a variable in an expression
A variable in Qlik Sense is a named entity, containing a data value. When a variable is used in an expression, it is substituted by its value or the variable's definition.

Example:

The variable x contains the text string Sum(Sales).

In a chart, you define the expression $(x)/12. The effect is exactly the same as having the chart expression Sum(Sales)/12.

However, if you change the value of the variable x to for example Sum(Budget), the data in the chart are immediately recalculated with the expression interpreted as Sum(Budget)/12.

When using variables in expressions, you can change the expression used in a range of charts simultaneously simply by editing the variable.

How names are interpreted
It is not recommended to name a variable identically to a field or a function in Qlik Sense. But if you do, you must know how to use them in an expression.

Example:

The string XXX represents a field, a variable, a function, or a measure. XXX will be interpreted as one of these depending on how you create the expression.

Examples of how names are interpreted

<table>
<thead>
<tr>
<th>Expression</th>
<th>XXX interpreted as</th>
</tr>
</thead>
<tbody>
<tr>
<td>xxx</td>
<td>measure, variable, or field</td>
</tr>
<tr>
<td>$(xxx)</td>
<td>variable</td>
</tr>
<tr>
<td>count(xxx)</td>
<td>field or variable</td>
</tr>
<tr>
<td>xxx()</td>
<td>function</td>
</tr>
</tbody>
</table>
**Variable calculation**

There are several ways to use variables with calculated values in Qlik Sense, and the result depends on how you define it and how you call it in an expression.

This example requires the following data is loaded in the data load editor:

```
LOAD * INLINE [  
  Dim, Sales  
  A, 150  
  A, 200  
  B, 240  
  B, 230  
  C, 410  
  C, 330  
];
```

Let’s define two variables, from the variables overview:

- **Name** `vSales` **Definition** `'Sum(Sales)'`
- **Name** `vSales2` **Definition** `'=Sum(Sales)'`

In the second variable, we add an equal sign before the expression. This will cause the variable to be calculated before it is expanded and the expression is evaluated.

If you use the `vSales` variable as it is, for example in a measure, the result will be the string `Sum(Sales)`, that is, no calculation is performed.

If you add a dollar-sign expansion and call `$(vSales)` in the expression, the variable is expanded, and the sum of Sales is displayed.

Finally, if you call `$(vSales2)`, the variable will be calculated before it is expanded. This means that the result displayed is the total sum of Sales. The difference between using `=$(vSales)` and `=$(vSales2)` as measure expressions is seen in this chart showing the results:

<table>
<thead>
<tr>
<th>Dim</th>
<th>$(vSales)</th>
<th>$(vSales2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>350</td>
<td>1560</td>
</tr>
<tr>
<td>B</td>
<td>470</td>
<td>1560</td>
</tr>
<tr>
<td>C</td>
<td>740</td>
<td>1560</td>
</tr>
</tbody>
</table>

As you can see, `$(vSales)` results in the partial sum for a dimension value, while `$(vSales2)` results in the total sum.

**See also:**

*Working with the expression editor (page 111)*
Searching in the assets

The search field at the top of the assets panel helps you find assets on the different tabs. As you start to type in the search field, all items that have a name or a tag that contains the search string, are presented.

*The search function is not case sensitive.*

When a matching string is found in a tag, it is indicated by a tag icon in the search result. Clicking the item in the list of results, brings up a preview of it.

*Searching for “inv” among the measures presents any measure that contains that string in its name or a tag.*

Designing visualizations with Direct Discovery

Designing visualizations from Direct Discovery fields requires some background knowledge about the nature of the field types that can be used.
3.5  When to use what type of visualization

A good visualization clearly presents relationships among many values, and lets you analyze data at a glance. Qlik Sense offers a range of visualizations and charts. Each chart excels at visualizing data in different ways for different purposes. You should select your charts by deciding what you want to see from the data in your charts.

If you are unsure of what visualizations to use, Qlik Sense can offer recommendations. For more information, see Creating visualizations with Insight Advisor (page 500) and Creating visualizations using Insight Advisor chart suggestions (page 508).

The following lists the purposes for viewing data and the chart type recommended to achieve that purpose:

### Viewing comparisons

Comparison charts are used to compare values against each other. They show the differences in values, such as the difference between categories, or how values are changing over time.

Questions that might be answered by comparison charts include:

- What product has the highest total sales this year?
- How have product sales risen or fallen over the last 24 months?
### Chart types for viewing comparisons

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bar chart (page 133)</strong></td>
<td>Comparing categories against the same measure or measures.</td>
</tr>
<tr>
<td><strong>Line chart (page 218)</strong></td>
<td>Comparing trends over time.</td>
</tr>
<tr>
<td><strong>Combo chart (page 168)</strong></td>
<td>Comparing measures that are different in scale.</td>
</tr>
</tbody>
</table>

If you want to compare different values of the same dimension, you can use alternate states.

### Viewing relationships

Relationship charts are used to explore how values relate to each other. A relationship chart allows you to find correlations, outliers, and clusters of data.

Questions that might be answered by relationship charts include:

- Is there a correlation between advertising spending and sales for our products?
- How do expenses and income vary per region?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scatter plot (page 343)</strong></td>
<td>Viewing the relationship between two or three measures for a dimension.</td>
</tr>
</tbody>
</table>

### Viewing compositions

Composition charts take a total value and discover what component values make up that total. Composition charts can be static, showing the current composition of a total value, or they can show how the composition of a total value changes over time. Composition charts can display compositions either by percentage of the total value or the fixed values in the total value.

Questions that might be answered by composition charts include:

- What percentages of our total sales come from which regions?
- What is each department’s allotment of our total quarterly budget over the past year?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bar chart (page 133)</strong></td>
<td>Viewing the changing composition of a value over a short period of time.</td>
</tr>
<tr>
<td><strong>Line chart (page 218)</strong></td>
<td>Viewing the changing composition of a value over a long period of time.</td>
</tr>
<tr>
<td><strong>Pie chart (page 317)</strong></td>
<td>Viewing the static composition of a value.</td>
</tr>
<tr>
<td><strong>Waterfall chart (page 397)</strong></td>
<td>Viewing the static composition of a value with accumulation or subtraction to the total.</td>
</tr>
<tr>
<td><strong>Treemap (page 386)</strong></td>
<td>Viewing the static composition of a value's accumulation to the total.</td>
</tr>
</tbody>
</table>
Viewing distributions

Distribution charts are used to explore how the values within data are grouped. Distribution charts show you the shape of your data, the range of its values, and possible outliers.

Questions that might be answered by distribution charts include:

- What is the number of customers per age group?
- What cities have the highest use of our services?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Histogram (page 207)</em></td>
<td>Viewing the how data is distributed over intervals.</td>
</tr>
<tr>
<td><em>Scatter plot (page 343)</em></td>
<td>Viewing the distribution of two measures.</td>
</tr>
<tr>
<td><em>Distribution plot (page 186)</em></td>
<td>Viewing the distribution of measure values in a dimension.</td>
</tr>
<tr>
<td><em>Box plot (page 156)</em></td>
<td>Viewing the range and distribution of numerical data.</td>
</tr>
</tbody>
</table>

Viewing performances

Performance charts provide a quick view of a performance measure. Looking at a performance chart, a user can quickly identify the measure value and whether the results are as expected or not.

Questions that might be answered by performance charts include:

- What are the current total sales for this quarter?
- Are current total sales for this quarter meeting the projected sales for the quarter?
- How is performance for this product line compared with other product lines?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Bullet chart (page 166)</em></td>
<td>Comparing performance of a measure for several dimensions.</td>
</tr>
<tr>
<td><em>Gauge (page 202)</em></td>
<td>Viewing a performance value to understand performance immediately.</td>
</tr>
<tr>
<td><em>KPI (page 213)</em></td>
<td>Viewing one or two performance measures.</td>
</tr>
<tr>
<td><em>Text &amp; image (page 380)</em></td>
<td>Viewing text or several measures with an image.</td>
</tr>
</tbody>
</table>

Viewing data

Data charts present detailed data rather than a visualization of the data. Data charts are useful when you need to view precise values, and when you want to compare individual values.

Questions that might be answered by data charts include:
3 Visualizations

- What are the records for each transaction for this month?
- What are the quantity and sales for each item in each product group for each of our customers?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table (page 357)</td>
<td>Viewing precise values from your data without trends or patterns.</td>
</tr>
<tr>
<td>Pivot table (page 328)</td>
<td>Viewing precise value for several dimensions and measures.</td>
</tr>
</tbody>
</table>

Viewing geography

Geographical charts let you visualize your data by geography, displaying your data on a map either as points or areas.

Common questions that might be answered by geographical charts include:

- What cities have the highest use of our services?
- Which countries have the most customers?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maps (page 234)</td>
<td>Viewing data represented geographically by point or area.</td>
</tr>
</tbody>
</table>

What if no standard chart suits my purpose?

You can use controls or objects from a bundle supplied by Qlik:

- Dashboard bundle (page 418)
- Visualization bundle (page 434)

You can also create custom visualization objects if none of the standard charts provided fit your requirements for visualizing your data.

For more information, see Creating a visualization using a custom object (page 518).

3.6 Visualizations

You can use visualizations to present the data that is loaded into the app. For example, you can use a bar chart to compare sales numbers for different regions, or use a table to show precise values for the same data.

The selections you make in a visualization are reflected in all associated visualizations on all sheets.

Creating a visualization

You create visualizations from pre-defined charts or custom objects. You must be in Edit mode to be able to add a visualization to the sheet.
1. Drag the visualization from the assets panel onto the sheet, or double-click the visualization.

2. Add dimensions and measures to the visualization. The number of dimensions and measures that are required depends on which visualization you selected.
   Dimensions determine how the data in a visualization is grouped. For example: total sales per country or number of products per supplier. For more information, see Dimensions (page 65).
   Measures are calculations used in visualizations, typically represented on the y-axis of a bar chart or a column in a table. Measures are created from an expression composed of aggregation functions, such as Sum or Max, combined with one or several fields. For more information, see Measures (page 68).

3. Adjust the presentation, for example sorting, coloring, or labeling.

You can convert from one visualization type to another by dragging a new chart to a visualization on a sheet.

For other methods of creating a visualization, see Creating and editing visualizations (page 495).

Reusing a visualization

If you have created a visualization that you want to reuse in other sheets of the app, you can save it as a master visualization. You can only create master visualizations in an unpublished app. When the app is published, all users can add the visualization to their own sheets, but not modify it.

![Right-click on a visualization and select Add to master items to save it as a master visualization.]

You can find master visualizations under in the assets panel.

Which visualizations are available?

There are two basic types of visualizations available in the assets panel.

- Charts illustrate the data with visual elements like bars, lines, or points.
- Text-based visualizations presents data in text form, for example, tables or filters.

There are dashboard objects available in the assets panel.

The best choice of chart type depends on the purpose of the visualization.

If the pre-defined visualizations does not fill your purpose, you can use a visualization extension or a widget. You find them in the assets panel under .

<table>
<thead>
<tr>
<th>Charts</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>![Bar chart icon]</td>
<td>The bar chart displays a bar for each dimension value. The bar length corresponds to its numerical measure value.</td>
</tr>
<tr>
<td>Chart</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Box plot</td>
<td><img src="https://example.com/box.png" alt="Box plot icon" /></td>
<td>The box plot is suitable for comparing range and distribution for groups of numerical data, illustrated by a box with whiskers, and a center line in the middle.</td>
</tr>
<tr>
<td>Bullet chart</td>
<td><img src="https://example.com/bullet.png" alt="Bullet chart icon" /></td>
<td>Bullet charts can be used to visualize and compare performance of a measure to a target value and to a qualitative scale, such as poor, average, and good.</td>
</tr>
<tr>
<td>Combo chart</td>
<td><img src="https://example.com/combo.png" alt="Combo chart icon" /></td>
<td>The combo chart combines bars and lines in the same chart. The bars and lines have different axes to enable comparing percentages and sums.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td><img src="https://example.com/distribution.png" alt="Distribution plot icon" /></td>
<td>The distribution plot is suitable for comparing range and distribution for groups of numerical data. Data is plotted as value points along an axis.</td>
</tr>
<tr>
<td>Gauge</td>
<td><img src="https://example.com/gauge.png" alt="Gauge icon" /></td>
<td>The gauge is used to display the value of a single measure, lacking dimensions.</td>
</tr>
<tr>
<td>Histogram</td>
<td><img src="https://example.com/histogram.png" alt="Histogram icon" /></td>
<td>The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or a certain time period. The data is divided into bins.</td>
</tr>
<tr>
<td>Line chart</td>
<td><img src="https://example.com/line.png" alt="Line chart icon" /></td>
<td>The line chart displays data lines between values. Line charts are often used to visualize a trend in data over intervals of time.</td>
</tr>
<tr>
<td>Map</td>
<td><img src="https://example.com/map.png" alt="Map icon" /></td>
<td>The map is used to combine geospatial data and measure values, such as the sales for a region or a store.</td>
</tr>
<tr>
<td>Pie chart</td>
<td><img src="https://example.com/pie.png" alt="Pie chart icon" /></td>
<td>The pie chart shows the relation between a single dimension and a single measure.</td>
</tr>
<tr>
<td>Scatter plot</td>
<td><img src="https://example.com/scatter.png" alt="Scatter plot icon" /></td>
<td>The scatter plot presents values from two measures. This is useful when you want to show data where each instance has two numbers, for example, country (population and population growth). An optional third measure can be used and is then reflected in the size of the bubbles. When showing large data sets colors will be used instead of bubble size to represent the measure size.</td>
</tr>
<tr>
<td>Treemap</td>
<td><img src="https://example.com/treemap.png" alt="Treemap icon" /></td>
<td>The treemap shows hierarchical data. A treemap can show a large number of values simultaneously within a limited space.</td>
</tr>
</tbody>
</table>
### 3 Visualizations

<table>
<thead>
<tr>
<th>Chart</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waterfall chart</td>
<td>![Waterfall Chart Icon]</td>
<td>The waterfall chart illustrates how an initial value is affected by intermediate positive and negative values.</td>
</tr>
<tr>
<td>Visualization bundle</td>
<td>![Visualization Bundle Icon]</td>
<td>The Visualization bundle is a set of charts that can be used to enhance and increase your Qlik Sense app’s charting capacity.</td>
</tr>
</tbody>
</table>

#### Text-based visualizations

<table>
<thead>
<tr>
<th>Chart</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter pane</td>
<td>![Filter Icon]</td>
<td>The filter pane allows you to control what data that is shown in the visualizations on a sheet. A filter pane can filter the data of several dimensions at once.</td>
</tr>
<tr>
<td>KPI</td>
<td>![KPI Icon]</td>
<td>The KPI is used to present central performance figures. You can add a link to a sheet.</td>
</tr>
<tr>
<td>Pivot table</td>
<td>![Pivot Table Icon]</td>
<td>The pivot table presents dimensions and measures as rows and columns of a table. The pivot table allows you to analyze data in multiple dimensions at a time. The data in a pivot table may be grouped based on a combination of the dimensions, and partial sums can be shown.</td>
</tr>
<tr>
<td>Table</td>
<td>![Table Icon]</td>
<td>The table displays values in record form, so that each row of the table contains fields calculated using measures. Typically, a table includes one dimension and multiple measures.</td>
</tr>
<tr>
<td>Text &amp; image</td>
<td>![Text &amp; Image Icon]</td>
<td>You can use the text &amp; image visualization to add text, images, measures and links to a webpage.</td>
</tr>
</tbody>
</table>

#### Dashboard objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td>![Button Icon]</td>
<td>You can use buttons to add quick links for easy selection and navigation in your app.</td>
</tr>
<tr>
<td>Container</td>
<td>![Container Icon]</td>
<td>You can add visualizations in a limited space and show or hide the visualizations inside the container based on conditions.</td>
</tr>
<tr>
<td>Dashboard bundle</td>
<td>![Dashboard Bundle Icon]</td>
<td>A set of controls that you can use to enhance navigation and selection in your Qlik Sense app.</td>
</tr>
</tbody>
</table>

---

Create apps and visualizations - Qlik Sense, February 2021
Bar chart

The bar chart is suitable for comparing multiple values. The dimension axis shows the category items that are compared, and the measure axis shows the value for each category item.

In the image, the dimension values are different regions: Nordic, USA, Japan, UK, Spain, and Germany. Each region represents a dimension value, and has a corresponding bar. The bar height corresponds to the measure value (sales) for the different regions.

You can make more complex comparisons of data by using grouped or stacked bars. This requires using two dimensions and one measure. The two example charts use the same two dimensions and the same measure:

Grouped bars: With grouped bars, you can easily compare two or more items in the same categorical group.
Stacked bars: With stacked bars it is easier to compare the total quantity between different months. Stacked bars combine bars of different groups on top of each other and the total height of the resulting bar represents the combined result.

The bar chart can be displayed horizontally or vertically, as in the example below:
3 Visualizations

When to use it
Grouping and stacking bars makes it easy to visualize grouped data. The bar chart is also useful when you want to compare values side by side, for example sales compared to forecast for different years, and when the measures (in this case sales and forecast) are calculated using the same unit.

Advantages: The bar chart is easy to read and understand. You get a good overview of values when using bar charts.

Disadvantages: The bar chart does not work so well with many dimension values due to the limitation of the axis length. If the dimensions do not fit, you can scroll using the scroll bar, but then you might not get the full picture.

Creating a bar chart
You can create a simple bar chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty bar chart to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

In a bar chart you need at least one measure.

You can include up to two dimensions and one measure, or one dimension and up to 15 measures in a bar chart. Each bar corresponds to a dimension, and the values of the measures determine the height or length of the bars.

You can also create a bar chart with no dimension and up to 15 measures. In this case, one bar is displayed for every measure. The value of the measure determines the height or length of a bar.
Creating a bar chart

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>1 measure</td>
<td>A simple bar chart with one bar for each dimension value.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>1 measure</td>
<td>A grouped or a stacked bar chart with one bar for each value of the two dimensions.</td>
</tr>
<tr>
<td>No dimension</td>
<td>up to 15 measures</td>
<td>A simple bar chart with one bar for each measure.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>up to 15 measures</td>
<td>A grouped or a stacked bar chart with one bar for each value of each measure..</td>
</tr>
</tbody>
</table>

When you have created the bar chart, you may want to adjust its appearance.

Display limitations

Displaying large numbers of dimension values
When the number of dimension values exceeds the width of the visualization, a mini chart with a scroll bar is displayed. You can scroll by using the scroll bar in the mini chart, or, depending on your device, by using the scroll wheel or by swiping with two fingers. When a large number of values are used, the mini chart no longer displays all the values. Instead, a condensed version of the mini chart (with the items in gray) displays an overview of the values, but the very low and the very high values are still visible.

You can exchange the mini chart with a regular scrollbar, or hide it, with the Scrollbar property.

Displaying out of range values
In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a limit, the range is automatically set to include the highest positive and lowest negative value, but if you set a limit you may have values that exceed that limit. A bar that exceeds the limit will be cut diagonally to show that it is
out of range.

When a reference line is out of range, an arrow is displayed together with the number of reference lines that are out of range.

Displaying large amounts of data in a stacked bar chart

When displaying large amounts of data in a stacked bar chart, there may be cases when not each dimension value within a bar is displayed with correct color and size. These remaining values will instead be displayed as a gray, striped area. The size and total value of the bar will still be correct, but not all dimension values in the bar will be explicit.

To remove the gray areas, you can either make a selection or use dimension limits in the properties panel.

The approximate limit for how many stacked bars that can be displayed without gray areas is 5000 bars, assuming that each bar consists of 10 inner dimension values and one dimension value and one measure value for the whole bar.

The initial data load is 500 dimension values or dimension stacks. (The value 500 refers to the outer dimension values, not each dimension value in a stack.) When you have scrolled past those 500 values, an incremental load is performed, where values are instead loaded based on the current view or scroll position.

Comparing categories against a measure with a bar chart

This example shows how to make a bar chart to visualize sales data and how to compare different product groups against the same measure.
Dataset
In this example, we'll use two data files available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial, and the files are available in the *Tutorials source* folder:

- *Sales.xls*
- *Item master.xls*

To download the files, go to [Tutorial - Building an App](#).

Add the two data files to an empty app, and make sure that they are associated by *Item Number*.

The dataset that is loaded contains sales data. The *Item master* table holds the information about the items ordered, such as product groups.

Measure
We use the sales volume as the measure, by creating a measure in Master items with the name *Sales*, and the expression `sum(Sales)`.

Visualization
We add a bar chart to the sheet and set the following data properties:

- **Dimension**: Product Group (product group).
- **Measure**: Sales; the measure that was created as a master item.

The following bar chart is created, with a bar showing the sales for each product group:
But we want to have some more detailed information about the product sales, by adding the Product Sub Group as a dimension. The Product Sub Group field divides the product groups into sub groups. By default, a grouped chart is selected when adding the second dimension. We want to display a stacked chart instead, that is changed under **Appearances** in the properties panel.

**Discovery**

The bar chart visualizes the sales volume of different product groups, divided into product sub groups. The visualization is sorted in order of sales volume per product. You can hover the mouse pointer over a product sub group and view the details.
In the bar chart we can see that Produce has the highest sales volume. One of the sub products contribute to most of the Produce sales, if we hover over that part of the bar we can see it is Fresh Vegetables.

Accumulating values over a dimension in a bar chart
This example shows how to use a bar chart to visualize sales data which accumulate over a dimension.

![Accumulation of sales per quarter](image)

Dataset
In this example, we will use a data file available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial. The file is available in the Tutorials source folder: Sales.xls

To download the file, go to Tutorial - Building an App.

Add the data file to an empty app. The dataset that is loaded contains sales data.

Measure
We use the sales volume as the measure that we create in Master items:

- *Sales* with the expression `sum(Sales)`. This is the sum of the sales volume.

Visualization
We add a bar chart to the sheet and set the following data properties:
• **Dimension**: Month (Date.Month).
• **Measure**: Sales; the measure that was previously created.

The following bar chart is created, with a bar showing the sum of sales for each month.

![Bar Chart](image)

**Accumulation**

To have our sales data accumulate over one dimension, we need to apply a modifier to our *Sales* measure.

**Do the following:**

- Under **Measure**: *Sales* set the **Modifier** to Accumulation. This will set the measure to accumulate over one dimension.

Our bar chart becomes as follows, with the sales accumulating from one month to the next.
We want to achieve a visual separation of the periods of time, by adding the Quarter as a second dimension. The Quarter field groups the month bars into larger groups. By default, a grouped chart is selected when adding a second dimension.

**Do the following:**

1. **Add** **Dimension**: Quarter (Date. Quarter).
2. **Under** **Measure**: Sales set the **Modifier>Dimension** to Month. This sets the dimension over which the accumulation will take place.

If **Across all dimensions** is turned on, the accumulation continues across all quarters.
Notice how the bars of the previous two bar charts are the same.

If **Across all dimensions** is turned off, the accumulation starts again at the beginning of each quarter. Our bar chart becomes as follows, with the sales accumulating from one month to the next, inside each quarter.
It is good practice to have the title of your charts represent their content. So consider changing the title of your new bar chart to reflect that the bars are now an accumulation of sales.

**Discovery**

The bar chart visualizes the sales volume of each month, grouped into quarters. By having the sales accumulate inside each quarter, we get a better understanding of the volume of sales for each quarter. You can hover the mouse pointer over a month and view the details.

In the bar chart we can see that Q1 has the highest sales volume. We can also see that even though Q4 had the lowest sales volume, the first two months of the quarter were better than the ones from Q3.

**Bar chart properties**

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

*If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.*
Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.

Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click \( \text{fx} \) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

\[=\text{If}(\text{Week} < 14, \text{Week}, \text{'Sales'})\]

If Add is missing, you cannot add more dimensions.

- **<Dimension name>**: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, right-click the dimension and select \( \text{edit} \) in the dialog. Alternatively, click the dimension and click \( \text{edit} \).
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click \( \text{fx} \) to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values.
      You can also use an expression to set the number. Click \( \text{fx} \) to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click \( \text{fx} \) to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can
also use an expression to set the number. Click \( \text{fx} \) to open the expression editor.

- **Calculated on measure**: \(<\text{measure}>\): Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.

- **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click \( \text{fx} \) to open the expression editor.

- **Master item**: You can create a master dimension based on the dimension expression by clicking Create new.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (\( \text{=} \)) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click \( \text{fx} \) to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is missing, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.
  
  If you want to delete the measure, long-touch/right-click the measure and select \( \text{\textit{trash}} \) in the dialog.
  
  Alternatively, click the measure and click \( \text{\textit{trash}} \).

  - **Expression**: Click \( \text{fx} \) to open the expression editor. The existing expression is displayed by default.
  
  - **Modifier**: Selects a modifier for the measure. Options are None, Accumulation, Moving average, Difference, and Relative numbers.
  
  - **Accumulation**: Only displayed when Accumulation has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions.
The following options are available:

- **Dimension**: Selects the dimension on which the accumulation will take place. If the accumulation is made across multiple dimensions, this will be the first dimension.
- **Across all dimensions**: Continues accumulation across all available dimensions.
- **Range**: Select whether the accumulation will happen on the Full range, or a Custom range of the dimension.
- **Steps**: Only displayed when Range is set to Custom. The number of steps in the dimension which form an accumulation range. Only zero and positive integers are accepted.
- **Show excluded values**: Include excluded values in the accumulation.
- **Output expression**: Shows the expression used by the modifier.

- **Moving average**: Only displayed when Moving average has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions.

The following options are available:

- **Dimension**: Selects the dimension on which the moving average will take place. If the moving average is made across multiple dimensions, this will be the first dimension.
- **Across all dimensions**: Continues moving average across all available dimensions.
- **Range**: Select whether the moving average will happen on the Full range, or a Custom range of the dimension.
- **Steps**: Only displayed when Range is set to Custom. The number of steps in the dimension which form a moving average range. Only zero and positive integers are accepted.
- **Show excluded values**: Include excluded values in the moving average.
- **Output expression**: Shows the expression used by the modifier.

- **Difference**: Only displayed when Difference has been selected as a modifier. It allows you to calculate the difference between consecutive values of a measure over one or two dimensions.

The following options are available:

- **Dimension**: Selects the dimension on which the difference will take place. If the difference is made across multiple dimensions, this will be the first dimension.
- **Across all dimensions**: Continues difference across all available dimensions.
- **Show excluded values**: Include excluded values in the difference.
- **Output expression**: Shows the expression used by the modifier.

- **Relative numbers**: Only displayed when Relative numbers has been selected as a modifier. It allows you to calculate percentages relative to a specific selection, relative to
3  Visualizations

the total, or relative to a field value. The modifier can be calculated over one or two dimensions.

The following options are available:

- **Selection scope**: Sets whether the relative numbers are calculated based on the current selection or a specific field value. You can also disregard the current selection.

- **Dimensional scope**: Sets whether the relative numbers are calculated based on a dimension. You can choose to have the modifier respect all available dimensions, respect a specific dimension if there are two, or to disregard the dimensions.

- **Output expression**: Shows the expression used by the modifier.

- **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.

- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples:**

- # ###0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.

- ####0 describes the number as an integer without a thousands separator.

- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.

- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.

- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations: Only works with visualizations that accept measures. Cannot be used with a box plot. Does not affect the number formatting of the axis.

- **Add trend line**: Trend lines are lines used to show trends over time.
  - **Label**: Enter a label for the trend line. Click to open the expression editor.
  - **Type**: Set the type of the trend line. The following types are available:
    - Average
    - Linear
    - Second degree polynomial
    - Third degree polynomial
    - Fourth degree polynomial
    - Exponential
    - Logarithmic
    - Power
  - **Colors**: Set to **Custom** to change the color of the trend line.
  - **Dashed**: Choose between dashed or continuous line style.

- **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Dimensions and measures can also be sorted internally:
Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

- **Data handling**:
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  - A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.
- **Reference lines**: **Add reference line**: Click to add a new reference line.
  - **Show condition**: Sets a condition that needs to be fulfilled for the reference line to appear. Click \(\subseteq\) to open the expression editor.
  - **Label**: Enter a label for the reference line.
  - **Show label**: Select to show the reference line label.
  - **Color**: In the color picker, select the color of the reference line and the label.
  - **Reference line expression**: Enter a value or an expression for the reference line. Click \(\subseteq\) to open the expression editor.
  - **Show value**: Select to show the value of the reference line.
  - **Line type**: You can choose between solid and dashed line types.
  - **Colored background**: Adds the selected color as a background around the label text.
  - \(\text{[ ]} \) Click to remove the reference line.

- **Dimension reference lines**: **Add reference line**: Click to add a new dimensional reference line.
  - **Show condition**: Sets a condition that needs to be fulfilled for the dimensional reference line to appear. Click \(\subseteq\) to open the expression editor.
  - **Label**: Enter a label for the dimensional reference line.
  - **Show label**: Select to show the dimensional reference line label.
3 Visualizations

- **Color**: In the color picker, select the color of the dimensional reference line and the label.
- **Reference line expression**: Enter a value or an expression for the dimensional reference line. Click \( \text{\textbullet} \) to open the expression editor.
- **Show value**: Select to show the value of the dimensional reference line.
- **Line type**: You can choose between solid and dashed line types.
- **Colored background**: Adds the selected color as a background around the label text.
- \( \text{\textbullet} \): Click to remove the dimensional reference line.

**Appearance**

**General**
- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click \( \text{\textbullet} \) if you want to create an expression by using the expression editor.

"Titles are displayed on a single line. If you inject line breaks they will be ignored."

**Example:**

Assume that the following string is used, including quotation marks: ‘\textit{Sales: ’} & \textit{Sum(Sales)}. By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’\textit{Sales: ’} & \textit{Sum(Sales)}), the string is interpreted as an expression instead. The output is then \textit{Sales: <value of expression>}, where <value of expression> is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**
- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - \(<\text{inherited}>\), in which case the state defined for the sheet is used.
  - \(<\text{default state}>\), which represents the state where no alternate state is applied.

**Presentation**

When you have at least two dimensions or two measures, you can present the dimensions or measures grouped together or stacked on top of each other.

Select vertical or horizontal orientation of the visualization.
3 Visualizations

- **Scroll alignment**: Set the position of the chart scrollbar. By default the scroll alignment is set to Start.
- **Scrollbar**: Set the type of scrollbar to display. There are three settings:
  - **Mini chart**: Show a miniature of the chart.
  - **Bar**: Show a regular scrollbar.
  - **None**: There is no scrollbar, but you can still scroll in the visualization.
- **Grid line spacing**: Select the spacing of the grid lines. The **Auto** setting is Medium.
- **Value labels**: By default, Off. With the **Auto** setting, the value labels are displayed when there is enough space. You can select to show **Segment labels**, **Total labels**, or both.

You can change the styling of the bars by clicking on **Styling**.

- **Outline width**: Select if the bars should have an outline, and what the width of the outline should be. Default setting is **None**.
- **Outline color**: In the color picker, select the color of the outline. This option is not available if **Outline width** is set to **None**.
- **Bar width**: Set the bar width. This option is not available when using a continuous axis.
- **Reset all**: Resets all style editor properties to their default values.

**Colors and legends**

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
  - **Multicolored**: Option when more than one measure is used. By default, 12 colors are used for the measures. The colors are reused when there are more than 12 measures/values.
    - When selected, the following settings are available:
      - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
      - **Color scheme**: Select **12 colors** or **100 colors** to be used for the different
values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By dimension:** Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
  - **Select dimension:** Enter a field or expression containing the values to color objects in this chart.
  - **Library colors:** Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
  - **Persistent colors:** Select to have colors remain the same between selection states.
  - **Color scheme:** Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By measure:**
  - **Select measure:** Select the measure to use to color your chart.
  - **Library colors:** Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has a color assigned to it.
  - **Label:** Enter text or an expression for the measure that displays in the legend.
  - **Number formatting:** You can set the format of the field or expression values. The following number formats are available:
    - **Auto:** Qlik Sense automatically sets a number formatting based on the source data.
      To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
    - **Number:** By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples:**

- `###0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `####0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example "." is used as a decimal separator.
If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the *Format pattern* box to change the format pattern.

- **Date**: By default, the formatting is set to *Simple*, and you can select the formatting from the options in the drop-down list. Click the button to change to *Custom* formatting, and use the *Format pattern* box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the *Format pattern* box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the *Format pattern* boxes to change the format pattern.
  
  - **Decimal separator**: Set the decimal separator.
  
  - **Thousands separator**: Set the thousands separator.
  
  - **Format pattern**: Set the number format pattern.
  
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

- **Color scheme**: Select a color scheme from the following options:
  
  - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
  
  - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
  
  - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
  
  - **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

- **Reverse colors**: When selected, the color scheme is reversed.
**Range**: Define the range of values used to color by measure or by expression.
- **Auto**: The color range is set by the measure or expression values.
- **Custom**: When custom is selected, you can set the Min and Max values for the color range.

**By expression**: Color the chart using an expression to define colors for values.
Supported color formats are: RGB, ARGB, and HSL.
- **Expression**: Enter the expression that you want to use. Click $fx$ to open the expression editor.
- **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see Coloring a visualization (page 534)
When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option The expression is a color code must be cleared before you can set the color range.
- **Show legend**: Not available when Single color is selected. By default set to Off. The legend is displayed if there is enough space. The placement can be changed in the Legend position setting.
- **Legend position**: Select where to display the legend.
- **Show legend title**: When selected, the legend title is displayed.

**X-axis**
- `<Dimension>`
  - **Continuous**: Set to Custom to be able to show a continuous axis by selecting Use continuous scale. Use continuous scale is only available for dimensions with numeric values. You cannot change sorting when you use a continuous scale.
  - **Show mini chart**: You can select if you want to display the mini chart below the chart. This option is only available when you use a continuous scale.
  - **Labels and title**: Select what to display of labels and title.
  - **Label orientation**: Select how to display the labels.
  - **Position**: Select where to display the dimension axis.
  - **Number of bars**: Set the upper limit to the number of visible bars.
    - **Auto**: The number of visible bars is determined by the number of dimensions and measures used.
    - **Max**: The number of visible bars is set to maximum.
    - **Custom**: When custom is selected, you can directly set the upper limit to the number of visible bars using Maximum number, or by entering an expression. Click $fx$ to open the expression editor.
3 Visualizations

Y-axis
- <Measure>
  - Labels and title: Select what to display of labels and title.
  - Position: Select where to display the measure axis.
  - Scale: Set the spacing of the measure axis scale.
  - Range: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Tooltip
- Tooltip: Set to Custom to add measures and images as tooltips.
- Hide basic rows: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, Hide basic rows will also hide dimension values as well.
- Title: Enter a title for the tooltip.
- Description: Enter a description for the tooltip.
- Measures
  - Add measure: Add a measure to be shown as a tooltip. You can add a measure from a field using From a field. You can also use an expression to add a measure. Click $\mathbf{f}$ to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using Label as well as its formatting using Number formatting.
- Images
  - Type: Choose whether to add an image from your Media library or from a URL.
  - Size: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - Small: Set the width and height of the container to 50 pixels.
    - Medium: Set the width and height of the container to 200 pixels.
    - Large: Set the width and height of the container to 340 pixels.
    - Original: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
  - Media library: Appears when you choose Media library for Type. Click to select an image from your media library.
  - URL: Appears when you choose URL for Type. Enter a URL.

Box plot
The box plot is suitable for comparing range and distribution for groups of numerical data, illustrated by a box with whiskers, and a center line in the middle. The whiskers represent high and low reference values for excluding outlier values.

You can define the box start and end points, and whiskers ranges with a few different presets, or define your own settings using expressions.
1. First whisker
2. Box start
3. Center line
4. Box end
5. Last whisker

You can hover over a box to display a popup showing the respective values of the box plot elements.

When to use it

The box plot is suitable for comparing range and distribution for groups of numerical data.

Advantages: The box plot organizes large amounts of data, and visualizes outlier values.

Disadvantages: The box plot is not relevant for detailed analysis of the data as it deals with a summary of the data distribution.

Creating a box plot

You can create a box plot on the sheet you are editing.

In a box plot you need to use one or two dimensions, and one measure. If you use a single dimension you will receive a single box visualization. If you use two dimensions, you will get one box for each value of the second, or outer, dimension.

You cannot use calculated dimensions in a box plot.

Do the following:

1. From the assets panel, drag an empty box plot to the sheet.
2. Add the first dimension.
   This is the inner dimension, which defines a box.
3. Add a second dimension.
   This is the outer dimension, which defines the boxes shown on the dimension axis.
4. Click Add measure and create a measure from a field. The measure does not have to contain an aggregation.
When you have created the box plot, you may want to adjust its appearance and other settings in the properties panel. By default, the **Standard (Tukey)** preset is used.

### Changing the definition of the box plot

You can use one of the three presets, found under **Box plot elements** in the properties panel, to define your box plot.

- **Standard (Tukey)**
  
  This preset is based on the original box plot definition by J. Tukey. The center line represents the median (second quartile), and the box start and end points represent the first and third quartiles. Whisker length can be set to 1, 1.5 or 2 inter-quartile ranges. An inter-quartile range represents the difference between the first and third quartiles.

- **Percentile-based**
  
  This preset is also defined with the box start and end points representing the first and third quartiles, and the center line representing the median, but the whisker length is adjusted by setting a percentile based whisker position.

- **Standard deviation**
  
  This preset is based on standard deviations, with the center line representing the average value, and the box start and end points representing one standard deviation variance. You can set the whisker length to a multiple of standard deviations.

You can also define a custom box plot where you set the value of each box plot element using an expression.

### Visualizing range and distribution of numerical data with a box plot

This example shows how to make a box plot to visualize range and distribution of numerical data using daily temperature measurements.

![Box plot of temperature data](image)

**Dataset**

In this example, we'll use the following weather data.
• Location: Sweden > Gällivare Airport
• Date range: all data from 2010 to 2017
• Measurement: Average of the 24 hourly temperature observations in degrees Celsius

The dataset that is loaded contains a daily average temperature measurement from a weather station in the north of Sweden during the time period of 2010 to 2017.

Measure
We use the average temperature measurement in the dataset as the measure, by creating a .measure in Master items with the name Temperature degrees Celsius, and the expression \( \text{Avg}([\text{Average of the 24 hourly temperature observations in degrees Celsius}]) \).

Visualization
We add a box plot to the sheet and set the following data properties:

• **Dimension**: Date (date) and Year (year). The order is important; Date needs to be the first dimension.
• **Measure**: Temperature degrees Celsius; the measure that was created as a master item.

In this example we use the default box plot preset, **Standard (Tukey)** with the whisker length **1.5 interquartile range**.

Discovery
The box plot visualizes the distribution of the daily temperature measurements. The visualization is sorted in mean temperature order. The mean temperature for each year is illustrated by the middle line in each box. The box stretches from the first quartile to the third quartile, and the whiskers stretch 1.5 inter-quartile ranges. There are also a number of outlier values, the points that are placed outside the whiskers. You can hover the mouse pointer over an outlier point and view the details.
In the box plot we can see that the year 2010 has the longest box and whiskers. That shows that the year 2010 has the largest distribution of temperatures measured. It also seems to be the coldest year in average.

The range of 2017 is small, as the dataset only contains measurements from the first months of the year.

Box plot properties

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click Add to add a dimension or a measure.

Dimensions

On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

=If (Week < 14, Week, 'Sales')

If Add is dimmed, you cannot add more dimensions.

It is not possible to put limitations on the inner dimension of a box plot.

- <Dimension name>: Click the dimension name to open the dimension settings.

  If you want to delete the dimension, right-click the dimension and select in the dialog. Alternatively, click the dimension and click .

    Dimension: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
3  Visualizations

- **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click \( \mathbf{f} \mathbf{x} \) to open the expression editor.

- **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.

- **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).

- **Master item**: You can create a master dimension based on the dimension expression by clicking **Create new**.

  You can also click \( \mathbf{f} \mathbf{x} \) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

  - **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

  You cannot use calculated dimensions in a box plot.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (听见) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click \( \mathbf{f} \mathbf{x} \) to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.
  
  If you want to delete the measure, long-touch/right-click the measure and select \( \mathbf{c} \) in the dialog. Alternatively, click the measure and click \( \mathbf{c} \).
  
  - **Expression**: Click \( \mathbf{f} \mathbf{x} \) to open the expression editor. The existing expression is displayed by default.
3 Visualizations

- **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
  To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- `# ##0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression.
  Use this option to display custom number formatting for a measure in a visualization.
  Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.
- **Bars/Line/Marker**: You can choose to add a measure as bars, as a line, or as markers.
  For lines and markers, you can use the Primary axis to the left or the Secondary axis to the right.
  For markers you can choose between several different shapes.
- **Fill marker**: Select to display markers filled.
- **Master item**: You can create a master measure based on the measure expression by clicking Create new.
- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (Ξ) to rearrange the order.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

**Box plot elements**
- **<Use presets>**: If you set this to On you can select one of the available presets that define the elements of the box plot: Standard (Tukey), Percentile-based or Standard deviation. If you set to Off you need to define all elements using custom expressions.
  - **Standard (Tukey)**: This preset is based on the original box plot definition by J. Tukey.
    The center line represents the median (second quartile), and the box start and end points represent the first and third quartiles.
    You can set the length of the whiskers with Whisker length: 1 inter-quartile range, 1.5 inter-quartile range or 2 inter-quartile ranges.
    1 inter-quartile range represents the length of the box, that is, the difference between the first and third quartiles.
  - **Percentile-based**: This preset is also defined with the box start and end points representing the first and third quartiles, and the center line representing the median, but the whisker length is adjusted by setting a percentile based Whisker position: Min/max.
    This setting sets the whisker start and end points to the minimum and maximum values: 1st/99th percentile, 5th/95th percentile or 10th/90th percentile.
  - **Standard deviation**: This preset is based on standard deviations, with the center line representing the average value, and the box start and end points representing one standard deviation variance. You can set the whisker length to a multiple of standard deviations: One standard deviation, Two standard deviations or Three standard deviations.
deviations.

- **Include outliers**: You can select to display outlier values, that is, values on either side of the whiskers.

- Custom boxplot element settings: If you set **Use presets** to **Off** you can define all elements using a custom expression and label. Expressions are prefilled with the expressions used to define the elements in the most recently used preset.

  **Center line**: Name and Expression
  **Box edges**: Box start name, Box start expression, Box end name or Box end expression
  **Whiskers**: First whisker name, First whisker expression, Last whisker name or Last whisker expression

**Sorting**
If you set **Sorting** to **Custom**, you can sort the box plot by a custom expression, or by the second dimension of the chart in numerical or alphabetical order. The sorting is either **Ascending** or **Descending**.

- **Sort by expression**: Select which element to sort by (First whisker, Box start, Center line, Box end or Last whisker).
- **Sort numerically**: Enable this to sort numerically by the second dimension of the chart. If you change the second dimension, the chart will be sorted by the new dimension.
- **Sort alphabetically**: Enable this to sort alphabetically by the second dimension of the chart. If you change the second dimension, the chart will be sorted by the new dimension.

You can also customize the sort expression. Do the following:

1. Click Φ to unlink the sort expression.
2. Edit the sort expression.

You can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

- **Data handling**: **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: count(distinct Team)<3. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines**:
Visualizations

- **Add reference line**: Click to add a new reference line.
- **Show**: When selected, the reference line is displayed.
- **Label**: Enter a label for the reference line.
- **Color**: In the color picker, select the color of the reference line and the label.
- **Reference line expression**: Enter a value or an expression for the reference line. Click $f$ to open the expression editor.
- **🗑️**: Click to remove the reference line.

**Appearance**

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click $f$ if you want to create an expression by using the expression editor.

*Titles are displayed on a single line. If you inject line breaks they will be ignored.*

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (='Sales: ' & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- `<inherited>`, in which case the state defined for the sheet is used.
- `<default state>`, which represents the state where no alternate state is applied.

**Presentation**

You can set the orientation to be **Vertical** or **Horizontal**.

- **Show whisker ticks**: Enable this to display vertical lines at the end of each whisker.
- **Gridline spacing**: Set this to **Custom** if you want to customize the horizontal gridlines. You can choose between: **No lines**, **Medium**, and **Narrow**.

---

Create apps and visualizations - Qlik Sense, February 2021
Colors

- **Colors**: You only need to select **Custom** if you want to change the settings. The **Auto** settings are based on the visualization used and the number of dimensions and measures, that is, the settings are not fixed, but are dependent on the data input.
  - **Single color**: A single color (by default blue) is used for all items in the chart. In visualizations that do not benefit from multiple colors (bar charts with one dimension and scatter plots), single color is the default setting. Use the color picker to change the dimension color.
  - **By expression**: You can use coloring by expression to accentuate certain values. Supported formats: RGB, ARGB, and HSL.
    - **Expression**: Enter the expression that you want to use. Click \( fx \) to open the expression editor.

X-axis

- **<Measure>**
  - **Labels and title**: Select what to display of labels and title.
  - **Label orientation**: Select how to display the labels.
  - **Position**: Select where to display the measure axis.

Y-axis

- **<Dimension>**
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the dimension axis.
  - **Scale**: Set the spacing of the dimension axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Bullet chart

The bullet chart (**Bullet chart**) displays a gauge with extended options. Bullet charts can be used to visualize and compare performance of a measure to a target value and to a qualitative scale, such as poor, average, and good.

In a bullet chart you need one measure, which determines the length of the bar.

You can also add a dimension. This will show one gauge for every dimension value. If you do not define a dimension, the chart will show a single gauge.

**Example:**

*A bullet chart showing sales performance for each value of the dimension (quarter)*
The example shows a bullet chart with sales performance for each quarter. It also shows the performance relative to target and performance range, which are different for each quarter.

When to use it

Bullet charts let you compare and measure performance with more enriched information than a common gauge. This is helpful when comparing performance according to a target and a simple performance rating. For example: you can show how sales relate to a target value, and in context of poor, good, and stretched performance.

Creating a bullet chart

You can create a bullet chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty bullet chart to the sheet.
2. Click Add dimension to select the dimension that define how many gauges are shown.
3. Click the Add measure button to select the value measure of the chart that defines the length of the bar.
   Once the measure is selected the bullet chart is displayed with default settings. Each gauge is displayed with an individual range. If you want to use a common range, you can set it with Appearance > Y-axis > Common range.
4. To add a target value, click Target under the measure. You can define a fixed value or use a measure with target values.
5. To add performance ranges, set Use segments under the measure to On.
   Click Add limit to set a range limit for the segments. You can adjust the color of each segment by clicking on it.
   You can define a fixed limit value or an expression.

The bullet chart is now displayed with the dimension and measure you selected.
Setting a target value
You can add a target value which is displayed as a marker line. If the measure contains sales numbers, this could be budgeted sales for example.
You can define a fixed value or use a measure with target values.

Setting performance ranges
To add performance ranges, set Use segments under the measure to On.
You need to add the limits for the ranges you want to use for showing indicators with Add limit. You can set a limit value in three ways.
- Use the slider.
- Type a value in the text box.
- Set an expression that returns the limit value.

Changing the color scheme
You can change color scheme of the value bar and the target by setting Appearance > Colors > Colors to Custom. You can set single colors or use an expression.

It’s a good idea to use a bar color that is visually dominant to the range colors.

When you have added the limits, you can select the color and the symbol of the indicator for each defined range.

Setting the scale of the axis
If you use a dimension to show several gauges, you can select how to show the scale of the axis with Appearance > Y-axis > Common range.
- If you want each dimension gauge to use the same scale, enable Common range. If the range measure depends on the dimension value, the range bars will have different lengths.
  This is useful when you want to be able to compare the actual values.
  You can also set a common axis for all gauges with Appearance > Y-axis > Common range.
- If you want each range bar to be equally long, disable Common range.
  This is useful when you want to be able to compare the relative performance of each dimension value.

Combo chart
The combo chart is suitable for comparing two sets of measure values that are usually hard to compare because of the differences in scale. It is basically a bar chart combined with a line chart.
A typical example is when you have a bar chart with sales figures and want to combine these figures with the margin values (in percent). In a regular bar chart, the bars for sales would be displayed as usual, but the margin values would be almost invisible because of the very large difference between the numeric values for sales and margin.

A combo chart with the margin values (in percent) and bars with sales figures.

With a combo chart you can combine these values by, for example, using bars for the sales values and a line for the margin values. By default, the bars have the measure axis on the left and the margin values have a separate axis to the right. The two measures use the same dimension (YearMonth).

If you have yet another measure, for example, gross sales, with values that are roughly in the same range as the sales values, you can add the third measure as bars and either stack or group the new measure values with the sales values. With grouped bars, you can easily compare two or more items in the same categorical group. Stacked bars combine bars of different groups on top of each other and the total height of the resulting bar represents the combined result.

A combo chart with three measures; the margin values (in percent), bars with sales figures and the measure Gross sales grouped with the sales values.
You can accumulate values of a measure over one or two dimensions:

*A combo chart with two accumulated measures, the accumulated margin values, and bars with accumulated sales figures.*

The combo chart can only be displayed vertically.

**When to use it**

With the possibility to have different measure scales, one to the left and one to the right, the combo chart is ideal when you want to present measure values that are normally hard to combine because of the significant difference in value ranges.
But a combo chart can also be quite useful when comparing values of the same value range. In the image above, the combo chart only has one measure axis, but the relationship between the two categories sales and cost is clear.

Advantages
The combo chart is the best choice when combining several measures of different value ranges.

Disadvantages
The combo chart only supports one dimension, and can therefore not be used when you need to include two or more dimensions in the visualization.

Creating a combo chart
You can create a combo chart on the sheet you are editing. In a combo chart, you need at least one dimension and one measure.

Do the following:

1. From the assets panel, drag an empty combo chart to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field. Select to show the measure as a bar.
4. Add another measure, selecting to show the measure as a line or a marker.

You can only have one dimension, but you can continue adding up to 15 measures. You can only have two measure axes though. This means, if you add three or more measures with a large difference in value range it can be hard to display all measures with a good distribution of values.

When you have created the combo chart, you may want to adjust its appearance and other settings in the properties panel.

Display limitations

Displaying out of range values
In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a limit, the range is automatically set to include the highest positive and lowest negative value, but if you set a limit you may have values that exceed that limit. A bar that exceeds the limit will be cut diagonally to show that it is out of range. For a line data point value that is out of range, an arrow indicates the direction of the value.

Comparing measures with a different scale using a combo chart
This example shows how to make a combo chart that visualizes sales data. You will also compare different product groups against two measures with a different scale.
Dataset

In this example, we will use two data files from the Qlik Sense Tutorial - Building an App. To download the files, go to Tutorial - Building an App. Download and unzip the tutorial, and find the files in the Tutorials source folder:

- Sales.xls
- Item master.xls

Create a new app, and add the two data files. Make sure that they are associated by Item Number.

The dataset that is loaded contains sales data. The Item master table holds the information about the items ordered, such as product groups.

Measures

We need to create two measures in Master items:

- Sales volume: with the name Sales, and the expression \( \text{sum(Sales)} \).
- Sales margin in percent: with the name Margin %, and the expression \( \text{avg(Margin/Sales)*100} \).

Visualization

We add a combo chart to the sheet and set the following data properties:

- Dimension: Product Group (product group).
- Measure: Sales (the master measure you created).

The following chart is created, with a bar showing the sales for each product group. It is a bar chart at this stage.
But we also want to show the sales margin, which has a different scale than the sales volume. Sales volume is in the scale of millions, while the margin is a percentage between 0 and 100. If we add margin as a bar next to sales volume, it would be too small to distinguish.

In the properties pane, go to **Measures > Height of line**. Use the drop down to add **Margin %** as a measure.

**Discovery**

The combo chart visualizes the sales volume and margin of different product groups. You can hover the mouse pointer over a product group and view the details. The bars show the sales volume with the scale to the left, and the line shows the margin with the scale to the right.
In the chart we can see that Produce and Canned Products have the highest sales volumes. Both groups have a lower margin than most other product groups.

Some product groups with low sales volume, like Eggs and Seafood, have a significantly higher margin.

**Combo chart properties**

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

- If the visualization has a symbol in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

- Some of the settings in the properties panel are only available under certain circumstances, for example, when you use at least one line or when you have two measures.

**Data**

Click Add to add a dimension or a measure.

**Dimensions**

On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

=If (Week < 14, Week, 'Sales')

If Add is dimmed, you cannot add more dimensions.

- **<Dimension name>:** Click the dimension name to open the dimension settings.
  - If you want to delete the dimension, right-click the dimension and select in the dialog. Alternatively, click the dimension and click .

- **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.

- **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click to open the expression editor.
3 Visualizations

- **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.

- **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).

- **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
  - **No limitation**: The default value.
  - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\mathcal{f}x$ to open the expression editor.
  - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathcal{f}x$ to open the expression editor.
  - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathcal{f}x$ to open the expression editor.
  - **Calculated on measure**: $<$measure$>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (**Fixed number**, **Exact value**, or **Relative number**), the value counts as 1 in that setting. If, for example, **Exact value** is used and set to 10, the tenth value is **Others**. This option is not available in box plot dimensions.

- **Other label**: Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click $\mathcal{f}x$ to open the expression editor.

- **Master item**: You can create a master dimension based on the dimension expression by clicking **Create new**.

  - **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars ($\equiv$) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.
If no measure is available, you need to create one. You can enter the expression directly in the text box, or click the measure icon to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add is dimmed, you cannot add more measures.

- **Measure name**: Click the measure to open the measure settings. If you want to delete the measure, long-touch/right-click the measure and select icon in the dialog. Alternatively, click the measure and click icon.
  - **Expression**: Click the expression icon to open the expression editor. The existing expression is displayed by default.
  - **Modifier**: Selects a modifier for the measure. Options are None, Accumulation, Moving average, Difference, and Relative numbers.
    - **Accumulation**: Only displayed when Accumulation has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions. The following options are available:
      - **Dimension**: Selects the dimension on which the accumulation will take place. If the accumulation is made across multiple dimensions, this will be the first dimension.
      - **Across all dimensions**: Continues accumulation across all available dimensions.
      - **Range**: Select whether the accumulation will happen on the Full range, or a Custom range of the dimension.
      - **Steps**: Only displayed when Range is set to Custom. The number of steps in the dimension which form an accumulation range. Only zero and positive integers are accepted.
      - **Show excluded values**: Include excluded values in the accumulation.
      - **Output expression**: Shows the expression used by the modifier.
    - **Moving average**: Only displayed when Moving average has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions. The following options are available:
      - **Dimension**: Selects the dimension on which the moving average will take place. If the moving average is made across multiple dimensions, this will be the first dimension.
      - **Across all dimensions**: Continues moving average across all available dimensions.
      - **Range**: Select whether the moving average will happen on the Full range, or a Custom range of the dimension.
3 Visualizations

- **Steps**: Only displayed when **Range** is set to **Custom**. The number of steps in the dimension which form a moving average range. Only zero and positive integers are accepted.
- **Show excluded values**: Include excluded values in the moving average.
- **Output expression**: Shows the expression used by the modifier.
- **Difference**: Only displayed when **Difference** has been selected as a modifier. It allows you to calculate the difference between consecutive values of a measure over one or two dimensions.

The following options are available:
- **Dimension**: Selects the dimension on which the difference will take place. If the difference is made across multiple dimensions, this will be the first dimension.
- **Across all dimensions**: Continues difference across all available dimensions.
- **Show excluded values**: Include excluded values in the difference.
- **Output expression**: Shows the expression used by the modifier.
- **Relative numbers**: Only displayed when **Relative numbers** has been selected as a modifier. It allows you to calculate percentages relative to a specific selection, relative to the total, or relative to a field value. The modifier can be calculated over one or two dimensions.

The following options are available:
- **Selection scope**: Sets whether the relative numbers are calculated based on the current selection or a specific field value. You can also disregard the current selection.
- **Dimensional scope**: Sets whether the relative numbers are calculated based on a dimension. You can choose to have the modifier respect all available dimensions, respect a specific dimension if there are two, or to disregard the dimensions.
- **Output expression**: Shows the expression used by the modifier.

- **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:
- **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
  To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom**.
formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `# ###0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `####0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money:** By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration:** By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom:** By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
- **Measure expression:** The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Label:** Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
- **Measure:** Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
- **Number formatting:** Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto:** Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
3 Visualizations

- **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples:**

- # ###0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- ###0 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example "," is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.

- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

  Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.

  Does not affect the number formatting of the axis.

- **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.

- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

  The following number formats are available:
3 Visualizations

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `##0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `#####0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Bars/Line/Marker**: You can choose to add a measure as bars, as a line, or as markers. For lines and markers, you can use the **Primary axis** to the left or the **Secondary axis** to the right.
  - For markers you can choose between several different shapes.
Fill marker: Select to display markers filled.
Master item: You can create a master measure based on the measure expression by clicking Create new.
Add alternative: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

Sorting
Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Dimensions and measures can also be sorted internally:

Click the dimension or measure name to open the settings and click the sorting button to switch to Custom sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- Sort by expression: Enter an expression to sort by. Only available for dimensions.
- Sort numerically
- Sort alphabetically

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

Add-ons

- Data handling:
  - Calculation condition: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: count(distinct Team)<3. If the condition is not fulfilled, the message or expression entered in Displayed message is displayed.

A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- Include zero values: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
Appearance

General
- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click **Fx** if you want to create an expression by using the expression editor.

  *Titles are displayed on a single line. If you inject line breaks they will be ignored.*

  **Example:**
  Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states
- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation
When you have at least two dimensions or two measures, you can present the dimensions or measures grouped together or stacked on top of each other.

Select vertical or horizontal orientation of the visualization.

- **Scroll alignment**: Set the position of the chart scroll bar. By default the scroll alignment is set to **Start**.
- **Grid line spacing**: Select the spacing of the grid lines. The **Auto** setting is **Medium**.
- **Value labels**: By default, **Off**. With the **Auto** setting, the value labels are displayed when there is enough space.

*Value labels are available for **Bars** and **Lines**, but they are not available for **Marker**.*
3 Visualizations

Colors and legends

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Color settings are based on the visualization used and the number of dimensions and measures, that is, the settings are not fixed, but are dependent on the data input.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: A single color (by default blue) is used for all items in the chart. In visualizations that do not benefit from multiple colors (bar charts with one dimension and scatter plots), single color is the default setting. Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
    - **Multicolored**: Option when more than one measure is used. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values.
      - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
      - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
    - **By dimension**: By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
      - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
      - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
      - **Persistent colors**: When selected, colors are persistent between selection states. Only available when using one dimension and the setting **By dimension** or **Multicolored**.
      - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
    - **By measure**: By default, **Sequential gradient** is selected. The higher the measure value, the darker the color.
3 Visualizations

- **Select measure**: Select the measure to use to color your chart.
- **Library colors**: Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has a color assigned to it.
- **Color scheme**: Select a color scheme from the following options:
  - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
  - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
  - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
  - **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
- **Reverse colors**: When selected, the color scheme is reversed.
- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click \( \text{fx} \) to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see *Coloring a visualization* (page 534)
    When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
  - **Range**: When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
- **Show legend**: Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.
- **Legend position**: Select where to display the legend.
- **Show legend title**: When selected, the legend title is displayed.
3 Visualizations

X-axis
- `<Dimension>`
  - **Continuous**: Set to **Custom** to be able to show a continuous axis by selecting **Use continuous scale**. **Use continuous scale** is only available for dimensions with numeric values. You cannot change sorting when you use a continuous scale.
  - **Show mini chart**: You can select if you want to display the mini chart below the chart. This option is only available when you use a continuous scale.
  - **Labels and title**: Select what to display of labels and title.
  - **Label orientation**: Select how to display the labels.
  - **Position**: Select where to display the dimension axis.

Y-axis
- `<Measure>`
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the measure axis.
  - **Scale**: Set the spacing of the measure axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Tooltip
- **Tooltip**: Set to **Custom** to add measures and images as tooltips.
- **Hide basic rows**: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, **Hide basic rows** will also hide dimension values as well.
- **Title**: Enter a title for the tooltip.
- **Description**: Enter a description for the tooltip.
- **Measures**
  - **Add measure**: Add a measure to be shown as a tooltip. You can add a measure from a field using **From a field**. You can also use an expression to add a measure. Click \( \text{fx} \) to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using **Label** as well as its formatting using **Number formatting**.
- **Images**
  - **Type**: Choose whether to add an image from your **Media library** or from a **URL**.
  - **Size**: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - **Small**: Set the width and height of the container to 50 pixels.
    - **Medium**: Set the width and height of the container to 200 pixels.
    - **Large**: Set the width and height of the container to 340 pixels.
    - **Original**: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
Distribution plot

The distribution plot is suitable for comparing range and distribution for groups of numerical data. Data is plotted as value points along an axis.

You can choose to display only the value points to see the distribution of values, a bounding box to see the range of values, or a combination of both as shown here:

When to use it

The distribution plot is suitable for comparing range and distribution for groups of numerical data.

Advantages

The distribution plot visualizes the distribution of data.

Disadvantages

The distribution plot is not relevant for detailed analysis of the data as it deals with a summary of the data distribution.

Creating a distribution plot

You can create a distribution plot on the sheet you are editing.
In a distribution plot you need to use one or two dimensions, and one measure. If you use a single dimension you will receive a single line visualization. If you use two dimensions, you will get one line for each value of the second, or outer, dimension.

**Do the following:**

1. From the assets panel, drag an empty distribution plot to the sheet.
2. Add the first dimension.  
   This is the inner dimension, which defines the value points.
3. Add a second dimension.  
   This is the outer dimension, which defines the groups of value points shown on the dimension axis.
4. Click **Add measure** and create a measure from a field.

**Viewing the distribution of measure values in a dimension with a distribution plot (page 187)**

When you have created the distribution plot, you may want to adjust its appearance and other settings in the properties panel.

**Distribution plot properties (page 189)**

### Display limitations

**Displaying large amounts of data in a distribution plot**

When displaying large amounts of data in a distribution plot, the message "**Currently showing a limited data set.**" is shown to indicate that not all data is displayed.

- If the chart uses more than one dimension, 3000 data points are displayed.

**Viewing the distribution of measure values in a dimension with a distribution plot**

This example shows how to make a distribution plot to view the distribution of measure values in a dimension, using weather data as an example.
3 Visualizations

Dataset
In this example, we'll use the following weather data.

- Location: Sweden > Gällivare Airport
- Date range: all data from 2010 to 2017
- Measurement: Average of the 24 hourly temperature observations in degrees Celsius

The dataset that is loaded contains a daily average temperature measurement from a weather station in the north of Sweden during the time period of 2010 to 2017.

Measure
We use the average temperature measurement in the dataset as the measure, by creating a .measure in Master items with the name Temperature degrees Celsius, and the expression \( \text{Avg}([\text{Average of the 24 hourly temperature observations in degrees Celsius}]) \).

Visualization
We add a distribution plot to the sheet and set the following data properties:

- **Dimension**: Date (date) and Year (year). The order is important, Date needs to be the first dimension.
- **Measure**: Temperature degrees Celsius, the measure that was created as a master item.

*Distribution plot with the dimensions Date (date) and Year (year) and the measure Temperature degrees Celsius.*
Discovery

The distribution plot visualizes the distribution of the daily temperature measurements. The visualization is sorted by year, and each point represents a temperature measurement.

In the visualization we can see that the year 2012 has the lowest extreme temperature measurement, close to -40 degrees Celsius. We can also see that the year 2016 seems to have the largest distribution of temperature measurements. With this many points in the distribution plot, it can be hard to spot clusters and outliers, but the year 2017 has two low temperature measurements that stand out. You can hover the mouse pointer over a point and view the details.

Distribution plot properties

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

- If the visualization has the in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

- Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click Add to add a dimension or a measure.
Dimensions

On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click $\mathcal{F}$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign ($=$). Here is an example with a calculated dimension:

$=\text{If (Week < 14, Week, 'Sales')}$

If Add is dimmed, you cannot add more dimensions.

- **<Dimension name>:** Click the dimension name to open the dimension settings.
  
  If you want to delete the dimension, right-click the dimension and select \( \square \) in the dialog. Alternatively, click the dimension and click \( \square \).

  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  
  - **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click \( \mathcal{F} \) to open the expression editor.
  
  - **Label:** Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  
  - **Include null values:** When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (−).
  
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    
    - **No limitation:** The default value.
    
    - **Fixed number:** Select to display the top or bottom values. Set the number of values.
      
      You can also use an expression to set the number. Click \( \mathcal{F} \) to open the expression editor.
    
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click \( \mathcal{F} \) to open the expression editor.
    
    - **Relative value:** Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click \( \mathcal{F} \) to open the expression editor.
    
    - **Calculated on measure:** <measure>: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
    
    - **Show others:** When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
This option is not available in box plot dimensions.

- **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click \( \text{expression editor} \) to open the expression editor.

- **Master item**: You can create a master dimension based on the dimension expression by clicking Create new.

  - **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars \( \text{תברך את הגזרה} \) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

### Measures

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click \( \text{expression editor} \) to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.

  If you want to delete the measure, right-click the measure and select \( \text{폐기} \) in the dialog. Alternatively, click the measure and click \( \text{폐기} \).

  - **Expression**: Click \( \text{expression editor} \) to open the expression editor. The existing expression is displayed by default.

  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.

  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:
3 Visualizations

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples:**

- `###0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `0000` describes the number as an integer without a thousands digits.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.

- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.

  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Bars/Line/Marker**: You can choose to add a measure as bars, as a line, or as markers. For lines and markers, you can use the **Primary axis** to the left or the **Secondary axis** to the right.

For markers you can choose between several different shapes.
• **Fill marker**: Select to display markers filled.
• **Master item**: You can create a master measure based on the measure expression by clicking Create new.
• **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

You can sort the distribution plot by any of the distribution plot elements or a custom expression, or by the second dimension of the chart in numerical or alphabetical order.

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

• **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
  • Sort numerically
  • Sort alphabetically

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

• **Data handling**:
  • **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  • **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

• **Reference lines**:
  • **Add reference line**: Click to add a new reference line.
  • **Show**: When selected, the reference line is displayed.
3 Visualizations

- **Label**: Enter a label for the reference line.
- **Color**: In the color picker, select the color of the reference line and the label.
- **Reference line expression**: Enter a value or an expression for the reference line. Click \(\text{fx}\) to open the expression editor.
- #: Click to remove the reference line.

**Appearance**

**General**

- **Show titles**: On by default in all visualizations except filter panes, KPIs, and text & image visualizations.

  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click \(\text{fx}\) if you want to create an expression by using the expression editor.

  *Titles are displayed on a single line. If you inject line breaks they will be ignored.*

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ‘ & Sum(Sales).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ‘ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - **<inherited>**, in which case the state defined for the sheet is used.
  - **<default state>**, which represents the state where no alternate state is applied.

**Presentation**

You can set the orientation to be **Vertical** or **Horizontal**.

You can present the distribution plot in three ways:

- **Points and background** - this option displays a bounding box showing the range of the values, and value points.
- **Points only** - this option displays value points only.
3 Visualizations

- **Background only**: this option displays a bounding box showing the range of the values only.
- **Gridline spacing**: Set this to **Custom** if you want to customize the horizontal gridlines. You can choose between: **No lines**, **Medium** or **Narrow**.
- **Bubble size**: You can adjust the size of the bubbles that illustrate the value points.
- **Jitter points**: You can use this option to jitter several overlapping value points. This moves some of the points slightly to create a larger footprint that shows that there are more than one value behind the point.

**Colors and legends**

You can set the presentation colors of the distribution plot. You only need to select **Custom** if you want to change the settings.

**Custom**: Manually select the method of coloring your values in the chart. The following methods are available:

- **Single color**: A single color (by default blue) is used for all items in the chart.
- **By dimension**: By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
  - **Persistent colors**: When selected, colors are persistent between selection states.
  - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click **fx** to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients.
  
  For more information, see Coloring a visualization (**page 534**)
  
  - **Range**: When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

- **Show legend**: Not available when **Single color** is selected. By default set to **Auto**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.

- **Legend position**: Select where to display the legend.

- **Show legend title**: When selected, the legend title is displayed.
3  Visualizations

X-axis

- `<Measure>`
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the measure axis.
  - **Scale**: Set the spacing of the measure axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Y-axis

- `<Dimension>`
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the dimension axis.

Filter pane

You can add a filter pane to control what data that is shown in the visualizations on a sheet. A filter pane can filter the data of several dimensions at once.

For example, if you have a chart of sales over time, you can use a filter pane to limit the data in the chart to only show sales from a selected time period, from certain product categories, and from a certain region.

When a dimension is added, it is placed to the right of the previous dimensions, or below, depending on the available space. As long as there is space enough, the dimensions are displayed as expanded lists. If there is not enough space, the dimensions that were added first are turned into filter panes.

*Selections have been made in the dimensions Year, Quarter, and Week.*

![Image of filter pane with Year, Quarter, Month, and Week dimensions]

**When to use it**

With filter panes, you can easily make several selections to define your data set exactly like you want it. With your well-defined data set, you can explore data of particular interest.
By using the selection menu options in the filter panes (select possible, select alternative, and select excluded), you can make adjustments to the data set and compare the results with the previous selection.

Advantages
Filter panes are good for making selections and defining data sets. But they also show the relationship between different values, the associations. The green, white, and gray colors reflect the data associations that exist - and that do not exist. And by analyzing those associations, you can make new discoveries, for example, that a sales representative has too many customers, or that a region lacks a sales representative.

Disadvantages
When the dimensions contain a very large amount of values, it may be hard to manage the data.

Creating a filter pane
You can create a filter pane on the sheet you are editing.

In a filter pane you can use up to 1000 dimensions.

Do the following:

1. From the assets panel, drag an empty filter pane to the sheet.
2. Click Add dimension and select a dimension or a field.
3. If you want to add more dimensions, click Add dimension again.

When you have created the filter pane, you may want to adjust its appearance and other settings in the properties panel.

If you double-click or drag a field or a dimension from the assets panel, a filter pane is added to the sheet using the dimension. If you then double-click more dimensions, they are automatically added to the new filter pane.

Showing the frequency of values
You can show the frequency next to each value, either as an absolute number or as a percentage. You select this with Show frequency under each dimension.

In some cases the frequency cannot be calculated and is displayed as -. One example of this is for key fields.

Selections in filter panes
During analysis you click a compressed filter pane dimension to open a selection list.

When you make a selection, it is reflected in the small bars at the bottom of each filter pane dimension. Four states can be displayed in the bars: selected (green), possible (white), alternative (light gray), and excluded (dark gray). Locked values are indicated by a lock icon. The details of the selections are displayed in the selections bar, above the sheet. You can click an item to see the details and change your selection.
Fields are filtered out from each dimension to be shown in the visualizations on the sheet.

Making selections in filter pane lists
When there is space enough in a filter pane, the dimension values are displayed in a list. In lists, you can click to select a single value or draw to select several values. On a touch device, you can two-finger-tap in the list to select a range of values.

Germany, Japan and Nordic selected in the Region filter pane.

The selections tool
The selections tool offers an option to get an overview of the fields and dimensions in an app. In the selections tool you can make selections in all the fields and dimensions in the app, regardless of whether they are used in the app or not.

During analysis, click **Selections** to open selections view.
Display limitations

Responsive design
The filter pane has a responsive design and renders as many dimensions as possible. When space is limited, this could involve reducing the size of each dimension so that all dimensions are displayed.

Example:
The following image shows a filter pane while it is being edited. Only three out of five dimensions are displayed. The other dimensions are replaced by a button with an ellipsis (...), indicating that there are more dimensions that are not displayed. You can click the button to open the filter pane in full screen view.

When you have finished editing the filter pane and enter analysis mode, you will see the filter pane with all the dimensions displayed. If all items cannot be shown due to lack of space, the ellipsis box is displayed to indicate that there are more dimensions.

*Five dimensions are displayed when analyzing data.*
3  Visualizations

Full screen view
In full screen view, the filter pane is maximized and displays as many dimensions as possible expanded. When not all dimensions can be displayed expanded, the priority order is that the most recently added dimensions are expanded to the right. You can change the priority order in the properties panel, under Dimensions. Drag the dimensions to change the order.

Filter pane properties

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

If the visualization has a flag in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Data
Click Add to add a dimension or create a dimension from a field. If the option is dimmed it is not available.

Dimensions
You can also click to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

=If(Week < 14, Week, 'Sales')

If Add is dimmed, you cannot add more dimensions.

The following properties are available for dimensions:

- **<Dimension name>:** Click the dimension name to open the dimension settings. If you want to delete the dimension, right-click the dimension and select in the dialog. Alternatively, click the dimension and click.
  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click to open the expression editor.
  - **Title:** Enter a title for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
- **Master item:** You can create a master dimension based on the dimension expression by clicking Create new.
3 Visualizations

- **Show frequency**: You can show the frequency of each value. You can show it as an absolute number with Frequency count or a percentage with Relative frequency (%).

- **Text alignment**: When set to Custom, you can select how to display the content: Align left, Align center, or Align right. If Text alignment is set to Auto, the alignment is automatically aligned left or right, depending on the content.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (買い物) to rearrange the order.

**Sorting**

By default, the dimensions are sorted in the order they were added, with the most recently added dimension last. For filter panes, you change the sorting order of the dimensions under Dimensions in the Data section. Drag the dimensions to change the order. Under Sorting you can change the internal sorting of the dimensions.

Each dimension is sorted internally in the most common way for that type of data. Numbers are sorted numerically, ascending. Text is sorted alphabetically, ascending. If you want to change the internal sorting of a dimension, click the sorting button. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- **Sort by state**: Sorts by selected, possible, and excluded selection states.
- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort by frequency**: Only available for filter panes.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Appearance**

**General**

- **Show titles**: On by default in all visualizations except filter panes, KPIs, and text & image visualizations. Enter Title, Subtitle, and Footnote. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click $\text{f}$ if you want to create an expression by using the expression editor.

*Titles are displayed on a single line. If you inject line breaks they will be ignored.*
Example:

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- **<inherited>**, in which case the state defined for the sheet is used.
- **<default state>**, which represents the state where no alternate state is applied.

Gauge

The gauge shows a single measure value and visualizes how to interpret that value.

![Gauge visualization](image)

**When to use it**

The gauge is often used to present KPIs, for example, on an executive dashboard, and together with segmenting and color coding, it is an effective way of illustrating a performance result.

It is important to set relevant max and min values to support the interpretation of the value. You can use a reference line to provide additional context.

**Advantages**

A gauge is easy to read and understand and gives an instant indication of the performance within an area.
Disadvantages
The gauge is quite space-demanding in relation to the single value it visualizes.

Although visually compelling, the gauge is not always the best choice for presenting a single measure value. Problems when deciding the max and min values can indicate that some other visualization should be used.

If you only want to show a performance value, without a gauge, consider using a KPI instead.

Creating a gauge
You can create a gauge on the sheet you are editing. In a gauge you can only have one measure and no dimensions.

Do the following:

1. From the assets panel, drag an empty gauge to the sheet.
2. Click Add measure and select a measure or create a measure from a field.

When you have created the gauge, you may want to adjust its appearance and other settings in the properties panel.

The following settings are used by default in a gauge:

- A radial gauge.
- A single (blue) color.
- Range limits: min (0), max (100).
- No segments.
- Label and title are displayed in medium scale.

For example, you can change the radial gauge to a bar, and use a color gradient.

Display limitations
When a measure value is outside the range limits, an arrow indicates whether the measure value is higher or lower than the range values.

Gauge properties
You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.
If the properties panel is hidden, click ☑ Show properties in the lower right-hand corner.

If the visualization has 🔍 in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Measures
On the Data tab, under Measures, click Add measure to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click 📉 to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add measure is dimmed, you cannot add more measures.

The following properties are available for measures:

- `<Measure name>`:
  - Measure: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - Expression: Click 📉 to open the expression editor. The existing expression is displayed by default.
  - Label: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - Number formatting: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- Auto: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- Number: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom
formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `# ###0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money:** By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration:** By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom:** By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator:** Set the decimal separator.
  - **Thousands separator:** Set the thousands separator.
  - **Format pattern:** Set the number format pattern.
  - **Reset pattern:** Click to reset to default pattern.

- **Measure expression:** The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  - Only works with visualizations that accept measures.
  - Does not affect the number formatting of the axis.

- **Master item:** You can create a master measure based on the measure expression by clicking **Create new**.

**Add-ons**

- **Data handling: Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines:** Add reference line: Click to add a new reference line.
  - **Show:** When selected, the reference line is displayed.
  - **Label:** Enter a label for the reference line.
  - **Color:** In the color picker, select the color of the reference line and the label.
  - **Reference line expression:** Enter a value or an expression for the reference line. Click \( \text{fx} \) to open the expression editor.
  - \( \text{\textcolor{red}{ delete}} \): Click to remove the reference line.

**Appearance**

**General**

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart.
  Enter Title, Subtitle, and Footnote. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click \( \text{fx} \) if you want to create an expression by using the expression editor.

  > **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Disable hover menu:** Select to disable the hover menu in the visualization.

- **Show details:** Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

- **State:** Set the state to apply to the visualization. You can select:
  - Any alternate state defined in Master items.
  - <inherited>, in which case the state defined for the sheet is used.
  - <default state>, which represents the state where no alternate state is applied.
3 Visualizations

**Presentation**

- **Range limits**
  - **Min**: Set the minimum value for the gauge. Click $\text{fx}$ if you want to create an expression.
  - **Max**: Set the maximum value for the gauge. Click $\text{fx}$ if you want to create an expression.
  - **Radial/Bar**: Select to display the gauge as a radial or as a bar.
  - **Select vertical or horizontal orientation of the visualization. Only available for bar gauges.**
  - **Use segments**: When not selected, a single color (by default blue) is used to illustrate the value. When selected, you can divide the gauge into segments with different colors. When segments are used, a pointer marks the value.
    - Click **Add limit** to add a segment to the gauge. Use the slider or type an expression to set the limit. Click $\text{fx}$ to create an expression. You can add several segments. Click the segment to change colors.
  - **Remove limit**: Click to remove the selected limit.
  - **Gradient**: Select to use different shades of colors in the transition between the segments.
  - **Use library**: Option when a master measure used in the visualization has a color assigned to it. You can select to use the master measure colors or to disable the master measure color.
    - This option is not available if **Use segments** is enabled.

**Measure axis**

- **Labels and title**: Select what to display of labels and title.
- **Scale**: Set the spacing of the measure axis scale.

**Histogram**

The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or a certain time period. The data is divided into bins, and each bar in a histogram represents the tabulated frequency at each bin.
When to use it

The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or a certain time period.

Advantages

The histogram organizes large amounts of data, and produces a visualization quickly, using a single dimension.

Disadvantages

The histogram is not relevant for detailed analysis of the data as it deals with a summary of the data distribution.

Creating a histogram

You can create a histogram on the sheet you are editing. You can only apply a single dimension to a histogram. Histograms do not need a measure, as the frequency of the binned data is automatically calculated.

Do the following:

1. From the assets panel, drag an empty histogram to the sheet.
2. Add the dimension to calculate the frequency on.

When you have created the histogram, you may want to adjust its appearance and other settings in the properties panel.

Dimension limitations

There are some limitations to the dimension used in a histogram.
The dimension must be a numerical field.
- You cannot use a master dimension that was created using the expression editor, even if the resulting field is numeric.
- The dimension cannot be based on an aggregation function.

Viewing the distribution of data over intervals with a histogram
This example shows how to make a histogram to the distribution of data over intervals, using weather data.

![Histogram Example](image)

**Dataset**
In this example, we'll use the following weather data.
- Location: Sweden > Gällivare Airport
- Date range: all data from 2010 to 2017
- Measurement: Average of the 24 hourly temperature observations in degrees Celsius

The dataset that is loaded contains a daily average temperature measurement from a weather station in the north of Sweden during the time period of 2010 to 2017.

**Visualization**
We add a histogram to the sheet and add the field *Average of the 24 hourly temperature observations in degrees Celsius* as dimension.

The visualization creates a frequency measure automatically, and sorts the temperature measurements into a number of bars according to frequency distribution.

We can adjust the size of the bars to get even intervals, by setting **Bars** to **Custom** and **Bar width (x-axis)** with a width of 5. This adjusts the bars to be intervals of 5 degrees Celsius as shown below:
Discovery

The histogram visualizes the frequency distribution of the temperature measurements. You can hover the mouse over a bar to see more details of the frequency.

We can see that most days, the temperature is between -5 and 15 degrees Celsius. There are days below -30, but they are not many.

Histogram properties

You open the properties panel for a visualization by clicking 

If the properties panel is hidden, click 

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click Add to add a field.
3 Visualizations

Fields

On the **Data** tab, under **Fields**, click **Add** to open a list of available **Fields**. Select the field that you want to use.

You can also click \( \mathcal{F} \) to create a field in the expression editor. Another way to create a field is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated field:

\[ =\text{If (Week < 14, Week, 'Sales') \}

If **Add** is dimmed, you cannot add more fields.

- **<Field name>**
  Field: Click the field name to open the field settings.
  If you want to delete the field, long-touch/right-click the field and select \( \mathcal{H} \) in the dialog. Alternatively, click the field and click \( \mathcal{B} \).

- **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click \( \mathcal{F} \) to open the expression editor.

- **Label**: Enter a label for the field.

- **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).

- **Master item**: You can create a master dimension based on the field expression by clicking **Create new**.

- **Add alternative**: Alternative fields are fields that are added to a visualization, but are not displayed until a user chooses to switch which fields are being displayed during visual exploration.

Histogram settings

- **Bars**: You can set **Bars** to **Auto** or **Custom**.
  - **Auto** divides the data into the optimal number of bars based on the current data selection. You do not need to make any other settings. The calculation is based on Sturje's formula.
  - **Custom** lets you define how to divide the data into bars.

- **Number of bars**: Set **Maximum number** to the number of bars you want to divide the data into.

- **Bar width (x-axis)**: Set **Width** to define how wide each bar is. This is based on the values on the x-axis.
  You can offset the bars by changing the **Offset** setting.

Example:

If you set **Width** to 2 and keep the default **Offset** setting 0, your bars may be defined 0 to 2, 2 to 4, 4 to 6, and so on. If you change **Offset** to 1, the bars are defined -1 to 1, 1 to 3, 3 to 5, and so on.

- **Count distinct values only**: Select this to exclude duplicate values.
Add-ons

- **Data handling: Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.

  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines: Add reference line**: Click to add a new reference line.
  - **Show**: When selected, the reference line is displayed.
  - **Label**: Enter a label for the reference line.
  - **Color**: In the color picker, select the color of the reference line and the label.
  - **Reference line expression**: Enter a value or an expression for the reference line. Click $fx$ to open the expression editor.
  - : Click to remove the reference line.

Appearance

General

- **Show titles**: On by default in all visualizations except filter panes, KPIs, and text & image visualizations.

  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click $fx$ if you want to create an expression by using the expression editor.

  **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

  **Example:**

  Assume that the following string is used, including quotation marks: ‘Sales: ‘ & Sum(Sales).

  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ‘ & Sum(Sales)), the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
• **Show details**: Set to *Show* if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

• **State**: Set the state to apply to the visualization. You can select:
  
  - Any alternate state defined in *Master items*.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

**Presentation**

**Gridline spacing**: Set this to *Custom* if you want to customize the horizontal gridlines. You can choose between: *No lines*, *Medium*, or *Narrow*.

**Value labels**: By default, *Off*. With the *Auto* setting, the value labels are displayed when there is enough space.

• **Colors**: You can only set the bar color of the histogram.

• **Y-axis: Frequency** When set to *Auto*, the label is displayed if there is enough space.
  
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the frequency axis.
  - **Scale**: Set the spacing of the frequency axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.
  - **Label**: Set the label for the frequency axis.

• **X-axis: <Field>**:
  
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the field axis.

**KPI**

The KPI visualization can show one or two measure values, and is used to track performance.

*A KPI visualization with two measure values, using conditional colors and symbols.*
When to use it
Use KPIs to get an overview of performance values that are central to an organization. Use color coding and symbols to indicate how the figures relate to the expected results.

Advantages
KPIs give a quick understanding of the performance within an area.

Disadvantages
The KPI is somewhat limited when it comes to graphical components. You can use symbols to help illustrate the performance, but if you want a more conspicuous component, consider using a gauge.

Creating a KPI
You can create a KPI visualization on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty KPI chart to the sheet.
2. Click Add measure and select a measure or create a measure from a field.

In a KPI visualization, you can have one or two measures and no dimensions. With two measures, the second value automatically becomes a complementary value and is shown with a smaller font size. You can easily switch their order by dragging the measures in the properties panel under Measures.

When you have created the KPI visualization, you may want to adjust its appearance and other settings in the properties panel.

The following settings are used by default in a KPI visualization:

- Centered alignment.
- Black text color.
- Responsive layout behavior.
- Medium font size.
- No titles.
- Measure label displayed.
- Conditional colors and symbols are turned off.
- No link to sheet.

If you double-click or drag a measure from the assets panel, a KPI visualization is added on the sheet using the measure.

Using conditional colors and symbols
When you use conditional colors for your KPI visualization, you have the option to use symbols to be displayed next to your measure value. Additionally, you can use the following options:
3 Visualizations

- Set range limits.
- Add limits to create subsections with different colors to indicate performance, for example, good (green), below expectations (yellow), or critical (red).
- Add symbols to the values.
- Use gradient coloring between color sections.

You can use expressions to set the limits. All these settings are done in the properties panel that is displayed on the right-hand side of the window when editing a sheet.

Linking to another sheet

You can link from the KPI visualization to a sheet in the app. When making data analysis and clicking the visualization, you can click a second time to go to a predefined sheet. The sheet is opened in a new tab.

When hovering over a, the name of the sheet is displayed. The icon is only displayed when Show title is selected, under Presentation.

KPI properties

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click Add to add a measure.

Measures

On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure. Pie charts require a measure for Angle, but optionally a measure can be added for Radius, which determines the radius of each slice of the pie chart.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.
If **Add measure** is dimmed, you cannot add more measures.

The following properties are available for measures:

- **<Measure name>**:
  - **Expression**: Click \text{\textbackslash{}fix} to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- **# ###0** describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- **###0** describes the number as an integer without a thousands separator.
- **0000** describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- **0.000** describes the number with three decimals. In this example ". " is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
3 Visualizations

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
- **Master item**: You can create a master measure based on the measure expression by clicking Create new.

**Add-ons**

- **Data handling: Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in Displayed message is displayed.
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

**Appearance**

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign `=` at the beginning of a string shows that it contains an expression.
  Click ![ ] if you want to create an expression by using the expression editor.

> **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

**Example:**

Assume that the following string is used, including quotation marks: `"Sales: ' & Sum(Sales)`.
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: `="Sales: ' & Sum(Sales)`), the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in *Master items*.
- `<inherited>`, in which case the state defined for the sheet is used.
- `<default state>`, which represents the state where no alternate state is applied.

Presentation

- **Show title**: *On* by default. When selected, the measure title is displayed above the KPI value.
- **Alignment**: Set the alignment of the KPI value and the title.
- **Layout behavior**: Sets the layout mode for the font. Options are: *Fixed* in which the font size is independent of the box size and the length of the text, *Fluid* in which the font size adapts to the size of the box, and *Responsive* in which the font size adapts to the size of the box and the length of text.
- **Font size**: Set the relative font size of the measure value. When the chart is resized, the font size might adjust to fit the chart depending on the setting of *Layout behavior*.
- **Link to sheet**: *Off* by default. When turned *On*, you can link from the KPI to any sheet in the app. Select the sheet in the list. You can also select if the linked sheet opens in a new tab.

Colors

- **Conditional colors**: When used, you can add range limits and use different colors and symbols for the different sections.
- **Add limit**: Use the slider to set the limit. You can add several sections. Click the section to change color.
  You can use an expression as a limit. Click \( f \) if you want to create an expression.
- **Gradient**: Select to use different shades of colors in the transition between the sections.
- **Remove limit**: Click to remove the selected limit. If no limit is selected, the most recently added limit is removed.

Line chart

The line chart is used to show trends over time. The dimension is always on the x-axis, and the measures are always on the y-axis.
Your data set must consist of at least two data points to draw a line. A data set with a single value is displayed as a point.

If you have a data set where data is missing for a certain month, you have the following options for showing the missing values:

- As gaps
- As connections
- As zeros

When a month is not present at all in the data source, it is also excluded from the presentation.

You can accumulate values of a measure over one or two dimensions:
When to use it
The line chart is primarily suitable when you want to visualize trends and movements over time, where the dimension values are evenly spaced, such as months, quarters, or fiscal years.

Advantages
The line chart is easy to understand and gives an instant perception of trends.

Disadvantages
Using more than a few lines in a line chart makes the line chart cluttered and hard to interpret. For this reason, avoid using more than two or three measures.

Creating a line chart
You can create a line chart on the sheet you are editing.

Do the following:
1. From the assets panel, drag an empty line chart to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

When you have created the line chart, you may want to adjust its appearance and other settings in the properties panel.

In a line chart you need at least one dimension and one measure.

You can include up to two dimensions and one measure, or one dimension and up to 15 measures in a line chart.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>1 measure</td>
<td>A simple line chart with a single line.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>1 measure</td>
<td>A line chart with the first dimension on the X-axis, and a line for each value of the second dimension.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>up to 15 measures</td>
<td>A line chart with one line for each measure.</td>
</tr>
</tbody>
</table>

Display limitations
Displaying large numbers of dimension values
When the number of dimension values exceeds the width of the visualization, a mini chart with a scroll bar is displayed. You can scroll by using the scroll bar in the mini chart, or, depending on your device, by using the scroll wheel or by swiping with two fingers. When a large number of values are used, the mini chart no longer displays all the values. Instead, a condensed version of the mini chart (with the items in gray) displays an overview of the values, but the very low and the very high values are still visible.
Displaying out of range values
In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a limit, the range is automatically set to include the highest positive and lowest negative value, but if you set a limit you may have values that exceed that limit. When a data point value cannot be displayed, due to the range limits, an arrow indicates the direction of the value.

When a reference line is out of range, an arrow is displayed together with the number of reference lines that are out of range.

Displaying large amounts of data in a line chart
When displaying large amounts of data in a line chart, the message "Currently showing a limited data set." is shown to indicate that not all data is displayed.

- If the chart uses a continuous scale, 2000 data points are displayed.
- If the chart uses a non-continuous scale, the number of data points displayed is in the range of 2500 to 5000. The limit depends on if the chart has one or two dimensions, and if coloring is used.

Above that number, data points are neither displayed, nor included in selections made in the line chart.

Additionally, only twelve dimension values are displayed for the second dimension in a chart with two dimensions and continuous scale.

To avoid displaying limited data sets, you can either make a selection or use dimension limits in the properties panel.

Line chart properties
You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.
If the visualization has \(\phi\) in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.

Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click \(\mathbf{fx}\) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

\[=\text{If} (\text{Week} < 14, \text{Week}, \text{‘Sales’})\]

If Add is dimmed, you cannot add more dimensions.

- \(<\text{Dimension name}\>\): Click the dimension name to open the dimension settings.
  If you want to delete the dimension, right-click the dimension and select \(\text{□}\) in the dialog. Alternatively, click the dimension and click \(\mathbf{fx}\).
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click \(\mathbf{fx}\) to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values.
      You can also use an expression to set the number. Click \(\mathbf{fx}\) to open the expression.
editor.

- **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.

- **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.

- **Calculated on measure**: $<\text{measure}>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.

- **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\mathbf{fx}$ to open the expression editor.

- **Master item**: You can create a master dimension based on the dimension expression by clicking Create new.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (↔) to rearrange the order.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.

**Measures**

- **<Measure name>**: Click the measure to open the measure settings.
  If you want to delete the measure, long-touch/right-click the measure and select Trash in the dialog.
  Alternatively, click the measure and click Trash.

  - **Expression**: Click $\mathbf{fx}$ to open the expression editor. The existing expression is displayed by default.

  - **Modifier**: Selects a modifier for the measure. Options are None, Accumulation, Moving average, Difference, and Relative numbers.

  - **Accumulation**: Only displayed when Accumulation has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions.
    The following options are available:
    - **Dimension**: Selects the dimension on which the accumulation will take place. If the accumulation is made across multiple dimensions, this will be the first dimension.
• **Across all dimensions**: Continues accumulation across all available dimensions.

• **Range**: Select whether the accumulation will happen on the **Full** range, or a **Custom** range of the dimension.

• **Steps**: Only displayed when **Range** is set to **Custom**. The number of steps in the dimension which form an accumulation range. Only zero and positive integers are accepted.

• **Show excluded values**: Include excluded values in the accumulation.

• **Output expression**: Shows the expression used by the modifier.

• **Moving average**: Only displayed when **Moving average** has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions.

  The following options are available:

  • **Dimension**: Selects the dimension on which the moving average will take place. If the moving average is made across multiple dimensions, this will be the first dimension.

  • **Across all dimensions**: Continues moving average across all available dimensions.

  • **Range**: Select whether the moving average will happen on the **Full** range, or a **Custom** range of the dimension.

  • **Steps**: Only displayed when **Range** is set to **Custom**. The number of steps in the dimension which form a moving average range. Only zero and positive integers are accepted.

  • **Show excluded values**: Include excluded values in the moving average.

  • **Output expression**: Shows the expression used by the modifier.

• **Difference**: Only displayed when **Difference** has been selected as a modifier. It allows you to calculate the difference between consecutive values of a measure over one or two dimensions.

  The following options are available:

  • **Dimension**: Selects the dimension on which the difference will take place. If the difference is made across multiple dimensions, this will be the first dimension.

  • **Across all dimensions**: Continues difference across all available dimensions.

  • **Show excluded values**: Include excluded values in the difference.

  • **Output expression**: Shows the expression used by the modifier.

• **Relative numbers**: Only displayed when **Relative numbers** has been selected as a modifier. It allows you to calculate percentages relative to a specific selection, relative to the total, or relative to a field value. The modifier can be calculated over one or two dimensions.

  The following options are available:
• **Selection scope**: Sets whether the relative numbers are calculated based on the current selection or a specific field value. You can also disregard the current selection.

• **Dimensional scope**: Sets whether the relative numbers are calculated based on a dimension. You can choose to have the modifier respect all available dimensions, respect a specific dimension if there are two, or to disregard the dimensions.

• **Output expression**: Shows the expression used by the modifier.

• **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.

• **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

• **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

• **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

• **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

• # ###0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.

• ###0 describes the number as an integer without a thousands separator.

• 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.

• 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

• **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

• **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

• **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days,
3 Visualizations

hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

Limitations:
- Only works with visualizations that accept measures.
- Cannot be used with a box plot.
- Does not affect the number formatting of the axis.

- **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.

- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples:**

- #0 describes the number as an integer. In this example "0" is used as a thousands separator.
- 0000 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example ".0" is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.

- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.
• **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

• **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

• **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

  Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

• **Add trend line**: Trend lines are lines used to show trends over time.

  • **Label**: Enter a label for the trend line. Click **fx** to open the expression editor.

  • **Type**: Set the type of the trend line. The following types are available:
    - Average
    - Linear
    - Second degree polynomial
    - Third degree polynomial
    - Fourth degree polynomial
    - Exponential
    - Logarithmic
    - Power

  • **Colors**: Set to **Custom** to change the color of the trend line.

  • **Dashed**: Choose between dashed or continuous line style.

  • **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.

  • **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Dimensions and measures can also be sorted internally:
Click the dimension or measure name to open the settings and click the sorting button to switch to Custom sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Add-ons**

- **Data handling**:
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  - A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines**: **Add reference line**: Click to add a new reference line.
  - **Show condition**: Sets a condition that needs to be fulfilled for the reference line to appear. Click \( \text{fx} \) to open the expression editor.
  - **Label**: Enter a label for the reference line.
  - **Show label**: Select to show the reference line label.
  - **Color**: In the color picker, select the color of the reference line and the label.
  - **Reference line expression**: Enter a value or an expression for the reference line. Click \( \text{fx} \) to open the expression editor.
  - **Show value**: Select to show the value of the reference line.
  - **Line type**: You can choose between solid and dashed line types.
  - **Colored background**: Adds the selected color as a background around the label text.
  - **\( \text{} \)**: Click to remove the reference line.

- **Dimension reference lines**: **Add reference line**: Click to add a new dimensional reference line.
  - **Show condition**: Sets a condition that needs to be fulfilled for the dimensional reference line to appear. Click \( \text{fx} \) to open the expression editor.
  - **Label**: Enter a label for the dimensional reference line.
• **Show label**: Select to show the dimensional reference line label.
• **Color**: In the color picker, select the color of the dimensional reference line and the label.
• **Reference line expression**: Enter a value or an expression for the dimensional reference line. Click $\mathcal{fx}$ to open the expression editor.
• **Show value**: Select to show the value of the dimensional reference line.
• **Line type**: You can choose between solid and dashed line types.
• **Colored background**: Adds the selected color as a background around the label text.
• **Uncheck**: Click to remove the dimensional reference line.

**Appearance**

**General**

• **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click $\mathcal{fx}$ if you want to create an expression by using the expression editor.

> **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

• **Disable hover menu**: Select to disable the hover menu in the visualization.
• **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

• **State**: Set the state to apply to the visualization. You can select:
  • Any alternate state defined in **Master items**.
  • `<inherited>`, in which case the state defined for the sheet is used.
  • `<default state>`, which represents the state where no alternate state is applied.

**Presentation**

• **Styling**: Change the styling of the lines. The following options are available:
  • **Data point size**: Adjust the slider to set the size of data points.
  • **Line thickness**: Adjust the slider to set the thickness of the lines.
- **Line type**: Set the line as Dashed or Solid.
- **Line curve**: Set the curvature of the line as Linear or Monotone.

- **Line/Area**: Select to display the chart as a line or as an area.

- **Vertical/Horizontal**: Select a vertical or horizontal orientation for the chart.

- **Scrollbar**: Set the type of scrollbar to display. There are three settings:
  - **Mini chart**: Show a miniature of the chart.
  - **Bar**: Show a regular scrollbar.
  - **None**: There is no scrollbar, but you can still scroll in the visualization.

- **Scroll alignment**: Set the position of the chart scrollbar. By default the scroll alignment is set to Start.

- **Stacked area**: When selected, the different areas are displayed on top of each other. Only available with Area style.

- **Stack positive and negative values separately**: Only available with Area style.

- **Missing values**
  Set how to show missing values.
  - **Show as gaps**: The line has a gap, which represents the missing value.
  - **Show as connections**: The line connects the values that exist on either side of the missing value. If the missing value is first or last, no line is drawn.
  - **Show as zeros**: The line is drawn to zero and from there to the next existing value. If the missing value is first or last, no line is drawn.

- **Show data points**: When selected, the data points are displayed. **Value labels**: By default, Off. With the Auto setting, the value labels are displayed when there is enough space.

- **Grid line spacing**: Select the spacing of the grid lines. The Auto setting is Medium.

**Colors and legends**

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.

    - **Multicolored**: Option when more than one measure is used.
      By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values.

      - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to
use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.

- **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
  
  - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
  
  - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
  
  - **Persistent colors**: Select to have colors remain the same between selection states.
  
  - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By measure**:
  
  - **Select measure**: Select the measure to use to color your chart.
  
  - **Library colors**: Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has assigned colors.
  
  - **Label**: Enter text or an expression for the measure that displays in the legend.
  
  - **Number formatting**: You can set the format of the field or expression values

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
    
    To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  
  - **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- # ##0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.

- ###0 describes the number as an integer without a thousands separator.
• 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
• 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

• **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

• **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

• **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

• **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  • **Decimal separator**: Set the decimal separator.
  • **Thousands separator**: Set the thousands separator.
  • **Format pattern**: Set the number format pattern.
  • **Reset pattern**: Click to reset to default pattern.

• **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

• **Color scheme**: Select a color scheme from the following options:
  • **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
  • **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
  • **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
  • **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
  • **Reverse colors**: When selected, the color scheme is reversed.
3 Visualizations

- **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the **Min** and **Max** values for the color range.
- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click ⚙️ to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see *Coloring a visualization (page 534)*. When the coloring is by measure or by expression, you can set the color range (**Min** and **Max** values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
- **Show legend**: Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.
- **Legend position**: Select where to display the legend.
- **Show legend title**: When selected, the legend title is displayed.

**X-axis / Y-axis**

The properties for x-axis and y-axis depend whether or not the axis is displaying a dimension or measure.

- **<Dimension>**
  - **Continuous**: Set to **Custom** to be able to show a continuous axis by selecting **Use continuous scale**. **Use continuous scale** is only available for dimensions with numeric values. You cannot change sorting when you use a continuous scale.
  - **Labels and title**: Select what to display of labels and title.
  - **Label orientation**: Select how to display the labels.
  - **Position**: Select where to display the dimension axis.
  - **Number of axis values**: Set the maximum number of values on the axis.

- **<Measure>**
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the measure axis.
  - **Scale**: Set the spacing of the measure axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.
3 Visualizations

- **Logarithmic**: When selected, a logarithmic scale is used for the measure values. To be able to use a logarithmic scale, the values must be all positive or all negative.

**Tooltip**
- **Tooltip**: Set to Custom to add measures and images as tooltips.
- **Hide basic rows**: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, Hide basic rows will also hide dimension values as well.
- **Title**: Enter a title for the tooltip.
- **Description**: Enter a description for the tooltip.
- **Measures**
  - **Add measure**: Add a measure to be shown as a tooltip. You can add a measure from a field using From a field. You can also use an expression to add a measure. Click $\text{Formula}$ to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using Label as well as its formatting using **Number formatting**.
- **Images**
  - **Type**: Choose whether to add an image from your Media library or from a URL.
  - **Size**: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - **Small**: Set the width and height of the container to 50 pixels.
    - **Medium**: Set the width and height of the container to 200 pixels.
    - **Large**: Set the width and height of the container to 340 pixels.
    - **Original**: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
  - **Media library**: Appears when you choose Media library for Type. Click to select an image from your media library.
  - **URL**: Appears when you choose URL for Type. Enter a URL.

**Maps**
Maps enable you to view your data geographically.

Maps have many ways to present your data. You can add multiple layers to your map to display different types of information on the same map. You can set a custom scope for locations so that if two locations have the same name, you display the locations and their data correctly. You can use drill-down dimensions to create a hierarchy of geographic areas for selection. You can limit the pan of a map to a specific view and scope of the map, such as a region of interest, out of which users cannot pan or zoom out. You can add custom base maps to your map and use non-WGS-84 coordinates.

*Map with density layer displaying number of global volcanic eruptions.*
When to use maps

You can use a map to show the geographical distribution of offices, stores, and other sites of business interest. You can visualize not only locations but also sales values and other measures and display the value differences by bubble size or color.

Advantages

The map is a versatile visualization that efficiently presents the geographical distribution of key values related to location or area.

Disadvantages

With a large number of values, it may be hard to get a good overview. Values may be placed on top of each other and not visible until zoomed in.

Base map

The base map provides the background for the data contained in your layers. You can select your base map in Map settings. Qlik Sense has four default base maps:

- **Default**: An OpenStreetMap-based map.
- **Pale**: A paler version of the Default map.
- **Satellite**: A satellite image map.
- **None**: No base map.

Additionally, custom base maps can be added using background layers to add your own custom base maps. For example, you could add the floor plan of an airport or office as a custom base map.

Layers

Layers contain visualized dimension and measure data that is displayed over your map. You can stack layers on top of each other. You can also control at what zoom levels different layers appear in or have layers that
appear only if other values in a drill-down dimension are selected. This enables you to create different levels of detail as you make selections and zoom in and out of areas of interest on your map. The following layers are available:

- **Point layer**: A point layer overlays individual locations on a map, representing them with shapes.
  \( \text{Point layers (page 239)} \)
- **Area layer**: An area layer presents areas on your map, such as countries or states. With polygon geometry loaded into a field, it can present any custom area.
  \( \text{Area layers (page 240)} \)
- **Line layer**: A line layer enables you to display lines between points on your map.
  \( \text{Line layers (page 241)} \)
- **Density layer**: A density layer enables you to visualize the density of points in an area using a color ramp.
  \( \text{Density layers (page 243)} \)
- **Chart layer**: A chart layer enables you to display small pie charts or bar charts over locations in your map.
  \( \text{Chart layers (page 244)} \)
- **Background layer**: Background layers enable you to display a custom base map for your map visualization.
  \( \text{Background layers (page 246)} \)

Layers that use drill-down dimensions can be used to create drill-down layers. Drill-down layers enable you to drill-down different hierarchical dimensions in a single layer or in multiple layers. You could, for example, switch between area and point layers as selections are made. For more information, see \( \text{Drill-down layers (page 249)} \). For an example map that uses drill-down dimensions and layers, see \( \text{Controlling visible map data with drill-down layers (page 266)} \).

**Location data for map layers**

Maps support several ways for determining locations in a layer. You can use the dimension added to the layer. You can alternatively specify fields containing location data for the layer, if the layer dimension does not contain geographic data. In the **Location** properties, you can specify additional parameters for the location field, such as adding additional fields that include country or administrative area information. For example, if you have a field containing custom area geometries and a field containing the names of the custom areas, you can set the name field as the dimension and then set the area geometry field as the location field in **Location** in the map properties.

Locations can be either geometries or names of locations such as names of countries, regions, cities, postal codes etc. Layer locations can be defined using fields that contain names and codes. Qlik Sense can identify the following types of locations:

- Continent names
- Country names
- ISO alpha 2 country codes
- ISO alpha 3 country codes
- First-order administrative area names, such as a state or province names
- Second-order administrative area names
- Third-order administrative area names
- Fourth-order administrative area names
- Postal codes or ZIP Codes
- City, village, or other populated place names
- IATA airport codes
- ICAO airport codes

**Availability of locations may vary by country. If the named location is not available, use coordinate or area data for the location.**

Qlik Sense uses map and location data obtained from recognized field leaders who use accepted methodologies and best practices in marking borders and naming countries within their mappings. Qlik Sense provides flexibility to enable users to integrate their own, separate background maps. If the standard maps do not fit, Qlik Sense offers the option to load customer provided background maps, borders, and areas.

Geometries can either be added at load time by the data preparation service or loaded from geographic sources such as KML. Point layers also support latitudes and longitudes in separate fields. For area layers, areas can be defined using geometries from a geographic data source such as KML files. Line layers support the same point data as point layers. Line layers also support strings with line geometries in GeoJSON LineString or MultiLineString formats.

If you are using a custom map in a background layer that uses non-WGS-84 coordinates, you can use a field with locations defined in the coordinate system the map uses (either degrees or meters). For more information, see *Using non-WGS-84 coordinate systems (page 239).*

**Creating maps**

You can add a map to the sheet you are editing.

You can create several map visualizations based on different point data or area data, which use the same dimension data.

**Do the following:**

1. From the assets panel, drag an empty map to the sheet.
2. From **Map settings**, select the **Base map**.
3. From **Layers** in the properties panel, add layers to your map.
   - Layers are placed above layers of the same type. You can set the order of layers by dragging layers up and down in the list. The layer at the top of your list is also overlaid on top of the other layers on your map.
   - For information on configuring layers, see:
Once the map is created, you can adjust its appearance and other settings for the map and its layers in the properties panel. For more information on settings, see Map properties (page 249).

⚠️ will appear in the top-left corner of your map if there is an issue with the added layer. Click the icon to see the error message.

Limiting location scope in map layers

By default, Qlik Sense searches a broad scope of locations for the location field when names are used. In cases where there are multiple possible matches, you may need to limit the scope of locations searched to ensure Qlik Sense displays the desired location.

Do the following:

1. From Layers in the properties panel, click Location.
2. Set Scope for location to Custom.
3. After Location type, select the type of data contained in the field or expression selected as Location field.
4. Optionally, after Country, enter a field, expression, or text indicating the country the locations in the Location field are located.
5. Optionally, after Administrative area (Level 1), enter a field, expression, or text indicating the first-level administrative area the locations in the Location field are located.
6. Optionally, after Administrative area (Level 2), enter a field, expression, or text indicating the second-level administrative area the locations in the Location field are located.

Limiting panning in your map

You can limit the panning settings in your map to keep the view in your map limited to a set area, such as a specific region of interest. When you limit the panning in a map, you lock the map to the current view. The map will not zoom out further than the current view. You cannot pan the map beyond the limits of the current view. If you zoom in, you can pan, but you are limited by the boundaries of the pan limit.

Do the following:

1. From the properties panel, click Appearance.
2. In Presentation, set Limit pan navigation to Custom.
3. Set your map to the view you want to which you want to limit the pan.

4. Click **Set pan limit**.

   You can toggle the set pan limit on and off with **Limit pan navigation**. You can clear the saved pan limit by clicking **Clear pan limit**.

**Using non-WGS-84 coordinate systems**

If you have data and a background map in a projection other than WGS-84, you should set the base map to **None**, add your background map as a background layer, and then set your projection to use undefined degrees or meters depending on the unit of length used in your base map.

When using non-WGS-84 coordinates, you must use geometries loaded into a field. Location names cannot be used.

**Do the following:**

1. From the properties panel, click **Map settings**.

2. In **Base map**, select **Empty (undefined degrees)** or **Empty (undefined meters)**.

3. Select **Background layer**.

4. After **URL**, enter the URL to a slippy map server.
   For example, `http://a.tile.opencyclemap.org/cycle/${z}/${x}/${y}.png`.

5. After **Attribution**, enter the attribution string for the map.
   For example, `<a href='http://www.opencyclemap.org/' target='_blank'>OpenCycleMap</a>`.
   `Map data &copy; <a href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a> contributors`.

6. From **Layers**, click **Add layer**.

7. Select your layer type.

8. In **Dimensions**, click **Add** and select a field containing data in your map's coordinate system.

**Point layers**

A point layer overlays individual locations on a map, representing them with shapes.

By default, point layers use circular bubbles, but you can also use several other shapes. You can also use custom images as the points in a point layer. The size of the points in your layer can be fixed or you can specify a measure or expression to set the sizes of the different points. You can highlight these differences in values further by coloring by measure.

*Map with point layer displaying cities in Atlantic Canada colored and sized by population.*
Adding a point layer

Do the following:

1. Drag and drop a field onto the map, select Add as new layer, and select Add as point layer.
2. From Layers in the properties panel, click Add layer and select Point layer. In Dimensions, click Add and select a field containing point data to use as the dimension.
3. If there are issues with the point locations, adjust the location settings in Locations in the properties panel. For more information, see Limiting location scope in map layers (page 238).

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 249).

Area layers

An area layer presents areas on your map, such as countries or states. With polygon geometry loaded into a field, it can present any custom area.

With an area layer, each dimension value corresponds to a presented area. By using colors with your area layer, you can present different measure values for the areas. In the properties panel, under Appearance > Colors and legend, switch Colors to Custom where the options By measure and By expression are available.

Map with area layer displaying Australian states and territories colored by population.
3 Visualizations

Adding an area layer

Do the following:

1. Do one of the following:
   - Drag and drop a field onto the map, select Add as new layer, and select Add as area layer.
   - From Layers in the properties panel, click Add layer and select Area layer. In Dimensions, click Add and select a field containing area data to use as the dimension.

2. If there are issues with the point locations, adjust the location settings in Locations in the properties panel.

   Limiting location scope in map layers (page 238)

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 249).

Line layers

A line layer enables you to display lines between points on your map.

For example, you can use a line layer to show aircraft flights between cities. With a line layer, you can use two fields containing point data to define the start points and end points for lines in the layer. Alternatively, you can use a field containing line geometry in either GeoJSON LineString or MultiLineString format. You can customize the width and curvature of lines in the line layer and add directional arrows to your lines.

Map with line layer displaying departing flights between airports in Europe.
Adding a line layer

Line layers display lines using either start and end points, where two fields are used to determine where lines start and end, or using line geometries in GeoJSONLineString or MultiLineString format.

If you are using a start and end point line layer, the dimension you select for your line layer should represent the fields selected as the start and end points in your Location settings. For example, if you wanted to visualize where your shipments are being sent, you could set Shipments as the dimension and then use Distribution Center Location and Shipping Destination as the start point and end point in Location.

Alternatively, you can add two dimensions to the line layer and use these as the start and end points. This is useful if you want to display lines between all locations in the first dimensions to all locations in the second dimension, which has an association to the first dimension.

Adding a line layer with start and end points

Do the following:

1. Do one of the following:
   - Drag and drop a field containing start point data onto the map, select Add as new layer, and select Add as line layer.
   - From Layers in the properties panel, click Add layer and select Line layer. In Dimensions, click Add and select a field to use as the dimension.
2. If your dimension contains start point data, add a field containing end point data. Do one of the following:
   - Drag and drop a field containing end point data onto the map, select **Use in <layer name>**, and select **Add <field name> as a second dimension**.
   - In **Data**, click **Add** and select a field containing end point data.

3. If your dimension does not contain start or end point data, in **Location**, add the fields containing the start point data and end point data as location fields.

4. If there are issues with the start and end point locations, adjust the location settings in **Location** in the properties panel.
   Line layers using start point field and end point fields each have separate location settings in **Location**.
   For more information, see **Limiting location scope in map layers** (page 238).

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see **Map properties** (page 249).

**Adding a line layer with line geometries**

Do the following:

1. Do one of the following:
   - Drag and drop a field containing line geometries onto the map, select **Add as new layer**, and select **Add as line layer**.
   - From **Layers** in the properties panel, click **Add layer** and select **Line layer**. In **Dimensions**, click **Add** and select a field to use as the dimension.

2. In **Location**, select **Line geometry** and then select a field in **Line geometry field**.
   By default, your dimension is selected as the **Line geometry field**.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see **Map properties** (page 249).

**Density layers**

A density layer enables you to visualize the density of points in an area using a color ramp.

Each point influences a circular area, with the highest influence at the center and declining towards its outer perimeter. You can specify the influence radius of the points, change its color and scale it to suit your visualization. Density layers can be used to show hotspots of activity, population densities and more.

*Map with density layer displaying number of global volcanic eruptions.*
Adding a density layer

Do the following:

1. Do one of the following:
   - Drag and drop a field containing point data onto the map, select Add as new layer, and select Add as density layer.
   - From Layers in the properties panel, click Add layer and select Density layer. In Dimensions, click Add and select a field containing point data to use as the dimension.

2. If there are issues with the point locations, adjust the location settings in Locations in the properties panel.
   For more information, see Limiting location scope in map layers (page 238).

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 249).

Chart layers

A chart layer enables you to display small pie charts or bar charts over locations in your map. It uses one dimension to identify the locations and a second dimension to create the pie or bar charts.

You can label the charts and use an expression to control their size. The info bubble displays useful information about the contents of the selected chart.

Map with chart layer displaying source of funds in European Union countries as pie charts. The size of each pie chart shows average absorption rate of funds.
3 Visualizations

Adding a chart layer

Do the following:

1. Do one of the following:
   - Drag and drop a field containing point data onto the map, select **Add as new layer**, and select **Add as chart layer**.
   - From **Layers** in the properties panel, click **Add layer** and select **Chart layer**.
2. In **Dimensions**, under **Location**, click **Add** and select a field containing point data to use as the locations on your map. Click **Add** and select a field containing data to use as the dimension on your charts.
3. In **Measures**, click **Add** and select a field containing data to use as the measure on your charts.
4. If there are issues with the point locations, adjust the location settings in **Location** in the properties panel.
   
   Limiting location scope in map layers (page 238)

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see **Map properties** (page 249).
Background layers

Background layers enable you to display a custom base map for your map visualization.

A background layer could, for example, be a map of an airport that then has a point layer with WIFI hotspot locations overlaid on it. If the custom base map format supports transparency, you can overlay it on top of another map. Qlik Sense supports the following custom maps formats as background layers:

- Slippy or tile map services (TMS)
- Web Map Service (WMS)
- Image URL (Image)

Maps services must be located on their own server. Unlike other layers, the background layer uses no dimensions or measures and only displays an external base map.

If your WMS contains areas with no data, you can set the areas with no data to be transparent. This enables the WMS background layer to be overlaid on another base map or background layer. You can also choose which WMS layers to include in the background layer.

You can insert an image as a background layer. This can be used as a custom base map. You could add an image of a floor plan and use it as a custom base map. An image background layer can also be overlaid on top of another background layer. For example, you could insert an image of a detailed local map as a background layer over top another map. Background layers support the following image types:

- .png
- .jpg
- .jpeg
- .gif

Map with background layer displaying a TMS OpenStreetMap map.
Adding a background layer
Background layer configuration varies depending on the type of background map.

Adding a TMS background layer

**Do the following:**

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Background layer**.
3. After **Format**, select **TMS**.
4. After **URL**, enter the URL to a tile or slippy map server. For example, `http://a.tile.opencyclemap.org/cycle/${z}/${x}/${y}.png`.
5. After **Attribution**, enter the attribution string for the map. For example, `<a href='http://www.opencyclemap.org/' target='_blank'>OpenCycleMap</a>`. Map data &copy; <a href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a> contributors.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 249).

Adding a WMS background layer

**Do the following:**

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Background layer**.
3. Under **Format**, select **WMS**.
4. Click **WMS setup**.
5. Under **WMS server URL**, enter the URL.
7. Click **Load WMS**.

   *If the load fails, select Via server (CORS) to try loading using the Qlik GeoAnalytics server and click Load WMS.*

8. After **CRS**, enter the coordinate reference system used by the WMS map.
9. Select **Transparent** to generate map images that are transparent where there is not data.

   *This is not supported by all WMS.*

10. Under **Image format**, select the WMS image format.
11. Under **Layers**, select the map layers that your WMS server supports.
12. Click **Save**.
13. After **Attribution**, enter the attribution string for the map.
   For example, &copy; <a href='http://www.opencyclemap.org/' target='_blank'>OpenCycleMap</a>. Map data &copy; <a href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a> contributors.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see **Map properties** (page 249).

### Adding an image background layer

Images can be used as a custom base map, such as for floor plans. When using an image background layer as a custom base map, set **Base map** in **Map settings** to **None**. Select **Undefined meters** or **Undefined degrees** as the projection. The location data for your other layers must use same coordinate system as this background layer.

- **When you add an image background layer for a smaller geographic area as a custom base map, add a layer containing data, such as a point layer, at the same time. This lets the map automatically zoom in to the position of your image background layer.**

- **The lowest unit in the scale bar is 10 meters. If this measurement is too large for your image, you can disable the scale bar in **Presentation** and then proportionally adjust up your image in the background layer to the scale you want. Scale the location data you want to use in other layers as well.**

**Do the following:**

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Background layer**.
3. Under **Format**, select **Image**.
4. After **URL**, enter the URL of the image.
5. Position your image by entering the coordinates for the top left and bottom right corners of the image. Coordinates must be in the same coordinate type as was selected in **Projection**.

- **If you are unsure of the coordinates in your image background layer, enable **Show debug info**. This will display the coordinates for the current center of your map.**

6. After **Attribution**, enter the attribution string for the image.
   For example, &copy; <a href='http://www.opencyclemap.org/' target='_blank'>OpenCycleMap</a>. Map data &copy; <a href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a> contributors.
Once the layer is added, you can adjust settings for the layer in the properties panel. For image background layers being used as custom base maps, it is recommended that you change the **Limit zoom levels** and **Limit pan navigation settings** to set the focus on your custom map. For more information on settings, see *Map properties (page 249)*.

**Drill-down layers**

When creating a map that has multiple points of data located in a wide geographical area, you can use drill-down dimensions to display your layers in a selection hierarchy.

This enables you to use different layers at different levels within your map, ensuring only the most relevant information is being displayed.

As you make selections in a drill-down layer, the dimension used for locations changes to the next dimension in the drill-down dimension. The drill-down happens across layers that use the same drill-down dimension. If you have an area and point layer that use the same drill-down dimension, you can set which layer displays with which dimension from the drill-down dimension.

> If selections cause the current drill-down dimension field to have only one possible value, the next field in the list is used instead.

Drill-down dimensions used for drill-down layers should have the fields in order of highest geographical area to smallest geographical area.

For information on creating drill-down dimensions, see *Creating a drill-down dimension (page 81)*.

**Do the following:**

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Point layer**, **Area layer**, **Line layer**, **Density layer**, or **Chart layer**.
3. Click **Dimensions**, click **Add** and select your drill-down dimension.
4. In your layer, click **Options**.
5. Click **Layer display**.
6. After **Visible drill-down levels**, select which dimensions to display in the layer.

**Map properties**

You open the properties panel for a visualization by clicking **Edit sheet** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click **Show properties** in the lower right-hand corner.
3 Visualizations

If the visualization has ☁ in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Common properties

Map settings

- **Base map**: Select the base map for the map chart. The following options are available:
  - **Default**: Use an OpenStreetMap-based map.
  - **Pale**: Use a paler version of the Default map.
  - **Satellite**: Use a satellite image map.
  - **None**: Use no map for the base map. This selection should be used if a background layer is going to be added to the map. None uses the background color from the current theme or the value defined for `mapChart.backgroundColor` in the current theme.

- **Projection**: Set the projection the map uses for locations and define what kind of coordinates the map uses. Each base map supports a set of projections. The following projections are available:
  - **Mercator**: Display the map using Mercator projection. Mercator projections requires coordinates use WGS-84. Available with Default, Pale, Satellite, and None base maps.
  - **Adaptive**: Display the map in an adaptive projection that does not exaggerate the areas close to the poles as much when zoomed out. Available with Default and Pale base maps.
  - **Undefined degrees**: Display the map using coordinates in a degree-based coordinate system. If you are using a custom base map with custom coordinates that use degrees, select this option. All settings in Location except Location field are not compatible with this projection. Available with None.
  - **Undefined meters**: Display the map using coordinates in a degree-based coordinate system. If you are using a custom base map with custom coordinates that use meters, select this option. All settings in Location except Location field are not compatible with this projection. Available with None.

- **Map language**: Set the language for labels on the map.
  - **Auto**: Use English labels (where available) when the map view is zoomed out and local language labels when zoomed in.
3 Visualizations

- **Local**: Use labels in the local language for the displayed country or region where available.
- **English**: Use English labels where available.
- **Map units**: Set the units of measure for the map. The following options are available:
  - **Metric**
  - **Imperial**
- **Selection method**: Sets how users can select multiple values on the map while holding down the Shift key:
  - **None**: Disable multiselect in the map using the Shift key and clicking and dragging the cursor.
  - **Circle with distance**: Select by dragging from a center point and out in a circle. The circle measures and presents the radius of the circle.
  - **Lasso**: Select by drawing the perimeter of an area.
- **Auto-zoom**: Set whether the map zooms to a selected locations when the selection changes.
- **Set default view**: Set the current view of the map as the default view of the map when the app is opened.

**Appearance**

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the map.
  
Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

Click $\text{fx}$ if you want to create an expression by using the expression editor.

```
Titles are displayed on a single line. If you inject line breaks they will be ignored.
```

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where **<value of expression>** is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.

**Alternate states**

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- **<inherited>**, in which case the state defined for the sheet is used.
- **<default state>**, which represents the state where no alternate state is applied.
Legend

- **Show legend**: Show or hide the legend for all layers.
- **Legend position**: Set the position of the legend relative to the map.

Presentation

- **Navigation**: Show navigation controls on top of map with buttons for panning, zooming, and returning to original position.
- **Location finder**: Show the location button on the map. The location button adds a pin to the map with the user's location when clicked. The user must choose to allow location sharing.
  - Location finder is not supported with:
    - Downloading visualizations
    - Storytelling.
- **Scale bar**: Select to show a scale bar for your map.
- **Limit zoom levels**: Set the zoom limits in the map.
  - If set to No, the map can be zoomed in and out to the predefined limits in the base map.
  - If set to Custom, the slider can be used to set limits:
    - Set the zoom out limit by adjusting the left side of the slider.
    - Set the zoom in limit by adjusting the right side of the slider.
- **Limit pan navigation**: Set limits on the vertical and horizontal movement of the map view, as well as limiting the zoom of the map.
  - If set to No, there are no pan limits.
  - If set to Custom, you set the pan limit to the current view of the map by clicking **Set pan limit**. When a pan limit is set, users cannot move the map view outside the bounds of the current view or zoom out past the current zoom level.
- **Debug info**: Display resolution, scale, zoom level, and coordinates for the center of the displayed area.

Layer properties

**Data (Point layer, area layer, line layer, and density layer)**

- **Dimensions**
  - **Field**: The field or expression selected as the dimension for the layer. The dimension usually defines the locations on the layer, although you can change the field that defines locations in the **Location** properties settings.
  - **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Include null values**: Select to include null values in the map. By default, this is selected.

**Data (Chart layer)**

- **Dimensions**
  - **Field**: The field or expression selected as the dimension for the layer. The first dimension usually defines the locations on the layer, although you can change the field that defines locations in the **Location** properties settings. The second dimension defines the dimension on
the charts of the layer.

- **Label**: Enter a label for the dimension. If you have added a field from *Fields* in the assets panel, the field name is automatically displayed.
- **Include null values**: Select to include null values in the map. By default, this is selected.
- **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
  - **No limitation**: The default value.
  - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.
  - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.
  - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.
  - **Calculated on measure**: $<$measure$>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
- **Others label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label.

**Measures**

- **Expression**: The field or expression selected as the measure for the charts on the layer.
- **Label**: Enter a label for the measure. If you have added a field from *Fields* in the assets panel, the field name is automatically displayed.
- **Number formatting**: Select to include null values in the map. By default, this is selected.

**Data (Background layer)**

- **Label**: Set the name of the background layer in the map.
- **Format**: The format of the service to which the background layer is connecting. The following formats are supported:
  - **TMS**
  - **WMS**
  - **Image**: Background layers support the following image types:
    - .png
    - .jpg
    - .jpeg
    - .gif
3  Visualizations

- **URL**: (TMS and image only)
  - TMS: Enter the URL to a slippy or tile map server. You can use \$z, \$x, \$y in the URL to select the correct tile. For example, http://tile.openstreetmap.org/${z}/${x}/${y}.png. You can also use Bing Maps $(quadkey)$ in the URL to select the correct tile. You can use expressions between the curly brackets in the URL when defining \$z, \$x, \$y, or $(quadkey)$.
  - The URL is an expression and if the URL changes, the background data is reloaded.
  - The map server must produce tiles in the same projection type as is set for the map in **Projection in Map settings** to display layer data correctly.
  - Image: Enter the URL to the image.

- **Attribution**: Enter the attribution string for the map set in **URL**. HTML-style escaped characters, such as &copy, and HTML links, (<a> elements with href attributes) are allowed.

- **Advanced options**: (TMS only) Enables additional configuration options for TMS format maps. The following settings are available:
  - **Tile size pixels**: Set the width and height of map tiles in pixels.
  - **Tile width**: Set the tile width at level 0 (maximum zoom out) in the base map. The geographic unit is the one used by the base map.

  *For most base maps, the internal coordinate system uses Mercator with width in meters, even if the external coordinate system uses WGS-84 format degrees.*

  - **Tile height**: Set the tile height at level 0 (maximum zoom out) in the base map. The geographic unit is the one used by the base map.

  *For most base maps, the internal coordinate system uses Mercator with height in meters, even if the external coordinate system uses WGS-84 format degrees.*

  - **Origin X**: The origin of tiles in the x-axis. This field uses the same unit as **Tile height**. All tiles to the left of this origin use a negative value.
  - **Origin Y**: The origin of tiles in the y-axis. This field uses the same unit as **Tile width**. All tiles to above this origin use a negative value.

  *If \$(-y) is used in the URL, the y-axis is reversed and all tiles below this value will have a negative value.*

- **WMS Setup**: (WMS only) Click to set up the WMS format background layer.
  - **WMS server URL**: Enter the URL to the WMS server.
  - **Version**: Select the WMS version. Qlik Sense supports:
    - 1.1.0
    - 1.1.1
    - 1.3.0
3 Visualizations

- **Via server (CORS):** Select this option if Qlik Sense fails to load information after you click
- **Load WMS:** If a browser does not allow loading data from another site, the Qlik GeoAnalytics server can load the capabilities information instead, enabling cross-origin resource sharing (CORS).
- **CRS:** Select the coordinate reference system used by the WMS map.
- **Transparent:** Select to make areas in the WMS map that have no data as transparent. This enables the WMS map can be overlaid another base map.

Support for transparency depends on your WMS.

- **Layers:** Select the WMS layers to display in the map chart. The available layers depend on your source WMS map.
  - **Image position:** (Image only) Set the coordinates of the image in the background layer.
    - **Top left corner:** Enter the coordinates for the location of the top left corner of the image.
    - **Bottom right corner:** Enter the coordinates for the location of the bottom right corner of the image.

**Sorting (Point layer, area layer, density layer, and chart layer)**

Click the dimension name to open the settings and click the sorting button to switch to Custom sorting.
Sorting determines the order map locations are added. For example, if you have three overlapping points in a layer, sorting determines which point is on top. Sorting also determines which locations are displayed in a layer if you limit the number of visible map objects with Max visible objects. The sorting is either Ascending or Descending. The following sorting options are available:

- **Sort by expression:** Enter an expression to sort by.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Location**

- **(Line layer only)** Set what kind of data you are using for your lines.
  - **Start & end point:** Select to use two fields to set the start and end points. When selected, separate sections are added in Location for the start point and end point location settings.
  - **Line geometry:** Select to use GeoJSONLineString or MultiLineString format line geometry from a field. When selected, all other location settings are replaced with Line geometry field.

  - **Latitude and Longitude fields:** (Point, Line, Density, and Chart layers only) Select to use separate latitude and longitude fields.
    If selected, Location field is replaced with the following fields:
    - **Latitude:** (Point, Line, Density, and Chart layers only) Enter the field or expression containing latitude data.
• **Longitude**: (Point, Line, Density, and Chart layers only) Enter the field or expression containing longitude data.

• **Location field**: Enter the field or expression containing the locations to use in this layer. The field can contain geometries or the names of locations such as countries, cities, or postal codes.

> **If there are multiple locations associated with dimension values, you should set a custom scope for locations or use an expression that contains qualifiers.**

• **Scope for locations**: Set the scope of locations names the map chart uses to look for values contained in **Location field**. This improves accuracy when the name of a location is not globally unique or if you want one location per dimension value.
  
  • **Auto**: Set the scope of locations to all any type of locations.
  
  • **Custom**: Set the scope of locations to a custom set of locations.

  ▪ **Location type**: Select the type of locations contained in **Location field**:
    
    • **Auto**: Any type of location.
    
    • **Continent**: Continent names.
    
    • **Country**: Country names.
    
    • **Country code (ISO 2)**: ISO alpha 2 country codes.
    
    • **Country code (ISO 3)**: ISO alpha 3 country codes.
    
    • **Administrative area (Level 1)**: First-level administrative area names. such as a state or province names.
    
    • **Administrative area (Level 2)**: Second-level administrative area names.
    
    • **Administrative area (Level 3)**: Third order administrative area names.
    
    • **Administrative area (Level 4)**: Fourth order administrative area names.
    
    • **Postal code/ZIP Code**: Postal codes or ZIP Codes.
    
    • **City, place**: City, village, or other populated place names.
    
    • **Airport code (IATA)**: IATA airport codes.
    
    • **Airport code (ICAO)**: ICAO airport codes.

  ▪ **Country**: Enter a field or expression containing country names or country codes for the locations in **Location field**.

  ▪ **Administrative area (Level 1)**: Enter a field or expression containing first-order administrative area names or codes for the locations in **Location field**.

  ▪ **Administrative area (Level 2)**: Enter a field or expression containing second-order administrative area names or codes for locations in **Location field**.

**Size & Shape (Point layer)**

• **Size by**: Enter a field or expression to control the size of the symbol. The minimum and maximum values in the data are mapped to the minimum and maximum sizes of the field in `<Symbol> size range`, unless the **Range** is set to **Custom**. You can set the format of the field or expression values in **Number formatting**.
The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `##0` describes the number as an integer with a thousands separator. In this example "" is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example "," is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

**Operations**:

- **Label**: Set a label for the **Size by** property.
- **<Symbol> size range**: Set a minimum and maximum size range limit for the selected symbol for your point layer.
- **Range**: Set the value limits for the size range.
O **Auto:** The symbol size range maps to the minimum and maximum value of the Size by field.

O **Custom:** The symbol size range maps to the minimum and maximum values set in Minimum size value and Maximum size value. Values exceeding the minimum and maximum values will use the same settings as the minimum and maximum values.

- **Shape:** Select the shape for your point layer. The following shapes are available:
  - Bubble
  - Triangle
  - Square
  - Pentagon
  - Hexagon
  - Image

- **Image:** (Image shape only) Click to open the media library where you can select an image. To remove the image, click.

- **Image rotation:** (Image shape only) Enter the degree of rotation. You can enter a numeric value for the degrees of rotation. You can also use an expression to set the degree of rotation for the image.

### Size & Shape (Chart layer)

- **Pie chart**
  - **Size by:** Enter a field or expression to control the size of the pie charts. The minimum and maximum values in the data are mapped to the minimum and maximum sizes of the pie charts, unless the Range is set to Custom. You can set the format of the field or expression values in Number formatting.

  The following number formats are available:

  - **Auto:** Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  - **Number:** By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

  **Examples:**

  - `###0` describes the number as an integer without a thousands separator. In this example, `" "` is used as a thousands separator.
  - `####0` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
  - `####0` describes the number with three decimals. In this example, `"."` is used as a decimal separator.

  If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.
3 Visualizations

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.
- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  - **Label**: Set a label for the Size by property.
  - **Pie chart size range**: Set a minimum and maximum size range limit for the pie charts for your chart layer.
  - **Range**: Set the value limits for the size range.
    - **Auto**: The size range maps to the minimum and maximum value of the Size by field.
    - **Custom**: The size range maps to the minimum and maximum values set in Minimum size value and Maximum size value. Values exceeding the minimum and maximum values will use the same settings as the minimum and maximum values.
- **Bar chart**
  - **Height**: Set a height size for the bar charts for your chart layer.
  - **Width**: Set a width size for the bar charts for your chart layer.

**Width & Style (Line layer only)**

- **Width by**: Enter a field or expression to control the width of the lines. The minimum and maximum values in the data are mapped to the minimum and maximum sizes of the field in Line size width range, unless the Range is set to Custom. You can set the format of the field or expression values in Number formatting.
  The following number formats are available:
  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  - **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

Create apps and visualizations - Qlik Sense, February 2021
Examples:

- # ###0 describes the number as an integer with a thousands separator. In this example "0000" is used as a thousands separator.
- ###0 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

- **Label**: Set a label for the **Width by** property.
- **Line size width range**: If you are using **Width by**, set the minimum and maximum width of the lines.
- **Line width**: Set the width of the lines.
- **Range**: Set the value limits for line width.
  - **Auto**: The line width range maps to the minimum and maximum value of the **Width by** field.
  - **Custom**: The line width range maps to the minimum and maximum values set in **Minimum line value** and **Maximum line value**. Values exceeding the minimum and maximum values will use the same settings as the minimum and maximum values.
- **Line curve**: Set the curvature of the lines in your line layer.
- **Arrow**: Set the style of the arrows for your lines. The following options are available:
  - **None**: No arrow is added to your line.
  - **Forward**: An arrow is added in the direction of the last point of the line.
3 Visualizations

- **Backward**: An arrow is added in the direction of the first point of the line.
- **Both**: Arrows are added facing both the first and last point of the line.
- **Arrow position**: Set the position of the arrow in the line.

**Weight & Radius (Density layer only)**

- **Weight by**: Enter a field or expression to control how much each point contributes to the density. The default weight value is 1.
- **Label**: Set a label for the **Weight by** property.
- **Influence radius**: Set the radius of the circular area that each point influences. The unit of measure for the radius is set by **Radius unit**.
- **Radius unit**: Set the unit of measure for the radius of influence. The following options are available:
  - **Pixels**: Screen pixels.
  - **Meters**: Map meters.
  - **Feet**: Map feet.

**Colors (Point layer, area layer, line layer, and chart layer)**

- **Colors**: Select how the map values are colored. There are two settings:
  - **Auto**: Colors the map values using default settings.
  - **Custom**: Manually select the method of coloring your values in the map. The following methods are available
    - **Single color**: Color the map using a single color (by default blue). When selected, the following settings are available:
      - **Color**: Select the color to use for objects in the layer.
      - **Outline color**: Select the outline color for objects in the layer.
    - **By dimension**: Color the map by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
      - **Select dimension**: Enter a field or expression containing the values to color objects in this layer.
      - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
      - **Persistent colors**: Select to have colors remain the same between selection states.
      - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
    - **By measure**:
      - **Select measure**: Select the measure to use to color your layer.
      - **Label**: Enter text or an expression for the measure that displays in the legend.
      - **Number formatting**: You can set the format of the field or expression values.
The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `##0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

- **Color scheme**: Select a color scheme from the following options:
  - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
  - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
  - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a map. Low and high values have dark colors, mid-range colors are light.
  - **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

- **Reverse colors**: When selected, the color scheme is reversed.

- **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the **Min** and **Max** values for the color range.

- **By expression**: Color the map using an expression to define colors for values.
  Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click \( \text{\textbullet} \) to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients.
    When the coloring is by measure or by expression, you can set the color range (**Min** and **Max** values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

- **Outline color**: Select the color for the outline of the shapes in the map.

- **Outline opacity**: (Point, chart, and area layers only) Set how opaque the outline of shapes in the map is.

- **Opacity**: Set how opaque the layer is over the base map.
3 Visualizations

Colors (Density layer)

- **Segment Colors**: Select how the influence area of the points is colored. There are two settings:
  - **Auto**: Colors the influence area using default settings.
  - **Custom**: Manually select the method of coloring the influence area in the map.
    - **Add limit**: Adds a segment to the gauge. Use the slider or type an expression to set the limit of the segment. Click $\text{fx}$ to open the expression editor. You can add several segments. Click the segment to change colors.
    - **Gradient**: Select to use different shades of colors in the transition between the segments.
  - **Remove limit**: Click to remove the selected limit.
- **Range**: Define the range of values used to color the influence area. There are two settings:
  - **Auto**: Sets the range of values using default settings.
  - **Custom**: Manually select the range of values coloring the influence area.
    - **Min**: Set the minimum value for the range. Click $\text{fx}$ if you want to create an expression.
    - **Max**: Set the maximum value for the range. Click $\text{fx}$ if you want to create an expression.
- **Opacity**: Set how opaque the layer is over the base map.

Options

General

- **Show legend**: Display a legend if there is enough space on the map. You can set a size for the legend or let Qlik Sense automatically determine the size. The placement can be changed using Legend position.
- **Show size legend**: (Point, line, and chart layers only) Display a legend for point, line, or chart size.
- **Show tooltip**: (Point, area, chart, and line layers only) Display a tooltip over the displayed locations in a layer with the location's value.
- **Max visible objects**: (Point, area, density, chart, and line layers only) Set the maximum locations to display in the layer. The maximum number of values in a map layer is 50,000. By default, map layers display a maximum of 4,000 values for point layers and 1,000 for other layers.
- **Show label**: (Point, area, chart, and line layers only) Set whether to include a text label with the layer's locations on your map.
  - **Labels**: Set the label for the locations in this layer.
  - **Label position**: Set the position of the label relative to the location.
  - **Show in zoom levels**: Set the label to be visible at all zoom levels or at a select range of zoom levels.
- **Disable selections**: If this option is selected, users cannot select data from this layer in the map.
3 Visualizations

Layer display

- **Show layer**: Select to show or hide layer.
- **Exclude from autozoom**: Select to exclude this layer when the map visualization is determining the automatic zoom level based on the data in the map.
- **Show in zoom levels**: Set the layer to be visible at all zoom levels or at a select range of zoom levels.
- **Visible drill-down levels**: Set which dimensions in the drill-down are displayed with this layer.
- **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.
- **Hide calculation message**: Select to hide the message or expression entered in **Displayed message**.

Tooltip (Point layer, area layer, line layer, and chart layer)

- **Tooltip**: Set to Custom to add measures and images as tooltips.
- **Hide basic rows**: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, **Hide basic rows** will also hide dimension values as well.
- **Title**: Enter a title for the tooltip.
- **Description**: Enter a description for the tooltip.
- **Measures**
  - **Add measure**: Add a measure to be shown as a tooltip. You can add a measure from a field using **From a field**. You can also use an expression to add a measure. Click **fix** to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using **Label** as well as its formatting using **Number formatting**.
- **Images**
  - **Type**: Choose whether to add an image from your **Media library** or from a **URL**.
  - **Size**: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - **Small**: Set the width and height of the container to 50 pixels.
    - **Medium**: Set the width and height of the container to 200 pixels.
    - **Large**: Set the width and height of the container to 340 pixels.
    - **Original**: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
  - **Media library**: Appears when you choose **Media library** for **Type**. Click to select an image from your media library.
  - **URL**: Appears when you choose **URL** for **Type**. Enter a **URL**.
Presentation (Background layer)
- **Opacity**: Set how opaque the layer is over the other layers.

Controlling visible map data with drill-down layers
This example will show you how to build a map with a top-level area layer that drills down into with two point layers.

When creating a map that has multiple points of data located in a wide geographical area, you can use drill-down dimensions to display your layers in a hierarchy. As users make selections in a layer, the dimension displayed in the layer changes to the next dimension in the drill-down dimension. This enables you to use display data at different selection levels within your map, ensuring only the most relevant information is being displayed.

We have a list of all historical sites in the United States National Park Service's National Register of Historic places. When we add the cities that historical sites are located in to a map as a point layer, we get accurate locations for our bubbles. It could be made more understandable with better organization, however.

How then can we organize this information better, especially if we also want to add in another point layer containing airports to help plan how to get to the different sites?
To solve this problem, we will create a map of the United States of America with a layer of states that drills down to the county level. Drilling down to the county level will also show the cities that contain the historical sites as data points, as well as all airports for that state and the surrounding states.

Dataset
This example uses two sets of data:

- Federal listings: National Register of Historic Places listed properties from federal agencies (federal_listed_20190404.xlsx)
3 Visualizations

This data set is available from the National Park Service National Register of Historic Places. It contains data about all registered history places, their location, and the federal agencies associated to them.

[ federal_listed_20190404.xlsx.]

- Airport data
  This table contains data for airports in the United States. It consists of each airport's International Air Transport Association (IATA) code, city, and state or territory.
  You must import this data into Qlik Sense either by adding to a spreadsheet that you then import into Qlik Sense or by importing the table from this help page as a web file.

Airport data

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABE</td>
<td>Allentown/Bethlehem/Easton, PA</td>
<td>PA</td>
</tr>
<tr>
<td>ABI</td>
<td>Abilene, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ABQ</td>
<td>Albuquerque, NM</td>
<td>NM</td>
</tr>
<tr>
<td>ABR</td>
<td>Aberdeen, SD</td>
<td>SD</td>
</tr>
<tr>
<td>ABY</td>
<td>Albany, GA</td>
<td>GA</td>
</tr>
<tr>
<td>ACT</td>
<td>Waco, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ACV</td>
<td>Arcata/Eureka, CA</td>
<td>CA</td>
</tr>
<tr>
<td>ADK</td>
<td>Adak Island, AK</td>
<td>AK</td>
</tr>
<tr>
<td>ADQ</td>
<td>Kodiak, AK</td>
<td>AK</td>
</tr>
<tr>
<td>AEX</td>
<td>Alexandria, LA</td>
<td>LA</td>
</tr>
<tr>
<td>AGS</td>
<td>Augusta, GA</td>
<td>GA</td>
</tr>
<tr>
<td>ALB</td>
<td>Albany, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ALO</td>
<td>Waterloo, IA</td>
<td>IA</td>
</tr>
<tr>
<td>AMA</td>
<td>Amarillo, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ANC</td>
<td>Anchorage, AK</td>
<td>AK</td>
</tr>
<tr>
<td>APN</td>
<td>Alpena, MI</td>
<td>MI</td>
</tr>
<tr>
<td>ART</td>
<td>Watertown, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ASE</td>
<td>Aspen, CO</td>
<td>CO</td>
</tr>
<tr>
<td>ATL</td>
<td>Atlanta, GA</td>
<td>GA</td>
</tr>
<tr>
<td>ATW</td>
<td>Appleton, WI</td>
<td>WI</td>
</tr>
<tr>
<td>AUS</td>
<td>Austin, TX</td>
<td>TX</td>
</tr>
<tr>
<td>AVL</td>
<td>Asheville, NC</td>
<td>NC</td>
</tr>
</tbody>
</table>
## 3 Visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVP</td>
<td>Scranton/Wilkes-Barre, PA</td>
<td>PA</td>
</tr>
<tr>
<td>AZO</td>
<td>Kalamazoo, MI</td>
<td>MI</td>
</tr>
<tr>
<td>BDL</td>
<td>Hartford, CT</td>
<td>CT</td>
</tr>
<tr>
<td>BET</td>
<td>Bethel, AK</td>
<td>AK</td>
</tr>
<tr>
<td>BFL</td>
<td>Bakersfield, CA</td>
<td>CA</td>
</tr>
<tr>
<td>BGR</td>
<td>Bangor, ME</td>
<td>ME</td>
</tr>
<tr>
<td>BKM</td>
<td>Birmingham, AL</td>
<td>AL</td>
</tr>
<tr>
<td>BIL</td>
<td>Billings, MT</td>
<td>MT</td>
</tr>
<tr>
<td>BIS</td>
<td>Bismarck/Mandan, ND</td>
<td>ND</td>
</tr>
<tr>
<td>BJI</td>
<td>Bemidji, MN</td>
<td>MN</td>
</tr>
<tr>
<td>BKG</td>
<td>Branson, MO</td>
<td>MO</td>
</tr>
<tr>
<td>BLI</td>
<td>Bellingham, WA</td>
<td>WA</td>
</tr>
<tr>
<td>BMI</td>
<td>Bloomington/Normal, IL</td>
<td>IL</td>
</tr>
<tr>
<td>BNA</td>
<td>Nashville, TN</td>
<td>TN</td>
</tr>
<tr>
<td>BOI</td>
<td>Boise, ID</td>
<td>ID</td>
</tr>
<tr>
<td>BOS</td>
<td>Boston, MA</td>
<td>MA</td>
</tr>
<tr>
<td>BPT</td>
<td>Beaumont/Port Arthur, TX</td>
<td>TX</td>
</tr>
<tr>
<td>BQK</td>
<td>Brunswick, GA</td>
<td>GA</td>
</tr>
<tr>
<td>BQN</td>
<td>Aguadilla, PR</td>
<td>PR</td>
</tr>
<tr>
<td>BRD</td>
<td>Brainerd, MN</td>
<td>MN</td>
</tr>
<tr>
<td>BRO</td>
<td>Brownsville, TX</td>
<td>TX</td>
</tr>
<tr>
<td>BRW</td>
<td>Barrow, AK</td>
<td>AK</td>
</tr>
<tr>
<td>BTM</td>
<td>Butte, MT</td>
<td>MT</td>
</tr>
<tr>
<td>BTR</td>
<td>Baton Rouge, LA</td>
<td>LA</td>
</tr>
<tr>
<td>BTV</td>
<td>Burlington, VT</td>
<td>VT</td>
</tr>
<tr>
<td>BUF</td>
<td>Buffalo, NY</td>
<td>NY</td>
</tr>
<tr>
<td>BUR</td>
<td>Burbank, CA</td>
<td>CA</td>
</tr>
<tr>
<td>BWI</td>
<td>Baltimore, MD</td>
<td>MD</td>
</tr>
<tr>
<td>BZN</td>
<td>Bozeman, MT</td>
<td>MT</td>
</tr>
<tr>
<td>CAE</td>
<td>Columbia, SC</td>
<td>SC</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>CAK</td>
<td>Akron, OH</td>
<td>OH</td>
</tr>
<tr>
<td>CDC</td>
<td>Cedar City, UT</td>
<td>UT</td>
</tr>
<tr>
<td>CDV</td>
<td>Cordova, AK</td>
<td>AK</td>
</tr>
<tr>
<td>CEC</td>
<td>Crescent City, CA</td>
<td>CA</td>
</tr>
<tr>
<td>CHA</td>
<td>Chattanooga, TN</td>
<td>TN</td>
</tr>
<tr>
<td>CHO</td>
<td>Charlottesville, VA</td>
<td>VA</td>
</tr>
<tr>
<td>CHS</td>
<td>Charleston, SC</td>
<td>SC</td>
</tr>
<tr>
<td>CIC</td>
<td>Chico, CA</td>
<td>CA</td>
</tr>
<tr>
<td>CID</td>
<td>Cedar Rapids/Iowa City, IA</td>
<td>IA</td>
</tr>
<tr>
<td>CLD</td>
<td>Carlsbad, CA</td>
<td>CA</td>
</tr>
<tr>
<td>CLE</td>
<td>Cleveland, OH</td>
<td>OH</td>
</tr>
<tr>
<td>CLL</td>
<td>College Station/Bryan, TX</td>
<td>TX</td>
</tr>
<tr>
<td>CLT</td>
<td>Charlotte, NC</td>
<td>NC</td>
</tr>
<tr>
<td>CMH</td>
<td>Columbus, OH</td>
<td>OH</td>
</tr>
<tr>
<td>CMI</td>
<td>Champaign/Urbana, IL</td>
<td>IL</td>
</tr>
<tr>
<td>CMX</td>
<td>Hancock/Houghton, MI</td>
<td>MI</td>
</tr>
<tr>
<td>COD</td>
<td>Cody, WY</td>
<td>WY</td>
</tr>
<tr>
<td>COS</td>
<td>Colorado Springs, CO</td>
<td>CO</td>
</tr>
<tr>
<td>COU</td>
<td>Columbia, MO</td>
<td>MO</td>
</tr>
<tr>
<td>CPR</td>
<td>Casper, WY</td>
<td>WY</td>
</tr>
<tr>
<td>CRP</td>
<td>Corpus Christi, TX</td>
<td>TX</td>
</tr>
<tr>
<td>CRW</td>
<td>Charleston/Dunbar, WV</td>
<td>WV</td>
</tr>
<tr>
<td>CSG</td>
<td>Columbus, GA</td>
<td>GA</td>
</tr>
<tr>
<td>CWA</td>
<td>Mosinee, WI</td>
<td>WI</td>
</tr>
<tr>
<td>CVG</td>
<td>Cincinnati, OH</td>
<td>KY</td>
</tr>
<tr>
<td>DAB</td>
<td>Daytona Beach, FL</td>
<td>FL</td>
</tr>
<tr>
<td>DAL</td>
<td>Dallas, TX</td>
<td>TX</td>
</tr>
<tr>
<td>DAY</td>
<td>Dayton, OH</td>
<td>OH</td>
</tr>
<tr>
<td>DBQ</td>
<td>Dubuque, IA</td>
<td>IA</td>
</tr>
<tr>
<td>DCA</td>
<td>Washington, DC</td>
<td>VA</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>DEN</td>
<td>Denver, CO</td>
<td>CO</td>
</tr>
<tr>
<td>DFW</td>
<td>Dallas/Fort Worth, TX</td>
<td>TX</td>
</tr>
<tr>
<td>DHN</td>
<td>Dothan, AL</td>
<td>AL</td>
</tr>
<tr>
<td>DIK</td>
<td>Dickinson, ND</td>
<td>ND</td>
</tr>
<tr>
<td>DLH</td>
<td>Duluth, MN</td>
<td>MN</td>
</tr>
<tr>
<td>DRO</td>
<td>Durango, CO</td>
<td>CO</td>
</tr>
<tr>
<td>DSM</td>
<td>Des Moines, IA</td>
<td>IA</td>
</tr>
<tr>
<td>DTW</td>
<td>Detroit, MI</td>
<td>MI</td>
</tr>
<tr>
<td>EAU</td>
<td>Eau Claire, WI</td>
<td>WI</td>
</tr>
<tr>
<td>ECP</td>
<td>Panama City, FL</td>
<td>FL</td>
</tr>
<tr>
<td>EGE</td>
<td>Eagle, CO</td>
<td>CO</td>
</tr>
<tr>
<td>EKO</td>
<td>Elko, NV</td>
<td>NV</td>
</tr>
<tr>
<td>ELM</td>
<td>Elmira/Coming, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ELP</td>
<td>El Paso, TX</td>
<td>TX</td>
</tr>
<tr>
<td>EUG</td>
<td>Eugene, OR</td>
<td>OR</td>
</tr>
<tr>
<td>EWN</td>
<td>New Bern/Morehead/Beaufort, NC</td>
<td>NC</td>
</tr>
<tr>
<td>EWR</td>
<td>Newark, NJ</td>
<td>NJ</td>
</tr>
<tr>
<td>EVV</td>
<td>Evansville, IN</td>
<td>IN</td>
</tr>
<tr>
<td>EYW</td>
<td>Key West, FL</td>
<td>FL</td>
</tr>
<tr>
<td>FAI</td>
<td>Fairbanks, AK</td>
<td>AK</td>
</tr>
<tr>
<td>FAR</td>
<td>Fargo, ND</td>
<td>ND</td>
</tr>
<tr>
<td>FAT</td>
<td>Fresno, CA</td>
<td>CA</td>
</tr>
<tr>
<td>FAY</td>
<td>Fayetteville, NC</td>
<td>NC</td>
</tr>
<tr>
<td>FCA</td>
<td>Kalispell, MT</td>
<td>MT</td>
</tr>
<tr>
<td>FLG</td>
<td>Flagstaff, AZ</td>
<td>AZ</td>
</tr>
<tr>
<td>FLL</td>
<td>Fort Lauderdale, FL</td>
<td>FL</td>
</tr>
<tr>
<td>FNT</td>
<td>Flint, MI</td>
<td>MI</td>
</tr>
<tr>
<td>FOE</td>
<td>Topeka, KS</td>
<td>KS</td>
</tr>
<tr>
<td>FSD</td>
<td>Sioux Falls, SD</td>
<td>SD</td>
</tr>
<tr>
<td>FSM</td>
<td>Fort Smith, AR</td>
<td>AR</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>FWA</td>
<td>Fort Wayne, IN</td>
<td>IN</td>
</tr>
<tr>
<td>GCC</td>
<td>Gillette, WY</td>
<td>WY</td>
</tr>
<tr>
<td>GCK</td>
<td>Garden City, KS</td>
<td>KS</td>
</tr>
<tr>
<td>GEG</td>
<td>Spokane, WA</td>
<td>WA</td>
</tr>
<tr>
<td>GFK</td>
<td>Grand Forks, ND</td>
<td>ND</td>
</tr>
<tr>
<td>GGG</td>
<td>Longview, TX</td>
<td>TX</td>
</tr>
<tr>
<td>GJT</td>
<td>Grand Junction, CO</td>
<td>CO</td>
</tr>
<tr>
<td>GNV</td>
<td>Gainesville, FL</td>
<td>FL</td>
</tr>
<tr>
<td>GPT</td>
<td>Gulfport/Biloxi, MS</td>
<td>MS</td>
</tr>
<tr>
<td>GRB</td>
<td>Green Bay, WI</td>
<td>WI</td>
</tr>
<tr>
<td>GRI</td>
<td>Grand Island, NE</td>
<td>NE</td>
</tr>
<tr>
<td>GRK</td>
<td>Killeen, TX</td>
<td>TX</td>
</tr>
<tr>
<td>GRR</td>
<td>Grand Rapids, MI</td>
<td>MI</td>
</tr>
<tr>
<td>GSO</td>
<td>Greensboro/High Point, NC</td>
<td>NC</td>
</tr>
<tr>
<td>GSP</td>
<td>Greer, SC</td>
<td>SC</td>
</tr>
<tr>
<td>GTF</td>
<td>Great Falls, MT</td>
<td>MT</td>
</tr>
<tr>
<td>GTR</td>
<td>Columbus, MS</td>
<td>MS</td>
</tr>
<tr>
<td>GUC</td>
<td>Gunnison, CO</td>
<td>CO</td>
</tr>
<tr>
<td>GUM</td>
<td>Guam, TT</td>
<td>TT</td>
</tr>
<tr>
<td>HDN</td>
<td>Hayden, CO</td>
<td>CO</td>
</tr>
<tr>
<td>HIB</td>
<td>Hibbing, MN</td>
<td>MN</td>
</tr>
<tr>
<td>HLN</td>
<td>Helena, MT</td>
<td>MT</td>
</tr>
<tr>
<td>HNL</td>
<td>Honolulu, HI</td>
<td>HI</td>
</tr>
<tr>
<td>HOB</td>
<td>Hobbs, NM</td>
<td>NM</td>
</tr>
<tr>
<td>HOU</td>
<td>Houston, TX</td>
<td>TX</td>
</tr>
<tr>
<td>HPN</td>
<td>White Plains, NY</td>
<td>NY</td>
</tr>
<tr>
<td>HRL</td>
<td>Harlingen/San Benito, TX</td>
<td>TX</td>
</tr>
<tr>
<td>HSV</td>
<td>Huntsville, AL</td>
<td>AL</td>
</tr>
<tr>
<td>IAD</td>
<td>Washington, DC</td>
<td>VA</td>
</tr>
<tr>
<td>IAH</td>
<td>Houston, TX</td>
<td>TX</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>ICT</td>
<td>Wichita, KS</td>
<td>KS</td>
</tr>
<tr>
<td>IDA</td>
<td>Idaho Falls, ID</td>
<td>ID</td>
</tr>
<tr>
<td>ILG</td>
<td>Wilmington, DE</td>
<td>DE</td>
</tr>
<tr>
<td>ILM</td>
<td>Wilmington, NC</td>
<td>NC</td>
</tr>
<tr>
<td>IMT</td>
<td>Iron Mountain/Kingsford, MI</td>
<td>MI</td>
</tr>
<tr>
<td>IND</td>
<td>Indianapolis, IN</td>
<td>IN</td>
</tr>
<tr>
<td>INL</td>
<td>International Falls, MN</td>
<td>MN</td>
</tr>
<tr>
<td>ISN</td>
<td>Williston, ND</td>
<td>ND</td>
</tr>
<tr>
<td>ISP</td>
<td>Islip, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ITO</td>
<td>Hilo, HI</td>
<td>HI</td>
</tr>
<tr>
<td>JAC</td>
<td>Jackson, WY</td>
<td>WY</td>
</tr>
<tr>
<td>JAN</td>
<td>Jackson/Vicksburg, MS</td>
<td>MS</td>
</tr>
<tr>
<td>JAX</td>
<td>Jacksonville, FL</td>
<td>FL</td>
</tr>
<tr>
<td>JFK</td>
<td>New York, NY</td>
<td>NY</td>
</tr>
<tr>
<td>JLN</td>
<td>Joplin, MO</td>
<td>MO</td>
</tr>
<tr>
<td>JNU</td>
<td>Juneau, AK</td>
<td>AK</td>
</tr>
<tr>
<td>KOA</td>
<td>Kona, HI</td>
<td>HI</td>
</tr>
<tr>
<td>KTN</td>
<td>Ketchikan, AK</td>
<td>AK</td>
</tr>
<tr>
<td>LAN</td>
<td>Lansing, MI</td>
<td>MI</td>
</tr>
<tr>
<td>LAR</td>
<td>Laramie, WY</td>
<td>WY</td>
</tr>
<tr>
<td>LAS</td>
<td>Las Vegas, NV</td>
<td>NV</td>
</tr>
<tr>
<td>LAW</td>
<td>Lawton/Fort Sill, OK</td>
<td>OK</td>
</tr>
<tr>
<td>LAX</td>
<td>Los Angeles, CA</td>
<td>CA</td>
</tr>
<tr>
<td>LBB</td>
<td>Lubbock, TX</td>
<td>TX</td>
</tr>
<tr>
<td>LCH</td>
<td>Lake Charles, LA</td>
<td>LA</td>
</tr>
<tr>
<td>LEX</td>
<td>Lexington, KY</td>
<td>KY</td>
</tr>
<tr>
<td>LFT</td>
<td>Lafayette, LA</td>
<td>LA</td>
</tr>
<tr>
<td>LGA</td>
<td>New York, NY</td>
<td>NY</td>
</tr>
<tr>
<td>LGB</td>
<td>Long Beach, CA</td>
<td>CA</td>
</tr>
<tr>
<td>LIH</td>
<td>Lihue, HI</td>
<td>HI</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>LIT</td>
<td>Little Rock, AR</td>
<td>AR</td>
</tr>
<tr>
<td>LMT</td>
<td>Klamath Falls, OR</td>
<td>OR</td>
</tr>
<tr>
<td>LNK</td>
<td>Lincoln, NE</td>
<td>NE</td>
</tr>
<tr>
<td>LRD</td>
<td>Laredo, TX</td>
<td>TX</td>
</tr>
<tr>
<td>LSE</td>
<td>La Crosse, WI</td>
<td>WI</td>
</tr>
<tr>
<td>LWS</td>
<td>Lewiston, ID</td>
<td>ID</td>
</tr>
<tr>
<td>MAF</td>
<td>Midland/Odessa, TX</td>
<td>TX</td>
</tr>
<tr>
<td>MBS</td>
<td>Saginaw/Bay City/Midland, MI</td>
<td>MI</td>
</tr>
<tr>
<td>MCI</td>
<td>Kansas City, MO</td>
<td>MO</td>
</tr>
<tr>
<td>MCO</td>
<td>Orlando, FL</td>
<td>FL</td>
</tr>
<tr>
<td>MDT</td>
<td>Harrisburg, PA</td>
<td>PA</td>
</tr>
<tr>
<td>MDW</td>
<td>Chicago, IL</td>
<td>IL</td>
</tr>
<tr>
<td>MEM</td>
<td>Memphis, TN</td>
<td>TN</td>
</tr>
<tr>
<td>MFE</td>
<td>Mission/McAllen/Edinburg, TX</td>
<td>TX</td>
</tr>
<tr>
<td>MFR</td>
<td>Medford, OR</td>
<td>OR</td>
</tr>
<tr>
<td>MGM</td>
<td>Montgomery, AL</td>
<td>AL</td>
</tr>
<tr>
<td>MHK</td>
<td>Manhattan/Ft. Riley, KS</td>
<td>KS</td>
</tr>
<tr>
<td>MHT</td>
<td>Manchester, NH</td>
<td>NH</td>
</tr>
<tr>
<td>MIA</td>
<td>Miami, FL</td>
<td>FL</td>
</tr>
<tr>
<td>MKE</td>
<td>Milwaukee, WI</td>
<td>WI</td>
</tr>
<tr>
<td>MKG</td>
<td>Muskegon, MI</td>
<td>MI</td>
</tr>
<tr>
<td>MLB</td>
<td>Melbourne, FL</td>
<td>FL</td>
</tr>
<tr>
<td>MLI</td>
<td>Moline, IL</td>
<td>IL</td>
</tr>
<tr>
<td>MLU</td>
<td>Monroe, LA</td>
<td>LA</td>
</tr>
<tr>
<td>MMH</td>
<td>Mammoth Lakes, CA</td>
<td>CA</td>
</tr>
<tr>
<td>MOB</td>
<td>Mobile, AL</td>
<td>AL</td>
</tr>
<tr>
<td>MOD</td>
<td>Modesto, CA</td>
<td>CA</td>
</tr>
<tr>
<td>MOT</td>
<td>Minot, ND</td>
<td>ND</td>
</tr>
<tr>
<td>MQT</td>
<td>Marquette, MI</td>
<td>MI</td>
</tr>
<tr>
<td>MRY</td>
<td>Monterey, CA</td>
<td>CA</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSN</td>
<td>Madison, WI</td>
<td>WI</td>
</tr>
<tr>
<td>MSO</td>
<td>Missoula, MT</td>
<td>MT</td>
</tr>
<tr>
<td>MSP</td>
<td>Minneapolis, MN</td>
<td>MN</td>
</tr>
<tr>
<td>MSY</td>
<td>New Orleans, LA</td>
<td>LA</td>
</tr>
<tr>
<td>MTJ</td>
<td>Montrose/Delta, CO</td>
<td>CO</td>
</tr>
<tr>
<td>MYR</td>
<td>Myrtle Beach, SC</td>
<td>SC</td>
</tr>
<tr>
<td>OAJ</td>
<td>Jacksonville/Camp Lejeune, NC</td>
<td>NC</td>
</tr>
<tr>
<td>OAK</td>
<td>Oakland, CA</td>
<td>CA</td>
</tr>
<tr>
<td>OGG</td>
<td>Kahului, HI</td>
<td>HI</td>
</tr>
<tr>
<td>OKC</td>
<td>Oklahoma City, OK</td>
<td>OK</td>
</tr>
<tr>
<td>OMA</td>
<td>Omaha, NE</td>
<td>NE</td>
</tr>
<tr>
<td>OME</td>
<td>Nome, AK</td>
<td>AK</td>
</tr>
<tr>
<td>ONT</td>
<td>Ontario, CA</td>
<td>CA</td>
</tr>
<tr>
<td>ORD</td>
<td>Chicago, IL</td>
<td>IL</td>
</tr>
<tr>
<td>ORF</td>
<td>Norfolk, VA</td>
<td>VA</td>
</tr>
<tr>
<td>ORH</td>
<td>Worcester, MA</td>
<td>MA</td>
</tr>
<tr>
<td>OTH</td>
<td>North Bend/Coos Bay, OR</td>
<td>OR</td>
</tr>
<tr>
<td>OTZ</td>
<td>Kotzebue, AK</td>
<td>AK</td>
</tr>
<tr>
<td>PAH</td>
<td>Paducah, KY</td>
<td>KY</td>
</tr>
<tr>
<td>PBI</td>
<td>West Palm Beach/Palm Beach, FL</td>
<td>FL</td>
</tr>
<tr>
<td>PDX</td>
<td>Portland, OR</td>
<td>OR</td>
</tr>
<tr>
<td>PHF</td>
<td>Newport News/Williamsburg, VA</td>
<td>VA</td>
</tr>
<tr>
<td>PHL</td>
<td>Philadelphia, PA</td>
<td>PA</td>
</tr>
<tr>
<td>PHX</td>
<td>Phoenix, AZ</td>
<td>AZ</td>
</tr>
<tr>
<td>PIA</td>
<td>Peoria, IL</td>
<td>IL</td>
</tr>
<tr>
<td>PIH</td>
<td>Pocatello, ID</td>
<td>ID</td>
</tr>
<tr>
<td>PIT</td>
<td>Pittsburgh, PA</td>
<td>PA</td>
</tr>
<tr>
<td>PNS</td>
<td>Pensacola, FL</td>
<td>FL</td>
</tr>
<tr>
<td>PPG</td>
<td>Pago Pago, TT</td>
<td>TT</td>
</tr>
<tr>
<td>PSC</td>
<td>Pasco/Kennewick/Richland, WA</td>
<td>WA</td>
</tr>
</tbody>
</table>
Create apps and visualizations - Qlik Sense, February 2021

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSE</td>
<td>Ponce, PR</td>
<td>PR</td>
</tr>
<tr>
<td>PSG</td>
<td>Petersburg, AK</td>
<td>AK</td>
</tr>
<tr>
<td>PSP</td>
<td>Palm Springs, CA</td>
<td>CA</td>
</tr>
<tr>
<td>PVD</td>
<td>Providence, RI</td>
<td>RI</td>
</tr>
<tr>
<td>PWM</td>
<td>Portland, ME</td>
<td>ME</td>
</tr>
<tr>
<td>RAP</td>
<td>Rapid City, SD</td>
<td>SD</td>
</tr>
<tr>
<td>RDD</td>
<td>Redding, CA</td>
<td>CA</td>
</tr>
<tr>
<td>RDM</td>
<td>Bend/Redmond, OR</td>
<td>OR</td>
</tr>
<tr>
<td>RDU</td>
<td>Raleigh/Durham, NC</td>
<td>NC</td>
</tr>
<tr>
<td>RHI</td>
<td>Rhinelander, WI</td>
<td>WI</td>
</tr>
<tr>
<td>RIC</td>
<td>Richmond, VA</td>
<td>VA</td>
</tr>
<tr>
<td>RKS</td>
<td>Rock Springs, WY</td>
<td>WY</td>
</tr>
<tr>
<td>RNO</td>
<td>Reno, NV</td>
<td>NV</td>
</tr>
<tr>
<td>ROA</td>
<td>Roanoke, VA</td>
<td>VA</td>
</tr>
<tr>
<td>ROC</td>
<td>Rochester, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ROW</td>
<td>Roswell, NM</td>
<td>NM</td>
</tr>
<tr>
<td>RST</td>
<td>Rochester, MN</td>
<td>MN</td>
</tr>
<tr>
<td>RSW</td>
<td>Fort Myers, FL</td>
<td>FL</td>
</tr>
<tr>
<td>SAF</td>
<td>Santa Fe, NM</td>
<td>NM</td>
</tr>
<tr>
<td>SAN</td>
<td>San Diego, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SAT</td>
<td>San Antonio, TX</td>
<td>TX</td>
</tr>
<tr>
<td>SAV</td>
<td>Savannah, GA</td>
<td>GA</td>
</tr>
<tr>
<td>SBA</td>
<td>Santa Barbara, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SBN</td>
<td>South Bend, IN</td>
<td>IN</td>
</tr>
<tr>
<td>SBP</td>
<td>San Luis Obispo, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SCC</td>
<td>Deadhorse, AK</td>
<td>AK</td>
</tr>
<tr>
<td>SCE</td>
<td>State College, PA</td>
<td>PA</td>
</tr>
<tr>
<td>SDF</td>
<td>Louisville, KY</td>
<td>KY</td>
</tr>
<tr>
<td>SEA</td>
<td>Seattle, WA</td>
<td>WA</td>
</tr>
<tr>
<td>SFO</td>
<td>San Francisco, CA</td>
<td>CA</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>SGF</td>
<td>Springfield, MO</td>
<td>MO</td>
</tr>
<tr>
<td>SGU</td>
<td>St. George, UT</td>
<td>UT</td>
</tr>
<tr>
<td>SHV</td>
<td>Shreveport, LA</td>
<td>LA</td>
</tr>
<tr>
<td>SIT</td>
<td>Sitka, AK</td>
<td>AK</td>
</tr>
<tr>
<td>SJC</td>
<td>San Jose, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SJT</td>
<td>San Angelo, TX</td>
<td>TX</td>
</tr>
<tr>
<td>SJU</td>
<td>San Juan, PR</td>
<td>PR</td>
</tr>
<tr>
<td>SLC</td>
<td>Salt Lake City, UT</td>
<td>UT</td>
</tr>
<tr>
<td>SMF</td>
<td>Sacramento, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SMX</td>
<td>Santa Maria, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SNA</td>
<td>Santa Ana, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SPI</td>
<td>Springfield, IL</td>
<td>IL</td>
</tr>
<tr>
<td>SPS</td>
<td>Wichita Falls, TX</td>
<td>TX</td>
</tr>
<tr>
<td>SRQ</td>
<td>Sarasota/Bradenton, FL</td>
<td>FL</td>
</tr>
<tr>
<td>STL</td>
<td>St. Louis, MO</td>
<td>MO</td>
</tr>
<tr>
<td>STT</td>
<td>Charlotte Amalie, VI</td>
<td>VI</td>
</tr>
<tr>
<td>STX</td>
<td>Christiansted, VI</td>
<td>VI</td>
</tr>
<tr>
<td>SUN</td>
<td>Sun Valley/Hailey/Ketchum, ID</td>
<td>ID</td>
</tr>
<tr>
<td>SXU</td>
<td>Sioux City, IA</td>
<td>IA</td>
</tr>
<tr>
<td>SWF</td>
<td>Newburgh/Poughkeepsie, NY</td>
<td>NY</td>
</tr>
<tr>
<td>SYR</td>
<td>Syracuse, NY</td>
<td>NY</td>
</tr>
<tr>
<td>TLH</td>
<td>Tallahassee, FL</td>
<td>FL</td>
</tr>
<tr>
<td>TOL</td>
<td>Toledo, OH</td>
<td>OH</td>
</tr>
<tr>
<td>TPA</td>
<td>Tampa, FL</td>
<td>FL</td>
</tr>
<tr>
<td>TRI</td>
<td>Bristol/Johnson City/Kingsport, TN</td>
<td>TN</td>
</tr>
<tr>
<td>TTN</td>
<td>Trenton, NJ</td>
<td>NJ</td>
</tr>
<tr>
<td>TUL</td>
<td>Tulsa, OK</td>
<td>OK</td>
</tr>
<tr>
<td>TUS</td>
<td>Tucson, AZ</td>
<td>AZ</td>
</tr>
<tr>
<td>TVC</td>
<td>Traverse City, MI</td>
<td>MI</td>
</tr>
<tr>
<td>TWF</td>
<td>Twin Falls, ID</td>
<td>ID</td>
</tr>
</tbody>
</table>
### Instructions

Once you have loaded the data sets into a new app in Qlik Sense, you can begin building your map. To make the example map, you must complete the following tasks:

1. Create the drill-down dimensions.
2. Add the map to our sheet.
3. Add the *State-County* area layer.
4. Add the *State-City* point layer.
5. Add the *State-Airport* point layer.
6. Add the *Resource* filter pane.

#### Creating the drill-down dimensions

First, you need to create three drill-down dimensions. This will create the relationships between *State* and the fields *County*, *City*, and *Airport*, enabling the *County*, *City*, and *Airport* layers to become visible after a state from the *State* layer has been selected.

#### Do the following:

1. In sheet view, click ![Edit sheet](image) in the toolbar.
2. Click ![Add](image) to display the master items.
3. Click **Dimensions**.
4. Click **Create new**.
5. Select **Drill-down**.
6. Add the field *State* to the dimension.
7. Add the field *County* to the dimension.
8. After **Name**, type *State-County*.
9. Click **Create**.
10. Add the field *State* to the dimension.
11. Add the field *City* to the dimension.
12. After *Name*, type *State-City*.
13. Click Create..
14. Add the field *State* to the dimension.
15. Add the field *Airport* to the dimension.
16. After *Name*, type *State-Airport*.
17. Click Create..
18. Click ✔ Done editing.

Adding the map to the sheet

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
2. From the assets panel, drag an empty map to the sheet.

Adding the *State-County* area layer

Do the following:

1. From Layers in the properties panel, click Add layer.
2. Select Area layer.
3. In Dimensions, click Add and select *State-County*.
4. Click Location.
5. Set Scope for locations to Custom.
6. After Country, enter ‘USA’.
7. After Administrative area (Level 1), select State.
8. Click Colors.
9. Set Colors to Custom, select By dimension, and select 100 colors.
10. Select Persistent colors.
11. Adjust the Opacity slider to half opacity.
12. Click ✔ Done editing.

Adding the *State-City* point layer

The next layer you add is a point layer. You add *State-City* as the dimension and then set the country as ‘USA’ and then set *State* as the first-level administrative area, as some counties cities in different states have the same names.
Do the following:

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Area layer**.
3. In **Dimensions**, click **Add** and select **State-City**.
4. Click **Location**.
5. Set **Scope for locations** to **Custom**.
6. After **Country**, enter 'USA'.
7. After **Administrative area (Level 1)**, select **State**.
8. Click **Colors**.
9. Set **Colors** to **Custom**, select **Single color**, and select a color.
10. Click **Options**.
11. In **Layer** display, set **Visible drill-down levels** to **Custom**.
12. Clear **State**.
13. Click ✔️ **Done editing**.

**Adding the State-Airport point layer**

The final layer you add to the map is a point layer to which you add the **State-Airport** field as the dimension. Qlik Sense recognizes IATA codes for placement, ensuring the airports are located in their actual position rather than just in their city.

Do the following:

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Area layer**.
3. In **Dimensions**, click **Add** and select **State-Airport**.
4. Click **Location**.
5. Set **Scope for locations** to **Custom**.
6. After **Country**, enter 'USA'.
7. After **Administrative area (Level 1)**, select **State**.
8. Click **Size & Shape**.
9. From **Shape**, select **Triangle**.
10. Click **Colors**.
11. Set **Colors** to **Custom**, select **Single color**, and select a color.
12. Click **Options**.
13. In **Layer** display, set **Visible drill-down levels** to **Custom**.
14. Clear **State**.
15. Click ✔️ **Done editing**.
Add the **Resource** filter pane

Finally, you can optionally add a filter pane containing the field *Resource*. This provides you with a list of the available historical sites as you make selections within your map.

**Do the following:**

1. In the assets panel, drag and drop a filter pane into the sheet.
2. Click **Add dimension**.
3. Add a filter pane containing the field *Resource*.

**Creating a map with multiple background layers**

You can use multiple background layers in a map chart. This enables you to create layered base maps for your map chart data.

Some WMS sources include layers with transparency. With these sources, you can overlay the WMS background layer on top of a base map or other layers. Images can also be placed over other background layers. This enables you to create more complex base maps for your data.

> **Whether or not an WMS transparency layer supports transparency is dependent on the WMS source.**

In this map example, a custom TMS is used in a background layer. Two WMS background layers are placed on top, using WMS endpoints from the National Ocean and Atmospheric Administration. The first contains sea temperature data. The second contains 24-hour rainfall data. A point layer containing cities is overlaid these background layers.

*Map chart with a point layer overlaid on a TMS background layer and two WMS background layers*
Dataset

This example uses a single table for data, *Cities*, with an external TMS and WMS data from external sources. You can import the two tables into your app using the web file connector.

### Cities

<table>
<thead>
<tr>
<th>Cities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Albany, New York</td>
</tr>
<tr>
<td>Annapolis, Maryland</td>
</tr>
<tr>
<td>Atlanta, Georgia</td>
</tr>
<tr>
<td>Augusta, Maine</td>
</tr>
<tr>
<td>Austin, Texas</td>
</tr>
<tr>
<td>Baton Rouge, Louisiana</td>
</tr>
<tr>
<td>Bismarck, North Dakota</td>
</tr>
<tr>
<td>Boise, Idaho</td>
</tr>
<tr>
<td>Boston, Massachusetts</td>
</tr>
<tr>
<td>Carson City, Nevada</td>
</tr>
<tr>
<td>Charleston, West Virginia</td>
</tr>
<tr>
<td>Cheyenne, Wyoming</td>
</tr>
<tr>
<td>Cities</td>
</tr>
<tr>
<td>----------------------------</td>
</tr>
<tr>
<td>Columbia, South Carolina</td>
</tr>
<tr>
<td>Columbus, Ohio</td>
</tr>
<tr>
<td>Concord, New Hampshire</td>
</tr>
<tr>
<td>Denver, Colorado</td>
</tr>
<tr>
<td>Des Moines, Iowa</td>
</tr>
<tr>
<td>Dover, Delaware</td>
</tr>
<tr>
<td>Frankfort, Kentucky</td>
</tr>
<tr>
<td>Harrisburg, Pennsylvania</td>
</tr>
<tr>
<td>Hartford, Connecticut</td>
</tr>
<tr>
<td>Helena, Montana</td>
</tr>
<tr>
<td>Honolulu, Hawaii</td>
</tr>
<tr>
<td>Indianapolis, Indiana</td>
</tr>
<tr>
<td>Jackson, Mississippi</td>
</tr>
<tr>
<td>Jefferson City, Missouri</td>
</tr>
<tr>
<td>Juneau, Alaska</td>
</tr>
<tr>
<td>Lansing, Michigan</td>
</tr>
<tr>
<td>Lincoln, Nebraska</td>
</tr>
<tr>
<td>Little Rock, Arkansas</td>
</tr>
<tr>
<td>Madison, Wisconsin</td>
</tr>
<tr>
<td>Montgomery, Alabama</td>
</tr>
<tr>
<td>Montpelier, Vermont</td>
</tr>
<tr>
<td>Nashville, Tennessee</td>
</tr>
<tr>
<td>Oklahoma City, Oklahoma</td>
</tr>
<tr>
<td>Olympia, Washington</td>
</tr>
<tr>
<td>Phoenix, Arizona</td>
</tr>
<tr>
<td>Pierre, South Dakota</td>
</tr>
<tr>
<td>Providence, Rhode Island</td>
</tr>
<tr>
<td>Raleigh, North Carolina</td>
</tr>
<tr>
<td>Richmond, Virginia</td>
</tr>
<tr>
<td>Sacramento, California</td>
</tr>
</tbody>
</table>

Create apps and visualizations - Qlik Sense, February 2021

283
Cities
Saint Paul, Minnesota
Salem, Oregon
Salt Lake City, Utah
Santa Fe, New Mexico
Springfield, Illinois
Tallahassee, Florida
Topeka, Kansas
Trenton, New Jersey

How I built this

This example adds layers so that they are layered on top of each other in the final order. If you add these layers in a different order, you click and drag layers into the correct order you want in Layers.

Do the following:

1. Add the table Cities to your app. You can copy and paste the table using manual entry or you can import the table into your app using the web file connector.
2. In a sheet, add a map chart.
3. In Map settings, set Base map to None.
4. Add a background layer and do the following:
   - In Data, do the following:
     - For Format, select TMS.
     - For URL, enter https://a.tile.openstreetmap.org/$z/$x/$y.png.
     - For Attribution, enter © OpenStreetMap contributors.
   - In Options, do the following:
     - Set Show legend to None.
5. Add a background layer and do the following:
   - For Label, enter Sea Surface Water Temperature - Global.
   - For Format, select WMS and click WMS setup. Do the following:
     - For WMS server URL, enter https://nowcoast.noaa.gov/arcgis/services/nowcoast/analysis_ocean_sfc_sst_time/MapServer/WMSServer.
     - For Version, select 1.3.0.
     - Click Load WMS.
In Step 2 (Settings), select the first Image layer.

Click Save.

For Attribution, enter NOAA/NOS/OCS nowCOAST, NOAA/NWS/NCEP, and NASA/MSFC/ESO/SPoRT.

6. Add a background layer and do the following:

   - For Label, enter 24-Hr Quantitative Precipitation Accumulation (inches).
   - For Format, select WMS and click WMS setup. Do the following:
     - For WMS server URL, enter https://nowcoast.noaa.gov/arcgis/services/nowcoast/analysis_meteohydro_sfc_qpe_time/MapServer/WMSServer.
     - For Version, select 1.3.0.
     - Click Load WMS.
     - In Step 2 (Settings), under layers, select the third Image layer.
     - Click Save.
     - For Attribution, enter NOAA/NOS/OCS nowCOAST, NOAA/NWS, and NOAA/OAR/NSSL.

7. Add a point layer and do the following:

   - In Data, add Cities as the dimension.
   - In Location, do the following:
     - Set Scope for locations to Custom.
     - Set Country to 'USA'.
   - In Colors, set Colors to Custom and set Color to f93f17.

Creating a map with an image background layer

You can use images as custom base maps in map visualizations. You may want to display data over a floor plan.

This example map chart displays an office floor plan with a point layer. Each bubble is positioned over an employee's desk. The weekly average of customer issues handled per day by the employee determines the size and color of each bubble.

Map example with floor plan image background with a point layer showing employees sized by the number of customer issues they have resolved
This example hides the default scale. Images do not have a consistent size scale. Image size in a map background layer is also dependent on what coordinates the user sets for the corners of the image.

Dataset
This example uses two tables and a background image. You can import the two tables into your app using the web file connector.

CustomerIssues

<table>
<thead>
<tr>
<th>Date</th>
<th>EmployeeNumber</th>
<th>CustomerIssues</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/1/2019</td>
<td>1</td>
<td>24</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>2</td>
<td>31</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>3</td>
<td>21</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>4</td>
<td>42</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>5</td>
<td>24</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>6</td>
<td>40</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>7</td>
<td>40</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>8</td>
<td>19</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>9</td>
<td>23</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>10</td>
<td>47</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>11</td>
<td>38</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>12</td>
<td>21</td>
</tr>
<tr>
<td>Date</td>
<td>EmployeeNumber</td>
<td>CustomerIssues</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>13</td>
<td>22</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>14</td>
<td>15</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>15</td>
<td>30</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>16</td>
<td>46</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>17</td>
<td>41</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>18</td>
<td>31</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>19</td>
<td>50</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>20</td>
<td>27</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>21</td>
<td>35</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>22</td>
<td>38</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>23</td>
<td>37</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>24</td>
<td>31</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>25</td>
<td>13</td>
</tr>
<tr>
<td>8/1/2019</td>
<td>26</td>
<td>11</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>1</td>
<td>35</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>2</td>
<td>31</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>3</td>
<td>33</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>4</td>
<td>14</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>5</td>
<td>24</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>6</td>
<td>33</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>7</td>
<td>40</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>8</td>
<td>14</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>9</td>
<td>44</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>10</td>
<td>24</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>11</td>
<td>37</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>12</td>
<td>39</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>13</td>
<td>49</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>14</td>
<td>16</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>15</td>
<td>42</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>16</td>
<td>13</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>17</td>
<td>45</td>
</tr>
<tr>
<td>Date</td>
<td>EmployeeNumber</td>
<td>CustomerIssues</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>18</td>
<td>48</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>19</td>
<td>46</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>20</td>
<td>18</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>21</td>
<td>18</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>22</td>
<td>45</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>23</td>
<td>47</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>24</td>
<td>31</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>25</td>
<td>10</td>
</tr>
<tr>
<td>8/2/2019</td>
<td>26</td>
<td>21</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>1</td>
<td>16</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>2</td>
<td>34</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>3</td>
<td>15</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>4</td>
<td>44</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>5</td>
<td>49</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>6</td>
<td>18</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>7</td>
<td>16</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>8</td>
<td>41</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>9</td>
<td>27</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>10</td>
<td>46</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>11</td>
<td>21</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>12</td>
<td>49</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>13</td>
<td>38</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>14</td>
<td>30</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>15</td>
<td>48</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>16</td>
<td>17</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>17</td>
<td>42</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>18</td>
<td>48</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>19</td>
<td>44</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>20</td>
<td>44</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>21</td>
<td>12</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>22</td>
<td>44</td>
</tr>
</tbody>
</table>
3 Visualizations

<table>
<thead>
<tr>
<th>Date</th>
<th>EmployeeNumber</th>
<th>CustomerIssues</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/3/2019</td>
<td>23</td>
<td>17</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>8/3/2019</td>
<td>26</td>
<td>33</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>1</td>
<td>20</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>2</td>
<td>45</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>3</td>
<td>32</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>4</td>
<td>37</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>5</td>
<td>32</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>6</td>
<td>50</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>7</td>
<td>41</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>8</td>
<td>14</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>9</td>
<td>37</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>10</td>
<td>39</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>11</td>
<td>28</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>12</td>
<td>35</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>13</td>
<td>24</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>14</td>
<td>19</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>15</td>
<td>25</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>16</td>
<td>26</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>17</td>
<td>23</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>18</td>
<td>45</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>19</td>
<td>48</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>20</td>
<td>36</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>21</td>
<td>40</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>22</td>
<td>21</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>23</td>
<td>10</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>24</td>
<td>42</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>25</td>
<td>35</td>
</tr>
<tr>
<td>8/4/2019</td>
<td>26</td>
<td>26</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>1</td>
<td>24</td>
</tr>
</tbody>
</table>

Create apps and visualizations - Qlik Sense, February 2021 289
<table>
<thead>
<tr>
<th>Date</th>
<th>EmployeeNumber</th>
<th>CustomerIssues</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/5/2019</td>
<td>2</td>
<td>28</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>3</td>
<td>44</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>4</td>
<td>19</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>5</td>
<td>34</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>6</td>
<td>37</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>7</td>
<td>14</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>8</td>
<td>26</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>9</td>
<td>38</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>10</td>
<td>25</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>11</td>
<td>41</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>12</td>
<td>35</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>13</td>
<td>48</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>14</td>
<td>36</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>15</td>
<td>36</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>16</td>
<td>37</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>17</td>
<td>31</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>18</td>
<td>44</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>19</td>
<td>21</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>20</td>
<td>28</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>21</td>
<td>13</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>22</td>
<td>10</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>24</td>
<td>35</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>25</td>
<td>11</td>
</tr>
<tr>
<td>8/5/2019</td>
<td>26</td>
<td>39</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>1</td>
<td>26</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>2</td>
<td>14</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>3</td>
<td>45</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>4</td>
<td>27</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>5</td>
<td>33</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>6</td>
<td>21</td>
</tr>
</tbody>
</table>
## Visualizations

<table>
<thead>
<tr>
<th>Date</th>
<th>EmployeeNumber</th>
<th>CustomerIssues</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/6/2019</td>
<td>7</td>
<td>14</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>8</td>
<td>45</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>9</td>
<td>41</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>10</td>
<td>35</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>11</td>
<td>35</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>12</td>
<td>13</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>13</td>
<td>35</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>14</td>
<td>26</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>15</td>
<td>40</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>16</td>
<td>14</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>17</td>
<td>20</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>18</td>
<td>23</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>19</td>
<td>11</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>20</td>
<td>23</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>21</td>
<td>31</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>22</td>
<td>48</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>23</td>
<td>39</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>24</td>
<td>50</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>25</td>
<td>47</td>
</tr>
<tr>
<td>8/6/2019</td>
<td>26</td>
<td>40</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>1</td>
<td>49</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>2</td>
<td>39</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>4</td>
<td>28</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>5</td>
<td>46</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>6</td>
<td>37</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>7</td>
<td>36</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>8</td>
<td>15</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>9</td>
<td>18</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>10</td>
<td>25</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>11</td>
<td>12</td>
</tr>
</tbody>
</table>
3 Visualizations

<table>
<thead>
<tr>
<th>Date</th>
<th>EmployeeNumber</th>
<th>CustomerIssues</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/7/2019</td>
<td>12</td>
<td>37</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>13</td>
<td>40</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>14</td>
<td>35</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>16</td>
<td>12</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>18</td>
<td>16</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>19</td>
<td>46</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>20</td>
<td>39</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>21</td>
<td>41</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>22</td>
<td>26</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>23</td>
<td>25</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>24</td>
<td>34</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>25</td>
<td>50</td>
</tr>
<tr>
<td>8/7/2019</td>
<td>26</td>
<td>41</td>
</tr>
</tbody>
</table>

EmployeeData

<table>
<thead>
<tr>
<th>Employee</th>
<th>EmployeeNumber</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nehru Pollard</td>
<td>1</td>
<td>2.1</td>
<td>-2.1</td>
</tr>
<tr>
<td>Duncan Bell</td>
<td>2</td>
<td>1.675</td>
<td>-2.1</td>
</tr>
<tr>
<td>Arthur Miller</td>
<td>3</td>
<td>2.1</td>
<td>-1.6</td>
</tr>
<tr>
<td>Latifah Randall</td>
<td>4</td>
<td>1.675</td>
<td>-1.6</td>
</tr>
<tr>
<td>Glenna Giles</td>
<td>5</td>
<td>2.1</td>
<td>-1.1</td>
</tr>
<tr>
<td>Chaim Gates</td>
<td>6</td>
<td>1.675</td>
<td>-1.1</td>
</tr>
<tr>
<td>Elijah Mcgowan</td>
<td>7</td>
<td>2.1</td>
<td>-0.585</td>
</tr>
<tr>
<td>Serina Richards</td>
<td>8</td>
<td>1.675</td>
<td>-0.585</td>
</tr>
<tr>
<td>Nora Odonnell</td>
<td>9</td>
<td>2.1</td>
<td>0.595</td>
</tr>
<tr>
<td>Fiona Craig</td>
<td>10</td>
<td>1.675</td>
<td>0.595</td>
</tr>
<tr>
<td>Kirestin Mcguire</td>
<td>11</td>
<td>2.1</td>
<td>1.155</td>
</tr>
<tr>
<td>Francesca Wilkerson</td>
<td>12</td>
<td>1.675</td>
<td>1.155</td>
</tr>
<tr>
<td>Virginia Sanford</td>
<td>13</td>
<td>2.1</td>
<td>1.6</td>
</tr>
</tbody>
</table>

Create apps and visualizations - Qlik Sense, February 2021 292
### 3 Visualizations

<table>
<thead>
<tr>
<th>Employee</th>
<th>EmployeeNumber</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beau Weeks</td>
<td>14</td>
<td>1.675</td>
<td>1.6</td>
</tr>
<tr>
<td>Justin Cook</td>
<td>15</td>
<td>2.1</td>
<td>2.2</td>
</tr>
<tr>
<td>Lisandra Sloan</td>
<td>16</td>
<td>1.675</td>
<td>2.2</td>
</tr>
<tr>
<td>Brody Ball</td>
<td>17</td>
<td>2.1</td>
<td>2.6</td>
</tr>
<tr>
<td>Kirk Welch</td>
<td>18</td>
<td>1.675</td>
<td>2.6</td>
</tr>
<tr>
<td>Julian Mcgee</td>
<td>19</td>
<td>0.7</td>
<td>3.25</td>
</tr>
<tr>
<td>Geoffrey Wheeler</td>
<td>20</td>
<td>0.7</td>
<td>3.7</td>
</tr>
<tr>
<td>Carter Leonard</td>
<td>21</td>
<td>0.14</td>
<td>3.25</td>
</tr>
<tr>
<td>Noel Watson</td>
<td>22</td>
<td>0.14</td>
<td>3.7</td>
</tr>
<tr>
<td>Damian Everett</td>
<td>23</td>
<td>-0.3</td>
<td>3.25</td>
</tr>
<tr>
<td>Justina Frazier</td>
<td>24</td>
<td>-0.3</td>
<td>3.7</td>
</tr>
<tr>
<td>MacKenzie Garcia</td>
<td>25</td>
<td>-0.85</td>
<td>3.25</td>
</tr>
<tr>
<td>Germane Carey</td>
<td>26</td>
<td>-0.85</td>
<td>3.7</td>
</tr>
</tbody>
</table>

**Background image**

*Example background image*
How I built this

Do the following:

1. Add the data sources to your app and associate the tables using the EmployeeNumber fields in each table.
2. In a sheet, add a map chart.
3. In Map settings, do the following:
   - Change Base map to None.
   - Change Projection to User defined (degrees).
4. In Appearance > Presentation, do the following:
   - Toggle the Scale bar to Off.
   - Set Limit zoom levels to Custom and set the zoom to 7x zoom - 8x zoom.
5. Add a background layer to the map chart and in Data, do the following:
   - In Format, select Image.
   - Set the Top left corner to 2.5 for Top (latitude) and -4.1 for Left (longitude).
   - Set the Bottom right corner to -2.5 for Bottom (latitude) and 4.1 for Right (longitude).
6. Add a point layer to the map chart and do the following:
   - In Data, add Employee as the field.
   - In Location, select Latitude and longitude fields. Set Lat as the Latitude field and Long as the Longitude field.
   - In Size & Shape, set Size by Avg(CustomerIssues).
   - In Color, do the following:
     - Set Color to Custom and color By measure.
     - Select Avg(CustomerIssues) as the measure.
     - Select Diverging classes as the color scheme.

Creating a map focused on a region

You can configure your map charts to stay focused on a region of interest, such as a country. You can also set the minimum and maximum zoom levels of your map. This controls how far the Qlik Sense zooms into the map when you make selections.

The following example explains how to make a map with the focus locked on a single region and with a custom maximum zoom level.

The map chart with panning limited to just the region of interest
This map has set a pan limit so users cannot pan the focus of the map visualization away from the region of interest. Users can drill down between separate map layers, but they cannot scroll outside of the initial view.

This map visualization uses a point layer and an area layer with two drill-down dimensions. One drill-down dimension enables the area layer to display counties after states are selected. The other drill-down dimension enables the point layer to display cities as a points after a state is selected in the area layer.

A zoom limit is applied to the map chart. When a state is selected in the area layer, the map drills down to display the counties in the area layer and the cities in a separate point layer. The map remains zoomed a level appropriate for a general regional overview.

A map chart with a state selection applied

Dataset
This example uses two sets of data. You must import this data into Qlik Sense. You can add the data to a spreadsheet and import it into Qlik Sense. You can also import the table from this help page as a web file.
### City data

<table>
<thead>
<tr>
<th>City</th>
<th>City Code</th>
<th>County</th>
<th>State</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>1</td>
<td>New York County</td>
<td>US</td>
<td>40.730599</td>
<td>-73.986581</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>2</td>
<td>Los Angeles County</td>
<td>CA</td>
<td>34.053678</td>
<td>-118.242702</td>
</tr>
<tr>
<td>Chicago</td>
<td>3</td>
<td>Cook County</td>
<td>IL</td>
<td>41.875555</td>
<td>-87.624421</td>
</tr>
<tr>
<td>Philadelphia</td>
<td>5</td>
<td>Philadelphia County</td>
<td>PA</td>
<td>39.952335</td>
<td>-75.163789</td>
</tr>
<tr>
<td>Phoenix</td>
<td>6</td>
<td>Maricopa County</td>
<td>AZ</td>
<td>33.446768</td>
<td>-112.075672</td>
</tr>
<tr>
<td>San Antonio</td>
<td>7</td>
<td>Bexar County</td>
<td>TX</td>
<td>29.4246</td>
<td>-98.49514</td>
</tr>
<tr>
<td>San Diego</td>
<td>8</td>
<td>San Diego County</td>
<td>CA</td>
<td>32.717421</td>
<td>-117.162771</td>
</tr>
<tr>
<td>Dallas</td>
<td>9</td>
<td>Dallas County</td>
<td>TX</td>
<td>32.776196</td>
<td>-96.796899</td>
</tr>
<tr>
<td>San Jose</td>
<td>10</td>
<td>Santa Clara County</td>
<td>CA</td>
<td>37.34385</td>
<td>-121.883135</td>
</tr>
<tr>
<td>Austin</td>
<td>11</td>
<td>Travis County</td>
<td>TX</td>
<td>30.271129</td>
<td>-97.7437</td>
</tr>
<tr>
<td>Indianapolis</td>
<td>12</td>
<td>Marion County</td>
<td>IN</td>
<td>39.76838</td>
<td>-86.158045</td>
</tr>
<tr>
<td>Jacksonville</td>
<td>13</td>
<td>Duval County</td>
<td>FL</td>
<td>30.332184</td>
<td>-81.655651</td>
</tr>
<tr>
<td>Columbus</td>
<td>15</td>
<td>Franklin County</td>
<td>OH</td>
<td>39.96226</td>
<td>-83.000706</td>
</tr>
<tr>
<td>Charlotte</td>
<td>16</td>
<td>Mecklenburg County</td>
<td>NC</td>
<td>35.227087</td>
<td>-80.843127</td>
</tr>
<tr>
<td>Detroit</td>
<td>17</td>
<td>Wayne County</td>
<td>MI</td>
<td>42.348664</td>
<td>-83.056738</td>
</tr>
<tr>
<td>Memphis</td>
<td>18</td>
<td>Shelby County</td>
<td>TN</td>
<td>35.149022</td>
<td>-90.051628</td>
</tr>
<tr>
<td>Seattle</td>
<td>19</td>
<td>King County</td>
<td>WA</td>
<td>47.603832</td>
<td>-122.330062</td>
</tr>
<tr>
<td>Denver</td>
<td>20</td>
<td>Denver County</td>
<td>CO</td>
<td>39.739154</td>
<td>-104.984703</td>
</tr>
<tr>
<td>Boston</td>
<td>22</td>
<td>Suffolk County</td>
<td>MA</td>
<td>42.360482</td>
<td>-71.059568</td>
</tr>
<tr>
<td>Nashville</td>
<td>23</td>
<td>Davidson County</td>
<td>TN</td>
<td>36.162226</td>
<td>-86.774342</td>
</tr>
<tr>
<td>Baltimore</td>
<td>24</td>
<td>Baltimore City County</td>
<td>MD</td>
<td>39.290861</td>
<td>-76.610807</td>
</tr>
<tr>
<td>Portland</td>
<td>25</td>
<td>Multnomah County</td>
<td>OR</td>
<td>45.520247</td>
<td>-122.674195</td>
</tr>
<tr>
<td>Las Vegas</td>
<td>26</td>
<td>Clark County</td>
<td>NV</td>
<td>36.166286</td>
<td>-115.149225</td>
</tr>
<tr>
<td>Milwaukee</td>
<td>27</td>
<td>Milwaukee County</td>
<td>WI</td>
<td>43.034993</td>
<td>-87.922497</td>
</tr>
<tr>
<td>Albuquerque</td>
<td>28</td>
<td>Bernalillo County</td>
<td>NM</td>
<td>35.084103</td>
<td>-106.650985</td>
</tr>
<tr>
<td>Tucson</td>
<td>29</td>
<td>Pima County</td>
<td>AZ</td>
<td>32.221742</td>
<td>-110.926476</td>
</tr>
<tr>
<td>Fresno</td>
<td>30</td>
<td>Fresno County</td>
<td>CA</td>
<td>36.73082</td>
<td>-119.699202</td>
</tr>
<tr>
<td>Sacramento</td>
<td>31</td>
<td>Sacramento County</td>
<td>CA</td>
<td>38.581572</td>
<td>-121.4944</td>
</tr>
</tbody>
</table>
3 Visualizations

<table>
<thead>
<tr>
<th>City</th>
<th>City Code</th>
<th>County</th>
<th>State</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kansas City</td>
<td>32</td>
<td>Jackson County</td>
<td>MO</td>
<td>39.084469</td>
<td>-94.56303</td>
</tr>
<tr>
<td>Colorado Springs</td>
<td>33</td>
<td>El Paso County</td>
<td>CO</td>
<td>38.833958</td>
<td>-104.825348</td>
</tr>
<tr>
<td>Atlanta</td>
<td>34</td>
<td>Fulton County</td>
<td>GA</td>
<td>33.749099</td>
<td>-84.390185</td>
</tr>
<tr>
<td>Omaha</td>
<td>35</td>
<td>Douglas County</td>
<td>NE</td>
<td>41.258732</td>
<td>-95.937873</td>
</tr>
<tr>
<td>Raleigh</td>
<td>36</td>
<td>Wake County</td>
<td>NC</td>
<td>35.780402</td>
<td>-78.639078</td>
</tr>
<tr>
<td>Miami</td>
<td>37</td>
<td>Miami-Dade County</td>
<td>FL</td>
<td>25.774266</td>
<td>-80.193659</td>
</tr>
<tr>
<td>Minneapolis</td>
<td>38</td>
<td>Hennepin County</td>
<td>MN</td>
<td>44.9773</td>
<td>-93.265469</td>
</tr>
<tr>
<td>Tulsa</td>
<td>39</td>
<td>Tulsa County</td>
<td>OK</td>
<td>36.152436</td>
<td>-95.990409</td>
</tr>
<tr>
<td>Cleveland</td>
<td>40</td>
<td>Cuyahoga County</td>
<td>OH</td>
<td>41.505161</td>
<td>-81.693445</td>
</tr>
<tr>
<td>New Orleans</td>
<td>41</td>
<td>Orleans Parish</td>
<td>LA</td>
<td>29.949932</td>
<td>-90.070116</td>
</tr>
</tbody>
</table>

Customer

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Superior System</td>
<td>10000453</td>
<td>1</td>
</tr>
<tr>
<td>Beech Aircraft Corporation</td>
<td>10003882</td>
<td>1</td>
</tr>
<tr>
<td>Deere and Company</td>
<td>10009863</td>
<td>1</td>
</tr>
<tr>
<td>Gailey Enterprises</td>
<td>10012851</td>
<td>1</td>
</tr>
<tr>
<td>J.A. Bauer Pottery Company</td>
<td>10017852</td>
<td>1</td>
</tr>
<tr>
<td>Old Towne Creations</td>
<td>10020715</td>
<td>1</td>
</tr>
<tr>
<td>Real World</td>
<td>10022755</td>
<td>1</td>
</tr>
<tr>
<td>ValueClick</td>
<td>10025878</td>
<td>1</td>
</tr>
<tr>
<td>A&amp;G</td>
<td>10000457</td>
<td>2</td>
</tr>
<tr>
<td>Bell Canada Enterprises</td>
<td>10004207</td>
<td>2</td>
</tr>
<tr>
<td>Échange CAC Exchange</td>
<td>10010832</td>
<td>2</td>
</tr>
<tr>
<td>Gainunion</td>
<td>10012885</td>
<td>2</td>
</tr>
<tr>
<td>J.M. Haggar</td>
<td>10018129</td>
<td>2</td>
</tr>
<tr>
<td>OnDeck Systems</td>
<td>10020849</td>
<td>2</td>
</tr>
<tr>
<td>Reflex Presentations</td>
<td>10022962</td>
<td>2</td>
</tr>
<tr>
<td>Wasabi</td>
<td>10026294</td>
<td>2</td>
</tr>
<tr>
<td>Aadast</td>
<td>10000471</td>
<td>3</td>
</tr>
</tbody>
</table>
### Customer

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bendix Corporation</td>
<td>10004255</td>
<td>3</td>
</tr>
<tr>
<td>ECI com</td>
<td>10010855</td>
<td>3</td>
</tr>
<tr>
<td>Galaxy Marketing Associates</td>
<td>10012907</td>
<td>3</td>
</tr>
<tr>
<td>Johnson and Higgins</td>
<td>10018352</td>
<td>3</td>
</tr>
<tr>
<td>One Planet Solutions</td>
<td>10020864</td>
<td>3</td>
</tr>
<tr>
<td>Relcom</td>
<td>10022978</td>
<td>3</td>
</tr>
<tr>
<td>Wayne's World</td>
<td>10026334</td>
<td>3</td>
</tr>
<tr>
<td>ABI TruTrac</td>
<td>10000488</td>
<td>5</td>
</tr>
<tr>
<td>Best Way! Imaging</td>
<td>10004602</td>
<td>5</td>
</tr>
<tr>
<td>Ed Stefanov</td>
<td>10010881</td>
<td>5</td>
</tr>
<tr>
<td>Gamacles</td>
<td>10013011</td>
<td>5</td>
</tr>
<tr>
<td>Joy Line</td>
<td>10018371</td>
<td>5</td>
</tr>
<tr>
<td>Onebox</td>
<td>10020907</td>
<td>5</td>
</tr>
<tr>
<td>SageGroup</td>
<td>10023511</td>
<td>5</td>
</tr>
<tr>
<td>VEI</td>
<td>10026023</td>
<td>5</td>
</tr>
<tr>
<td>AboveNet</td>
<td>10000496</td>
<td>6</td>
</tr>
<tr>
<td>Bezeq</td>
<td>10005043</td>
<td>6</td>
</tr>
<tr>
<td>EDA Today</td>
<td>10010882</td>
<td>6</td>
</tr>
<tr>
<td>Gamma One Conversions</td>
<td>10013039</td>
<td>6</td>
</tr>
<tr>
<td>K</td>
<td>10018518</td>
<td>6</td>
</tr>
<tr>
<td>Keystroke Quality</td>
<td>10019420</td>
<td>6</td>
</tr>
<tr>
<td>Outsource Documents</td>
<td>10020982</td>
<td>6</td>
</tr>
<tr>
<td>PAGE</td>
<td>10021240</td>
<td>6</td>
</tr>
<tr>
<td>Sarcom</td>
<td>10023703</td>
<td>6</td>
</tr>
<tr>
<td>Systems of Missouri</td>
<td>10024915</td>
<td>6</td>
</tr>
<tr>
<td>Velos Medical Informatics</td>
<td>10026038</td>
<td>6</td>
</tr>
<tr>
<td>Abplus</td>
<td>10000497</td>
<td>7</td>
</tr>
<tr>
<td>BF Datacom</td>
<td>10005099</td>
<td>7</td>
</tr>
<tr>
<td>Edmark</td>
<td>10010923</td>
<td>7</td>
</tr>
<tr>
<td>GammaGraphX (GGX)</td>
<td>10013052</td>
<td>7</td>
</tr>
</tbody>
</table>
# Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>K&amp;K Enterprises</td>
<td>10018603</td>
<td>7</td>
</tr>
<tr>
<td>Overdreams</td>
<td>10021006</td>
<td>7</td>
</tr>
<tr>
<td>SAS Institute</td>
<td>10023757</td>
<td>7</td>
</tr>
<tr>
<td>Ventana’s Group</td>
<td>10026081</td>
<td>7</td>
</tr>
<tr>
<td>ABSolute</td>
<td>10000499</td>
<td>8</td>
</tr>
<tr>
<td>BH Feldman Consulting</td>
<td>10005236</td>
<td>8</td>
</tr>
<tr>
<td>Elbit Oy</td>
<td>10010990</td>
<td>8</td>
</tr>
<tr>
<td>Gammel Group</td>
<td>10013061</td>
<td>8</td>
</tr>
<tr>
<td>Karickal Exports</td>
<td>10018868</td>
<td>8</td>
</tr>
<tr>
<td>Owl's Eye Productions</td>
<td>10021015</td>
<td>8</td>
</tr>
<tr>
<td>SAT-SAGEM (usa)</td>
<td>10023780</td>
<td>8</td>
</tr>
<tr>
<td>White Oak Interactive</td>
<td>10026365</td>
<td>8</td>
</tr>
<tr>
<td>Absolute Magic</td>
<td>10000501</td>
<td>9</td>
</tr>
<tr>
<td>Bibb Manufacturing Company</td>
<td>10005376</td>
<td>9</td>
</tr>
<tr>
<td>Eloi Companies</td>
<td>10011018</td>
<td>9</td>
</tr>
<tr>
<td>Gandalf Systems</td>
<td>10013079</td>
<td>9</td>
</tr>
<tr>
<td>KAT Micro Distributing</td>
<td>10018877</td>
<td>9</td>
</tr>
<tr>
<td>P.C’S</td>
<td>10021111</td>
<td>9</td>
</tr>
<tr>
<td>Science Applications International (SAIC)</td>
<td>10023964</td>
<td>9</td>
</tr>
<tr>
<td>Xcert</td>
<td>10026521</td>
<td>9</td>
</tr>
<tr>
<td>Abstract</td>
<td>10000502</td>
<td>10</td>
</tr>
<tr>
<td>BidCast</td>
<td>10005620</td>
<td>10</td>
</tr>
<tr>
<td>Elucidex</td>
<td>10011052</td>
<td>10</td>
</tr>
<tr>
<td>Ganymede</td>
<td>10013080</td>
<td>10</td>
</tr>
<tr>
<td>Kendrick Jansen</td>
<td>10018950</td>
<td>10</td>
</tr>
<tr>
<td>P.C.G. Associates</td>
<td>10021107</td>
<td>10</td>
</tr>
<tr>
<td>Screen Digest</td>
<td>10024016</td>
<td>10</td>
</tr>
<tr>
<td>Xyratex</td>
<td>10026868</td>
<td>10</td>
</tr>
<tr>
<td>AC Exchange</td>
<td>10001103</td>
<td>11</td>
</tr>
<tr>
<td>Bien Logic</td>
<td>10005688</td>
<td>11</td>
</tr>
</tbody>
</table>
## 3 Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embedded Support Tools (EST)</td>
<td>10011089</td>
<td>11</td>
</tr>
<tr>
<td>Garbee and Garbee</td>
<td>10013127</td>
<td>11</td>
</tr>
<tr>
<td>Kennecott Copper Corporation</td>
<td>10018957</td>
<td>11</td>
</tr>
<tr>
<td>Pacific Bell</td>
<td>10021160</td>
<td>11</td>
</tr>
<tr>
<td>Smith Manufacturing Company</td>
<td>10024477</td>
<td>11</td>
</tr>
<tr>
<td>Yurie Systems</td>
<td>10027119</td>
<td>11</td>
</tr>
<tr>
<td>AC&amp;E</td>
<td>10001263</td>
<td>12</td>
</tr>
<tr>
<td>Acara</td>
<td>10001786</td>
<td>12</td>
</tr>
<tr>
<td>Big</td>
<td>10005810</td>
<td>12</td>
</tr>
<tr>
<td>Big Picture Technologies</td>
<td>10005919</td>
<td>12</td>
</tr>
<tr>
<td>EMC</td>
<td>10011093</td>
<td>12</td>
</tr>
<tr>
<td>Garlin Imports</td>
<td>10013137</td>
<td>12</td>
</tr>
<tr>
<td>KENROB and Associates</td>
<td>10019066</td>
<td>12</td>
</tr>
<tr>
<td>Packet Design</td>
<td>10021232</td>
<td>12</td>
</tr>
<tr>
<td>Sterling Armament Company</td>
<td>10024704</td>
<td>12</td>
</tr>
<tr>
<td>Zero G</td>
<td>10027370</td>
<td>12</td>
</tr>
<tr>
<td>Acacia</td>
<td>10001784</td>
<td>13</td>
</tr>
<tr>
<td>Big Mountain Multi</td>
<td>10005861</td>
<td>13</td>
</tr>
<tr>
<td>Emergency</td>
<td>10011286</td>
<td>13</td>
</tr>
<tr>
<td>Gate9th</td>
<td>10013312</td>
<td>13</td>
</tr>
<tr>
<td>Kerite Company</td>
<td>10019194</td>
<td>13</td>
</tr>
<tr>
<td>PADL</td>
<td>10021239</td>
<td>13</td>
</tr>
<tr>
<td>Sun Microsystems</td>
<td>10024880</td>
<td>13</td>
</tr>
<tr>
<td>AccTonec</td>
<td>10001818</td>
<td>15</td>
</tr>
<tr>
<td>Big Planet</td>
<td>10005922</td>
<td>15</td>
</tr>
<tr>
<td>Enterprises</td>
<td>10011355</td>
<td>15</td>
</tr>
<tr>
<td>Gatierf Publications</td>
<td>10013341</td>
<td>15</td>
</tr>
<tr>
<td>kGS</td>
<td>10019469</td>
<td>15</td>
</tr>
<tr>
<td>Page Marketing</td>
<td>10021242</td>
<td>15</td>
</tr>
<tr>
<td>T &amp; S</td>
<td>10024916</td>
<td>15</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accel Partners</td>
<td>10002114</td>
<td>16</td>
</tr>
<tr>
<td>Biz-comm</td>
<td>10006836</td>
<td>16</td>
</tr>
<tr>
<td>Equitable Life Assurance Society</td>
<td>10011360</td>
<td>16</td>
</tr>
<tr>
<td>GCC Technologies</td>
<td>10013376</td>
<td>16</td>
</tr>
<tr>
<td>KillerGraffix</td>
<td>10019502</td>
<td>16</td>
</tr>
<tr>
<td>Page Research</td>
<td>10021270</td>
<td>16</td>
</tr>
<tr>
<td>T.F.C.</td>
<td>10024918</td>
<td>16</td>
</tr>
<tr>
<td>Accent Interactive</td>
<td>10002115</td>
<td>17</td>
</tr>
<tr>
<td>Boott Cotton Mills Corporation</td>
<td>10006916</td>
<td>17</td>
</tr>
<tr>
<td>Farmland Industries</td>
<td>10011499</td>
<td>17</td>
</tr>
<tr>
<td>GDC</td>
<td>10013426</td>
<td>17</td>
</tr>
<tr>
<td>Kim Tom Co</td>
<td>10019512</td>
<td>17</td>
</tr>
<tr>
<td>PageBoy</td>
<td>10021283</td>
<td>17</td>
</tr>
<tr>
<td>T.J.T. International</td>
<td>10024919</td>
<td>17</td>
</tr>
<tr>
<td>Accent Systems</td>
<td>10002117</td>
<td>18</td>
</tr>
<tr>
<td>Borden Company</td>
<td>10006917</td>
<td>18</td>
</tr>
<tr>
<td>Farrell Lines Company</td>
<td>10011546</td>
<td>18</td>
</tr>
<tr>
<td>GEAR</td>
<td>10013538</td>
<td>18</td>
</tr>
<tr>
<td>Kimball (W.W.) Company</td>
<td>10019514</td>
<td>18</td>
</tr>
<tr>
<td>PagePoint</td>
<td>10021286</td>
<td>18</td>
</tr>
<tr>
<td>T.M. Denton Consultants</td>
<td>10024924</td>
<td>18</td>
</tr>
<tr>
<td>Access Point</td>
<td>10002128</td>
<td>19</td>
</tr>
<tr>
<td>Accidental</td>
<td>10002137</td>
<td>19</td>
</tr>
<tr>
<td>Boston and Albany Railroad Company</td>
<td>10006919</td>
<td>19</td>
</tr>
<tr>
<td>Bre-X</td>
<td>10007117</td>
<td>19</td>
</tr>
<tr>
<td>FCS</td>
<td>10011600</td>
<td>19</td>
</tr>
<tr>
<td>Federated Co-Operatives Limited</td>
<td>10011732</td>
<td>19</td>
</tr>
<tr>
<td>GearSource</td>
<td>10013572</td>
<td>19</td>
</tr>
<tr>
<td>Gehlken Enterprises</td>
<td>10013670</td>
<td>19</td>
</tr>
<tr>
<td>Levi Strauss and Company</td>
<td>10019783</td>
<td>19</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lobster Productions</td>
<td>10019952</td>
<td>19</td>
</tr>
<tr>
<td>PageSites</td>
<td>10021297</td>
<td>19</td>
</tr>
<tr>
<td>PageWeavers</td>
<td>10021302</td>
<td>19</td>
</tr>
<tr>
<td>T3West</td>
<td>10024930</td>
<td>19</td>
</tr>
<tr>
<td>Tag Systems</td>
<td>10024942</td>
<td>19</td>
</tr>
<tr>
<td>AccessWare</td>
<td>10002136</td>
<td>20</td>
</tr>
<tr>
<td>Brazilian Traction, Light and Power Company</td>
<td>10006977</td>
<td>20</td>
</tr>
<tr>
<td>Federal Express Corporation</td>
<td>10011623</td>
<td>20</td>
</tr>
<tr>
<td>Gebbie Press</td>
<td>10013574</td>
<td>20</td>
</tr>
<tr>
<td>Lewis Grocer Company</td>
<td>10019812</td>
<td>20</td>
</tr>
<tr>
<td>PageWave</td>
<td>10021300</td>
<td>20</td>
</tr>
<tr>
<td>Tadpole</td>
<td>10024940</td>
<td>20</td>
</tr>
<tr>
<td>ACCPAC International</td>
<td>10002138</td>
<td>22</td>
</tr>
<tr>
<td>Brentano's</td>
<td>10006983</td>
<td>22</td>
</tr>
<tr>
<td>FenP Innovators</td>
<td>10011821</td>
<td>22</td>
</tr>
<tr>
<td>Greymac Trust Company</td>
<td>10013870</td>
<td>22</td>
</tr>
<tr>
<td>Lucky</td>
<td>10020080</td>
<td>22</td>
</tr>
<tr>
<td>Pallister Management</td>
<td>10021305</td>
<td>22</td>
</tr>
<tr>
<td>Take 3</td>
<td>10025022</td>
<td>22</td>
</tr>
<tr>
<td>Accrue</td>
<td>10002139</td>
<td>23</td>
</tr>
<tr>
<td>C&amp;C</td>
<td>10007134</td>
<td>23</td>
</tr>
<tr>
<td>Fentek Industries</td>
<td>10011842</td>
<td>23</td>
</tr>
<tr>
<td>Grove Farm Co., Inc.</td>
<td>10013871</td>
<td>23</td>
</tr>
<tr>
<td>Market</td>
<td>10020181</td>
<td>23</td>
</tr>
<tr>
<td>Palo Alto</td>
<td>10021331</td>
<td>23</td>
</tr>
<tr>
<td>Talarian</td>
<td>10025024</td>
<td>23</td>
</tr>
<tr>
<td>Accton</td>
<td>10002140</td>
<td>24</td>
</tr>
<tr>
<td>C. Hoelzle Associates</td>
<td>10007163</td>
<td>24</td>
</tr>
<tr>
<td>Fenwick &amp; West</td>
<td>10011870</td>
<td>24</td>
</tr>
<tr>
<td>Grumman Corporation</td>
<td>10013899</td>
<td>24</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maui Island (MIC)</td>
<td>10020193</td>
<td>24</td>
</tr>
<tr>
<td>Panasonic</td>
<td>10021350</td>
<td>24</td>
</tr>
<tr>
<td>Target</td>
<td>10025052</td>
<td>24</td>
</tr>
<tr>
<td>AccuCom</td>
<td>10002142</td>
<td>25</td>
</tr>
<tr>
<td>C.O.F.</td>
<td>10007183</td>
<td>25</td>
</tr>
<tr>
<td>Ferrari</td>
<td>10011918</td>
<td>25</td>
</tr>
<tr>
<td>Guarantee Mutual Life Company</td>
<td>10014043</td>
<td>25</td>
</tr>
<tr>
<td>MaxBan</td>
<td>10020227</td>
<td>25</td>
</tr>
<tr>
<td>Pangaea Systems</td>
<td>10021380</td>
<td>25</td>
</tr>
<tr>
<td>Taroch</td>
<td>10025063</td>
<td>25</td>
</tr>
<tr>
<td>ACCUCOMP</td>
<td>10002144</td>
<td>26</td>
</tr>
<tr>
<td>C3 Development</td>
<td>10007253</td>
<td>26</td>
</tr>
<tr>
<td>FiberPlex</td>
<td>10011979</td>
<td>26</td>
</tr>
<tr>
<td>GURUs</td>
<td>10014059</td>
<td>26</td>
</tr>
<tr>
<td>MaXpeed</td>
<td>10020239</td>
<td>26</td>
</tr>
<tr>
<td>Panix</td>
<td>10021411</td>
<td>26</td>
</tr>
<tr>
<td>Tartanchase</td>
<td>10025086</td>
<td>26</td>
</tr>
<tr>
<td>AccuLAN</td>
<td>10002149</td>
<td>27</td>
</tr>
<tr>
<td>C3I</td>
<td>10007258</td>
<td>27</td>
</tr>
<tr>
<td>FICOM</td>
<td>10012023</td>
<td>27</td>
</tr>
<tr>
<td>H.H. Robertson Company</td>
<td>10014064</td>
<td>27</td>
</tr>
<tr>
<td>MAXSTRAT</td>
<td>10020247</td>
<td>27</td>
</tr>
<tr>
<td>Paraclese</td>
<td>10021494</td>
<td>27</td>
</tr>
<tr>
<td>Taskers of Andover, Ltd.</td>
<td>10025158</td>
<td>27</td>
</tr>
<tr>
<td>Accumedic Systems</td>
<td>10002150</td>
<td>28</td>
</tr>
<tr>
<td>Cabco West</td>
<td>10007268</td>
<td>28</td>
</tr>
<tr>
<td>Fifth Generation</td>
<td>10012128</td>
<td>28</td>
</tr>
<tr>
<td>HarborGroup</td>
<td>10014238</td>
<td>28</td>
</tr>
<tr>
<td>Maxtor</td>
<td>10020256</td>
<td>28</td>
</tr>
<tr>
<td>Parian Development Group</td>
<td>10021575</td>
<td>28</td>
</tr>
</tbody>
</table>
## 3 Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tatters</td>
<td>10025213</td>
<td>28</td>
</tr>
<tr>
<td>Ace Equipment</td>
<td>10002153</td>
<td>29</td>
</tr>
<tr>
<td>Cadtex</td>
<td>10007309</td>
<td>29</td>
</tr>
<tr>
<td>Fifth Moon</td>
<td>10012157</td>
<td>29</td>
</tr>
<tr>
<td>HarveyOpolis</td>
<td>10014540</td>
<td>29</td>
</tr>
<tr>
<td>Maxwell Laboratories</td>
<td>10020266</td>
<td>29</td>
</tr>
<tr>
<td>Password Busters</td>
<td>10021641</td>
<td>29</td>
</tr>
<tr>
<td>Teamaker</td>
<td>10025239</td>
<td>29</td>
</tr>
<tr>
<td>Acer</td>
<td>10002154</td>
<td>30</td>
</tr>
<tr>
<td>Cajun</td>
<td>10007448</td>
<td>30</td>
</tr>
<tr>
<td>Filene's</td>
<td>10012158</td>
<td>30</td>
</tr>
<tr>
<td>HBS</td>
<td>10014802</td>
<td>30</td>
</tr>
<tr>
<td>Mb digital marketing</td>
<td>10020281</td>
<td>30</td>
</tr>
<tr>
<td>Patrick Townsend &amp; Associates</td>
<td>10021677</td>
<td>30</td>
</tr>
<tr>
<td>Teammax</td>
<td>10025241</td>
<td>30</td>
</tr>
<tr>
<td>ACES Research</td>
<td>10002155</td>
<td>31</td>
</tr>
<tr>
<td>CalComp</td>
<td>10007457</td>
<td>31</td>
</tr>
<tr>
<td>Filetron</td>
<td>10012161</td>
<td>31</td>
</tr>
<tr>
<td>Hederman Brothers</td>
<td>10015011</td>
<td>31</td>
</tr>
<tr>
<td>McGraw-Hill Publishing Company</td>
<td>10020306</td>
<td>31</td>
</tr>
<tr>
<td>Patton Enterprises</td>
<td>10021736</td>
<td>31</td>
</tr>
<tr>
<td>Teamsolve</td>
<td>10025242</td>
<td>31</td>
</tr>
<tr>
<td>ACI</td>
<td>1002159</td>
<td>32</td>
</tr>
<tr>
<td>Caleidoscopio S.r.l.</td>
<td>10007468</td>
<td>32</td>
</tr>
<tr>
<td>Emergent</td>
<td>10011345</td>
<td>32</td>
</tr>
<tr>
<td>FIND/SVP</td>
<td>10012305</td>
<td>32</td>
</tr>
<tr>
<td>GateMaster</td>
<td>10013332</td>
<td>32</td>
</tr>
<tr>
<td>Hekimian Laboratories</td>
<td>10015253</td>
<td>32</td>
</tr>
<tr>
<td>Mead Corporation</td>
<td>10020323</td>
<td>32</td>
</tr>
<tr>
<td>Paul Budde</td>
<td>10021750</td>
<td>32</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer Number</td>
<td>City Code</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Todd Shipyards Corporation</td>
<td>10025267</td>
<td>32</td>
</tr>
<tr>
<td>ACME Laboratories</td>
<td>10002161</td>
<td>33</td>
</tr>
<tr>
<td>Calypso</td>
<td>10007536</td>
<td>33</td>
</tr>
<tr>
<td>Finder</td>
<td>10012328</td>
<td>33</td>
</tr>
<tr>
<td>Helfand Enterprises</td>
<td>10015267</td>
<td>33</td>
</tr>
<tr>
<td>Medics</td>
<td>10020332</td>
<td>33</td>
</tr>
<tr>
<td>PayMaxx</td>
<td>10021794</td>
<td>33</td>
</tr>
<tr>
<td>Transylvania Company</td>
<td>10025288</td>
<td>33</td>
</tr>
<tr>
<td>Acsior</td>
<td>10002412</td>
<td>34</td>
</tr>
<tr>
<td>Camelot IT</td>
<td>10007591</td>
<td>34</td>
</tr>
<tr>
<td>Finest Host</td>
<td>10012369</td>
<td>34</td>
</tr>
<tr>
<td>Helius</td>
<td>10015325</td>
<td>34</td>
</tr>
<tr>
<td>Melville Shoe Corporation</td>
<td>10020340</td>
<td>34</td>
</tr>
<tr>
<td>Payton Group International</td>
<td>10021800</td>
<td>34</td>
</tr>
<tr>
<td>UBF</td>
<td>10025304</td>
<td>34</td>
</tr>
<tr>
<td>Action Systems</td>
<td>10002501</td>
<td>35</td>
</tr>
<tr>
<td>Camros</td>
<td>10007866</td>
<td>35</td>
</tr>
<tr>
<td>Finisar</td>
<td>10012399</td>
<td>35</td>
</tr>
<tr>
<td>Hercules Incorporated</td>
<td>10015686</td>
<td>35</td>
</tr>
<tr>
<td>Mersey Docks</td>
<td>10020364</td>
<td>35</td>
</tr>
<tr>
<td>Pick Professionals</td>
<td>10021802</td>
<td>35</td>
</tr>
<tr>
<td>UK Total.net</td>
<td>10025353</td>
<td>35</td>
</tr>
<tr>
<td>ActivCard</td>
<td>10002520</td>
<td>36</td>
</tr>
<tr>
<td>Champion International</td>
<td>10009606</td>
<td>36</td>
</tr>
<tr>
<td>Firehole</td>
<td>10012514</td>
<td>36</td>
</tr>
<tr>
<td>hesketh.com</td>
<td>10015789</td>
<td>36</td>
</tr>
<tr>
<td>Nancy Leffingwell Enterprises</td>
<td>10020449</td>
<td>36</td>
</tr>
<tr>
<td>Picka</td>
<td>10021804</td>
<td>36</td>
</tr>
<tr>
<td>UKNames.net</td>
<td>10025359</td>
<td>36</td>
</tr>
<tr>
<td>Active</td>
<td>10002526</td>
<td>37</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan River Mills, Inc.</td>
<td>10009633</td>
<td>37</td>
</tr>
<tr>
<td>FireTrans</td>
<td>10012600</td>
<td>37</td>
</tr>
<tr>
<td>Hewlett Packard</td>
<td>10015886</td>
<td>37</td>
</tr>
<tr>
<td>Nbase</td>
<td>10020491</td>
<td>37</td>
</tr>
<tr>
<td>PLAINFIELD ROOFING AND SHEET METAL</td>
<td>10026438</td>
<td>37</td>
</tr>
<tr>
<td>Ultimate Group</td>
<td>10025392</td>
<td>37</td>
</tr>
<tr>
<td>Aberdeen</td>
<td>10000486</td>
<td>38</td>
</tr>
<tr>
<td>Ad- vantage</td>
<td>10003687</td>
<td>38</td>
</tr>
<tr>
<td>Besicorp</td>
<td>10004516</td>
<td>38</td>
</tr>
<tr>
<td>Data General Corporation</td>
<td>10009639</td>
<td>38</td>
</tr>
<tr>
<td>ECS Associates</td>
<td>10010865</td>
<td>38</td>
</tr>
<tr>
<td>Galaxy Systems</td>
<td>10012927</td>
<td>38</td>
</tr>
<tr>
<td>G-Com International</td>
<td>10013397</td>
<td>38</td>
</tr>
<tr>
<td>Hidden Oak</td>
<td>10015956</td>
<td>38</td>
</tr>
<tr>
<td>Jones and Laughlin Steel Corpora</td>
<td>10018363</td>
<td>38</td>
</tr>
<tr>
<td>NBTel</td>
<td>10020492</td>
<td>38</td>
</tr>
<tr>
<td>One World</td>
<td>10020868</td>
<td>38</td>
</tr>
<tr>
<td>QualityLogic</td>
<td>10022166</td>
<td>38</td>
</tr>
<tr>
<td>Safe</td>
<td>10023495</td>
<td>38</td>
</tr>
<tr>
<td>Ultra-Image</td>
<td>10025418</td>
<td>38</td>
</tr>
<tr>
<td>Vectrix</td>
<td>10026009</td>
<td>38</td>
</tr>
<tr>
<td>Ad Agency</td>
<td>10003554</td>
<td>39</td>
</tr>
<tr>
<td>Day and Zimmermann, Inc.</td>
<td>10009645</td>
<td>39</td>
</tr>
<tr>
<td>G.R. Barron</td>
<td>10012761</td>
<td>39</td>
</tr>
<tr>
<td>Hill and Knowlton, Inc.</td>
<td>10016113</td>
<td>39</td>
</tr>
<tr>
<td>NBX</td>
<td>10020515</td>
<td>39</td>
</tr>
<tr>
<td>Quallaby</td>
<td>10022167</td>
<td>39</td>
</tr>
<tr>
<td>Underwriters Laboratories</td>
<td>10025467</td>
<td>39</td>
</tr>
<tr>
<td>Associates</td>
<td>10003749</td>
<td>40</td>
</tr>
<tr>
<td>Dayton Rubber Company</td>
<td>10009650</td>
<td>40</td>
</tr>
</tbody>
</table>
3 Visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Number</th>
<th>City Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gadzoox Microsystems</td>
<td>10012792</td>
<td>40</td>
</tr>
<tr>
<td>iBEAM</td>
<td>10016780</td>
<td>40</td>
</tr>
<tr>
<td>Nematron</td>
<td>10020662</td>
<td>40</td>
</tr>
<tr>
<td>Quantum</td>
<td>10022201</td>
<td>40</td>
</tr>
<tr>
<td>Universal Access</td>
<td>10025608</td>
<td>40</td>
</tr>
<tr>
<td>Beckman Instruments, Inc.</td>
<td>10003857</td>
<td>41</td>
</tr>
<tr>
<td>De Postel</td>
<td>10009669</td>
<td>41</td>
</tr>
<tr>
<td>Gaecom</td>
<td>10012799</td>
<td>41</td>
</tr>
<tr>
<td>Id</td>
<td>10017290</td>
<td>41</td>
</tr>
<tr>
<td>Oki</td>
<td>10020672</td>
<td>41</td>
</tr>
<tr>
<td>Rdlabs</td>
<td>10022746</td>
<td>41</td>
</tr>
<tr>
<td>Userland</td>
<td>10025737</td>
<td>41</td>
</tr>
</tbody>
</table>

How I built this

**Do the following:**

1. Import the data into **Data manager**.
2. Make the recommended associations between the two tables in **Data manager**.
3. Create two drill-down dimensions, one of **State** and **County** and one of **State** and **City**.
4. Add a map and in **Presentation**, set a **Custom** zoom level with a maximum zoom of **7x zoom**.
5. Add a point layer with **State - City** as the dimension. Set the following properties:
   - In **Location**, set the scope to **Custom** and enter 'USA' in **Country**.
   - In **Size & Shape**, set **Size by** to **Count(Distinct(Customer))**.
   - In **Colors**, color by measure using **Count(Distinct(Customer))**.
   - In **Options > Layer display**, set **Visible drill-down levels** to **Custom** and select **City**.
6. Add an area layer with **State-County** as the dimension. Set the following properties:
   - In **Location**, set the scope to **Custom**, enter 'USA' in **Country**, and **State** in **Administrative area (Level 1)**.
   - In **Colors**, color by measure using **Count(Distinct(Customer))** and set the **Opacity** slider to 40%.
7. Center the region in the map and then set **Limit pan navigation** to **Custom** and click **Set pan limit**.
Mekko chart

The mekko chart is suitable for comparing groups, while being able to compare category items contained within these groups. The dimension axis shows the groups, while the measure axis shows the normalized percentage value for each category item. The size of each group shows its value.

In this image, the dimensional groups represent different yearly quarters. The width of each quarter shows the normalized percentage value of the sum of sales, for that quarter. Each quarter is divided in several product categories, such as Produce, Canned Products, and Frozen Foods. The height of each product category corresponds to the normalized percentage value of the sum of sales of that product category, within that quarter. This allows you to easily compare between product categories inside a specific quarter, and between different quarters.

Sorting is automatic according to size. By default, the coloring is by dimension, with 12 colors, but that can be changed in the properties panel. You can decide which dimension to color by. In this example, the coloring is by product category to clearly distinguish the different categories and how their contribution to the sales change in each quarter.
If the data set contains negative values, a text message is shown stating that the negative values cannot be displayed.

When to use it
Use a mekko chart when you need to visualize normalized percentage values of grouped data. Mekko charts should primarily be used with values that can be aggregated.

Advantages
The mekko chart is easy to read and understand. You get a good comparison between groups, and a comparison of the impact of categories within each group.

Disadvantages
The mekko chart does not work so well with many dimension values due to the limitation of the axis length.
Mekko charts are not good when there is a big difference in the magnitude of the measure values. Nor is a mekko chart the right choice when mixing absolute and relative values.
Negative values cannot be displayed in mekko charts.

Creating a mekko chart
You can create a simple mekko chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty mekko chart to the sheet.
2. Click Add dimension and select a dimension or a field. This dimension defines the grouping.
3. Add a second dimension in the order of hierarchy level. The second dimension you add defines the categories.
4. Click Add measure and select a measure or create a measure from a field.

In a mekko chart you need two dimensions and one measure.

Each bar corresponds to the first dimension, divided into smaller categories based on the second dimension. The values of the measures determine the relevant height of the categories inside each bar, as well as the size of the bars.

When you have created the chart, you may want to adjust its appearance in the properties panel.

Comparing groups and group categories against a measure with a mekko chart
This example shows how to make a mekko chart to compare the sales between different years as well as the impact specific product groups have on a year's sales, and how that compares to other years.
In this example, we will use two data files available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial, and the files are available in the Tutorials source folder:

- Sales.xls
- Item master.xls

To download the files, go to Tutorial - Building an App.

Add the two data files to an empty app, and make sure that they are associated by Item Number.

The dataset that is loaded contains sales data. The Item master table holds the information about the items ordered, such as product groups.

**Measure**

We use the sales volume as the measure, by creating a measure in Master items with the name Sales, and the expression \( \text{sum}(\text{Sales}) \).

**Visualization**

We add a mekko chart to the sheet and set the following data properties:

- **Dimension**: Date.autoCalendar.Quarter (year).
- **Dimension**: Product Group (product group)
- **Measure**: Sales; the measure that was created as a master item.

The following mekko chart is created:
The size of each column represents the volume of sales for each year. The size of the different sections inside each column represent the volume of sales for each specific product group during that year.

Notice how the sum of all three yearly percentages adds up to 100%. The same applies to the percentages of the product groups section of each year. This is because the percentages are normalized, so the size of each section is relevant to the total.

We want to have a better overview of how each product group's sales change from one year to the next. This is not obvious for product groups such as Baking Goods, Dairy, or Beverages which do not sit side by side from one column to the next. We want to display a different sorting, one based on the product groups.

This can be changed under **Sorting** in the properties panel.

Set the sorting order to the following:

1. Date.Year
2. Product Group
3. Sum(Sales)

The chart becomes as follows:
Discovery

The mekko chart visualizes the normalized percentage of sales per year for different product groups, as well as the normalized percentage of sales of each year. The visualization is sorted in order of product group, per year. You can hover the mouse pointer over a product group and view the details.

In the mekko chart we can see that Produce has the highest sales volume throughout the three years.

Mekko chart properties

You can change the layout and formatting of mekko charts.

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.
3 Visualizations

Data
Click Add to add a dimension or a measure.

Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click $fx$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

=If (Week < 14, Week, ’Sales’)

If Add is missing, you cannot add more dimensions.

- `<Dimension name>`: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, right-click the dimension and select delete in the dialog. Alternatively, click the dimension and click delete.
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click $fx$ to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $fx$ to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $fx$ to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $fx$ to open the expression editor.
    - **Calculated on measure**: `<measure>`: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
3 Visualizations

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (**Fixed number. Exact value.** or **Relative number**), the value counts as 1 in that setting. If, for example, **Exact value** is used and set to 10, the tenth value is **Others**.

- **Other label**: Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click $\mathbf{\text{fx}}$ to open the expression editor.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars ($\text{\text{\textdollar}}$) to rearrange the order.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\mathbf{\text{fx}}$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is missing, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.
  
  If you want to delete the measure, long-touch/right-click the measure and select $\text{\text{\textdollar}}$ in the dialog.
  
  Alternatively, click the measure and click $\text{\text{\textdollar}}$.

  - **Expression**: Click $\mathbf{\text{fx}}$ to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
    
    To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  
  - **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
Examples:

- # ##0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- ###0 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

  **Limitations:**
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Dimensions and measures can also be sorted internally:
Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

### Add-ons

#### Data handling:

- **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.

- A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

### Appearance

#### General

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click **fx** if you want to create an expression by using the expression editor.

  *Titles are displayed on a single line. If you inject line breaks they will be ignored.*

#### Example:

Assume that the following string is used, including quotation marks: `‘Sales: ’ & Sum(Sales)`. By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=`Sales: ’ & Sum(Sales) `), the string is interpreted as an expression instead. The output is then **Sales**: `<value of expression>`, where `<value of expression>` is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- `<inherited>`, in which case the state defined for the sheet is used.
- `<default state>`, which represents the state where no alternate state is applied.

Colors and legends

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
      - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
      - **Persistent colors**: Select to have colors remain the same between selection states.
      - **Color scheme**: Select **12 colors** or **100 colors** to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
    - **Show legend**: By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.
    - **Show legend title**: When selected, the legend title is displayed.

Pie chart

The pie chart displays the relation between values as well as the relation of a single value to the total. You can use a pie chart when you have a single data series with only positive values.

In the pie chart, the dimensions form sectors of the measure values. A pie chart can have one dimension and up to two measures. The first measure is used to determine the angle of each slice in the chart.

*Sales per region in a pie chart.*
Optionally, a second measure can be used to determine the radius of each pie slice. This style of pie chart is also known as a rose chart.

*Sales by product sub group in a pie chart with the average sales per invoice sales determining slice radius*

In the pie presentation of the pie chart, negative values in the radius measure are not supported and will be excluded. Negative values in the radius measure are supported in the donut presentation and will point in towards the center of the pie chart.
Sales by product sub group in a pie chart with radius measure containing a comparison of sales from the previous year

When to use it
The primary use of a pie chart is to compare a certain sector to the total. The pie chart is particularly useful when there are only two sectors, for example yes/no or queued/finished.

We do not recommend that you compare the results of two pie charts with each other.

Advantages
The pie chart provides an instant understanding of proportions when few sectors are used as dimensions. When you use 10 sectors, or less, the pie chart keeps its visual efficiency.

Disadvantages
It may be difficult to compare different sectors of a pie chart, especially a chart with many sectors.
The pie chart takes up a lot of space in relation to the values it visualizes.

Creating a pie chart
You can create a pie chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty pie chart to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

The following settings are used by default in a pie chart:

- The top 10 sectors are presented in descending size order, clockwise.
- Colors are presented by dimension.
- Value labels are presented in percent.

After you have created the pie chart, you may want to add a radius measure or adjust its appearance and other settings in the properties panel.

Pie chart properties
You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

If the visualization has ⚙ in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.
**Dimensions**

On the **Data** tab, under **Dimensions**, click **Add** to open a list of available **Dimensions** and **Fields**. Select the dimension or field that you want to use.

You can also click **fx** to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

=If (Week < 14, Week, 'Sales')

If **Add** is dimmed, you cannot add more dimensions.

The following properties are available for dimensions:

- **<Dimension name>**: Click the dimension name to open the dimension settings. If you want to delete the dimension, right-click the dimension and select \[ ] in the dialog. Alternatively, click the dimension and click \[ ].
  - **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click **fx** to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click **fx** to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click **fx** to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click **fx** to open the expression editor.
    - **Calculated on measure**: <measure>: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
    - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (**Fixed number, Exact value**, or
3 Visualizations

Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.

- **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click ![fx](https://example.com/fx.png) to open the expression editor.

- **Master item**: You can create a master dimension based on the dimension expression by clicking Create new.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

### Measures

On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure. Pie charts require a measure for Angle, but optionally a measure can be added for Radius, which determines the radius of each slice of the pie chart.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click ![fx](https://example.com/fx.png) to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add is dimmed, you cannot add more measures.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

The following properties are available for measures:

- **<Measure name>**:
  - **Expression**: Click ![fx](https://example.com/fx.png) to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom.
formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `##0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money:** By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration:** By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom:** By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator:** Set the decimal separator.
  - **Thousands separator:** Set the thousands separator.
  - **Format pattern:** Set the number format pattern.
  - **Reset pattern:** Click to reset to default pattern.

- **Measure expression:** The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  - **Master item:** You can create a master measure based on the measure expression by clicking **Create new**.
  - **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

**Sorting**

Drag the dimension and measure to set the sorting priority order. The numbers show the order.

The dimension and measure can be sorted internally.

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options:
3 Visualizations

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

The sorting is either **Ascending** or **Descending**.

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**
- **Data handling: Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

**Appearance**

**General**
- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (`=`), at the beginning of a string shows that it contains an expression.
  Click **fix** if you want to create an expression by using the expression editor.

*Titles are displayed on a single line. If you inject line breaks they will be ignored.*

**Example:**

Assume that the following string is used, including quotation marks: `'Sales: ' & Sum(Sales)`.
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (`="Sales: ' & Sum(Sales)`), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where **<value of expression>** is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

**State**: Set the state to apply to the visualization. You can select:
- Any alternate state defined in Master items.
- `<inherited>`, in which case the state defined for the sheet is used.
- `<default state>`, which represents the state where no alternate state is applied.

### Presentation
- **Pie/Donut**: Select to present the chart as a pie or as a donut.
- **Dimension label**: When set to Auto, the label is displayed if there is enough space.
- **Value labels**:
  - **Auto**: The measure values are displayed as a percentage of the whole.
  - **Custom**: Select how to display the measure values.
    - **None**: No measure values are displayed.
    - **Share**: The measure values are displayed as a percentage of the whole (default setting).
    - **Values**: The regular measure values are displayed.
      - **Label measure**: Select whether to use the values from the Angle measure or the Radius measure.

You can change the styling of the pie chart by clicking on **Styling**.

- **Outline width**: Select if the pie chart slices should have an outline, and what the width of the outline should be. Default setting is **None**.
- **Outline color**: In the color picker, select the color of the outline. This option is not available if **Outline width** is set to **None**.
- **Corner radius**: Set the roundness of the corners of the slices.
- **Inner radius**: Set the inner radius of the chart when it is presented as a donut. This option is only available when **Donut** has been selected.
- **Reset all**: Resets all style editor properties to their default values.

### Colors and legends
- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
    - **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values.
When selected, the following settings are available:

- **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
- **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
- **Persistent colors**: Select to have colors remain the same between selection states.
- **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

**By measure**:

- **Select measure**: Select the measure to use to color your chart.
- **Label**: Enter text or an expression for the measure that displays in the legend.
- **Number formatting**: You can set the format of the field or expression values

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  - **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- `##0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to
change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

- **Color scheme**: Select a color scheme from the following options:
  - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
  - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
  - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
  - **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

- **Reverse colors**: When selected, the color scheme is reversed.

- **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the **Min** and **Max** values for the color range.

- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click $f$ to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a
number, which in turn is plotted against one of the chart gradients. For more information, see \textit{Coloring a visualization} (page 534).

When the coloring is by measure or by expression, you can set the color range (\texttt{Min} and \texttt{Max} values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option \textbf{The expression is a color code} must be cleared before you can set the color range.

- \textbf{Show legend}: Not available when \texttt{Single color} is selected. By default set to \texttt{Off}. The legend is displayed if there is enough space. The placement can be changed in the \textbf{Legend position} setting.
- \textbf{Legend position}: Select where to display the legend.
- \textbf{Show legend title}: When selected, the legend title is displayed.

\textbf{Tooltip}

- \textbf{Tooltip}: Set to \texttt{Custom} to add measures and images as tooltips.
- \textbf{Hide basic rows}: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, \texttt{Hide basic rows} will also hide dimension values as well.
- \textbf{Title}: Enter a title for the tooltip.
- \textbf{Description}: Enter a description for the tooltip.
- \textbf{Measures}
  - \textbf{Add measure}: Add a measure to be shown as a tooltip. You can add a measure from a field using \texttt{From a field}. You can also use an expression to add a measure. Click $\mathbb{f}$ to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using \texttt{Label} as well as its formatting using \texttt{Number formatting}.

- \textbf{Images}
  - \textbf{Type}: Choose whether to add an image from your \texttt{Media library} or from a \texttt{URL}.
  - \textbf{Size}: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - \texttt{Small}: Set the width and height of the container to 50 pixels.
    - \texttt{Medium}: Set the width and height of the container to 200 pixels.
    - \texttt{Large}: Set the width and height of the container to 340 pixels.
    - \texttt{Original}: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
  - \texttt{Media library}: Appears when you choose \texttt{Media library} for \texttt{Type}. Click to select an image from your media library.
  - \texttt{URL}: Appears when you choose \texttt{URL} for \texttt{Type}. Enter a \texttt{URL}.

\textbf{Pivot table}

The pivot table presents dimensions and measures as rows and columns in a table. In a pivot table you can analyze data by multiple measures and in multiple dimensions at the same time.

You can rearrange measures and dimensions by pivoting rows and columns.
When to use it
The pivot table is useful when you want to include several dimensions or measures in a single table, and then want to reorganize them to see different subtotals.

Advantages
The pivot table is very powerful when you want to analyze multiple dimensions and measures at once, and then reorganize them to get a different perspective on your data. You can expand the rows you are interested in while keeping the rows in the rest of the table collapsed.

Disadvantages
The pivot table may seem a bit complicated, and does not give insights at a glance.

Creating a pivot table
You can create a new pivot table on the sheet you are editing.

Do the following:
1. From the assets panel, drag an empty pivot table to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

You can adjust appearance and other settings in the properties panel.

Column width is automatically set to keep columns together for improved readability. You can adjust the width of the dimension column by dragging the header divider. The width of individual measure columns will still be automatically set. Double-click the header divider to reset to automatic column width.

Pivoting your data in the table
When you want to rearrange your data, drag the items to a new column or row.

In the following pivot table, the dimension Customer has been dragged to the position after Product Group. The dimension Item Desc has been moved to the position before Product Group. As a consequence, the dimensions are now sorted by Item, primarily. Focus has shifted from Customer to Item Desc. You can find out the quantities and sales for each customer by clicking +. This will expand a dimension.
By moving the dimension *Customer* from rows to columns, you retain focus on the dimension *Item Desc*, but you also get the distribution of items per customer. The move has made the pivot table more information dense.

Measure grouping
As you may have noticed, *Quantity* and *Sales* are not presented as separate measures in the top column row. Next to the dimension *Customer*, you find an item called *Values*. When you use more than one measure, they are automatically grouped together forming a measure group, *Values*. This group can be added to the rows section or the columns section. The measure group cannot be edited or selected in the table. You cannot split up the measure item and use one measure as a row and another as a column.

Pivoting your data in the properties panel
In the properties panel, you can add measures and dimensions to the pivot table, and also pivot rows or columns.

Data
In the data pane, you can add dimensions and measures. You can move items between rows and columns. You can also change item order inside rows or columns. When you use more than one measure, they are grouped and a *Values* item is created.
### Chart suggestions

**Data**

**Dimensions**

**Row**
- **Item Desc**
- **Product Group**
- **Customer**

Add

**Column**
- **Values**

Add

**Measures**

**Values**
- **Quantity**
- **Sales**

Add

**Sorting**

**Add-ons**

**Appearance**

Hide properties
Sorting

On the sorting pane, you can change the internal order of dimensions and measures.

Sort by first measure

If you have more than one measure, a measure group is created. *Sort by first measure* will sort dimension values by the numeric value of the first measure. This sort order will affect all dimensions, and take precedence before any other sort order defined under the dimensions.

For example, you have two measures: *Quantity* and *Sales*. In the properties pane, under *Data > Measures*, *Quantity* is listed first. If you *Sort by first measure* in descending order, your table is sorted starting with the dimension with the highest *Quantity*.

*Pivot table in Edit mode. Sort by first measure has been toggled on.*
Limitations:

- This option is only supported if subtotals are calculated. You can calculate subtotals by doing one of the following:
  - In the properties pane, go to Data, and click on a dimension. Toggle on Show totals.
  - In the properties pane, go to Appearance > Presentation. Toggle on Indent rows.
- This option is not supported for calculated dimensions.
- This option is only supported if all dimensions are in the Row section and all measures are in the Column section.

Global grouping

Global grouping lets you create a limited data set, and within that data set, single out values that you want to focus on. For example: the best quarters, the top sales people, or the worst selling products.

Example:

In the following pivot table, no limitation is applied. The values are sorted on Sales, descending. The list is long and the values for 2013 are not shown.
In the following pivot table, a limitation has been applied to the (inner) dimension *Sales Rep Name*, so that only the top five sales representatives for the years 2013 and 2014 are shown.

<table>
<thead>
<tr>
<th>Year</th>
<th>sum(Sales)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>$41,086,958.72</td>
</tr>
<tr>
<td>Judy Thurman</td>
<td>$6,037,992.86</td>
</tr>
<tr>
<td>Stewart Wind</td>
<td>$4,717,671.77</td>
</tr>
<tr>
<td>Lee Chin</td>
<td>$3,535,768.74</td>
</tr>
<tr>
<td>Cheryle Sincock</td>
<td>$1,791,498.88</td>
</tr>
<tr>
<td>Brenda Gibson</td>
<td>$1,750,292.96</td>
</tr>
<tr>
<td>John Greg</td>
<td>$1,443,128.36</td>
</tr>
<tr>
<td>Martha Richard</td>
<td>$1,388,492.75</td>
</tr>
<tr>
<td>Amalia Craig</td>
<td>$1,200,853.57</td>
</tr>
<tr>
<td>David Laychak</td>
<td>$1,170,791.14</td>
</tr>
<tr>
<td>Karl Anderson</td>
<td>$957,467.35</td>
</tr>
<tr>
<td>Max Blagburn</td>
<td>$940,445.81</td>
</tr>
<tr>
<td>David Howard</td>
<td>$850,675.53</td>
</tr>
<tr>
<td>Angelen Carter</td>
<td>$810,618.88</td>
</tr>
<tr>
<td>Amanda Honda</td>
<td>$704,245.66</td>
</tr>
<tr>
<td>Amelia Fields</td>
<td>$635,124.63</td>
</tr>
<tr>
<td>Donna Brown</td>
<td>$603,855.39</td>
</tr>
<tr>
<td>Peggie Hurt</td>
<td>$525,843.84</td>
</tr>
<tr>
<td>Craig Amundson</td>
<td>$495,495.93</td>
</tr>
<tr>
<td>Micheal Williams</td>
<td>$469,046.29</td>
</tr>
<tr>
<td>Donald Miller</td>
<td>$432,641.09</td>
</tr>
</tbody>
</table>
The next step is to select global grouping in the properties panel. The option **Global grouping** is only available after you have applied a limitation on the dimension.

When global grouping is selected, the limitation on the top five sales representatives is applied again, but this time the dimension *Year* is ignored. The five sales representatives with the highest sales (either in 2013 or 2014) are the only ones that will be presented in the final pivot table.

The following image shows the six highest results for 2014 and 2013. The top four results are from 2014, but the fifth (John Greg) is from 2013. Because five other sales representatives have higher sales than Brenda Gibson (who was number five in 2014), she is removed.

The following image shows the pivot table with global grouping applied. The pivot table only contains the sales results for the top five sales representatives. Even though *Brenda Gibson* had a better result in 2014 than John Greg, his result for 2013 qualified him for the top five list.
Creating a bookmark with an expanded pivot table

By default, if you create a bookmark that contains a pivot table, the pivot table will be shown collapsed. If you expanded any rows using , they will not be shown. However, you can choose to show the pivot table as expanded.

**Do the following:**

1. Click in the toolbar.
2. Click *Create new bookmark*. Change the name and description, if desired.
3. Toggle on *Save layout*.
4. Click *Save*.

Comparing straight tables and pivot tables

You can see the efficiency of a pivot table if you compare it to a regular table that has the same data.

**Straight table**

In the following table, you have:

- Three dimensions: Customer, Product Group, and Item Desc
- Two measures: Quantity and Sales
The table shows food product sales. If you want to rearrange the data to simplify analysis, your options are limited. You can change the order of the columns, but that does not improve the overview. You can also set the sorting order, either in the sorting section in the properties panel, or by clicking the dimension columns. However, the problem persists. The customers, product groups, and items are all displayed more than once. It is not possible to get a good summary of the data.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Product Group</th>
<th>Item</th>
<th>Quantity</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td></td>
<td></td>
<td>1,818,294</td>
<td>$164,852,674.81</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Good Light Wine</td>
<td>2</td>
<td>$337.58</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Pearl Chardonnay</td>
<td>8</td>
<td>$513.89</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Pearl Light Beer</td>
<td>1</td>
<td>$60.16</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Walrus Light Wine</td>
<td>7</td>
<td>$34.00</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baked Goods</td>
<td>Colony Pumpernickel Bread</td>
<td>2</td>
<td>$9.54</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baked Goods</td>
<td>Colony Wheat Bread</td>
<td>1</td>
<td>$74.73</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baked Goods</td>
<td>Great Blueberry Muffins</td>
<td>3</td>
<td>$146.02</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBS Best Apple Butter</td>
<td>6</td>
<td>$211.35</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBS Best Apple Preserves</td>
<td>2</td>
<td>$276.28</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBS Best Extra Chunky Peanut Butter</td>
<td>1</td>
<td>$817.46</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBS Best Grape Jam</td>
<td>1</td>
<td>$33.75</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBS Best Pepper</td>
<td>4</td>
<td>$328.97</td>
</tr>
</tbody>
</table>

**Pivot table**

We add a pivot table to the sheet and use the same info:

- Three dimensions: Customer, Product Group, and Item Desc
- Two measures: Quantity and Sales
Visualizations

As you can see, the pivot table presents the data in a much more condensed way. Compared to the regular table, the number of rows has been halved and the number of columns is three instead of five.

One of the advantages of a pivot table is the interchangeability: the ability to move row items to columns and column items to rows. You can rearrange the data and have several different views of the same data set. You can move dimensions and measures to bring forward data of interest and hide data that is either too detailed, or irrelevant to the analysis.

The pivot table shows the dimensions Customer, Product Group, and Item Desc, and the measures Quantity and Sales. In this view, you have a summary of quantity and sales for each customer. If you want to know which items and product groups that the customers bought, you can expand the customer fields by clicking . A icon indicates that a field can be further expanded and present more details, while a icon indicates that the field can be collapsed, to reduce the number of fields and details.

Discovery

You can change the appearance and sorting of a pivot table using the properties panel.

You open the properties panel for a visualization by clicking in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.
Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Dimensions

- **<Dimension name>:** Click the dimension name to open the dimension settings.
  
  If you want to delete the dimension, right-click the dimension and select ![delete](image) in the dialog. Alternatively, click the dimension and click ![delete](image).

  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  
  - **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click ![expression](image) to open the expression editor.
  
  - **Label:** Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  
  - **Includenull values:** When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    
    - **No limitation:** The default value.
    
    - **Fixed number:** Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click ![expression](image) to open the expression editor.
    
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click ![expression](image) to open the expression editor.
    
    - **Relative value:** Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click ![expression](image) to open the expression editor.
    
    - **Calculated on measure: <measure>:** Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

  - **Show column if:** You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown. You can use this to require a field selection before calculating and showing large amounts of data.

  - **Background color expression:** Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

  - **Text color expression:** Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible.
3 Visualizations

- **Show others:** When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
- **Other label:** Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\mathfrak{f}$ to open the expression editor.
  - **Add:** Click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.
  - You can also click $\mathfrak{f}$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
- **Global grouping:** If a limitation is set, you can use global grouping.
- **Show totals:** Adds a top row in the pivot table showing the total value of the underlying rows. Show totals is not available for dimensions (except the first one) when Indent rows is selected in the Appearance property.
- **Totals label:** Enter a label for the totals row.
- **Text alignment:** When set to Custom, you can select how to display the content: Left, Center, or Right. If Text alignment is set to Auto, the alignment is automatically aligned, depending on the content.
- **Master item:** You can create a master dimension based on the dimension expression by clicking Create new.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.

**Measure**

- **<Measure name>:** Click the measure to open the measure settings.
  - If you want to delete the measure, right-click the measure and select $\cancel{\text{Measure}}$ in the dialog. Alternatively, click the measure and click $\cancel{\text{Measure}}$.
  - **Expression:** Click $\mathfrak{f}$ to open the expression editor. The existing expression is displayed by default.
  - **Label:** Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - **Measure:** Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting:** Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.
  - The following number formats are available:
3 Visualizations

- **Auto:** Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

## Examples:

- # ###0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- ####0 describes the number as an integer without a thousands digits separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money:** By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration:** By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom:** By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator:** Set the decimal separator.
  - **Thousands separator:** Set the thousands separator.
  - **Format pattern:** Set the number format pattern.
  - **Reset pattern:** Click to reset to default pattern.

- **Measure expression:** The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Show column if:** You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown.
3 Visualizations

- **Background color expression**: Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

- **Text color expression**: Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible.

- **Text alignment**: When set to **Custom**, you can select how to display the content: **Align left** or **Align right**. If **Text alignment** is set to **Auto**, the alignment is automatically aligned left or right, depending on the content.

- **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

The **Sort by first measure** toggle will sort dimension values by the numeric value of the first measure. This sort order will affect all dimensions, and take precedence before any other sort order defined under the dimensions. See: **Pivot table (page 328)**.

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Dimensions and measures can also be sorted internally:

Click the dimension or measure to expand sorting options. Toggle **Sorting** to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

**Data handling**:

- **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.

- **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
3 Visualizations

A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

General

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title, Subtitle, and Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click ![expression icon](image) if you want to create an expression with the expression editor.

  > Titles are displayed on a single line. If you inject line breaks they will be ignored.

  **Example:**

  Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where **<value of expression>** is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- **<inherited>**, in which case the state defined for the sheet is used.
- **<default state>**, which represents the state where no alternate state is applied.

Presentation

- **Styling**: Customize the styling of the pivot table, overriding the app theme. You can add custom header and content font sizes and colors. You can set rows to be highlighted when hovered over and set colors for the row and font. You can also set the size of the scrollbar.

- **Fully expanded**: When selected, all values in the pivot table are displayed.

- **Indent rows**: When selected, an indentation is added to the beginning of each row.

Scatter plot

The scatter plot presents pairs of values from two or three measures.
This is useful when you want to show data where each instance has two numbers, for example, the relationship between Sales and Quantity per Customer. In the scatter plot below, a third measure (Cost) is used to generate the bubble size.

*Scatter plot displaying the relationship between Sales and Quantity per Customer.*

The scatter plot presents values from different measures over one dimension as a collection of points. In most charts, you find your dimension on one of the axes, but for a scatter plot, the dimension is represented by the points in the chart, and the measures are found on each of the two axes. When a third, optional, measure is used, its value is reflected in the bubble size. If you are analyzing large data sets and view compressed data, the density of the data points is reflected by color.

**When to use it**

The scatter plot helps you find potential relationships between values, and to find outliers in data sets. The scatter plot is useful when you want to show data where each instance has at least two metrics, for example, average life expectancy and average gross domestic product per capita in different countries.

**Advantages**

The scatter plot is a great way to visualize the correlation of two or more measures at the same time. The third measure is an efficient way of differentiating between values and simplifying the identification of, for example, large countries, large customers, large quantities, and so on.

**Disadvantages**

The scatter plot may be difficult to understand for an inexperienced user, because it has measure value on both axes, and the third, optional, measure adds complexity to the interpretation. Make sure a novice can interpret the scatter plot correctly. Using descriptive labels is a good way to make the visualization easier to interpret.

Values may be placed on top of each other and are then not visible until you zoom in.
Creating a scatter plot

You can create a scatter plot on the sheet you are editing.

In a scatter plot you need one dimension and at least two measures. You can have maximum one dimension and three measures, where the third measure is visualized as bubble size.

Do the following:

1. From the assets panel, drag an empty scatter plot to the sheet.
2. Click **Add dimension** and select a dimension or a field.
3. Click **Add measure** and select a measure or create a measure from a field.
4. Click **Add measure** and select a measure or create a measure from a field.
5. Optionally, if you want bubble size to be set according to a third measure:
   - Click **Add measure** and select a measure or create a measure from a field.

When you have created the scatter plot, you may want to adjust its appearance and other settings in the properties panel.

Display limitations

Large data sets in scatter plots

If you have a scatter plot with large amounts of data (more than 1000 data points) Qlik Sense uses an algorithm to create an overview of the data, as shown in the scatter plot below. However, if you zoom or make selections so that the number of displayed data points is reduced to less than 1000 data points, the data will be shown as individual bubbles. This switch between compressed view and bubble view is done automatically. The density of the data points is reflected by color.
3 Visualizations

Zooming and panning

In a scatter plot, you can zoom and pan around in your data. The interaction differs depending on what device you are using. If you are zooming in you can see where in the data set you are located by looking at the mini chart in the bottom right corner. If you zoom in on large data sets you will be able to see the data shown as boxes with values inside. The values represent the number of points in each box. If you zoom in so that there are <1000 data points, you will instead see the data points represented by bubbles.

Zooming and panning is not possible when you have made a selection in the compressed data view.

You can change the compression resolution in the visual exploration menu or in the properties panel.

Coloring

Compressed scatter plots are always auto-colored by the primary data color. That means that any custom color definition made will not affect compressed data.

However, if you zoom or make selections so that the number of displayed data points is reduced to less than 1000 data points, the data will be colored as defined.

Correlating two measures with a scatter plot to find outliers

This example shows how to make a scatter plot to correlate two measures. We want to compare how the average sales volume correlates with the average margin for a group of sales persons, and find the outliers.
3 Visualizations

Dataset
In this example, we'll use two data files available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial, and the files are available in the *Tutorials source* folder:

- *Sales.xls*
- *Sales rep.csv*

To download the files, go to [Tutorial - Building an App](#).

Add the two data files to an empty app, and make sure that they are associated by *Sales Rep ID - Sales Rep Number*.

The dataset that is loaded contains sales data. The *Sales rep* table holds the information about the sales persons.

Measures
We need two measures that we create in Master items:

- *AverageSales* with the expression `Avg(Sales)`. This is the average of the sales value for all orders.
- *AverageMargin* with the expression `Avg(Margin/Sales)`. This is the average of the sales margin for all orders.

Visualization
We add a scatter plot to the sheet and set the following data properties:
A scatter plot is created, with a bubble for each sales person.

But we also want to have information about the total sales for each sales person, by adding the third measure $\text{Avg}(\text{Sales})$. The size of each bubble reflects the total sales for each sales person.

**Discovery**

The scatter plot visualizes the average sales versus average margin for each sales person, and we can see which sales persons distinguish themselves in performance. You can hover the mouse pointer over a sales person and view the details.

In the chart we can see that Lee Chin has the highest average sale value. Stewart Wind has the largest total sales volume, followed by Judy Thurman. Cheryle Sincock has a significantly smaller average margin than other sales persons, while outperforming most of them in average sales volume.

**Scatter plot properties**

You can change the layout and formatting of scatter plots in Qlik Sense.
You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.

Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

\[=\text{If (Week < 14, Week, 'Sales')}\]

If Add is dimmed, you cannot add more dimensions.

- <Dimension name>: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, right-click the dimension and select in the dialog. Alternatively, click the dimension and click .
  - Dimension: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - Field: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click to open the expression editor.
  - Label: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - Includenull values: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
3 Visualizations

- **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
  - **No limitation**: The default value.
  - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\mathcal{F}_x$ to open the expression editor.
  - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathcal{F}_x$ to open the expression editor.
  - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathcal{F}_x$ to open the expression editor.
  - **Calculated on measure**: $<$measure$>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others. This option is not available in box plot dimensions.

- **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\mathcal{F}_x$ to open the expression editor.
  - **Master item**: You can create a master dimension based on the dimension expression by clicking Create new.
  - **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\mathcal{F}_x$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.
3 Visualizations

- `<Measure name>`:
  - **Expression**: Click \( \mathbf{fx} \) to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- `##0` describes the number as an integer with a thousands separator. In this example `""` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  - Limitations:
    - Only works with visualizations that accept measures.
    - Does not affect the number formatting of the axis.

- **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.
- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

### Add-ons

#### X-axis reference lines:

- **Add reference line**: Click to add a new reference line.
- **Show**: When selected, the reference line is displayed.
- **Label**: Enter a label for the reference line.
- **Color**: In the color picker, select the color of the reference line and the label.
- **Reference line expression**: Enter a value or an expression for the reference line. Click $\mathbb{f}x$ to open the expression editor.
- **Delete**: Click to remove the reference line.

#### Y-axis reference lines:

- **Add reference line**: Click to add a new reference line.
- **Show**: When selected, the reference line is displayed.
- **Label**: Enter a label for the reference line.
- **Color**: In the color picker, select the color of the reference line and the label.
- **Reference line expression**: Enter a value or an expression for the reference line. Click $\mathbb{f}x$ to open the expression editor.
- **Delete**: Click to remove the reference line.
Data handling:

- **Include zero values:** When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.

- **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.

A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

**General**

- **Show titles:** On by default in all visualizations except filter panes, KPIs, and text & image visualizations.

Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

Click $\text{fx}$ if you want to create an expression by using the expression editor.

*Titles are displayed on a single line. If you inject line breaks they will be ignored.*

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Disable hover menu:** Select to disable the hover menu in the visualization.

- **Show details:** Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

**State:** Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.

- `<inherited>`, in which case the state defined for the sheet is used.

- `<default state>`, which represents the state where no alternate state is applied.
3 Visualizations

Presentation

- **Navigation**: By default, off. When set to **Auto**, the navigation tool is displayed, with options to pan and zoom.

- **Bubble size**: Set the size of the data point bubbles. For a scatter plot with two measures, this sets the uniform size of all bubbles. For a scatter plot with three measures, this sets the scale of the bubble sizes. In a scatter plot with three measures, the third measure controls the size of each bubble.

- **Labels**: Select what labels to display, you have three options:
  - **Auto**: The number of labels displayed varies with the size of the visualization
  - **All**: All labels are displayed. This option may cause labels to overlap.
  - **None**: No labels are displayed.

- **Compression resolution**: Set the resolution for compressed data. Only available for large data sets (>1000 data points).

- **Grid line spacing**: Select the spacing of the grid lines. The **Auto** setting is Medium.

Colors and legends

You can set the presentation colors of the distribution plot. You only need to select **Custom** if you want to change the settings.

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension used in the visualization has a color assigned to it. You can select to use the master dimension color or to disable the master dimension color.
    - **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
      - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
      - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
      - **Persistent colors**: Select to have colors remain the same between selection states.
      - **Color scheme**: Select **12 colors** or **100 colors** to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
3 Visualizations

- **By measure:**
  - **Select measure:** Select the measure to use to color your chart.
  - **Library colors:** Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has assigned colors.
  - **Label:** Enter text or an expression for the measure that displays in the legend.
  - **Color scheme:** Select a color scheme from the following options:
    - **Sequential gradient:** The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
    - **Sequential classes:** The transition between the different color groups is made using distinctly different colors.
    - **Diverging gradient:** Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
    - **Diverging classes:** Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
  - **Reverse colors:** When selected, the color scheme is reversed.
  - **Range:** Define the range of values used to color by measure or by expression.
    - **Auto:** The color range is set by the measure or expression values.
    - **Custom:** When custom is selected, you can set the **Min** and **Max** values for the color range.

- **By expression:** Color the chart using an expression to define colors for values.
  Supported color formats are: RGB, ARGB, and HSL.
  - **Expression:** Enter the expression that you want to use. Click \( \text{\textcolor{red}{f}} \) to open the expression editor.
  - **The expression is a color code:** Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see *Coloring a visualization* (page 534)
  When the coloring is by measure or by expression, you can set the color range (**Min** and **Max** values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
  - **Show legend:** Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.
  - **Legend position:** Select where to display the legend.
  - **Show legend title:** When selected, the legend title is displayed.
X-axis

- **Labels and title**: Select what to display of labels and title.
- **Position**: Select where to display the axis.
- **Scale**: Set the spacing of the axis scale.
- **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Y-axis

- **Labels and title**: Select what to display of labels and title.
- **Position**: Select where to display the axis.
- **Scale**: Set the spacing of the axis scale.
- **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Tooltip

- **Tooltip**: Set to `Custom` to add measures and images as tooltips.
- **Hide basic rows**: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, `Hide basic rows` will also hide dimension values as well.
- **Title**: Enter a title for the tooltip.
- **Description**: Enter a description for the tooltip.
- **Measures**
  - **Add measure**: Add a measure to be shown as a tooltip. You can add a measure from a field using `From a field`. You can also use an expression to add a measure. Click `fx` to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using `Label` as well as its formatting using `Number formatting`.
- **Images**
  - **Type**: Choose whether to add an image from your `Media library` or from a `URL`.
  - **Size**: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - **Small**: Set the width and height of the container to 50 pixels.
    - **Medium**: Set the width and height of the container to 200 pixels.
    - **Large**: Set the width and height of the container to 340 pixels.
    - **Original**: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
  - **Media library**: Appears when you choose `Media library` for `Type`. Click to select an image from your media library.
  - **URL**: Appears when you choose `URL` for `Type`. Enter a `URL`. 
Table

The table shows several fields simultaneously, where the content of each row is logically connected. Typically, a table consists of one dimension and several measures.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Sales</th>
<th>Quantity</th>
<th>Margin (%)</th>
<th># of Invoices</th>
<th>Average Sales per Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td>$108,852,674.81</td>
<td>1,816,372</td>
<td>412.71 %</td>
<td>38,314</td>
<td>$2,736.57</td>
</tr>
<tr>
<td>A-3-Z Solutions</td>
<td>$96,398.49</td>
<td>1,418</td>
<td>384.17 %</td>
<td>58</td>
<td>$1,684.46</td>
</tr>
<tr>
<td>A-ARVID Laser Resources</td>
<td>$4,053.05</td>
<td>25</td>
<td>3792.05 %</td>
<td>13</td>
<td>$311.77</td>
</tr>
<tr>
<td>A Superior System</td>
<td>$103,728.12</td>
<td>868</td>
<td>4974.55 %</td>
<td>187</td>
<td>$021.13</td>
</tr>
<tr>
<td>A&amp;B</td>
<td>$93,120.69</td>
<td>891</td>
<td>4202.00 %</td>
<td>18</td>
<td>$5,117.81</td>
</tr>
<tr>
<td>A&amp;G</td>
<td>$12,692.01</td>
<td>133</td>
<td>4796.00 %</td>
<td>12</td>
<td>$1,041.68</td>
</tr>
<tr>
<td>AAR Partners</td>
<td>$50,302.45</td>
<td>166</td>
<td>3485.00 %</td>
<td>6</td>
<td>$5,055.41</td>
</tr>
<tr>
<td>A1 Datacom Supply</td>
<td>$150,598.52</td>
<td>8,399</td>
<td>4929.74 %</td>
<td>111</td>
<td>$2,359.73</td>
</tr>
<tr>
<td>A2i</td>
<td>$451.54</td>
<td>14</td>
<td>5983.74 %</td>
<td>9</td>
<td>$50.18</td>
</tr>
<tr>
<td>A2Z Solutions</td>
<td>$66,977.38</td>
<td>484</td>
<td>4121.14 %</td>
<td>94</td>
<td>$742.44</td>
</tr>
<tr>
<td>AA-Wizard</td>
<td>$94,299.44</td>
<td>917</td>
<td>4099.00 %</td>
<td>41</td>
<td>$2,387.79</td>
</tr>
</tbody>
</table>

You only make selections in the dimension columns. All dimension columns have a search icon in the header.

When to use it

Use a table, when you want to view detailed data and precise values rather than visualizations of values. Tables are good when you want to compare individual values. Drill-down group dimensions are very efficient in tables. Within a limited space, you can drill down to the next level of detail and analyze the updated measure values.

Advantages

You can filter and sort the table in different ways. Many values can be included in a table, and when you drill down in a table, you make good use of a limited space of the sheet. A table is excellent when you want to see exact values rather than trends or patterns.

Disadvantages

If the table contains many values, it is difficult to get an overview of how values are related. It is also hard to identify an irregularity within the table.

Creating a table

You can create a new table on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty table to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.
When you have created the table, you may want to adjust its appearance and other settings in the properties panel.

Column width is automatically set to keep columns together for improved readability. You can adjust the width of a column by dragging the header divider. Double-click the header divider to reset to the default width.

Aligning data
If Text alignment is set to Auto, column data is aligned according to data type: text values are left-aligned and number values, including date related values, are right-aligned. If you set it to Custom, you can align the data to the left, center, or right.

Sorting the table
You can adjust the sorting of the table in several ways:

- Column sorting: adjust the order of the dimensions and measures from left to right
- Row sorting: adjust the sorting priority order of the rows
- Internal sorting: use the internal sorting order of dimensions and measures
- Interactive sorting: during analysis you can click on a column header to sort the table

Column sorting
By default, the order in which columns are sorted is set by the order in which dimensions and measures are added to the table. If you add the measure Sales first, it is presented first (leftmost) in the table. The next dimension or measure that is added is presented in the second column, and so on. The column sorting order can be changed in the properties panel, under Columns.

Row sorting
By default, rows are sorted by the first added dimension or measure, numeric values descending, text values ascending. A small arrow under the column header shows by which column the table is sorted.

You can change the row sorting in the properties panel, under Sorting. Drag the dimensions and measures to change the sorting priority order. In many cases, sorting is not only affected by the first dimension or measure in Sorting, but also the following ones.

Example:

In the following screenshot, the rows are first sorted by Customer, then by Month, and then by Product Type. As you can see, the columns Customer and Month have several rows with the same values (A-2-Z Solutions and Month). The rows in Product Type are ordered alphabetically, but only those that were sold in January to the customer A-2-Z Solutions are displayed.
By changing the sorting order, so that secondary sorting is by Product Type, followed by Month, all Product Type items sold to the customer A-2-Z Solutions are presented in alphabetical order, whereas only the months when they were sold are displayed under Month.
Internal sorting
Each dimension and measure has a default (Auto) internal sorting order, which can be changed. Under Sorting, click the item you want to change and click the button to switch to Custom sorting. Changes made to the internal sorting of an item may not have any effect if the sorting is in conflict with an item with higher priority.

Interactive sorting
During analysis, you can set which column to sort on by clicking the column header. The first click sorts the table according to the default sorting of the selected item. A second click reverses the sorting order. Interactive sorting is session based and is not saved. If you want your changes to the sorting to be persistent, you need to make the changes in the properties panel.

Accumulating data
You can accumulate values of a measure over one or two dimensions:
Displaying totals
By default, the totals of numeric values are displayed under the column names. In the properties panel, you can change this to display the totals at the bottom of a column, or not at all.

Displaying more data
You can freeze the first column from scrolling, and select to wrap multiline text in headers and cells separately. These settings are changed in the property panel under Appearance > Presentation. You can also disable horizontal scrolling, and enable the column picker feature. This lets app consumers change table column order.

Adding a trend indicator to a measure
You can add a trend indicator to a measure column. This will show a symbol next to the measure value. You can define the ranges that determine which symbol is displayed and in which color it is displayed. You enable the indicator by setting Representation to Indicator in the measure properties.

Setting the indicator limits
You need to add the limits for the ranges you want to use for showing indicators with Add limit. You can set a limit value in three ways.

- Use the slider.
- Type a value in the text box.
- Set an expression that returns the limit value.

When you have added the limits, you can select the color and the symbol of the indicator for each defined range.

Styling the indicator
You can style the way the indicator is displayed.

- You can show both the indicator and the measure value by selecting Show values.
- You can set the value color to the same as the indicator color with Apply color to value.
3 Visualizations

- You can display the indicator to the right or to the left of the value with **Indicator position**.

**Example**

In this example, we added a trend indicator to the Sales measure to indicate which values are below the target value. The indicator limits are:

- For values below 3000000 a red flag is displayed.
- For values in the range of 3000000 to 3500000 a yellow flag is displayed.
- For values above 3500000 a green check-mark is displayed.

<table>
<thead>
<tr>
<th>Year</th>
<th>Month</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012</td>
<td>Jan.</td>
<td>1773749,81</td>
</tr>
<tr>
<td>2012</td>
<td>Feb.</td>
<td>3807568,91</td>
</tr>
<tr>
<td>2012</td>
<td>Mars</td>
<td>3892194,80</td>
</tr>
<tr>
<td>2012</td>
<td>Apr.</td>
<td>3660633,9</td>
</tr>
<tr>
<td>2012</td>
<td>Maj.</td>
<td>3191647,98</td>
</tr>
<tr>
<td>2012</td>
<td>Juni</td>
<td>4259259,66</td>
</tr>
<tr>
<td>2012</td>
<td>Jul.</td>
<td>2519872,65</td>
</tr>
<tr>
<td>2012</td>
<td>Aug.</td>
<td>3790274,66</td>
</tr>
<tr>
<td>2012</td>
<td>Sep.</td>
<td>3739007,87</td>
</tr>
<tr>
<td>2012</td>
<td>Okt.</td>
<td>3036455,81</td>
</tr>
<tr>
<td>2012</td>
<td>Nov.</td>
<td>3528899,04</td>
</tr>
<tr>
<td>2012</td>
<td>Dec.</td>
<td>2905448,63</td>
</tr>
</tbody>
</table>

**Adding a mini chart to a measure**

You can add a mini chart to a measure column. This will show a small chart visualization instead of the measure value. You can define the dimension that determines what data is displayed and in which color it is displayed. You enable the indicator by setting **Representation** to **Mini chart** in the measure properties.

**Setting the mini chart type**

After specifying which dimension the mini chart will be based on, you must select a **Mode**.

- **Bars** creates a bar chart.
- **Dots** creates a dot chart.
- **Sparkline** creates a sparkline chart. You can show dots at each data point along the sparkline chart by selecting **Show dots**.
- **Positive/negative** creates a chart with each value represented by a dot above or below the zero.

When you have selected the mode, you can specify the **Y-axis** of the Mini chart at the bottom of the mini chart options.

**Styling the mini chart**

You can set the color of bars or lines for **Bars, Dots, and Sparkline**.

Create apps and visualizations - Qlik Sense, February 2021
You can optionally set the **Max value color** and **Min value color**, which will highlight the highest and lowest visible chart values.

You can optionally set the **Highlight first** and **Highlight last** colors, which will highlight the first and last visible chart values.

You can set the positive and negative color for a **Positive/negative** mini chart.

**Display limitations**

**Number of rows and columns**

In a table, you can have millions of rows and virtually any number of columns with dimensions and measures. But because huge tables are impractical and hard to manage, the limit for what is practical is far less than the theoretical maximum. In most cases, it is desirable to see all the columns without scrolling horizontally.

**Tables with content of mixed sizes**

In a table you can have both columns where the content fits on one row within the cell, and columns containing wrapped multiline text. In some cases you will see a shift in alignment and number of rows when the multiline column is scrolled in and out of view. When the view only contains content that fits on one row, the table will adjust and show all columns on single line rows, which means more rows are displayed.

We recommend that you disable multiline text wrapping in these cases to avoid confusion for the user.

**Searching in tables**

In a table, you can search the dimension columns, and make selections in the resulting list.

Do the following:

1. Click 🔍 in the dimension column that you want to search in.
   A selection popup is displayed with a list of all values of the field. This includes values that are excluded by selections. Excluded values are dark gray.
2. Type your search string.
   While you type, the list is filtered to only display matching items.
3. Make a selection by clicking or drawing.
4. Confirm your selection.

   You can confirm the selection of all matching items by pressing Enter.

The new selection is active and reflected in all associated visualizations.

   You can remove the search string by clicking 🔍 or pressing Esc. The search string is always removed when you press Enter.

**Selections in tables**

You can make selections in a table by clicking or drawing in the dimension columns.
Measure values cannot be selected. When you make a selection, it is always the dimension values that you select. You can only make selections in one column at a time.

*Table with three selected fields in the dimension Customer.*

<table>
<thead>
<tr>
<th>Customer</th>
<th>Sales</th>
<th>Margin (%)</th>
<th># of Invoices</th>
<th>Average Sales per Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-2-Z Solutions</td>
<td>$158.56</td>
<td>3929.7%</td>
<td>1</td>
<td>$1,277.65</td>
</tr>
<tr>
<td>ARKON Laser Resources</td>
<td>$1,288.63</td>
<td>3643.3%</td>
<td>1</td>
<td>$248.63</td>
</tr>
<tr>
<td>A Superior System</td>
<td>$1,138.84</td>
<td>1730.2%</td>
<td>1</td>
<td>$1,138.84</td>
</tr>
<tr>
<td>A&amp;B</td>
<td>$1,088.88</td>
<td>5872.6%</td>
<td>2</td>
<td>$1,988.68</td>
</tr>
<tr>
<td>A&amp;R Partners</td>
<td>$1,088.88</td>
<td>8856.5%</td>
<td>1</td>
<td>$129.25</td>
</tr>
<tr>
<td>AL Datacom Supply</td>
<td>$1,088.88</td>
<td>3650.6%</td>
<td>1</td>
<td>$24.60</td>
</tr>
<tr>
<td>a2i</td>
<td>$1,088.88</td>
<td>4078.9%</td>
<td>1</td>
<td>$300.81</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>$1,088.88</td>
<td>8856.5%</td>
<td>1</td>
<td>$129.25</td>
</tr>
</tbody>
</table>

To deselect a row, click it. To confirm a selection, click ✔ or click outside the visualization. You can also press Enter. To cancel, click ✗ or press Esc. If you confirm, the selection is reflected in all visualizations associated with the table.

You cannot select dimension values that are null. Null values in a table are presented as dashes (-). Rows without valid dimension values will not be included in the selection.

**Accumulating values over a dimension in a table**

This example shows how to use a table to compare data which accumulate over a dimension.
In this example, we will use a data file available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial. The file is available in the Tutorials source folder: Sales.xls

To download the file, go to Tutorial - Building an App.

Add the data file to an empty app. The dataset that is loaded contains sales data.

Measure

We use the sales volume as the measure that we create in Master items:

- Sales with the expression `sum(Sales)`. This is the sum of the sales volume.

Visualization

We add a table to the sheet and set the following data properties:

- **Dimension**: Year (Date.Year).
- **Dimension**: Month (Date.Month).
- **Measure**: Sales; the measure that was previously created.

The following table is created, with columns showing the year, the month, and the sum of sales for each month.
3 Visualizations

Make sure to set the **Sorting** with **Year > Month > Sales**.

**Accumulation**

To have our sales data accumulate over one dimension, we need to set an additional data property:

- **Measure**: `Sales`; the measure that was previously created.

We add this measure twice to reuse it for accumulation. To do this we need to apply a modifier to our `Sales` measure.

**Do the following:**

1. Under **Measure**: `Sales` set the **Modifier** to Accumulation. This will set the measure to accumulate over one dimension.
2. Set the **Modifier>Dimension** to **Month**. This sets the dimension over which the accumulation will take place.
3. Make sure **Across all dimensions** is turned off. We want the accumulation to restart at the beginning of each year.

Our table becomes as follows, with the last column showing sales accumulating from one month to the next, for each year.
It is good practice to have the title of your charts represent their content. So consider changing the titles of the columns of your table to reflect that the last column contains an accumulation of sales.

Our data for the year 2014 is insufficient as it stops at June. In order to achieve a better comparison between the accumulated sales of all three years we will choose a more appropriate range of months, from January to June.

**Do the following:**

1. Click **Done**.
2. Select all months from January to June and confirm your selection.

Our table becomes as follows, with the sales accumulating from January to June, inside each year.
Discovery

The table shows the sales volume of each month, grouped into years. By having the sales accumulate inside each year, we get a better understanding of the volume of sales for each year. We have made a selection of the months from January to June, to compare the same range of months between the three years. In the last column of the table we can see that the accumulated sales for 2014 so far have been higher than the accumulated sales for 2012, but not as high as the ones for 2013.

Using relative numbers in a table to calculate contribution

This example shows how to use the relative numbers modifier to calculate contribution in a one dimensional table.
Dataset
In this example, we will use a data file available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial. The file is available in the Tutorials source folder: Sales.xls

To download the file, go to Tutorial - Building an App.

Add the data file to an empty app. The dataset that is loaded contains sales data.

Measure
We use the sales volume as the measure that we create in Master items:

- Sales with the expression sum(Sales). This is the sum of the sales volume.

Visualization
We start by adding a filter pane to the sheet and set the following data properties:

- Dimension: Product Group.

We also add a table to the sheet and set the following data properties:

- Dimension: Year (Date.Year).
- Measure: Sales; the measure that was previously created.

The following table is created, with columns showing the year, and the sum of sales for each year.

Make sure to set the Number formatting to Money, and the Format pattern to $#,##0;-$#,##0.

It is good practice to have the title of your charts represent their content. Additionally, consider changing with the title of each column to reflect what it represents. The first column that we added is the Year, and the second column contains the Sales per year.

Relative numbers
We could use the filter pane to select specific product groups and see their yearly sales and their total sales. That would not provide a good comparison to their contribution. Instead we will use relative numbers to get percentages as an indication of the product group contribution. By changing the parameters upon which the relative numbers calculation is based, we will get different contributions and gain more insight.
Contribution of a year to the sales of product group
To see how much each year has contributed to the total sales of a specific product group when we make a selection, we need to add a third column:

Do the following:

- In the properties panel right-click on Sales per year and select Duplicate.

To use this duplicate measure as a relative number we will apply a modifier.

Do the following:

1. Under Measure: Sales per year set the Modifier to Relative numbers. This will set the measure to act as a relative number.
2. Set the Modifier>Selection scope to Current selection. This sets the modifier to be calculated relative to any selection made.
3. The Modifier>Dimensional scope is set to Disregard dimension by default. This sets the modifier to be calculated relative to the total.
4. Set the Number formatting to Custom, and the Format pattern to #,##0%.
5. Change the Label to something meaningful such as Contribution to total sales of current selection.

Our table becomes as follows, with the last column showing the contribution of each year to the total sales of the selected product group.

![Contribution of a year to the sales of product group table]

Contribution of a product group to total sales
To see how much each year's sales of a specific product group have contributed to the total sales of all product groups, we need to add a fourth column:

Do the following:

- In the properties panel right-click on Contribution to total sales of current selection and select Duplicate.

We will apply the Relative numbers modifier again, but with different properties this time.
Do the following:

1. Set the **Modifier>Selection scope** to *Disregard selection*. This sets the modifier to be calculated disregarding any selection made.
2. The **Modifier>Dimensional scope** is already set to *Disregard dimension*. This sets the modifier to be calculated relative to the total.
3. Change the **Label** to something meaningful such as *Contribution to total sales from all years*.

The **Number formatting** and the **Format pattern** are already set, since we duplicated the previous measure.

Our table becomes as follows, with the last column showing the contribution of the selected product group to the total sales from all three years.

<table>
<thead>
<tr>
<th>Product Group</th>
<th>Sales comparison table</th>
<th>Contribution to total sales from all years</th>
<th>Contribution to sales of each year</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Year</td>
<td>Sales per year</td>
<td>Total Sales</td>
</tr>
<tr>
<td>---------------</td>
<td>------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>1. Alcoholic Beverages</td>
<td>2012</td>
<td>$34,173,392</td>
<td>38%</td>
</tr>
<tr>
<td>2. Baked Goods</td>
<td>2014</td>
<td>$21,955,382</td>
<td>21%</td>
</tr>
<tr>
<td>3. Baking Goods</td>
<td>Total</td>
<td>$104,852,575</td>
<td>100%</td>
</tr>
</tbody>
</table>

Since we have not made any selections yet, the last two columns have the same values.

**Contribution of a product group to yearly sales**

To see how much the sales of a specific product group have contributed to that year’s sales compared to all the other product groups, we need to add a fifth column:

**Do the following:**

- In the properties panel right-click on *Contribution to total sales from all years* and select **Duplicate**.

We will apply the Relative numbers modifier again, but with different properties this time.

**Do the following:**

1. Set the **Modifier>Selection scope** to *Disregard selection*. This sets the modifier to be calculated disregarding any selection made.
2. The **Modifier>Dimensional scope** is already set to *Respect dimension*. This sets the modifier to be calculated relative to each dimensional value.
3. Change the **Label** to something meaningful such as *Contribution to sales of each year*.

Our table becomes as follows, with the last column showing the contribution of the selected product group to the total sales from all three years.
Since we have not made any selections yet, the last column shows the yearly contribution of all product groups for each year.

Making a selection
We can now start making selections to change our relative numbers to something that provides more insight.

Do the following:

1. Click ✔️ Done editing in the toolbar.
2. Select Canned Products from the product group filter pane.

Our table becomes as follows.

**Discovery**

The table shows the relative sales for each year. By having the different contribution columns, using the relative numbers as a measure modifier, we get a better understanding of the contribution of each product group to the total sales. From the Contribution to total sales of current selection column we can see that 40% of the Canned Product sales happened in 2012, with a dramatic drop in 2014. The Contribution to total sales from all years column shows that 8% of the total sales from all three years came from the 2012 sales of Canned Product. The Contribution to sales of each year column also tells us that for 2012 the Canned Product sales contributed 21% of the sales of that year, and the same applies to the sales of 2014.

**Table properties**

You can change the layout and formatting of tables in Qlik Sense.

You open the properties panel for a visualization by clicking(Edit sheet) in the toolbar and clicking the visualization that you want to edit.
If the properties panel is hidden, click **Show properties** in the lower right-hand corner.

*If the visualization has ☐ in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.*

*Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.*

**Data**
Click **Add column** to add a dimension or a measure. Options that are dimmed are not available.

**Columns**
In the table, the dimensions and measures are presented together under the heading **Columns**.

**Dimension settings**
On the **Data** tab, click **Add column** and select **Dimension** to open a list of available **Dimensions** and **Fields**. Select the dimension or field that you want to use.

A dimension can either be selected from the list of already existing **Dimensions**, or created from the list of available **Fields**.

To edit a dimension that is stored as a master item, you must first unlink the dimension from the master item.

- **<Dimension name>**: Click the dimension name to open the dimension settings. If you want to delete the dimension, right-click the dimension and select ☐ in the dialog. Alternatively, click the dimension and click ☐.
  - **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click ☒ to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion.
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values.
You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.

- **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.

- **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.

- **Calculated on measure** $<\text{measure}>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

  - **Show column if**: You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown. You can use this to require a field selection before calculating and showing large amounts of data.

  - **Background color expression**: Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

  - **Text color expression**: Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible.

  - **Text alignment**: When set to **Custom**, you can select how to display the content: **Align left**, **Align center**, or **Align right**. If **Text alignment** is set to **Auto**, the alignment is automatically aligned left or right, depending on the content.

- **Representation**: When set to **Text**, all values are displayed as static text. When set to **Link**, field values that contain a URL are displayed as clickable links. Clickable links open a new browser tab.

  - **Link setting**: Select the type of link displayed, either **Add link** or **Add URL**. When you set a link setting, only the corresponding option will be displayed.

    - **Link label**: Enter an expression for the link content. Links will be displayed and ordered by the link URL. Click $\text{fx}$ to open the expression editor.

    - **Link URL**: Enter an expression for the link content. Links will be displayed and ordered by the link destination label. Click $\text{fx}$ to open the expression editor.

  - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (**Fixed number**, **Exact value**, or **Relative number**), the value counts as 1 in that setting. If, for example, **Exact value** is used and set to 10, the tenth value is **Others**.

    - **Others label**: Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click $\text{fx}$ to open the expression editor.
• **Master item**: You can create a master dimension based on the dimension expression by clicking Create new.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measure settings**

On the **Data** tab, click **Add column** and select **Measure** to open a list of available measures. Select the measure that you want to use. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

To edit a measure that is stored as a master item, you must first unlink the measure from the master item.

• **<Measure name>**: Click the measure to open the measure settings. If you want to delete the measure, click **Delete**.
  
  - **Expression**: Click \( \text{Expression} \) to open the expression editor. The existing expression is displayed by default.
  
  - **Modifier**: Selects a modifier for the measure. Options are **None**, **Accumulation**, **Moving average**, **Difference**, and **Relative numbers**.
    
    - **Accumulation**: Only displayed when **Accumulation** has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions.
      
      The following options are available:
        
        - **Dimension**: Selects the dimension on which the accumulation will take place. If the accumulation is made across multiple dimensions, this will be the first dimension.
        
        - **Across all dimensions**: Continues accumulation across all available dimensions.
        
        - **Range**: Select whether the accumulation will happen on the **Full** range, or a **Custom** range of the dimension.
        
        - **Steps**: Only displayed when **Range** is set to **Custom**. The number of steps in the dimension which form an accumulation range. Only zero and positive integers are accepted.
        
        - **Show excluded values**: Include excluded values in the accumulation.
        
        - **Output expression**: Shows the expression used by the modifier.
      
    - **Moving average**: Only displayed when **Moving average** has been selected as a modifier. It allows you to accumulate values of your measure over one or two dimensions.
      
      The following options are available:
        
        - **Dimension**: Selects the dimension on which the moving average will take place. If the moving average is made across multiple dimensions, this will be the first dimension.
• **Across all dimensions**: Continues moving average across all available dimensions.
• **Range**: Select whether the moving average will happen on the **Full** range, or a **Custom** range of the dimension.
• **Steps**: Only displayed when Range is set to **Custom**. The number of steps in the dimension which form a moving average range. Only zero and positive integers are accepted.
• **Show excluded values**: Include excluded values in the moving average.
• **Output expression**: Shows the expression used by the modifier.

**Difference** : Only displayed when Difference has been selected as a modifier. It allows you to calculate the difference between consecutive values of a measure over one or two dimensions.

The following options are available:

• **Dimension**: Selects the dimension on which the difference will take place. If the difference is made across multiple dimensions, this will be the first dimension.
• **Across all dimensions**: Continues difference across all available dimensions.
• **Show excluded values**: Include excluded values in the difference.
• **Output expression**: Shows the expression used by the modifier.

**Relative numbers** : Only displayed when Relative numbers has been selected as a modifier. It allows you to calculate percentages relative to a specific selection, relative to the total, or relative to a field value. The modifier can be calculated over one or two dimensions.

The following options are available:

• **Selection scope**: Sets whether the relative numbers are calculated based on the current selection or a specific field value. You can also disregard the current selection.
• **Dimensional scope**: Sets whether the relative numbers are calculated based on a dimension. You can choose to have the modifier respect all available dimensions, respect a specific dimension if there are two, or to disregard the dimensions.
• **Output expression**: Shows the expression used by the modifier.

• **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
• **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
• **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
  To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
3 Visualizations

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `##00` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.00` describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

**Limitations:**

- Only works with visualizations that accept measures.
- Cannot be used with a box plot.
- Does not affect the number formatting of the axis.

- **Show column if**: You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown.

- **Background color expression**: Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

- **Text color expression**: Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible.

  For more information, see *Coloring a visualization* (page 534).

- **Text alignment**: When set to **Custom**, you can select how to display the content: **Align left** or **Align right**. If **Text alignment** is set to **Auto**, the alignment is automatically aligned left or right, depending on the content.
3  Visualizations

- **Totals function**: Select which aggregation function you want to use for the Totals row in the table. If Totals function is set to Auto, it will use the same function that is used in the measure expression. You can set the position of the Totals row under Presentation.

- **Representation**: You can select to show a value (Text) or an indicator (Indicator) or a Mini chart (Mini chart).

  The following properties are available if you select **Indicator**:
  - **Add limit**: Add indicator limits.
  - **Gradient**: Set the indicator color as a gradient according to the limit colors.
  - **Show values**: Show both the value and the indicator.
  - **Apply color to value**: Apply the indicator color to the value. This is only available when Show values is selected.
  - **Indicator position**: Select which side of the value to display the indicator. This is only available when Show values is selected.

  The following properties are available if you select **Mini chart**:
  - **Select dimension**: Select a dimension for the Mini chart.
  - **Mode**: Select a visualization mode for the Mini chart. Bars, Dots, Sparkline, and Positive/negative are available.
  - **Colors**: Set optional colors for the mini chart.
  - **Show dots**: Adds dots to each data point on the sparkline mini chart.
  - **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
  - **Y-axis**: Select what value to use for the Y-axis of the mini chart

- **Master item**: You can create a master measure based on the measure expression by clicking Create new.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Dimensions and measures can also be sorted internally:

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.
• **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
• **Sort numerically**
• **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

• **Data handling**:
  • **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  • **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

**Appearance**

**General**

• **Show titles**: **On** by default in all visualizations except filter panes, KPIs, and text & image visualizations.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click ℹ️ if you want to create an expression by using the expression editor.

  *Titles are displayed on a single line. If you inject line breaks they will be ignored.*

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ‘ & Sum(Sales).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ‘ & Sum(Sales)), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where **<value of expression>** is the calculated value.

• **Disable hover menu**: Select to disable the hover menu in the visualization.
• **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

State: Set the state to apply to the visualization. You can select:

- Any alternate state defined in Master items.
- &lt;inherited&gt;, in which case the state defined for the sheet is used.
- &lt;default state&gt;, which represents the state where no alternate state is applied.

Presentation

- Styling: Customize the styling of the table, overriding the app theme. You can add custom header and content font sizes and colors. You can set rows to be highlighted when hovered over and set colors for the row and font. You can also set the size of the scrollbar.

- Totals:
  - Auto: The totals (the result of the expression), are automatically included at the top of the table.
  - Custom: Select whether to display the totals and where to display them, at the top or bottom.

- Totals label: Set the label for the totals row. You can also use an expression as a label.

- Horizontal scrolling: Use the drop down to choose between:
  - Scroll: Enable horizontal scrolling. Use the toggle to freeze the first column when scrolling.
  - Column picker: Enable column picker feature. App consumers can change column order in the table.

- Multiline text wrapping: Enable or disable multiline text wrapping in headers and cells separately.

Text & image

The text & image visualization complements other visualizations by offering options to add text, images, hyperlinks, and measures.

You can format and color the text and align the paragraphs. The background image has sizing and positioning options. You can also set the responsive behavior for text and images.

When to use it

The text & image visualization is intended for presentation purposes, and does not support selections. However, the measures in the text & image visualization are updated when selections are made. Some typical uses:

- Use it on the first sheet of an app for essential information.
- Display a company image, or use a background image together with formatted text and measure values to present figures in a compelling way.
- Link to sites with additional information.
- Use the responsive behavior to ensure that the visualization renders well on all devices.

Advantages

The text & image visualization contrasts with the other visualizations. You have many options for making the text & image visualization stand out next to more regular charts.
Disadvantages
You are limited to a few measure values and rather short texts, otherwise the text & image visualization will be cluttered.

Creating a text & image
You can create a text & image visualization on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty text & image chart to the sheet.
2. Click the text & image chart to open the editing toolbar.
3. Add and format text, images, hyperlinks or measures to the text & image chart.

If you double-click a text & image chart in the assets panel, it is added to the sheet immediately.

Editing a text & image
In the text & image visualization you can add and format text, images, measures, and links in various ways.

When you are editing a sheet and the text & image visualization does not have focus, you need to click twice to open the editing toolbar. In the editing toolbar, you can format text properties such as color, size, and style, and also align the text. Additionally, you have options for adding links and images.

Creating a link
You can mark a text section and use it for a link.

If you do not add a prefix, http:// is added automatically, assuming that you are adding a web address.

Do the following:

1. Select the text section that you want to use for the link.
2. Click in the editing toolbar to open the link dialog.
3. Enter the web address that you want to link to.
4. Click .

Removing a link
You can remove a link from a text section.

Do the following:

1. Click the link so that the cursor is somewhere inside it.
2. Click in the editing toolbar to open the link dialog.
3. Click .

The link is removed, but not the text.
Adding an image

You can add an image through the editing toolbar. You can use one of the default images, or an image of your own.

**Do the following:**

1. Click 📀 in the editing toolbar.
   The **Media library** opens.
   - The following formats are supported: .png, .jpg, .jpeg, and .gif.
   - For Qlik Sense: You can upload images to the **In app** folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.
   - For Qlik Sense Desktop: You can place images in the following folder on your computer: `C:\Users\<user>\Documents\Qlik\Sense\Content\Default`. Images will be available in the **default** folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, the images will be in the **In app** folder in the media library for the app.

2. Click on a folder in the media library, for example **In app** or **Default**.
3. Select the image that you want to add.
4. Click **Insert**.

   *Alternatively, long-touch/right-click the image file you want to add and select **Insert**.*

   *In the properties panel, you can add a background image, which, for example, can be used when you want to insert text in the image. The images added through the editing toolbar are not background images.*

Adding a measure

You can add a measure in the following ways:

- By dragging a field from the assets panel and adding it as a measure.
- By dragging a measure from **Master items**.
- By adding a measure (existing or new) from the properties panel.

When you are editing the measure, it is displayed as a token, which can be styled and moved around in the visualization. You can also apply number formatting to it. When you leave the editor, the measure value is displayed. Values that cannot be aggregated are shown as a hyphen (-).

Deleting a measure

You can delete a measure in the following ways:

- Place the cursor before the token and press Delete.
- Place the cursor after the token and press Backspace.
In the properties panel, right-click the measure and select Delete in the dialog.

In the properties panel, click the measure and click Delete.

**Text & image properties**

You can change the layout and formatting of text and images in Qlik Sense.

You open the properties panel for a visualization by clicking Edit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click Show properties in the lower right-hand corner.

- If the visualization has link icon in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

- Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

**Data**

Click Add measure and select a measure or create a measure from a field.

**Measure**

On the Data tab, under Measures, click Add measure to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click fx to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add measure is dimmed, you cannot add more measures.

- **<Measure name>:** Click the measure to open the measure settings.
  
  If you want to delete the measure, long-touch/right-click the measure and select Delete in the dialog.
  
  Alternatively, click the measure and click Delete.
  
  - **Expression:** Click fx to open the expression editor. The existing expression is displayed by default.
  
  - **Label:** Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
3 Visualizations

- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

Examples:

- `# ###0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.
- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.
- **Decimal separator**: Set the decimal separator.
3 Visualizations

- **Thousands separator**: Set the thousands separator.
- **Format pattern**: Set the number format pattern.

- **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.

### Appearance

#### General

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.
  
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click \( \text{.fx} \) if you want to create an expression by using the expression editor.

> **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

#### Example:

Assume that the following string is used, including quotation marks: \( 'Sales: \ & \ Sum(Sales) \).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: \( (='Sales: \ & \ Sum(Sales) \), \) the string is interpreted as an expression instead. The output is then \( Sales: \ <value \ of \ expression> \), where \( <value \ of \ expression> \) is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

#### Alternate states

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- \(<\text{inherited}>\), in which case the state defined for the sheet is used.
- \(<\text{default state}>\), which represents the state where no alternate state is applied.

#### Presentation

In the list, set whether text and images should have a responsive behavior. When responsive behavior is selected, the size of text and images are adjusted to the size of the visualization area. However, they do not expand beyond their normal size.

#### Background image

**Use background image**: **Off** by default. Click the button to enable selection or removal of a background image. You can only have one background image at a time.
**Image**: Click to open the media library where you can select a background image. To remove the background image, click 

**Sizing**: Set the sizing of the image. With the Auto setting, the image does not scale when the text & image visualization is resized.

**Position**: Select the position of the image.

### Treemap

Treemaps display hierarchical data by using nested rectangles, that is, smaller rectangles within a larger rectangle.

In this image you have several product groups, such as Produce, Canned Products, and Frozen Foods. Each product group consists of a large rectangle. You can regard the product groups as branches of the tree. When you select a product group, you drill down to the next level, the product type, for example, Vegetables, Meat, and Dairy. You can regard the product types as sub-branches of the tree. The branches have leaves. A leaf node's rectangle has an area proportional to a specified dimension of the data. In this example, the items Ebony Squash, Bravo Large Canned Shrimp, Red Spade Pimento Loaf, and so on, are the leaves. The leaf nodes are colored to show a separate dimension of the data.

Sorting is automatic according to size. By default, the coloring is by dimension, with 12 colors, but that can be changed in the properties panel. When you have more than one dimension, you can decide which dimension to color by. In this example, the coloring is not by dimension, but by expression (Avg(Margin)), a calculated measure, and by using this expression, you can see which items have the highest average margin. The darker the color, the higher the average margin.

If the data set contains negative values, a text message is shown stating that the negative values cannot be displayed.

### When to use it

Use a treemap when space is constrained and you have a large amount of hierarchical data that you need to get an overview of. Treemaps should primarily be used with values that can be aggregated.
Advantages
Treeemaps are economical in that they can be used within a limited space and yet display a large number of items simultaneously.

When there is a correlation between color and size in the tree structure, you are able to see patterns that would be difficult to spot in other ways, for example, when a certain color is particularly relevant.

Disadvantages
Treeemaps are not good when there is a big difference in the magnitude of the measure values. Nor is a treemap the right choice when mixing absolute and relative values.

Negative values cannot be displayed in treemaps.

Creating a treemap
You can create a treemap on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty treemap to the sheet.
2. Click Add dimension and select a dimension or a field. This should be the highest level in the hierarchy. It will be displayed as the main group in the chart.
3. Click Add measure and select a measure or create a measure from a field. The measure will define the size of a rectangle.
4. Add more dimensions in the order of hierarchy level. The last dimension you add defines the rectangles. The other dimensions define the grouping of the rectangles.

In a treemap you need at least one dimension and one measure, but to make full use of the treemap it is preferable to have two or three dimensions. You can only have one measure, but up to 15 dimensions. We do not recommend using more than three dimensions as the treemap may become unmanageable.

When you have created the treemap, you may want to adjust its appearance and other settings in the properties panel.

Display limitations
When displaying large amounts of data in a treemap, there may be cases when not each dimension value within a rectangle is displayed with correct color and size. These remaining values will instead be displayed as a gray, striped area. The size and total value of the rectangle will still be correct, but not all dimension values in the rectangle will be explicit.

To remove the gray areas, you can either make a selection or use dimension limits in the properties panel.

Displaying hierarchical data with a treemap
This example shows how to make a treemap to view hierarchical data. You can display a large number of values in limited space and detect patterns that could be hard to spot with other charts.

We will look at sales numbers for different products which are categorized in four levels.
In this example, we'll use two data files available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial, and the files are available in the Tutorials source folder:

- Sales.xlsx
- Item master.xlsx

To download the files, go to Tutorial - Building an App.

Add the two data files to an empty app, and make sure that they are associated by Item Number.

The dataset that is loaded contains sales data for food and beverage products. The Item Master table holds the information about the product categories.

**Visualization**

We add a tree map to the sheet and set the following dimensions and measures:

- **Dimensions > Group**: Product Group (product group)
- **Dimensions > Group**: Product Sub Group (product sub group)
3 Visualizations

- **Dimensions > Rectangle**: Item Desc (product item description)
- **Measures > Size**: Sum(Sales) (sum of sales)

A treemap is created, with a rectangle for each product item. Rectangles are sized according to sales and grouped according to Product Group and Product Sub Group.

But we also want to add some more information to the chart. The rectangles are colored by the product group dimension, but we want color them by margin to also see which items are most profitable. You can do this in Appearance > Colors and legend.

- Set **Colors** to Custom.
- Set **Color by measure** to Avg(Margin/Sales)

We also want to see the sales values in the chart. You can turn them on with **Value labels Appearance > Presentation**.

**Discovery**

We can see in the chart that Produce has the largest sales, followed by Canned Products. The coloring by margin allows you to identify product items or groups that stand out. You can drill down in the tree by selecting a product group.
Here we have selected Produce, then Fresh Fruit. Tell Tale Red Delicious Apples are the number one sellers, but margins are higher on Ebony Red Delicious Apples.

Treemap properties

You open the properties panel for a visualization by clickingEdit sheet in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, clickShow properties in the lower right-hand corner.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

ClickAdd to add a dimension or a measure.
Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click \( \text{fx} \) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

\[
=\text{If (Week < 14, Week, 'Sales')}
\]

If Add is dimmed, you cannot add more dimensions.

- **<Dimension name>:** Click the dimension name to open the dimension settings.
  If you want to delete the dimension, right-click the dimension and select \( \text{trash can} \) in the dialog. Alternatively, click the dimension and click \( \text{trash can} \).
  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click \( \text{fx} \) to open the expression editor.
  - **Label:** Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values:** When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation:** The default value.
    - **Fixed number:** Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click \( \text{fx} \) to open the expression editor.
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click \( \text{fx} \) to open the expression editor.
    - **Relative value:** Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click \( \text{fx} \) to open the expression editor.
    - **Calculated on measure: <measure>:** Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
    - **Show others:** When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
3 Visualizations

- **Other label**: Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click \( \text{express} \) to open the expression editor.

- **Master item**: You can create a master dimension based on the dimension expression by clicking **Create new**.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (\( \equiv \)) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click \( \text{express} \) to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings. If you want to delete the measure, long-touch/right-click the measure and select \( \equiv \) in the dialog. Alternatively, click the measure and click \( \equiv \).

  - **Expression**: Click \( \text{express} \) to open the expression editor. The existing expression is displayed by default.

  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.

  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as \( k \) (thousand), \( M \) (million), and \( G \) (billion).
3 Visualizations

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- # ###0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- ###0 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  Only works with visualizations that accept measures.
  Cannot be used with a box plot.
  Does not affect the number formatting of the axis.

- **Master item**: You can create a master measure based on the measure expression by clicking **Create new**.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to
Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

Sorting
The sorting is done automatically by measure size.

Add-ons

- **Data handling:**
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: count(distinct Team)<3. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click [ ] if you want to create an expression by using the expression editor.

  *Titles are displayed on a single line. If you inject line breaks they will be ignored.*

**Example:**

Assume that the following string is used, including quotation marks: `Sales: ' & Sum(Sales)`. By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (`=Sales: ' & Sum(Sales)`), the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Disable hover menu**: Select to disable the hover menu in the visualization.
- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
3 Visualizations

- `<inherited>`, in which case the state defined for the sheet is used.
- `<default state>`, which represents the state where no alternate state is applied.

Presentation

- **Headers and labels:** With the **Auto** setting, the display varies with the size of the treemap. Very small treemaps have no headers or leaf labels. Small treemaps have overlay labels and no leaf labels. Large treemaps have headers and (some) leaf labels. With the **Custom** option you can make settings for headers and leaf labels:
  - **Headers:** When set to **Off**, you can either use **Overlay labels**, or no labels at all, by setting **Overlay labels** to **Off**.
  - **Leaf labels:** With the **Auto** setting the leaf labels are displayed if there is enough space.
  - **Value labels:** Set this to **Off** if you want to hide value labels on bars. With the **Auto** setting, the value labels are displayed if there is enough space.

Colors and legends

- **Colors:** Select how the chart values are colored. There are two settings:
  - **Auto:** Colors the chart values using default settings.
  - **Custom:** Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color:** Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors:** Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
  - **By dimension:** Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
    - **Select dimension:** Enter a field or expression containing the values to color objects in this chart.
    - **Library colors:** Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
    - **Persistent colors:** Select to have colors remain the same between selection states.
    - **Color scheme:** Select **12 colors** or **100 colors** to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
3 Visualizations

- **By measure:**
  - **Select measure:** Select the measure to use to color your chart.
  - **Library colors:** Select whether to use the master measure colors or to disable the master measure colors. Option available only when a master measure used in the visualization has colors assigned to it.
  - **Label:** Enter text or an expression for the measure that displays in the legend.
  - **Color scheme:** Select a color scheme from the following options:
    - **Sequential gradient:** The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
    - **Sequential classes:** The transition between the different color groups is made using distinctly different colors.
    - **Diverging gradient:** Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
    - **Diverging classes:** Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
    - **Reverse colors:** When selected, the color scheme is reversed.
    - **Range:** Define the range of values used to color by measure or by expression.
      - **Auto:** The color range is set by the measure or expression values.
      - **Custom:** When custom is selected, you can set the Min and Max values for the color range.
  - **By expression:** Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
    - **Expression:** Enter the expression that you want to use. Click $\text{fx}$ to open the expression editor.
    - **The expression is a color code:** Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see Coloring a visualization (page 534)
      When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
    - **Show legend:** Not available when Single color is selected. By default set to Off. The legend is displayed if there is enough space. The placement can be changed in the Legend position setting.
    - **Legend position:** Select where to display the legend.
    - **Show legend title:** When selected, the legend title is displayed.
Tooltip

- **Tooltip**: Set to Custom to add measures and images as tooltips.
- **Hide basic rows**: Hide the rows of the tooltip that show basic information. If a custom tooltip has no measures and a title and description, Hide basic rows will also hide dimension values as well.
- **Title**: Enter a title for the tooltip.
- **Description**: Enter a description for the tooltip.
- **Measures**
  - **Add measure**: Add a measure to be shown as a tooltip. You can add a measure from a field using From a field. You can also use an expression to add a measure. Click \( \text{fx} \) to open the expression editor. The existing expression is displayed by default. You can add a title and description to the tooltip. You can change the label of the tooltip using Label as well as its formatting using Number formatting.
- **Images**
  - **Type**: Choose whether to add an image from your Media library or from a URL.
  - **Size**: Set the size of the tooltip container. Qlik Sense fits the image into the container.
    - **Small**: Set the width and height of the container to 50 pixels.
    - **Medium**: Set the width and height of the container to 200 pixels.
    - **Large**: Set the width and height of the container to 340 pixels.
    - **Original**: Qlik Sense fits the image into the container. If the image is larger than 340 pixels, it is scaled down.
  - **Media library**: Appears when you choose Media library for Type. Click to select an image from your media library.
  - **URL**: Appears when you choose URL for Type. Enter a URL.

**Waterfall chart**

The waterfall chart is suitable for illustrating how an initial value is affected by intermediate positive and negative values. The starting and the final values are represented by whole bars, and intermediate values by floating bars. You can also show subtotals in the chart.

*Waterfall chart displaying Sales, Sales cost and Sales margin.*
When to use it

The waterfall chart is suitable for illustrating how an initial value is affected by intermediate positive and negative values. One example of this is an income statement, when you want to show the positive and negative contributions of different accounts.

Advantages

The waterfall chart provides a quick understanding of the transition of a value.

Disadvantages

The waterfall chart is not relevant for detailed analysis of the data as you can't make selections in the chart or expand the data.

Creating a waterfall chart

You can create a waterfall chart on the sheet you are editing.

In a waterfall chart you need to use one measure for each bar in the chart. The order of the measures defines the order of the bars in the chart. For each measure, you need to define how it affects the previous value.

Do the following:

1. From the assets panel, drag an empty waterfall chart to the sheet.
2. Add the first measure.
This is the first bar of the chart. By default, it will use the measure operation Add, and show a positive value.

3. Add a second measure.
   This is the second bar of the chart. If you want to show this measure as a negative contribution, change Measure operation to Subtract.

4. Continue to add measures, setting Measure operation to Add or Subtract depending on how you want them to contribute.

5. Add subtotals. There are two ways of adding subtotal bars to the chart:
   - If you have a data field containing subtotal data, add a measure with the subtotal data and select Subtotals as Measure operation.
   - If you don't have a data field containing subtotal data, you can add an automatically calculated subtotal by selecting the Subtotals check box of the measure before where you want the subtotal bar.

When you have created the waterfall chart, you may want to adjust its appearance and other settings in the properties panel.

Defining your measures

You can use the Measure operation option of each measure to set how it affects the previous value.

- **Add**
  The measure value adds to the previous bar. If this is the first measure, a whole bar is shown starting at 0.

- **Subtract**
  The measure value subtracts from the previous bar.

  *If the data already contains a negative sign, the result of subtraction will be a positive change.*

- **Subtotals**
  The measure value is considered a subtotal.

  *If you do not have sub-totals as a field, you can add subtotals automatically by enabling Subtotals in the measure before you want the subtotal.*

In the waterfall chart shown above, the first bar, Sales, is defined as Add. The second bar, Sales cost, is defined as Subtract, and the third bar, Sales margin, is defined as Subtotals.

Visualizing positive and negative contributions to the result with a waterfall chart

This example shows how to make a waterfall chart to visualize how positive and negative values contribute to the final result.
We want to see the positive contributions to CO2 in the atmosphere, such as oil or gas, in relation to negative factors, such as land sink.

Dataset
In this example, we will use a simple dataset that you can copy to a text file to use as data source. It contains the atmosphere CO2 level in ppm from 1870, as well as the positive and negative contributors to CO2 in the atmosphere in the time between 1870 and 2017.

Atmosphere 1870, Coal, Oil, Gas, Cement, Land, Imbalance, Land sink, Ocean sink, Atmosphere 2017
288, 94, 72, 31, 5, 88, -12, -89, -72, 405
(Source: CDIAC/GCP/NOAA-ESRL/UNFCCC/BP/USGS)

Add the text file as data source in an empty app, and load the data. Make sure that you use comma as field delimiter.

Visualization
We add a waterfall chart to the sheet and add the fields as measures in the following order. Edit the label for each measure to remove the sum() part.

- Sum(Atmosphere1870)
- Sum(Coal)
- Sum(Oil)
- Sum(Gas)
- Sum(Cement)
- Sum(Land)
- Sum(Imbalance)
• Sum(Land_sink)
• Sum(Ocean_sink)

To add a bar that shows the calculated result, the CO2 level for 2017, open the final measure and select **Subtotals**. You can set **Subtotal label** to **Atmosphere 2017**.

![Sources and sinks of CO2 in the atmosphere (ppm)](chart)

**Discovery**

As you can see in the chart, the CO2 level in the atmosphere is higher in 2017 than in 1870. Coal is the main contributor of CO2. Some of the increase is offset by carbon sinks that absorb CO2, for example, the ocean. As we can see, this is unfortunately not enough to stop the increase of CO2 in the atmosphere.

**Waterfall chart properties**

You open the properties panel for a visualization by clicking **Edit sheet** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click **Show properties** in the lower right-hand corner.

---

*If the visualization has ∇ in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.*
Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.

On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click \( \text{fx} \) to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add is dimmed, you cannot add more measures.

Measures
- **<Measure name>**: Click the measure to open the measure settings.
  - If you want to delete the measure, long-touch/right-click the measure and select \( \text{trash can} \) in the dialog. Alternatively, click the measure and click \( \text{trash can} \).
  - **Expression**: Click \( \text{fx} \) to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Measure operation**: Select how to use the measure in the chart:
    - **Add**: The measure value is added.
    - **Subtract**: The measure value is subtracted.
    - **Subtotals**: The measure value is treated as a subtotal value of the last measures using the same measure operation.
  - **Subtotals**: Select Subtotals to add an automatically calculated subtotal measure based on the result of all previous measure operations.
  - **Subtotal label**: Enter a label for the automatically calculated subtotal measure.
  - **Master item**: You can create a master measure based on the measure expression by clicking Create new.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars \( \equiv \) to rearrange the order.
Number formatting

- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor. The following number formats are available:
  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  - **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples:**

- `# ###0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example ",," is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.
- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
Only works with visualizations that accept measures. Cannot be used with a box plot. Does not affect the number formatting of the axis.

Add-ons

- **Data handling:**
  - **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines:** **Add reference line:** Click to add a new reference line.
  - **Show:** When selected, the reference line is displayed.
  - **Label:** Enter a label for the reference line.
  - **Color:** In the color picker, select the color of the reference line and the label.
  - **Reference line expression:** Enter a value or an expression for the reference line. Click `fx` to open the expression editor.
  - ![Remove](image): Click to remove the reference line.

Appearance

**General**

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click `fx` if you want to create an expression by using the expression editor.

> **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales). By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where <value of expression> is the calculated value.

- **Disable hover menu:** Select to disable the hover menu in the visualization.
- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in Master items.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation

- **Gridline spacing**: Set this to Custom if you want to customize the horizontal gridlines. You can choose between: No lines, Medium or Narrow.
- **Value labels**: Set this to Off if you want to hide value labels on bars.

Colors and legend

- **Colors**: You can set the presentation color for the different measure operations: Positive value color, Negative value color or Subtotal color
- **Show Legend**: Set to Auto to show a legend of the measure operations. You can set the position of the legend with Legend position:
  - **Auto**: The legend is automatically positioned where there is available space.
  - **Right**
  - **Bottom**
  - **Left**
  - **Top**

Y-axis

- **Labels**: Select if you want to show labels on the Y-axis.
- **Position**: Select where to display the dimension axis.
- **Scale**: Select how many lines you want to show on the Y-axis. Narrow shows many lines, and Wide shows few lines.
- **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

X-axis

- **Labels**: Select if you want to show labels on the X-axis.
- **Label orientation**: Select orientation of the labels.
- **Position**: Select where to display the measure axis.

Button

You can use buttons to:

- add quick links for easy selection and navigation in your app
- reload data
When to use it

The button is useful when you want to help the app user by providing:

- predefined selections or selection controls
- navigation links to other sheets, stories or websites
- reload data functionality in an app

You can reload data in an app that you own. App users need the appropriate access rights.

Creating a button

You can create a button on the sheet you are editing. This shows how to create a button that makes a selection and then navigates to another sheet. It is also possible to create a button that just performs the action, or that navigates.

Do the following:

1. From the assets panel, drag a Button object to the sheet.
2. Click Add action under Actions in the properties panel.
3. Select the action you want to use.
   For some actions you need to provide details for the action. For example, for the Select values in a field action, you need to select a field, and which value to select in the field.
4. Select which navigation option to use under Navigation. You can navigate to another sheet, a story or a website.
5. Set the label of the button in Label under General in the properties panel.

You will now have a button that makes a data selection and then navigates to the place in the app you selected.

Setting the action

You can add one or more actions to be performed when the button is clicked. For some actions you need to provide details for the action.

The actions are performed in the order they are listed under Actions. You can change the order of an action by dragging it.

You do not have to add an action if you just want the button to perform navigation.

Apply bookmark

You can apply the selection that is defined in a bookmark that you choose.

Clear all selections

You can clear all selections in the app. You can optionally overwrite locked selections.
3 Visualizations

Clear selections in other fields
You can clear selections from all fields except the one you specify. You can optionally overwrite locked selections.

Move forwards in your selections
You can move one step forwards in your selection history.

Move backwards in your selections
You can move one step backwards in your selection history.

Clear selections in field
You can clear all selections from a field that you specify.

Lock all selections
You can lock all selections in the app.

Lock a specific field
You can lock selections in a field that you specify.

Unlock all selections
You can unlock all selections in the app.

Unlock a specific field
You can unlock selections in a field that you specify.

Select all values in a field
You can select all values in a field that you specify. You can optionally overwrite locked selections.

Select values in a field
You can select a list of values in a field that you specify. Separate the values to select with a semi colon. You can optionally overwrite locked selections.

It is not possible to use fields with date, timestamp, or money data type.

Select values matching search criteria
You can select all values that match the search results from a search criteria that you specify. You need to specify the search criteria as a string. You can optionally overwrite locked selections.

- If you want to use an expression, you need to enclose it in single quotes, for example, `=`Sum([Sales Amount]) > 200000`.
- If you want to search for a partial string, you need to use wild cards (`*, ?, ^`). If you do not use wild cards, only strings that match exactly are selected.

Select alternatives
Select all alternative values in a field that you specify. You can optionally overwrite locked selections.
Select excluded
Select all excluded values in a field that you specify. You can optionally overwrite locked selections.

Select possible values in a field
Select all possible values in a field that you specify. You can optionally overwrite locked selections.

Toggle field selection
You can set the button to toggle between the current selection, and a selection that adds selections defined by a search string. You can use wild cards in the search string. If you want to define a list of values you need to use the format \((A|B)\), where A and B are values to select.

Set variable value
You can assign a value to a variable.

Reload data
You can run the load script to reload data.

You can also select Partial reload.

Navigation
You can choose to navigate to another sheet, a story, or a website when the button is clicked. You do not have to specify an action if you want to create a simple navigation button.

*Navigation is not supported in stories.*

Navigating to a specific sheet
If you want to navigate to a specific sheet, you need to state the sheet ID. You can find the ID of a sheet in the URL of the browser with the sheet open. The sheet ID follows after `/sheet/` followed by `/`.

Example: Sheet URL
qlik.com/sense/app/8f8fa0e-3fde-48a5-a127-59645923a1fc/sheet/7300b241-f221-43db-bb8b-8c8cc1887531/state/analysis
The ID of the sheet is 7300b241-f221-43db-bb8b-8c8cc1887531 in this example.

Styling the button
You have a number of styling options available under Appearance.

- You can set the label text under General.
- You can set the size, color and style of the font under Font styling.
- You can set the background to a color or an image under Background. If you use a background image, you have options to size and position the image.
3 Visualizations

- You can add an icon to the button under **Icon**.
- You can adjust the border of the button under **Borders**. You can set the corner radius and the width of the border. You can also set the color of the border, either a single color or with an expression.

Disabling and enabling the button
You can set a calculation condition to enable the chart under **Enable chart**. If the condition is evaluated to 0, the button is disabled.

Converting from the **Button for navigation** in the Dashboard bundle
You can convert an existing **Button for navigation** control into a button. There are some limitations when you do the conversion.

- The navigation option to switch to edit mode (**Switch to edit mode**) is not supported.
- The action to select a value and then lock the field (**Select a value and lock field**) is not supported. This will be converted into two consecutive actions, **Select values in a field** and **Lock a specific field**.

Container
The container is an object that lets you add visualizations in a limited space. You can also show or hide the visualizations inside the container based on conditions.
When to use it

The container is useful when you want to be able to quickly switch between different visualizations, on a dashboard with limited screen real estate. You can also use a container to show different visualizations based on:

- Which user is accessing the chart.
- The value of a variable.
- Possible number of values in a field, by using the `GetPossibleCount()` function in the condition expression.

*Displaying different charts based on selections with a container (page 411)*

Creating a container

You can create a container on the sheet you are editing.

**Do the following:**

1. From the assets panel, drag a Container object to the sheet.
2. Click Add under Content in the properties panel.
3. Select a master visualization in Master items, or select to create a new visualization in Charts. Alternatively: you can add content to your container by dragging available visualizations from your sheet, or from your Master items, directly on the container.
4. Drag the charts in the property panel to set the tab order.

You will now have a container with a tab for each visualization you added. You can switch between tabs to show different visualizations.

Adding show conditions

You can add show conditions on the tabs you have created.

**Do the following:**

1. Click on the chart you want to add a show condition to, under Content in the property panel.
2. Add a show condition for the chart in Show condition. Typically you would use an If() function.
3. Add another show condition to a different chart.

The charts will now be shown or hidden depending on the result of the conditions you added. If the condition of a chart results in True, it is shown, and if it is False, it is hidden.

Display limitations

- You cannot use a master visualization that contains a container inside another container.
- It is not possible to add the same master visualization twice on a container.
- Tab selection is remembered when navigating between sheets or refreshing the browser only for the same session only.
- It is not possible to create a chart inside a container by dropping measures or dimensions on the container.
Displaying different charts based on selections with a container

This example shows how to display different chart content based on user selections using a container.

- When a single product group is selected a chart for product sub groups is displayed.
- When more than one product group is selected a chart for product groups is displayed.

Dataset

In this example, we will use two data files from the Qlik Sense Tutorial - Building an App. To download the files, go to Tutorial - Building an App. Download and unzip the tutorial, and find the files in the Tutorials source folder:

- Sales.xls
- Item master.xls

Create a new app, and add the two data files. Make sure that they are associated by Item Number.

The dataset that is loaded contains sales data. The Item master table holds the information about the items ordered, such as product groups.

Measures

We need to create two measures in Master items:

- Sales volume: with the name Sales, and the expression `sum(Sales)`.
- Sales margin in percent: with the name Margin %, and the expression `Avg(Margin/Sales)*100`.

Visualizations

We need two different master visualizations based on product group selections. One of them with product group as dimension, the other with product sub group as dimension.

Product group visualization

This is the visualization we want to show when more than one product group is selected.

We add a combo chart to the sheet and set the following data properties:

- **Dimension**: Product Group (product group).
- **Measure**: Sales (the master measure you created).

The following chart is created, with a bar showing the sales for each product group. It is a bar chart at this stage.
But we also want to show the sales margin, which has a different scale than the sales volume. Sales volume is in the scale of millions, while the margin is a percentage between 0 and 100. If we add margin as a bar next to sales volume, it would be too small to distinguish.

In the properties pane, go to **Measures > Height of line**. Use the drop down to add *Margin %* as a measure.

**Product sub group visualization**

This is the visualization we want to show when a single product group is selected.

Make a copy of the product group visualization, and change the dimension to Product Sub Group.

**Master visualizations**

You need to create two master visualizations to use in the container.
• Add the product group visualization as a master visualization with name Product Group - sales and margin.
• Add the product sub group visualization as a master visualization with name Product Sub Group - sales and margin

You can now delete the two visualizations you created earlier, they are saved as master visualizations.

**Container**
You need to add a container to the sheet. Add the two visualizations to the container.

• Product Group - sales and margin
  Set **Show condition** to =GetPossibleCount([Product Group])>1
• Product Sub Group - sales and margin
  Set **Show condition** to =GetPossibleCount([Product Group])=1

You can also hide the selection tabs of the container under **Appearance > Container > Tabs**.

To demonstrate how it works, you can add a filter pane with Product Group.

**Discovery**
You can now make selections in Product Group. When a single product group is selected, the chart displays data for product sub groups of that product group. Otherwise, the chart displays data for product groups.

**Container properties**
You open the properties panel for a container by clicking **Edit sheet** in the toolbar and clicking the container that you want to edit.

If the properties panel is hidden, click **Show properties** in the lower right-hand corner to open it.

- **If the container has a link in the upper right-hand corner, the container is linked to a master item. You cannot edit a linked container, but you can edit the master item. You can also unlink the container to make it editable.**

- **Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.**

**Content**
Click **Add** to add a chart to the container. If the container has more than one charts, you can drag the charts to set the tab order.

You can edit each chart under **Content**:
3 Visualizations

- **Label**: Change how the label of the chart appears on the tab.
- **Show condition**: Add a show condition for the chart. Typically you would use an If() function.
- **Edit properties**: Allows you to edit the properties of the chart inside the container.
- **Delete**: Deletes the chart from the container.

### Appearance

#### General

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the container.
  
  Enter **Title, Subtitle, and Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  
  Click **fx** if you want to create an expression by using the expression editor.

  **Titles are displayed on a single line. If you inject line breaks they will be ignored.**

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where **<value of expression>** is the calculated value.

- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

#### Alternate states

**State**: Set the state to apply to the visualization. You can select:

- Any alternate state defined in **Master items**.
- **<inherited>**, in which case the state defined for the sheet is used.
- **<default state>**, which represents the state where no alternate state is applied.

#### Container

- **Tabs**: Set whether each chart in the container appears in a tab. If set to **Off** only the top chart will appear. By default, set to **On**.
- **Menu**: Set whether a menu button appears when there is not enough space for all tabs. By default, set to **Auto**.
- **Navigation arrows**: Set whether navigation arrows appear when there is not enough space for all tabs. By default, set to **Auto**.
- **Show icons**: By default, **Off**. With the **On** setting, chart icons are displayed on each tab.

### Properties

**Borders:**
• **Auto**: Default setting. Container will or will not have a border depending on app theme settings.
• **Border**: Container will have a border.
• **No border**: Container will not have a border.

### Reference lines

A reference line is a line intersecting the chart area from a given point on the measure axis.

You can use a reference line to indicate a certain level of chart data. The reference line is only drawn if it falls within the current range of the measure axis. You can have several reference lines in the same chart.

**Bar chart Top 5 customers with a reference line at 5M.**

Reference lines are available in the following visualization types:

- Bar chart
- Box plot
- Distribution plot
- Gauge
- Histogram
- Line chart
- Scatter plot
- Waterfall chart

### Reference line expression

You can either set the reference line expression to an absolute numeric value, or enter an arbitrary numeric expression.
Dimensional reference lines

You can also add reference lines along the dimension axis. Both continuous and discrete axes are supported. It is possible to enter text values for discrete dimensional axes, and numerical values or expressions for continuous axes. On a time axis it is possible to enter an expression that gives a time-based result like a date or a month.

*Line chart average sales per month, with a reference line at 3.5k and a dimensional reference line in September.*

Dimensional reference lines are available in the following visualization types:

- Bar chart
- Line chart

**Custom tooltips**

You can add measures and images as custom tooltips that appear as additional tooltips over a visualization. You can add a measure from a field, or you can add a measure using an expression. You can also hide all or part of the tooltips from a visualization.

*Custom tooltip over a pie chart slice*
Custom tooltips are available in the following visualization types:

- Bar chart
- Combo chart
- Line chart
- Map
- Pie chart
- Scatter plot
- Treemap

Creating a custom tooltip

**Do the following:**

1. In sheet view, click 📝 Edit sheet in the toolbar.
2. Click the chart that you want to edit.
3. In the properties panel, click the Tooltip tab.
4. Set the switch to **Custom** to be able to add measures as tooltips.

5. Click on **Add measure** to add measures as a tooltip. Click **Add an image** to add an image as a tooltip. You can add measures and an image to a single tooltip. You can add a measure from a field using **From a field**. You can also use an expression to add a measure. Click $\mathbb{f}$ to open the expression editor. The existing expression is displayed by default.

You can remove basic tooltip rows using **Hide basic rows**.

**Null values in visualizations**

Data is sometimes missing or cannot be calculated, because the fields contain values that are null or not a number (NaN). In the visualizations, null and NaN values are displayed in different ways, according to the following table.

<table>
<thead>
<tr>
<th>Visualization type</th>
<th>Null values in dimensions</th>
<th>NaN values in measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>-</td>
<td>- (when labels are enabled in the properties panel, otherwise empty)</td>
</tr>
<tr>
<td>Box plot</td>
<td>-</td>
<td>No representation</td>
</tr>
<tr>
<td>Combo chart</td>
<td>-</td>
<td>A combination of the NaN value for the bar and the line.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>-</td>
<td>No representation</td>
</tr>
<tr>
<td>Filter pane</td>
<td>No representation</td>
<td>N/A</td>
</tr>
<tr>
<td>Gauge</td>
<td>N/A</td>
<td>-</td>
</tr>
<tr>
<td>Histogram</td>
<td>-</td>
<td>No representation</td>
</tr>
<tr>
<td>KPI</td>
<td>N/A</td>
<td>-</td>
</tr>
<tr>
<td>Line chart</td>
<td>-</td>
<td>Empty</td>
</tr>
<tr>
<td>Map</td>
<td>No representation</td>
<td>Gray</td>
</tr>
<tr>
<td>Pie chart</td>
<td>-</td>
<td>Empty</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>-</td>
<td>Empty</td>
</tr>
<tr>
<td>Table</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Text &amp; image</td>
<td>N/A</td>
<td>-</td>
</tr>
<tr>
<td>Treemap</td>
<td>-</td>
<td>Empty</td>
</tr>
</tbody>
</table>

**Dashboard bundle**

Dashboard bundle is a set of controls that you can use to enhance navigation and selection in your Qlik Sense app. The controls are optional. You do not have to install or enable them to use Qlik Sense.
Enabling Dashboard bundle

You can install the Dashboard bundle when you install Qlik Sense. If you need to adjust your installation, see: Modifying an object bundles installation.

Dashboard bundle controls

Dashboard controls are in the asset panel under Custom objects.

The following controls are included:

- **Animator (page 421)**
  You can animate changes in your visualizations over a period of time.

- **Date range picker (page 422)**
  You can select a single date or a range of dates from a calendar.

- **On-Demand reporting control (page 424)**
  You can add a button that creates a Qlik NPrinting report using the current selections in the app.

- **Share button control (page 429)**
  You can add a button to generate a link to share so other can see what you see.

- **Variable input control (page 430)**
  You can set the value of a variable.

- **Video player (page 432)**
  You can add a video to your sheet.

Deprecated controls

These controls have been deprecated by the addition of a native control. Existing instances of these controls will still function, but new ones cannot be added. We recommend that you replace deprecated controls with the native control.

**Show/hide container**

Deprecated by **Container**.

If you need to configure existing instances of this control, please refer to the last version of the help before deprecation.

**Tabbed container**

Deprecated by **Container**.

If you need to configure existing instances of this control, please refer to the last version of the help before deprecation.

**Navigation button**

Deprecated by **Button**.

If you need to configure existing instances of this control, please refer to the last version of the help before deprecation.
Limitations

When you use objects from Dashboard bundle there are some limitations compared to built-in controls. The following limitations are valid for all controls from Dashboard bundle:

- The user interface of the visualization is not localized to the language that Qlik Sense is using.
- Right-to-left reading order is not supported.
- Accessibility features are not supported.
- It is not possible to edit objects from an object bundle supplied by Qlik with Dev Hub.

The following tables show which additional features are supported, or not supported, for all bundled objects. Some capabilities are generally supported (Y), with some exceptions (N), as described in the capability support tables. In some cases the capability is not applicable to an object (N/A)

- Printing
  Printing a visualization made in an object.
- Qlik NPrinting
  There is an On-Demand reporting control (page 424). However, visualizations made in some objects cannot be used in Qlik NPrinting reports.
- Download
  Downloading as image, PDF, or Excel.
- Storytelling
  Using a snapshot of a visualization created with an object in a story.
- Alternate states
- Qlik Sense Mobile offline
- Qlik Sense Mobile
- Mashups

<table>
<thead>
<tr>
<th>Control</th>
<th>Printing</th>
<th>Qlik NPrinting</th>
<th>Download</th>
<th>Storytelling</th>
<th>Alternate states</th>
<th>Qlik Sense Mobile offline</th>
<th>Qlik Sense Mobile</th>
<th>Mashups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date picker</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>On-demand reporting</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
</tr>
<tr>
<td>Variable input</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>
## Visualizations

### Animator

The animator control animates the changes in values in your visualizations over a range of values. For example, you could view changes in your visualizations over a period of time. It is included in the Dashboard bundle.

The animator control adds a button and progress slider to the sheet. When pressed, animator cycles through the values of its dimension. Users can use the slider to manually pick values from the dimension to display.

**Animator**

![Animator](image)

**Month** Jan

### When to use it

The animator is useful when you want to see your visualizations change over a specified range, such as over a period of time. For example, you could use the animator control to view how visualizations in your sheet change month to month over a period of a year. Animator can be used to animate any dimension values. You could, for example, animate how your sales visualizations change city to city by selecting a dimension containing city values to use with animator.

The selections animator makes while running through values are applied to your current selections.

### Creating animators

You can create an animator on the sheet you are editing. The dimension you select to use with animator contains the range of values you want animated. By default, every value in the dimension will be used as a step. You can customize the number of steps used in the animation as well as how quickly animator moves between steps. Animator runs through dimension values by the order in `Sorting`.

### Do the following:

1. From the assets panel, under `Custom objects > Dashboard bundle`, drag an `Animator` object to the sheet.
2. Select a field to add as the dimension.

---

Create apps and visualizations - Qlik Sense, February 2021
Once you have created the animator, you may want to adjust its animation options and other settings.

**Setting animator options**

Animator options are set in **Animator Options** in the **Properties** pane.

You can control how fast an animator transitions between values in the selected dimension in **Time Between Steps**. **Time Between Steps** requires values be set in milliseconds.

*It is not recommended to set Time Between Steps lower than 300 milliseconds.*

You can set the total steps the animator runs through in **Total Steps**. The animator will divide the total steps evenly across the dimension values. For example, if there are 10 values in the time dimension selected and Total Steps is set to 5, animator will go to values 2, 4, 6, 8, 10). If Total Steps is set to 0, the animator will use every value.

If you want the animation to show the total building over time for your selected values, select **Aggregate**. When **Aggregate** is selected, each step is aggregated to the previous step.

By default, the animator will run through steps in a loop. You can control this with the **Loop** option.

You can control whether or not the dimension and current value displays in the animator as it runs with **Show Dimension Label** and **Show Dimension Value**.

**Limitations**

Animator has the following limitations:

- Animator does not support drill-down dimensions as the dimension.
- Animator does not support animating trellis charts.

**Date range picker**

The date range picker (**Date picker**) lets you select a single date or a range of dates from a calendar. It is included in Dashboard bundle.

**Date picker** has two modes:

- In single date mode, you select from a simple calendar.
- In date interval mode, you can select a range from the calendar, or any of the predefined ranges that are available.

Dates associated to data appear in black in the calendar. Dates with no associated data appear in grey. Users can select any date.

**When to use it**

The date range picker is useful when you have one or more date fields that you need to use to filter your selections. Unlike a filter pane, a date range picker will only display date fields.
Creating a date range picker
You can create a date range picker on the sheet you are editing.

Do the following:

1. From the assets panel, under **Custom objects > Dashboard bundle** drag a **Date picker** object to the sheet.
2. Select the date field to use as filter in **Date field**.
   The list contains only fields that are recognized as a date field by Qlik Sense.

   *If you want to use a timestamp field, you need to convert it to a date. Use the expression* \(=date(floor(myTimeStamp\_Field))\) *instead of myTimeStamp\_Field.*

3. Select if you want to be able to pick a single date or a date interval in **Single date / interval**.
   **Date interval** lets you pick a range of dates.
   **Single date** lets you pick a single date only.

When you have created the date range picker, you may want to adjust its appearance and other settings.

Setting the available date range
You can set the range of dates available to pick by setting the option **Advanced setup** to **On**. You can use expressions or explicit date values. The expressions used below refer to a field named **DateField**.

- Set the first date of the calendar with **Min date**.
  Default value is \(=min(\{1\} [DateField])\). This expression returns the first date in **DateField** in the full data set.
- Set the last date of the calendar with **Max date**.
  Default value is \(=max(\{1\} [DateField])\). This expression returns the last date in **DateField** in the full data set.
- Set the date to show when the date range picker is opened with **Start date**.
  Default value is \(=\min([DateField])\). This expression returns the first date in **DateField** in the current selection.

Setting locale of the calendar
You can set the locale of the calendar to get local names for days and months. Change the setting **Locale** under **Calendar Settings > Language and labels** to the two-letter code of the locale you want to use. For example, you can change the default value of **en** for English to **de** for German.

Using predefined ranges
In date interval mode there are a number of predefined ranges available to pick if **Show predefined ranges** is set to **On**. You can customize the text labels for the predefined range selections with the settings under **Calendar Settings > Predefined ranges**:
• **Custom Range** represents the option where you select a date interval freely from the calendar. Default value is Range.

• **Today** represents the date value of today. Default value is Today.

• **Yesterday** represents the date value of yesterday. Default value is Yesterday.

• **Last $ days** represents the two options for showing the last 7 or 30 days. $ is replaced by 7 or 30 in the string. Default value is Last $ days.

• **This** represents the current period. By default **Month** is selected. You can select:
  - Day
  - Month
  - Quarter
  - Year
  - None

• **Last** represents the previous period. By default **Month** is selected. You can select:
  - Day
  - Month
  - Quarter
  - Year
  - None

You can specify how many of the previous periods to include in **Last number of**.

You can include the current period by selecting **Include current**.

### Customizing text labels

You can customize the text labels that are shown when the date range picker is used.

You change the text prompt shown when the date range picker is minimized with the setting **Default Text** under **Calendar Settings > Language and labels**. The default setting is 'Select date range'.

### Limitations

For information about general limitations, see *Limitations (page 420)*.

### On-Demand reporting control

The On-Demand reporting control adds a button to create Qlik NPrinting reports on demand. It is included in Dashboard bundle.

### Requirements

- Qlik NPrinting Server (June 2017 or later) with a Qlik NPrinting app that is connected to the Qlik Sense app that you are designing. This Qlik NPrinting app contains your report templates.

- All users generating On-Demand reports need to be added as users in Qlik NPrinting, with a security role that supports running On-Demand reports.

- Users must be logged into Qlik Sense via NTML (Windows) authentication in order to generate reports or create reporting buttons.
3 Visualizations

When to use it
The On-Demand reporting control is useful when you want the user to be able to print predefined Qlik NPrinting reports within Qlik Sense, using their selections in the app as a filter.

Installing the Dashboard bundle
You can install the Dashboard bundle when you install Qlik Sense.

You can add or remove object bundles from your Qlik Sense deployment at any moment. If you have a multi-node installation, object bundles are installed on the central node.

You can see which extensions are installed in your deployment by checking the Extensions section in the Qlik Management Console (QMC).

Do the following:

1. In Windows Control Panel, open Programs and Features.
2. In the list of programs, double-click the object bundle that you want to modify.
3. The Object Bundle Setup Wizard opens. Click Next.
4. Select Change.
5. On the Custom setup screen, click on the bundle icon to select how to modify the bundle installation:
   - If the bundle is installed, select Entire feature will be unavailable to uninstall it.
   - If the bundle is not installed, select Entire feature will be installed on local hard drive to install it.
   Then, click Next.
6. Click Change.
   Once the modification is complete, you are required to manually restart the Qlik Sense Repository Service.
7. Click Finish to close the Object Bundle Setup Wizard.
8. Manually restart the Qlik Sense Repository Service to apply the changes.

You can verify that the changes have been correctly applied by checking the Extensions section in the QMC.
Adding a server as a trusted origin

If you are creating On-Demand reports in Qlik Sense or a QlikView Web Server hosted QlikView AccessPoint, you must add these servers as a trusted origin in Qlik NPrinting web console.

For each server path used to access the Qlik NPrinting web console, you must add a trusted origin. For example, if your server can be accessed through a local domain, a shortened host, or fully qualified URLs, a trusted origin must be added for each of those server paths.

How you enter the server paths in the Address field of the trusted origin depends on your security configuration.

**Configuration 1: SSL security not setup with Qlik NPrinting web console**

A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. For example, if your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the following trusted origins:

- http://qlikserver1
- http://qlikserver1.domain.local
- http://192.168.0.101

**Configuration 2: SSL security setup with Qlik NPrinting web console and third-party**

A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. URLs must use HTTPS. For example, if your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the following trusted origins:

- https://qlikserver1
- https://qlikserver1.domain.local
- https://192.168.0.101

**Adding a trusted origin**

Do the following:

1. In Qlik NPrinting, click Admin > Settings.
2. Click On-Demand Settings.
3. Click Add trusted origin.
4. After Name, enter a name for the trusted origin.
5. After Description, enter a description for the trusted origin.
6. After Address, enter the URL for the QlikView Server.
   - The URL must be the base URL (scheme and host) only. For example, http://qlikserver1 rather than http://qlikserver1/qlikview/index.htm.
7. Click Create.

**Configuring On-Demand settings on Qlik NPrinting Server**

You must configure these settings on your Qlik NPrinting Server:
You must have a connection to a QlikView Server or a Qlik Sense server. QlikView Server and QlikView Cluster connections are supported with On-Demand. Local connections are not supported. See: Creating connections.

If you are connecting to a QlikView Server or Cluster with a QlikView Server Extranet License, the following options must be enabled when configuring the connection:

- Connection requires authentication
- Apply user section access for reports

You must enable your Qlik NPrinting reports for On-Demand.

You can limit On-Demand report creation through security roles. See: Role based security.

On-Demand is compatible with Chrome, Firefox, and Explorer. It will not run in Microsoft Edge, because the certificates will not download.

Enabling Qlik NPrinting reports for On-Demand creation

Qlik NPrinting reports must be manually enabled for On-Demand creation. Reports must be assigned to the QlikView document or Qlik Sense app with which you want to generate On-Demand reports. On-Demand creation can be enabled during the creation of a new report.

Do the following:

1. In Qlik NPrinting web console, click Reports.
2. Open a report or create a new report.
3. Select an app from the App drop-down list is connected to the QlikView document or Qlik Sense app for which you want to generate a report.
4. Select the Enable On-Demand check box.
5. Click Save.

The report template is now available.

Accepting the Qlik NPrinting web console certificate

The default installation certificate for Qlik NPrinting web console may be registered as invalid by your browser. If your browser registers the Qlik NPrinting web console certificate as invalid, you must accept the certificate before you can use On-Demand in QlikView AccessPoint or Qlik Sense.

If you switch to a different browser or clear your browser’s cache, you will have to re-accept the Qlik NPrinting certificate. On-Demand works in Chrome, Firefox, and Explorer. It does not run in Microsoft Edge, because the certificates will not download.

Do the following:
1. Open the Qlik NPrinting web console.
2. Depending on your browser, do one of the following:
   a. Choose to continue to the Qlik NPrinting web console.
   b. Add a security exception and continue to the Qlik NPrinting web console.
3. Log into your Qlik NPrinting web console.

You can now use Qlik NPrinting On-Demand using this browser.

Creating an On-Demand reporting button
You can create an On-Demand reporting button on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag On-demand reporting to the sheet.
2. In the property panel, under NPrinting Connection > NPrinting server URL, set the server connection. The URL must end with /.
   For example: https://<server name>:4993/
3. Under NPrinting App, select the Qlik NPrinting app that contains the report template.
4. Under NPrinting connection, select the Qlik NPrinting connection.
   As the default, the list only shows Qlik NPrinting connections to the Qlik Sense app you are working in. You can use the App/Connection filter toggle to display connections not associated with the current Qlik Sense app.
5. Under Report Configuration > Choose Report, select the report you want to connect to the button.
6. In Default Export Format, select a default export format.
7. Under Appearances > Button Label, set the button label. For example: Generate report.

You have now created an On-Demand reporting button.

Generating a report
You can generate a report that is filtered according to the current selections in the Qlik Sense app. You need to be in analysis mode.

You can only filter on fields that are included in the Qlik NPrinting report template, or the report will fail. It is not possible to filter on selections using an expression.

Do the following:

1. Click on the button that you created.
   The Export dialog opens.
2. There are two buttons to choose from:
   a. Quick Report: generates a single report with the default output format.
   b. New Report: choose from a list of reports that have been made available to you. You can also
choose the output format.

3. When the report is generated a download button is activated. Click the **Download** button to download the report.

Limitations

For information about general limitations, see *Limitations* (page 420).

- If the Qlik NPrinting report template contains a filter, it is not possible to make conflicting selections in the Qlik Sense app, or the report will fail.
- When you use the On-Demand reporting control in a mashup, you need to use Windows authentication. Header authentication is not supported. Additionally, if the mashup contains multiple apps, you can only use the app where on-demand originates from to filter on-demand reports.

Share button control

> The share button control will be removed as of August 2021. Existing share buttons will continue to function. You can publish bookmarks to Community in the app overview, or copy a link to a bookmark instead.

The Share button (**Share button**) is a control that lets you add a button to generate a link to the current sheet. When you follow the link all selections are maintained. It is included in the Dashboard bundle.

When to use it

The share button is useful when you want others to see this sheet as you see it.

Creating a share button

You can create a share button on the sheet you are editing.

**Do the following:**

1. From the assets panel, under **Custom objects** > **Dashboard bundle** drag a **Share button** object to the sheet.
2. Click **Copy from textbox** under **Export settings** > **Output method** in the property panel. The button displays with the text **Generate Link** and an empty textbox next to it.
3. Click the **Done** button to stop editing the sheet.
4. Click the button you created. A link is generated and displayed in the textbox next to the share button.
5. Copy and share the link with those you wish to share with. You can share the generated link through three output methods:
   - Copy to Clipboard
   - Create New Email with link
3 Visualizations

- A textbox.

**Example:**

![Image of a share button](image-url)

> **When you create a share button the “full screen” Copy to clipboard button is created by default. To use this version, click **Done** and click the button you created to copy the sharable site link to the clipboard. There are limitations to this option in certain browsers, for example when using a mobile.**

**Limitations**

For information about general limitations, see *Limitations (page 420).*

- We recommend that you do not use selections of many individual values. The URL should contain less than 2000 characters due to browser limitations. You can limit the number of selections included with the option **Export Settings > Max Values Selected in One Field.**
- Special characters (’ / - * & ’) are not allowed in selections.
- It is not possible to copy to clipboard in all browsers.
- It is not possible to use selections based on an expression.

**Variable input control**

You can use the variable input control to set the value of a variable. It is included in Dashboard bundle.

**When to use it**

If you have visualizations with expressions that contain a variable, you can use the variable input control to let the user control the variable value.

**Creating a variable input control**

You can create a variable input control on the sheet you are editing.
3 Visualizations

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag a Variable input object to the sheet.
2. Select the variable to use in Name under Appearance > Variable in the property panel.
3. Select how you want to input data in Show as:
   - **Buttons** lets you add a number of buttons with one button for each defined variable value. You can select how to display the buttons in Display, select Row to show them in a horizontal row or Column to show them in a vertical column. You can define the buttons in two different ways, fixed (Fixed) or (dynamic) Dynamic with the Fixed or dynamic values setting under Values. If you select to use fixed values, you need to add each button with Add Alternative and define a value (Value) and a label (Label) for each button. If you use dynamic values, you define the buttons with a string in Dynamic values. Use | to separate buttons, and ~ to separate value from label. For example, ‘Germany~GER|France~FRA’ will create two buttons labelled GER and FRA. The first will change the variable value to Germany, and the second changes the value to France. You do not need to specify labels if you want to use values as labels.
   - **Drop down** adds a drop down with one item for each defined variable value. You can define the items in two different ways, fixed (Fixed) or (dynamic) Dynamic with the Fixed or dynamic values setting under Values. If you select to use fixed values, you need to add each item with Add Alternative and define a value (Value) and a label (Label) for each item. If you use dynamic values, you define the items with a string in Dynamic values. Use | to separate items, and ~ to separate value from label. For example, ‘Germany~GER|France~FRA’ will create two items labelled GER and FRA. The first will change the variable value to Germany, and the second changes the value to France. You do not need to specify labels if you want to use values as labels.
   - **Input box** provides a simple input box that will update the variable value.
   - **Slider** creates a slider that updates the variable value. You define the minimum setting with Min and the maximum setting with Max under Values. You can also set the step to use with Step. If you select Slider label, the selected value is displayed when you drag the slider. The variable value is updated when you stop dragging the slider, but you can select Update on drag if you want the variable value to be updated while you drag. This can be useful when you want visualizations based on the variable to update dynamically when dragging the slider. Use this option with caution, as the constant redrawing of charts can be annoying.

Limitations
For information about general limitations, see Limitations (page 420).

- The slider label can only display numeric values. This means, if the value is a date the numeric value of the date is displayed. If the value is a percentage value, the percentage character is not displayed.
3 Visualizations

Video player

The video player lets you play videos in different formats from external sources. It is included in the Dashboard bundle.

The following video formats are supported.

- MP4
- OGG
- WEBM

When to use it

The video player is useful when you want to include a video in your application. For example, you want to show a demo or a training video, add a tutorial, or present corporate news.

Adding videos

You can add video player object to a sheet that you are editing. Add or paste a video link into the video object. The video is streamed from a source; it is not uploaded to Qlik Sense. By default, the video format of the link will be auto-detected, the video will not auto-play, and video controls will be available to app consumers.

Do the following:
1. From the assets panel, under Custom objects > Dashboard bundle, drag a Video player object to the sheet, or click Add to Sheet.

2. Add a video as a URL in the video player object field Add URL, or in the properties panel under Video > URL. You can format the URL field as an expression.

3. Autodetect format is default setting and it will adjust accordingly based on the URL. You can also turn off Autodetect, and then select the correct supported video format.

Once you have added the video, you may want to adjust its options.

Setting video options

Video options are set in the Properties pane.

Click Auto play if you want the video to automatically start when viewed in analyzer mode. Auto play is turned off by default. When Auto play is selected, the video starts but it is muted. The app user has to select Unmute to turn the sound on.

Click Hide Controls to turn off video controls in analyzer mode. By default, video controls are visible.

You can add a Poster image. By default, the poster image is turned off. For Source, select an external URL that directs to an image, or add an image from your media library.

If a poster image is selected, the selected image is displayed before the video starts playing. Poster alignment specifies how the poster image will align inside the video player.

You cannot play the video in edit mode. The video restarts when you switch between analyzer mode and edit mode.

In analyzer mode, you start the video with the play button. You can pause, switch between mute and unmute, and view the video in full screen. You can also save the video player object, and Take snapshot.

Limitations

The video player has the following limitations:

- Browsers Microsoft Internet Explorer 11 and Safari do not support OGG and WEBM formats.
- Qlik Sense Desktop cannot play MP4 format due to limitations in Chromium.
- Qlik Sense Mobile on iOS can only play MP4 compressed in H.264 or MPEG-4 format, but not other MP4, OGG and WEBM formats due to limitations in iOS.
- Qlik Sense Mobile offline is not supported for video playing.
- iPhone adds native video controls. It does not use video player controls, therefore Hide Controls will not turn off controls.
- Android does not support OGG format.
- When exporting or printing a sheet that includes a video player object, the video player object will not be included.
- Qlik NPrinting does not support the video player object.
Visualizations are an important means of conveying information from massive data. The Visualization bundle is a set of charts that can be used to enhance and increase your Qlik Sense app’s charting capacity. The charts are optional. You do not have to install or enable them to use Qlik Sense.

Enabling Visualization bundle
You can install the Visualization bundle when you install Qlik Sense. If you need to adjust your installation, see: Modifying an object bundles installation.

Visualization bundle charts
Visualization bundle charts are in the asset panel under Custom objects.

The following charts are included:

- **Bar & area chart (page 436)**
  Create bar charts and area charts and enhance them with transitions and connectors.

- **Bullet chart (page 439)**
  A bullet chart is a gauge that can also show a target marker and a qualitative range to show performance.

- **Funnel chart (page 442)**
  A funnel chart is a visual representation of the connected stages of a linear process.

- **Grid chart (page 448)**
  A chart that displays comparative data and with the values represented as colors.

- **Heatmap chart (page 451)**
  A chart that displays comparative data and with the values represented as colors.

- **Multi KPI chart (page 456)**
  A chart that shows KPI for multiple dimension values to quickly understand and track performance.

- **Network chart (page 467)**
  Creates a cluster diagram representing a graphical chart of a computer network.

- **P&L pivot chart (page 475)**
  Creates a pivot table that you can style, for example for profit and loss reporting.

- **Radar chart (page 479)**
  Creates a two-dimensional chart using radial axes to show the scoring of a measure in one dimension or another.

- **Sankey chart (page 482)**
  A flow chart diagram chart visually emphasizing major transfers or flows within defined system boundaries.

- **Trellis container (page 486)**
  Creates a trellis chart based on a master visualization.

- **Variance waterfall chart (page 489)**
  Shows the variance between two measures over the different values of a dimension.
3 Visualizations

- **Word cloud chart (page 491)**
  A cloud chart of words with their size based on measure value.

**Limitations**

When you use visualizations from Visualization bundle there are some limitations compared to built-in visualizations, such as bar charts. The following limitations are valid for all visualizations from Visualization bundle:

- The user interface of the visualization is not localized to the language that Qlik Sense is using.
- Right-to-left reading order is not currently supported.
- Accessibility features are not currently supported.
- It is not possible to edit objects from an object bundle supplied by Qlik with Dev Hub.

The following tables show which additional features are supported, or not supported, for all bundled objects. Some capabilities are generally supported (Y), with some exceptions (N), as described in the capability support tables. In some cases the capability is not applicable to an object (N/A)

- Printing
  Printing a visualization made in an object .
- Qlik NPrinting
  There is an On-Demand reporting control (page 424). However, visualizations made in some objects cannot be used in Qlik NPrinting reports.
- Download
  Download as image, PDF, or Excel.
- Storytelling
  Using a snapshot of a visualization created with an object in a story.
- Alternate states
- Qlik Sense Mobile offline
- Qlik Sense Mobile
- Mashups

### Visualization bundle capability support

<table>
<thead>
<tr>
<th>Chart</th>
<th>Printing</th>
<th>Qlik NPrinting</th>
<th>Download</th>
<th>Storytelling</th>
<th>Alternate states</th>
<th>Qlik Sense Mobile offline</th>
<th>Qlik Sense Mobile</th>
<th>Mashups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar &amp; area</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Bullet</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Funnel</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Chart</th>
<th>Printing</th>
<th>Qlik NPrinting</th>
<th>Downloading</th>
<th>Storytelling</th>
<th>Alternates</th>
<th>Qlik Sense Mobile offline</th>
<th>Qlik Sense Mobile</th>
<th>Mashups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heatmap</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Multi KPI</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Network</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Org chart</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>P&amp;L pivot</td>
<td>Y</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Radar</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Sankey</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Trellis container</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Variance waterfall</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Wordcloud</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

### Bar & area chart

*The bar & area chart will be removed as of May 2021. Existing bar & area charts will continue to function.* Bar & area chart features have been added to the bar, line, and combo charts.

- Bar chart (page 133)
- Line chart (page 218)
- Combo chart (page 168)

You can use the bar & area chart (**Bar & area chart**) to create simple or stacked bar charts and area charts. You can enhance the charts with transitions and connectors, and use the **100% bar chart** option to make all stacked bars the same height. The bar & area chart is included in the Visualization bundle.

**Bar & area chart dimensions and measures**

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>no dimension</td>
<td>up to 10 measures</td>
<td>A simple bar chart with one bar for each measure.</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>1 measure</td>
<td>A simple bar chart with one bar for each dimension value.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>up to 5 measures</td>
<td>A stacked bar chart with one bar for each dimension value or an area chart.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>1 measure</td>
<td>A stacked bar chart with one bar for each value of the first dimension or an area chart. Each bar will show the measure value for each value of the second dimension.</td>
</tr>
</tbody>
</table>

#### Bar & area chart recipes

Here are some examples of charts you can create with the bar & area chart.

**100% stacked bar chart**

This example creates a stacked bar chart where each bar is the same height. You can use this to compare the bar segments relative to each other, but not in absolute values.

You need a chart with two dimensions and one measure. Set the following properties:

- **Appearance > Presentation > 100% bars** = 100% bars
- **Appearance > Presentation > Grid height relative to max bar** = 1
- **Appearance > Colors and Legend > Single Colors** = Multi-color

![100% stacked bar chart example](chart-example)

We can add connectors to the chart. Set the following additional properties:

- **Appearance > Presentation > Show bar connectors** = Bars with connectors
- **Appearance > Presentation > Bar spacing** = 0.5
- **Appearance > Presentation > Outer bar spacing** = 0
Area chart
This example creates an area chart. You can use the same data set as in the previous examples. Set the following properties:

- Appearance > Presentation > 100% bars = Not 100%
- Appearance > Presentation > Grid height relative to max bar = 1.1
- Appearance > Presentation > Show bar connectors = Bars with connectors
- Appearance > Presentation > Bar spacing = 1
- Appearance > Presentation > Outer bar spacing = 0

Just like the stacked bar chart, you can make a 100% area chart by changing the following properties:

- Appearance > Presentation > 100% bars = 100% bars
- Appearance > Presentation > Grid height relative to max bar = 1
3 Visualizations

Changing the appearance of the chart
You can customize the appearance of your chart.

Adding connectors
You can add connectors between bars by setting Appearance > Presentation > Show bar connectors to Bars with connectors. You can adjust the width of the connectors with the Bar spacing setting. If you set Bar spacing to 1, you will get an area chart.

Setting stacked bars to 100%
You can set the bars to be equally high to compare the bar segments relative to each other. Set Appearance > Presentation > 100% bars to 100% bars.

Adding transitions
You can add transition effects when the chart is updated by changed selections under Appearance > Transitions.

Limitations
For information about general limitations, see Limitations (page 435).

Negative measure values are not supported.

Bullet chart
The bullet chart (Bullet chart) displays a gauge with extended options. Bullet charts can be used to visualize and compare performance of a measure to a target value and to a qualitative scale, such as poor, average, and good. The bullet chart is included in the Visualization bundle.

We recommend that you use the Bullet chart instead of this object. The bullet chart in the Visualization bundle will be deprecated in a later release. Existing instances of this chart will still function, but new ones cannot be added.

A bullet chart can contain from one to three measures:
3 Visualizations

- The first measure (Measure) is the actual value, represented by the bar.
- The second measure (Marker) defines a target value, which is represented by a vertical marker line.
- The third measure (Range) defines a qualitative range displayed behind the bar. This consists of three ranges.

You can also add a dimension. This will show one gauge for every dimension value. If you do not define a dimension, the chart will show a single gauge.

*A bullet chart with one gauge for each value of the dimension (product group).*

When to use it
Bullet charts let you compare and measure performance with more enriched information than a common gauge. This is helpful when comparing performance according to a target and a simple performance rating. For example: you can show how sales relate to a target value, and in context of poor, good, and stretched performance.

Creating a bullet chart
You can create a bullet chart on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Bullet chart object to the sheet.
2. Click the Add measure button to select the value measure of the chart. Once the first measure is selected the bullet chart is displayed.
3. To add a target value, click Add under Measures. You can define a fixed value or use a measure with target values.
4. To add performance ranges, click Add under Measures. This will define the maximum performance range value. You can set the internal range limits later.

5. To show one gauge for every dimension value, click Add under Dimensions.

The bullet chart is now displayed with the dimensions and measures you selected.

Changing the appearance of the chart

You can customize the appearance of your bullet chart.

Changing the color scheme

You can change color scheme of the value bar, the marker and the range.

Do the following:

- Set value bar color in Appearance > Measure bar > Change bar color in the property panel.
- Set marker color in Appearance > Marker > Change marker color in the property panel.
- Set range color in Appearance > Range > Change range color in the property panel. The color you select is used for the highest range. The two lower ranges are displayed in darker shades of that color.

> It's a good idea to select a light range color to avoid poor contrast between the ranges. You should also make sure that the range color is less visually dominant than the value bar.

Changing the range limits

You can also customize the limits of the ranges under Appearance > Range in the properties panel. The full range is defined by the value of the third measure of the chart.

- Set middle range (%) defines the upper limit of the middle range.
- Set lower range (%) defines the upper limit of the lower range.

Changing the scale of the axis

If you use a dimension to show several gauges, you can select how to show the scale of the axis with Axis > Consistent for all axis dimension values.

- If you want each dimension gauge to use the same scale, enable this option. If the range measure depends on the dimension value, the range bars will have different lengths. This is useful when you want to be able to compare the actual values.
- If you want each range bar to be equally long, disable this option.

Example:

In this example, Consistent for all axis dimension values is disabled. This makes it easier to compare the relative performance of each product group.

A bullet chart with Consistent for all axis dimension values disabled.
Limitations
For information about general limitations, see Limitations (page 435).

- You can not make selections in a bullet chart.
- If you want to change the number format, you need to set the same format in Number formatting for all three measures.

Funnel chart
The Funnel chart (Funnel chart) lets you add a sequential chart showing the connected stages of a process. Each stage will decrease and should contain a subset of the previous stage. The decrease is gradual, giving the chart an ever narrower funnel.

A funnel chart displaying the conversion rates of prospects to customers in a sales process.
Funnel charts show values across multiple stages in a process. They can represent anything that is decreasing in size. The funnel chart shows a process that starts at 100% and ends with a lower percentage. Each chart segment represents the value of a specific item and can influence the size of other segments. The Funnel chart is included in the Visualization bundle.

- The chart requires one dimension and one measure.
- Unlike bar charts, funnel chart segments are centered to create a funnel shape.
- A chart with increasing stages instead of decreasing is a pyramid graph.

When to use it
The funnel chart is useful to illustrate the stages of a process and the overall decrease of each step, for example:

- Represent a sales process showing the amount of potential revenue for each stage.
- Illustrate the number of sales prospects at each stage in a sales pipeline, i.e. the process from prospective customer to made purchase.
- Identify potential problem areas and bottlenecks of a sales process.
- Communicate a sales process to new team members and vendors.
- Illustrate website visitor trends – from visitor homepage hits to other areas, for example downloads, etc.
• Show order fulfillment with initiated orders at the top, followed by for example, orders in delivery, delivered, canceled and returned.
• Showing the flow of information from top secret to unclassified.
• Representing knowledge areas from general knowledge to expert knowledge.

Creating a funnel chart
You can create a funnel chart on the sheet you are editing.

• The dimension decides how it should be grouped in segments. By default, dimension values are displayed in descending order by measure value.
• The measure is the value that decides the size of each segment.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Funnel chart object to the sheet.
2. Click the top Add dimension button and select the target dimension (usually target market) of the chart.
3. Click the Add measure button to select the measure (what is to be measured) of the chart. Once dimensions (dimension label) and measure (value label) have been selected the funnel chart displays automatically (in color) in the chart field.
4. Click Done to revert to the main display field.
5. Click applicable region under Region. The chart field will update displaying chosen parameters and details.

Dimension, measure and region details will continue to display in the chart field even when reverting to Edit mode.

Changing the appearance of the chart
You can customize your chart with one or more features.

Funnel mode
You can set the shape of the funnel with Appearance > Presentation > Funnel Mode.

Area
The area of each item is proportionate to the measure. Only the height of the individual segment is affected - not the overall chart or contents.
3 Visualizations

Height
The height of each item is proportionate to the measure. Only the height of the individual segment is affected - not the overall chart or contents.

Width
The width of the upper edge is proportionate to the maximum value of the measure. The top segment is always 100% and the following segments are relative in size to the first. The lowest segment is rectangular. This affects the shape of the funnel and each segment has its individual slope.
### Ordering

The measure only orders the segments with largest value at the top. The ordering is fixed so the shape of the funnel is not affected.

### Colors

You can choose how to color the funnel chart by changing the **Appearance > Colors** setting from **Auto** to **Custom**.

**Single color**

You can use a single color for the entire funnel chart by selecting **Single color** in **Colors**.
3 Visualizations

Color by dimension
You can also color your entire funnel chart by dimension by selecting **By dimension** in **Colors**. There are two gradient color schemes available:

- 12 colors
- 100 colors

You can also select to keep persistent colors with **Persistent colors**.

Color by measure
You can color your funnel chart by measure by selecting **By measure** in **Colors**. The measure of the chart is selected as default, but you can change it under **Select measure**. This measure must be unlinked before a new one can be selected. You can also change the measure using an expression in the Expression editor (fx).

You can choose between four color schemes. It is also possible to reverse the colors.

- Sequential gradient
- Sequential classes
- Diverging gradient
- Diverging classes

You can also set a color range for your chart based on your measure by setting **Range** to **Custom**. Set the range in **Range > Min** and **Range > Max**. You can use a number or an expression that evaluates as a number.

Color by expression
You can color your funnel chart by measure by selecting **By expression** in **Colors**. You can color it in two ways.
The expression evaluates as a valid CSS color to color the chart. **The expression is a color code** should be checked.

- The chart is colored by the expression value according to a color scheme. **The expression is a color code** should be unchecked.
  - You can also set the range of the colors.

### Sorting

Funnel chart elements are automatically sorted from largest to smallest. You can change the sort order in the properties pane. Go to **Sorting**, and drag your dimensions and measurements into the desired order.

### Styling and formatting

The position and order of labels for dimension and measure values can be displayed in different ways. You can for example hide the dimension value or display measures as values or as a percentage.

#### Dimension label

You can choose if you want to show the dimension label or not with **Appearance > Presentation > Dimension label**.

#### Value labels

You can choose how to show value labels for each segment by setting **Appearance > Presentation > Value labels to Custom**.

- **None** hides the value labels.
- **Share** displays the values as percentage.
- **Values** displays the actual measure values.

### Limitations

For information about general limitations, see **Limitations (page 435)**.

### Grid chart

The grid chart (**Grid chart**) uses symbols of varying size sorted in a grid. The grid chart is included in the Visualization bundle.

- Grid charts must have two dimensions and one measure. The dimension values are the x and y axes. The measure is the metric that determines the size of the symbol in each crossing.

  **Grid chart with circles. Circle color is set by dimension (Quarter) and circle size is based on measure (Sum of Sales)**
When to use it
A grid chart is useful when you need to quickly find measure values that stand out from other values. For example: you want to see which products sell well in some months, but poorly in others.

Grid charts do not work well when the measure has:

- Many duplicate values.
- Values that are numerically close to each other.

Creating a grid chart
You can create a grid chart on the sheet you are editing.

Do the following:

1. In the assets panel, open **Custom objects > Visualization bundle** and drag a **Grid chart** object to the sheet.
2. Click the **Add Dimension** button to select the x axis value of the chart.
3. Click the second **Add Dimension** button to select the y axis value of the chart.
4. Click the **Add Measure** button to select the metric being weighed.

The grid chart is now displayed with the dimensions and measures you selected.

Sorting
Grid chart elements are automatically sorted alphabetically or numerically from smallest to largest on the x axis. You can change the sort order of either axes in the property panel.

Do the following:

1. In the property panel, go to **Appearance > Sorting**.
2. Click on a dimension.
3. Toggle **Sorting** from **Auto** to **Custom**.
4. You can choose any of these options:
   - **Sort by expression**: Ascending or Descending.
   - **Sort numerically**: Ascending or Descending.
   - **Sort alphabetically**: Ascending or Descending.
Changing the appearance of the chart
You can customize the appearance of your grid chart.

*Grid chart with stars. Star color and size is set by measure (Gross Sales).*

Customizing the symbols
You can change the shape and size of the symbols from the Appearance > Presentation tab in the property panel:

- Use the Symbol size slider to change size.
- Use the Symbol dropdown to change symbol type.

Changing the color scheme
You can change the color scheme of the symbols from the Colors and legend tab. Set Colors to Custom. From the dropdown, choose:

- **Single color**: You can choose any color.
- **By dimension**: Under Color scheme, you can change how many different colors are used.
- **By measure**: Under Color scheme, you can alter the color gradient. Click the Reverse colors check box to flip the gradient order. The colors used are based on your app theme.
- **By expression**: You can have a color code in the expression. Or, deselect the The expression is a color code check box, and you can alter the color gradient. Click the Reverse colors check box to flip the gradient order. The colors used are based on your app theme.

Changing the range limits
You can customize the limits of the ranges if you color by measure or expression. The full range is defined by the value of the dimensions. Go to Appearance > Colors and legend > Range in the properties panel:

- **Min**: Defines the lower limit of the range.
- **Max**: Defines the upper limit of the range.
3 Visualizations

Changing the scale of the axes
You can customize the presentation of the x and y axes. Go to Appearance > X-axis: [dimension] or Appearance > Y-axis: [dimension] in the properties panel. You can set:

- Labels and title
- Label orientation
- Position
- Number of axis values:
  - Auto
  - Max
  - Custom
- Show grid lines

Limitations
For information about general limitations, see Limitations (page 435).

- The Number of axis values setting in the property panel has a limit of 55 per axis.
- Sometimes when you set dimension limits on a grid chart, chart labels will incorrectly display more items than requested.

Heatmap chart
A Heatmap chart (Heatmap chart) displays comparative data where the values are represented as color patterns in a chart. You can convey information instantly by combining elements from several sources into one. It is included in the Visualization bundle.

Heatmap chart with grid layout, data, and labels.
A heatmap can display large amounts of data in their entirety because values are replaced by colors. This condensed color-coded format provides an easy-to-understand overview of data.

Heatmaps require two dimensions and one measure. A second measure is optional. The chart displays in a tabular format with color-coded tiles. The highest and lowest values show in each dimension column. The values in between are shown in a color gradient, centered upon the average.

When to use it
A heatmap chart displays a visual summary of large amounts of comparative data. The information is presented in color patterns, and is communicated almost instantly in a single chart. A heatmap is useful when:

- Comparing performance between companies, markets, or investments.
- Identifying the level of performance between departments of a business.
- Setting investment priorities and highlighting areas of concern.
- Presenting vast statistical data and data sets.
- Measuring user interaction with websites.
- Rating and categorizing places, people, performances, or jobs.
Creating a heatmap chart

You can create a heatmap chart on the sheet you are editing.

**Do the following:**

1. From the assets panel, under Custom objects > Visualization bundle drag a Heatmap chart object to the sheet.
2. Click the top Add dimension button and select dimension.
3. Click the lower Add dimension button and select second dimension variable.
4. Click the Add measure button to select the measure of the chart.

Changing the appearance of the chart

**Using the lasso selection tool**

The lasso selection tool lets you make a two-dimensional selection of a specific area you want to take a closer look at, by tracing a border around it.

That outline then disappears and you can trace another lasso in the desired area.

**Do the following:**

1. Open your heat map in the main display field. If you are working in edit mode, click Done.
2. Click the cursor on a tile and, while pressing the mouse button down, outline of the area of the chart you want to take a close look at.
3. End your outline where it began. The chart will automatically zoom in and display only the outlined area.

**Examples:**

A border is traced around an area using the lasso tool, coloring it green.
Once selection is complete, only the zoomed-in outlined area show in the chart.

Using dimension selection option
You can select a column or row of tiles for either dimension by clicking on the dimension label, or a selection of two dimensions by clicking on a tile. Once selected, only the chosen row, column or tile displays in the chart.

Changing the color scheme
You can change color scheme of your chart.

Do the following:

1. Click Appearance > Design in the property panel.
2. Select a color scheme under Color schema.
Changing label colors
You can set your own label color under Appearance > Label color in the properties panel. Click the label color box and select a color from the gradient color circle. You can also click the easel symbol below the color circle, and select color or enter a color code string in the field next to the easel symbol. The colors should be valid CSS colors.

Toggling the legend
The legend provides a thin gradient line of color description at the top of the chart. You can hide the legend by turning off Appearance > Design > Legend in the properties panel.

Adjusting tile opacity
You can adjust tile opacity by moving the slide button of the tile opacity slider under Appearance > Design > Tile opacity in the properties panel. Setting opacity to 1 allows the setting to show colors clearly, giving tiles a more individually distinct appearance.

Using a mean in color scale
In a heatmap you can calculate and display the mean of data set. It is used as middle value in a color scale. You can toggle this feature on or off under Appearance > Options > Use mean in scale in the properties panel.

Enter a scale value by expression for mean value. This allows the system to choose color range that defines a median color scale. You can also insert a scale string into the expression in the Expression editor (fx) under Appearance > Options > Mean scale value in the properties panel. When no mean is used, the mean scale value should be set to 0.
Setting a fixed scale
You can set minimum, maximum, and mean values to define a fixed color scale independent from a data set. To do this, move the Fixed scales slide button to the right under Appearance > Options > Fixed scale in the properties panel. Then enter a minimum value under Min scale value, a maximum value under Max scale value, and a mean value under Mean scale value. You can also insert a scale string into the expression in the Expression editor (fx).

Toggling titles
This option hides the name of the heatmap chart. Click Appearance > General in the properties panel, and toggle the Show titles slide button.

Changing label sizes on chart axes
You can also customize the size of the labels on both the y-axis and the x-axis of the chart. Click Appearance in the properties panel, and enter the label size you want under Y-axis label size and under X-axis label size.

Setting minimum horizontal size
You can set a minimum size of how the chart displays horizontally with Appearance > Options > Minimum horizontal size in the properties panel. You can also insert a string into the expression in the Expression editor (fx).

Limitations
For information about general limitations, see Limitations (page 435).

Multi KPI chart
The Multi KPI chart (Multi KPI) is a visualization that allows you to show multiple KPI values for different dimension values. The values can be individually customized using various conditional formatting settings. This enables an easy view and tracking of goals. It is included in the Visualization bundle.

- The chart shows KPIs using measures and one dimension.
- Up to 15 measures and 80 values can display simultaneously.
- All KPI values can be grouped or displayed individually.
- Each value can be independently customized using for example, colors, icons, labels, font sizes, alignments, styles, links to different sheets, etc.
- The chart supports adding graphics, embedding objects into a chart and to display measures infographically.

When to use it
The multi KPI chart is useful when you want to easily view, understand and track the performance of your goals. It is also helpful when you want to customize individual KPI values using conditional formatting. You can link KPIs to separate sheet and insert objects to represent information or data.
Creating a multi KPI chart
You can create a multi KPI chart on the sheet you are editing.

Do the following:

1. In the assets panel, open `Custom objects > Visualization bundle` and drag a Multi KPI object to the sheet.
2. Click the Add measure button and select the main measure of the KPI chart. The main measure and a KPI value for the chosen measure is displayed.
3. Click Add under Data > Dimensions in the property panel and select dimension.

When you have selected measure and dimension, a multi KPI chart is displayed.

Example:

A chart with the measure (Margin %) shown for different values of the dimension (City).

<table>
<thead>
<tr>
<th></th>
<th>Washington</th>
<th>Sartember</th>
<th>Hannover</th>
<th>Detroit</th>
<th>Bristol</th>
<th>Miami</th>
<th>Newcastle</th>
<th>Liverpool</th>
<th>Valladolid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin (%)</td>
<td>66</td>
<td>53</td>
<td>53</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

Adding additional measures
You can add additional measures to your chart in property panel under Data > Dimensions. The chart updates to reflect the added measures. Up to 15 measures and 80 values can display simultaneously. The main measure is always the top measure listed for each dimension. When you add more measures, they appear under the initial KPI value in the order they are entered.

Example:

A chart with a two measures (Margin %, Quantity) grouped per dimension (City).

<table>
<thead>
<tr>
<th></th>
<th>Washington</th>
<th>Sartember</th>
<th>Hannover</th>
<th>Detroit</th>
<th>Bristol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin (%)</td>
<td>66</td>
<td>53</td>
<td>53</td>
<td>51</td>
<td>51</td>
</tr>
<tr>
<td>Quantity</td>
<td>771</td>
<td>53</td>
<td>53</td>
<td>51</td>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Washington</th>
<th>Sartember</th>
<th>Hannover</th>
<th>Detroit</th>
<th>Bristol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin (%)</td>
<td>771</td>
<td>53</td>
<td>53</td>
<td>51</td>
<td>51</td>
</tr>
<tr>
<td>Quantity</td>
<td>1k</td>
<td>53</td>
<td>53</td>
<td>51</td>
<td>51</td>
</tr>
</tbody>
</table>

Customizing the KPIs
You can customize your KPI values and measures with one or more conditional settings. You can add several KPIs together, group them and link to different sheets. You can also configure KPI values independently by differentiating them with one or more conditional settings such as text, color, icons, graphics, etc.

For conditional settings options, see Changing a measure/label color (page 458).
Limitations
For information about general limitations, see Limitations (page 435).

Multi KPI charts cannot be used in Qlik NPrinting reports.

Customizing your KPIs
With the Multi KPI chart (Multi KPI) values and measures can be customized using one or more conditional settings. You can add several KPIs together, group them, and link to different sheets. KPI values can also be customized independently by differentiating them using one or more CSS-properties, such as text color, fonts, sizes, icons, labels, graphics.

KPI values can also be customized independently by differentiating them using one or more CSS-properties such as text color, background color, fonts, sizes, icons, labels, graphics.

KPI values using icons, different colors, fonts, Master Visualizations

<table>
<thead>
<tr>
<th>Icon</th>
<th>Today Profit</th>
<th>This Week</th>
<th>Total Sales</th>
<th>Visitors</th>
<th>Page View</th>
</tr>
</thead>
<tbody>
<tr>
<td>📊</td>
<td>96</td>
<td>250,75</td>
<td>1,8k</td>
<td>1,2k</td>
<td>118,23</td>
</tr>
<tr>
<td>-26%</td>
<td>from yesterday</td>
<td>-26%</td>
<td>-26%</td>
<td>-26%</td>
<td>-26%</td>
</tr>
</tbody>
</table>

Coloring a Multi KPI
The color option enables all KPI values (measures and labels) to be differentiated by colors. You can change the colors of text, icons and background color. The colors should be valid CSS-colors.

You can choose from the following options:

- The color palette with a set of predefined colors.
- The color circle (click the easel symbol in the color palette and choose individually).
- Enter a color code string in the field next to the easel symbol.

Changing a measure/label color

Do the following:

1. Click Data > Measures in the property panel.
2. Click applicable measure and select to color the value (Value color) or the label (Label color).
3. Select color from the color palette that opens.

### Changing background color

Do the following:

1. You can also set your own color by clicking the easel symbol in the color palette and select color or enter a color code string in the field next to the easel symbol. The colors should be valid css-colors.
2. Click **Appearance > Styles** in the property panel.
3. Click the **Background color** box.
4. Select color from the color palette that opens and the chart updates.

### Changing sizes of a Multi KPI

The size of dimensions, measures, labels and icons can be configured using predefined sizes available from a drop-down menu:

- **Dimension labels**: Select the size of the labels from the drop-down menu under **Appearance > Dimensions > Size** in the property panel.
- **Measure labels**: All measures can have individual sizes.

Do the following:

1. Select the size of the measures in the property panel under **Data > Measures**.
2. Select **measure** and click the **Override parameters** box.
3. Enter the label type as a string or in the expression under **Label** and select the size from the options in the drop-down menu under **Size**.

**Icons**: All icons can be differentiated by applying different colors.

Do the following:

1. Go to **Data > Measures** in the property panel.
2. Select **measure** and choose icon from the icon option.
3. Then choose **icon size** from the drop-down menu under **Icon**.

**Changing the fonts of a Multi KPI**
You can change the font-family of all labels if you go to **Data > Measures** in the property panel and select applicable measure. Under **Font style** enter a label string and press Enter.

You can also change the font using an expression in the Expression editor (¶) or apply individual font css properties entered through **Appearance > Styles > Styles (CSS)** in the property panel.

**Changing icons**
You can set a predefined icon to represent a value and/or label by selecting from the icon set. The icons can then be further customized by differentiating using the colors, fonts, labels and sizes options.

**Do the following:**

1. Click **Data > Measures** in the property panel.
2. Check the **Select icon** box and click applicable icon from the icons set that opens.

![Icon Selection](image)

3. Click **OK**. The pop-up will close and your chart update.
4. Choose whether to configure your label or value by selecting **Label** or **Value** under **Icon position**.

You can also change a value/label to an icon by entering an icon string under **Icon** (Data > Measures > applicable measure in the property panel) and then press Enter. Thereafter click **Label** or **Value** under **Icon position** depending on which you want to configure. It is also possible to change an icon using an expression in the Expression editor (¶). The icons should be valid CSSicons.

**Using infographic mode**
The infographic mode allows you to show each measure graphically as an appropriate number of icons.

**Do the following:**

1. Click the applicable measure under **Data > Measures** in the property panel and click the **Icon** button.
2. Select an icon to represent a measure from the predefined icon set (Icons) that opens.
3. Click the **Infographic mode** button. The resulting KPI chart updates and graphically shows the measures with applicable number of icons (max. 100 icons per measure).

You can also select an icon using an expression in the Expression editor (\(\text{\textbullet}\)).

![Visualization](image)

**Embedding a master visualization**

To graphically illustrate the KPI object, you can embed a master visualization.

**Do the following:**

1. In the in the property panel go the **Data > Measures** and click **Add**.
2. Click the **Expression editor** (\(\text{\textbullet}\)) button.
3. Enter the string =`Drag and Drop here` into the **Expression editor** and click **Apply**.
4. Drag and drop a master visualization object into the value region of each measure placeholder.

You can also change insert the object ID string into the expression in the Expression editor (\(\text{\textbullet}\)) under **Visualization** for each measure (**Data > Measures** > applicable measure in the property panel).

![Master Visualization](image)

**Using Styles (CSS) properties**

You can further configure your measures using non-predefined Styles (CSS) property for each measure. This can be icons, changing color of text/icons, label, font, background color, size, etc. Copy and paste the styles into the **Styles (CSS)** field (under **Appearance > Styles** in the property panel).

For icons, enter appropriate classes in the **Icon** field of the chosen measure under **Data > Measures** in the property panel. You can also enter the icon string using an expression in the Expression editor (\(\text{\textbullet}\)).
Formatting your KPIs
You can format the chart layout to be presented in different ways.

Alignment
You can configure the main chart text alignment by selecting applicable box under Alignment of chosen measure under Data > Measures in the property panel.

All KPIs can also be vertically aligned. This alignment can be adjusted to align top, bottom and center or as stretched. Select applicable alignment from the Vertical alignment menu under Appearance > Styles in the property panel. It is also possible to center align labels by checking the Center align labels in the property panel under Appearance > Dimensions.

Number formatting
You can also custom format the KPI number values. Different formatting can be applied to the same values. The chart updates to reflect the changed number type.

Do the following:

1. Click Data > Measures in the property panel and select applicable measure.
2. Select applicable number formatting from the Number formatting menu.
Format pattern

The text of a specific measure can be changed or removed.

Do the following:

1. Click **Data > Measures** in the property panel.
2. Click applicable measure and enter/remove the applicable format string under **Format pattern** and press Enter.

Segment/card

It is also possible to configure the layout of the KPI chart where dimensions and values display in a segment or card layout.

Do the following:

1. Click **Appearance > Dimensions** in the property panel.
2. Choose **Segment** or **Card** layout from the **Show as** menu. The chart will update.
The segment layout can be configured horizontally or vertically under Appearance > Dimensions > Orientation in the property panel. Click either the Horizontal or the Vertical buttons.

**Items per row**

It is also possible to decide the number of items (KPIs) per line in a chart in the property panel under Appearance > Measures. Use the default Auto or select applicable number from the Items per row menu (between 1-8).

**Borders**

You can hide external and internal borders of the chart. By default all borders are visible. To configure borders go to Appearance > Dimensions in the property panel and check, as applicable, Hide external borders or Hide internal borders.

**Value/Label layout and formatting**

The position and order of labels for both dimension and measure values can be altered and displayed in different ways. Labels can be hidden or displayed vertically or horizontally. By default Horizontal is selected.
3 Visualizations

Dimension label layout

Do the following:

1. Click Appearance > Measures in the property panel.
2. Click either Horizontal or Vertical under Labels orientation to select how the labels should display.

Measure value layout

Measure value layout can be set in two different ways.

Do the following:

1. Existing parameters:
   a. Click Appearance > Measures in the property panel.
   b. Click either Horizontal or Vertical under Labels orientation to select how the labels should display.

2. New parameters:
   a. Click Data > Measures in the property panel.
   b. Click applicable measure and check the Override parameters box.
   c. Enter the label string under Label and press Enter.

Label order

You can also adjust the order in which measure value labels appear.

Do the following:

1. Click Appearance > Measures in the property panel.
2. Click either Label, Value or Value, Label under Labels orientation to select how the labels should display.

Icon order

You can decide where to show icons - before or after a value. In the property panel under Appearance > Measures go to Icon order and click either the Icon, Value or Value, Icon buttons to select which displays first in the chart.

Hide Labels

- Measure labels: This option hides the measure label of each KPI. To hide the labels click Data > Measures in the property panel and select applicable measure. Then check the Hide labels box.
- Dimension labels: This option hides the dimension label of each KPI. To hide the labels click Appearance > Dimensions in the property panel. Then check the Hide labels box.
Hide Values
This option hides the value for each KPI. To hide the value, click Data > Measures in the property panel. Then check the Hide values box.

Group KPI values
All KPI values can be grouped or displayed individually per measure. Go to the Data > Measures in the property panel. Choose applicable measure and check the Group by dimension box.

Another option is to enter a dimension value string under Dimension value and press Enter. The chart will update. You can also enter the dimension value using an expression in the Expression editor (fx). The values should be valid CSS values.

Link to a separate sheet
Each measure can be linked to another sheet.

Do the following:

1. Click Data > Measures in the property panel and select applicable measure.
2. Move the Link to sheet slider to the right to turn the option on.
3. Click the Select sheet button and from the Select sheet pop-up click the page you want a link to. The sheet will close and your pages link.

Limitations
For information about general limitations, see Limitations (page 435).
Network chart

The network chart (network chart) lets you draw a network of connected nodes and edges from a data set to a sheet. A network chart shows how information flows, how components interact, and where components exist in the network. The network chart is included in the Visualization bundle.

A network chart can provide a broad overview or be very detailed. Nodes represent system components, and edges show the movement of information from one component to another. Network nodes are connected to the nodes they interact with the most. This visualization uses different styles, colors, sizes, and images to represent different levels of a network.

What it contains

You need to define three dimensions, with a fourth optional dimension:

- **Node identifier**: This dimension controls which nodes are presented in the chart.
- **Node label**: This dimension sets the label of each node.
- **Node parent**: This dimension sets the parent of a node, and controls the relationships between nodes. It needs to contain the value of the node identifier of the parent to connect to.
- **Node group** (optional): You can use this dimension to group nodes. All nodes in the same group will have the same color.

You can use up to three measures to enhance the diagram. All measures are optional, but you need to add them in the following order:

1. **Tooltip**: You can set a measure value that is displayed in a tooltip when hovering over a node.
2. **Node size**: You can set the size of the node according to a measure.
3. **Edge size**: You can set the width of the lines between nodes according to a measure.

You need to add a tooltip before you can set node size. You can set edge size after adding a tooltip and node size.

When to use it

Network chart diagrams can illustrate computer or telecommunications networks. They show the components of a network and how they interact. For example, a group of connected computers, printers, modems, hubs, and routers. This type of chart is helpful when:

- Planning the structure of a network.
- Coordinating updates to an existing network.
- Reporting and troubleshooting network problems.
- Keeping track of components.
- Documenting detailed network documentation.
3 Visualizations

Formatting your data
A network chart requires data that is structured consistently according to a network data model where each record can have multiple parents and children. Each record needs to contain at least:

- A field that identifies the node, the node identifier. Node identifier values must be integer values, starting from 0 and in sequential order.
- A field with the name of the node.
- A field that defines the parent node. This value needs to be the node identifier of another node. If this field is empty, and no other record refers to this node, a disconnected node is created.

It is also possible to use a hierarchical data model where each node has a single parent. This will create a tree-shaped chart.

Here is some example data that you can save in a text editor and load in a new app. You need to load both example files. The example shows passenger flows between different airports.

- ID is the identifier of an airport node.
- Name is the name of an airport node. This is used as label of the node.
- LinkTo contains the node identifier of the parent node.
- Group states the group of a node. This can be used to color the nodes according to group.
- Volume is the passenger flow volume between ID and LinkTo. This can be used as a measure in edge size.
- NodeVolume is the total passenger flow volume for a node. This is loaded in a separate table as the chart cannot aggregate the volumes automatically.

Example 1: Airports1.csv

<table>
<thead>
<tr>
<th>ID;Name;LinkTo;Group;Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>0;Frankfurt;;0;</td>
</tr>
<tr>
<td>1;London;0;1;5</td>
</tr>
<tr>
<td>2;Madrid;0;1;4</td>
</tr>
<tr>
<td>2;Madrid;1;1;8</td>
</tr>
<tr>
<td>3;Warsaw;0;1;7</td>
</tr>
<tr>
<td>4;Arlanda;0;1;1</td>
</tr>
<tr>
<td>3;Warsaw;1;1;5</td>
</tr>
<tr>
<td>4;Arlanda;1;1;6</td>
</tr>
<tr>
<td>5;Tunis;0;2;8</td>
</tr>
<tr>
<td>5;Tunis;2;2;4</td>
</tr>
<tr>
<td>6;Berlin;0;1;6</td>
</tr>
<tr>
<td>6;Berlin;4;1;4</td>
</tr>
<tr>
<td>7;Rome;0;1;6</td>
</tr>
<tr>
<td>7;Rome;6;1;3</td>
</tr>
<tr>
<td>8;San Francisco;0;3;2</td>
</tr>
<tr>
<td>9;New York;0;3;9</td>
</tr>
</tbody>
</table>
Example 2: Airports2.csv

<table>
<thead>
<tr>
<th>ID</th>
<th>NodeVolume</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>48</td>
</tr>
<tr>
<td>1</td>
<td>24</td>
</tr>
<tr>
<td>2</td>
<td>16</td>
</tr>
<tr>
<td>3</td>
<td>12</td>
</tr>
<tr>
<td>4</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>12</td>
</tr>
<tr>
<td>6</td>
<td>13</td>
</tr>
<tr>
<td>7</td>
<td>9</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>

Creating a network chart

This example of a network chart illustrates how different airports are connected worldwide based on base data set. It uses the example data set from Formatting your data. Prepare by saving the example data set in a text file, creating a new app and loading the example data set.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle, and drag a Network chart object to the sheet.
2. Click the top Add dimension button and select ID as the node identifier.
3. Click the second Add dimension button and select Name as the node label.
4. Click the third Add dimension button and select LinkTo as the parent node.
5. Click Data in the properties panel. Click the Add button under Node group and select Group as the group dimension.
6. Under Measure, click the Add button under Tooltip, and select Volume > Sum(NodeVolume).
7. Click the Add button under Node size, and select Volume > Sum(NodeVolume).
8. Click the Add button under Edge size, and select Volume > Sum(Volume).
The chart displays:

Changing the appearance of the chart
You can customize your chart with one or more features.

**Configuring edge type**
You can configure the shape of the curve between chart nodes under **Settings > Edge Type** in the properties panel. Select the shape option of the chart curves from the menu.

**Examples:**

*A chart with dynamic edge type (curves).*

*The same chart with curved CW edges.*
Toggling edge value
The edge value represents value of the curves between chart nodes and their width. This option hides the numerical value of each curve. To hide the value move the slide button under Settings > Display edge value in the properties panel to the left to turn the option off.

Configuring edge label
The edge label value is the numerical value of each chart curve. You can change the position of these or hide the labels.

- **Hide edge label value**: This option hides the edge label of the network chart. Toggle the slide button under Settings > Display edge value in the properties panel.

- **Edge label position**: This option decides where on each chart curve the edge value displays, for example: above or below. Select applicable option from the menu.

Configuring node shape
You can customize the shape of the nodes, for example: dot, square, diamond, or triangle. Go to Settings > Node shape in the properties panel, and select the node shape from the menu.

Toggling shadow option
This option lets you turn off the shadow effects behind chart curves and nodes (used to highlight background). Toggle the slide button under Settings > Display shadow in the properties panel.

Sorting
Sorting is set to Auto with the system choosing the sorting order as the default (under Sorting > chosen dimension or measure in the properties panel) for all dimensions and measures. You can change them individually by expression.
3 Visualizations

Do the following:

1. Open the dimension or measure menu under Sorting in the properties panel.
2. Move Sorting slide button to the left to turn the option from Auto to Custom.
3. Click the Sort by expression check box.
4. Enter an order string under Expression and press Enter. You can also change the color using an expression in the Expression editor (f).
5. Choose start order by selecting Ascending or Descending for the menu below.

Number formatting
It is possible to format the measure value. Different formatting can be applied to the same value, for example: money, data, or duration. The chart updates to reflect the changed number type.

Do the following:

1. Click Data > Measures in the properties panel and click chosen measure.
2. Select applicable number formatting form the Number formatting menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto when to configuring the chart.

Limitations
For information about general limitations, see Limitations (page 435).

- Network chart visualizations cannot be used in Qlik NPrinting reports.
- The maximum size of the data set displayed in the network chart is 1400 rows. If the selected data set is larger, nodes and links can be omitted from the chart.
  Use a smaller data set or employ selections to limit the data set.

Org chart
You can use the org chart (Org chart) to create organization charts from data with a tree structure. You can navigate through the hierarchy by expanding and collapsing the tree. The org chart is included in the Visualization bundle.

You need to use a data set with two dimensions that define the tree structure.

- The first dimension needs to be the ID of the node. This would typically be an employee ID in a traditional organization chart.
- The second dimension needs to be the ID of the parent node. This would typically be the employee ID of a manager.
  This connects to the first dimension to create a tree structure.
  If this value is empty or points to a node that does not exist, the node becomes a root node at the top of the tree.
Example data set for an org chart

<table>
<thead>
<tr>
<th>EmployeeID</th>
<th>ManagerID</th>
<th>Name</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A101</td>
<td>A101</td>
<td>Mary Bell</td>
<td>CEO</td>
</tr>
<tr>
<td>A102</td>
<td>A101</td>
<td>John Bialik</td>
<td>Executive secretary</td>
</tr>
<tr>
<td>O101</td>
<td>A101</td>
<td>Lee Mayer</td>
<td>COO</td>
</tr>
<tr>
<td>I101</td>
<td>A101</td>
<td>Wendy Sanderson</td>
<td>CIO</td>
</tr>
<tr>
<td>T101</td>
<td>A101</td>
<td>Asim Nawrat</td>
<td>CTO</td>
</tr>
<tr>
<td>T102</td>
<td>T101</td>
<td>Emily Diaz</td>
<td>VP Products</td>
</tr>
<tr>
<td>T103</td>
<td>T101</td>
<td>Christine Nemic</td>
<td>VP R &amp; D</td>
</tr>
</tbody>
</table>

You can also add a measure that is used as a card description.

Preparing the dataset
There are some things you need to consider when preparing the dataset for an org chart.

- You need to use a dataset with less than 33000 rows. If you use a larger dataset, the excess rows will be ignored. This can result in a tree with incorrect structure. A message is displayed: The maximum data limit is reached. The tree may display incorrectly.
- Make sure that the data does not contain circular references. Circular references can result in nodes being omitted, or creation of multiple root nodes. One of these messages is displayed: Data contains circular references, nodes are omitted. No root node, check your data for circular references.
- If a node has more than 99 children, the excess children nodes will not be rendered. A message is displayed: Maximum number of child nodes reached, nodes are omitted.
- You should avoid having a large number of rows that do not have a parent node. These will be shown as root nodes. The maximum number of root nodes is 99.

Creating an org chart
You can visualize the example data set using an org chart. Every employee is shown as a card in a tree structure that you can expand and collapse.

Do the following:

1. Add an Org chart to your sheet.
2. Set the first dimension to be EmployeeID.
3. Set the second dimension to be ManagerID.
4. Add labels to the cards. Expand the EmployeeID dimension to see the label properties.
   a. Set Card title to Name.
   b. Set Card sub-title to Title.
Changing the appearance of the chart
You can customize the appearance of your org chart.

Adding a measure to set a description
You can display a description by adding a measure. This will replace the value set in the property Card description.

Changing the presentation mode
You can set how the org chart displays in Appearance > Presentation > Presentation mode. Org charts can either display the entire tree, or they can collapse and expand. If an org chart is set to Expand/collapse, you can also set the org chart to automatically resize to fit every time it is expanded or collapsed.

Changing the colors
You can change the color of the card background in two different ways:

- Expand the first dimension and set an expression that returns a color or a color code under Card background color. You can refer to data fields in the expression.
- Set a background color under Appearance > Presentation > Background color. You can set all cards to a single color, or use an expression. If you use an expression you cannot refer to data fields.

You can also set the color of the text with Appearance > Presentation > Font color.

Changing card borders
You can choose if org chart cards have borders and top bars under Card appearance. If you choose to include borders, you can set a border color in Appearance > Presentation > Border color. You can set borders to a single color or use an expression. If you use an expression, you cannot refer to data fields.
Selections in the org chart
You can select cards in the org chart. Selecting a card will include all child nodes below a card in the selection.

For information about general limitations, see Limitations (page 435).

P&L pivot chart
You can use the P&L pivot chart to create a pivot table with a layout for profit and loss reporting. You can color cells according to performance and style the chart with custom fonts and alternating row colors. You can also download the chart to Excel including formatting. The P&L pivot chart is included in the Visualization bundle.

<table>
<thead>
<tr>
<th>Account Desc</th>
<th>France</th>
<th></th>
<th></th>
<th></th>
<th>Italy</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Balance</td>
<td>Bal Y (k)</td>
<td>% Var</td>
<td>Diff (k)</td>
<td>Balance</td>
<td>Bal Y (k)</td>
<td>% Var</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revenues</td>
<td>33,329</td>
<td>29,483</td>
<td>9</td>
<td>3,866</td>
<td>37,493</td>
<td>33,371</td>
<td>9</td>
</tr>
<tr>
<td>Gross sales revenues</td>
<td>346</td>
<td>242</td>
<td>9</td>
<td>104</td>
<td>369</td>
<td>272</td>
<td>9</td>
</tr>
<tr>
<td>Less return &amp; allowances</td>
<td>32,983</td>
<td>29,695</td>
<td>9</td>
<td>3,676</td>
<td>37,166</td>
<td>33,543</td>
<td>9</td>
</tr>
<tr>
<td>Cost of goods sold</td>
<td>0</td>
<td>0</td>
<td>9</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>9</td>
</tr>
<tr>
<td>Direct materials</td>
<td>-6,320</td>
<td>-6,636</td>
<td>-4</td>
<td>310</td>
<td>-7,110</td>
<td>-7,460</td>
<td>-4</td>
</tr>
<tr>
<td>Direct labor</td>
<td>-6,100</td>
<td>-5,817</td>
<td>0</td>
<td>-183</td>
<td>-6,656</td>
<td>-6,857</td>
<td>0</td>
</tr>
<tr>
<td>Manufacturing overhead</td>
<td>-5,203</td>
<td>-5,896</td>
<td>0</td>
<td>-269</td>
<td>-5,921</td>
<td>-6,026</td>
<td>0</td>
</tr>
<tr>
<td>Indirect labor</td>
<td>-350</td>
<td>-7</td>
<td>49</td>
<td>-353</td>
<td>-465</td>
<td>-8</td>
<td>49</td>
</tr>
<tr>
<td>Depreciation, manufacturing equip</td>
<td>-4,600</td>
<td>-4,406</td>
<td>0</td>
<td>-400</td>
<td>-4,560</td>
<td>-4,990</td>
<td>0</td>
</tr>
<tr>
<td>Other mfr overhead</td>
<td>-9,623</td>
<td>-9,407</td>
<td>0</td>
<td>-116</td>
<td>-10,825</td>
<td>-10,583</td>
<td>0</td>
</tr>
<tr>
<td>Net costs of goods sold</td>
<td>-10,946</td>
<td>-9,407</td>
<td>-2</td>
<td>20,347</td>
<td>12,385</td>
<td>-10,583</td>
<td>-2</td>
</tr>
<tr>
<td>Gross profit</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Operating expenses</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Selling expenses</td>
<td>-4,730</td>
<td>-3,800</td>
<td>0</td>
<td>-110</td>
<td>-4,730</td>
<td>-4,489</td>
<td>0</td>
</tr>
<tr>
<td>Sales salaries</td>
<td>-730</td>
<td>-15</td>
<td>49</td>
<td>-715</td>
<td>-821</td>
<td>-16</td>
<td>49</td>
</tr>
</tbody>
</table>

P&L pivot chart dimensions and measures

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>up to 9 measures</td>
<td>A table with one row for each dimension value and one column for each measure.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>up to 8 measures</td>
<td>A pivot table with one row for each value of the first dimension and one column for each measure pivoted using the second dimension.</td>
</tr>
</tbody>
</table>

Coloring cells to show performance
You can color cells to show performance according to a scale of Poor, Fair and Good. All rows and columns are colored by default, but you can choose which columns and rows to color if you want to.
Do the following:

1. Make sure that **Enabled** is set to **On** under **Appearance > Color by condition**.
2. Select which rows to color by performance.
   - Set **Color all rows by condition** to **Specified rows**.
   - Add rows to color by name (dimension value) with **Add row to color**.
3. Select which measures to color by performance.
   - Set **Color all measures to Specified measures**.
   - Add a list of measures by number in **Measure indices** with the first measure of the chart numbered zero. Separate the measures with a comma.

**Example: Color the first, third, and fifth measure.**

0,2,4

4. Set performance limits and colors.
   - You can set the range limits for **Poor** and **Fair**.
     - All cells with a value lower than the **Poor** range limit are displayed with the background color and text color set for **Poor**.
     - All cells with a value lower than the **Fair** range limit, but higher than **Poor**, are displayed with the background color and text color set for **Fair**. You should set the **Fair** range limit higher than **Poor**.
     - All other cells are displayed with the background color and text color set for **Good**.

Styling the chart using a style template

You can create a layout for the chart, for example to show a profit and loss report, using a style template.

> You need to be able to add and load a CSV file to the app.

Do the following:

1. Create a style template as a CSV file. Use the style template format described below.
2. Load the style template to your app as one field. When you add the file, do not use semicolon as field separator, each row should be loaded as one field.
3. Set **Style template field** under **Appearance > Table format** to the name of the template field you added.

You can load several style templates in your app, and change the layout with **Style template field**.

**Style template format**

The style template is created as a comma separated text file (CSV) using UTF-8 encoding.
The style template rows need to align to the data in your first dimension. You need to refer to a dimension value in the template. The dimension value should be first in every row. You do not need to specify all rows/dimension values in the template.

Each row in the template should be in the following format. It is not required to use a header row.

DimensionValue;Bold;Background;FontStyle;TextColor;Align;FontSize;Comment

- **DimensionValue**
  - The dimension value of the row that you want to style.
- **Bold**
  - Set to `<bold>` if you want bold text.
- **Background**
  - Set a background color. You can use `<dark>`, `<night>`, `<soft>`, `<red>`, `<orange>`, `<violet>`, `<blue>`, `<green>` or a color code in RGB format, for example rgb(183,219,255). The default background color is white.
- **FontStyle**
  - You can set the font style to `<italic>` or `<oblique>`.
- **TextColor**
  - You can set the color of the text to `<white>`. The default background color is black.
- **Align**
  - You can center align the text with `<center>`. The default alignment is left for text and right for numeric values.
- **FontSize**
  - You can set the font size to `<large>`, `<medium>` (default) or `<small>`.
- **Comment**
  - You can use the `<comment>` tag to replace all zero values with a space. This is useful when you want to include a sub header row without values.

You can also use the style tags in any order, and exclude tags that are not used. These rows will give the same result:

```
Operating expenses;<bold>;;<italic>;;;
Operating expenses;<italic>;<bold>;;;
```

**Style template example for profit and loss reporting**

```
Cost of goods sold;<bold>;RGB(225,226,226);;;;;
Extraordinary items after tax;<bold>;RGB(193,216,47);;;;;<center>;<large>;
Extraordinary items;<bold>;<italic>;;;;<center>;;<comment>
Financial revenue & expenses;<bold>;<italic>;;;;<center>;;<comment>
General & administrative expenses;<bold>;<italic>;;;;<center>;;<comment>
Gross profit;<bold>;RGB(193,216,47);;;;;<center>;<large>;
Income before tax & extraordinary items;<bold>;RGB(193,216,47);;;;;<large>;
Manufacturing overhead;<bold>;<italic>;;;;<center>;;<comment>
Net costs of goods sold;<bold>;RGB(225,226,226);;;;;
Net gain on sale of land;<bold>;RGB(193,216,47);;;;;<center>;<large>;
Net Income (Profit);<bold>;#191970;<white>;;;;<center>;<large>;
Net mfr overhead;<bold>;RGB(225,226,226);;;;;
Net sales revenues;<bold>;RGB(225,226,226);;;;;
Operating expenses;<bold>;<italic>;;;;
Operating income before taxes;<bold>;RGB(193,216,47);;;;;<large>;
Other general & admin expenses;<bold>;rgb(128,191,255);<white>;;;;<center>;<large>
```
3 Visualizations

To use this template, you need a data file where the first dimension contains values that correspond to the first item of each row, for example Cost of goods sold.

P&L pivot chart styled with the layout template in the example

Limitations

For information about general limitations, see Limitations (page 435).

- There is a limitation for data transfer between Qlik Engine and P&L pivot. This limits each request for data to 10000 elements, for example, 1000 rows and 10 columns. P&L pivot can make automatic requests for more data using pagination.
  You can set the limit of how much data to request with Pagination > Max pagination loops. The default value is 20000 elements (20k cells) and the maximum value is 40000 elements.
  You can also modify the error message displayed to the user when the data limit is exceeded. The recommended workaround when the data limit is exceeded is to apply filters to the data to limit the data transfer.
- It is not possible to convert a P&L pivot chart to another visualization or convert another visualization to a P&L pivot chart.
3 Visualizations

Radar chart

The Radar chart (Radar chart) displays a two-dimensional chart using radial axes to chart one or more groups of values over multiple variables. Radar charts can be used to visualize and compare performance to a set standard or to a group's performance. The Radar chart is included in the Visualization bundle.

Radar charts require two dimensions and one measure. The y-axis goes from the center to the perimeter and the x-axis is the perimeter of the chart. Each value represents the distance from the center of the chart, and displays on axes starting from the center. The center of the chart represents the minimum value, and the edge the maximum value.

A radar chart can show multiple series, each separately connected with their values. The data only goes around the chart once. Adding values only increases the chart's granularity.

Understanding a radar chart

A radar chart consists of evenly spaced segments (axes) arranged radially around a point. There is one segment for each data value of the second dimension. The value of each measure is shown by a node on applicable axis. A line connects the values that belong to the same series creating the chart's star-like shape.

A radar chart with one axis for each month of the Date.Month dimension.
3 Visualizations

When to use it
Radar charts let you compare and measure data with an arbitrary number of variables. This is helpful when comparing something's features or performance over several metrics. For example: before buying a computer, you can compare different computers across several features, such as memory storage, processing, and screen size. A radar chart is also useful when:

- Measuring quality improvements and performance.
- Comparing allocated amount versus actual spending in an organization.
- Identifying outliers, commonality, and clusters of data with similar values and features.
- Charting an athlete's strengths and weaknesses.
- Comparing results of small-to-moderate-sized multivariate data sets.

Creating a radar chart
You can create a radar chart on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Radar chart object to the sheet.
2. Click the top Add dimension button and select the first dimension category to be measured (x-axis).
3. Click the second Add dimension button to select the second dimension (y-axis).
4. Click the Add measure button to select the measure of the chart.

Once dimensions and measure have been selected the radar chart displays automatically (in color) in the chart field.

* A radar chart with two dimensions and one measure. 
Changing the appearance of the chart
You can customize your radar chart with one or more features.

**Changing the color scheme**
You can change color scheme of your chart by choosing from four predefined options.

**Do the following:**

1. Click **Appearance > Design** in the property panel.
2. Select a color scheme under **Color**.

![Color Scheme](image)

**Changing the stroke type**

You can also customize the shape line connecting each node under **Appearance > Design > Stroke type** in the properties panel. Select the shape from the menu.

**Toggling the legend**

The legend provides a small text description of each node of the chart. The legend expands to show its text, and the chart shrinks to accommodate the legend. To toggle the legend, move the slide button under **Appearance > Design > Legend** in the properties panel.

**Limiting dimensions**

You can set limits on your dimension values. To change limitations and terms go to **Data > Dimensions** in the properties panel. Click dimension, and under **Limitation** choose a limitation from the menu.

**Toggling titles**

This option can hide the name of the radar chart. To toggle the name, click **Appearance > General** in the properties panel. Move the **Show titles** slide button.

**Number formatting**

The default setting for **Number formatting** for measures and dimensions is **Auto**. You can change this setting to **Number**, and then select a number format.

**Limitations**

Radar charts can only process 100 unique values per dimension.

For information about general limitations, see **Limitations (page 435)**.

**Sankey chart**

The Sankey chart (Sankey chart) lets you add a specific type of flow chart to the sheet you are
Visualizations

The chart visually emphasizes major transfers or flows within defined system boundaries. The width of the chart arrows is shown proportionally to the flow quantity. The Sankey chart is included in the Visualization bundle.

- A minimum of two dimensions and one measure is required. You can use up to five dimensions, but only one measure.
- The dimensions do not need to be of equal size on each side of the diagram.
- You can use the dimension values to set the color of the flows in the chart.
- Link colors can be based on source or target anchor.

A chart with a source dimension (Quarter) and the target dimension (Year).

When to use it

The sankey chart is useful when you want to locate the most significant contributions to an overall flow. The chart is also helpful when you want to show specific quantities maintained within set system boundaries.

Creating a sankey chart diagram

You can create a sankey chart on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Sankey chart object to the sheet.
2. Click the top **Add dimension** button and select the source dimension for the flow of the chart (appears to the left).

3. Click the second **Add dimension** button to select the target dimension for the flow of the chart (appears to the right).

4. Click the **Add measure** button to select the measure of the chart.

Once dimensions and measure have been selected the sankey chart diagram displays automatically (in color) in the chart field.

### Adding additional dimensions

You can add up to five dimensions to your chart in property panel under **Data > Dimensions**. The chart updates to reflect the added dimensions. The dimensions are displayed from left to right, with the first entered dimension always being the source dimension. The target dimension is always displayed to the to the right. When you add more dimensions, they are added to the right in the order they are entered.

*A chart with three dimensions: the source dimension (Origin), the target dimension (Decision) and one additional (Destination).*

### Sorting

Sankey chart elements are automatically sorted from largest to smallest flow. You can change the sort order in the property pane.

**Do the following:**

1. Click **Sorting** under **Appearance** in the property panel.
2. Toggle **Sorting** from **Auto** to **Custom**.
3. You can toggle **Sort numerically**:
   - Toggle on: Sort numerically by **Ascending** or **Descending**.
   - Toggle off: Drag your dimensions and measurements into the desired order.

**Changing the appearance of the chart**

You can customize your chart with one or more features. Your chart automatically updates.

**Link colors**

The colors of chart links are based on either the source or target anchors. To apply the source or target anchor color to chart links either use the string ="SOURCE" or ="TARGET". You can also select a separate color by entering a color code string. The color should be a valid CSS color.

**Do the following:**

1. Click **Presentation** under **Appearance** in the property panel.
2. Enter the applicable string under Link color.
3. Press Enter and the chart updates.

You can also change the link colors using an expression in the Expression editor (¶). It is also possible to color a link that has its intensity based on the Margin % of the dimension values it represents.

**Example:**

Enter the string =rgb(round(Avg ([Margin %])*255), 100, 100) where Margin % is a value between 0-1 and the link will display as red in the chart.

**Link opacity**

You can adjust link opacity by moving the slide button of the link opacity slider under **Appearance > Link opacity** in the property panel. Also, setting opacity to 1 (furthest right) allows the setting to drop a shadow, giving links a more individually distinct appearance.

**Node colors**

You can change the node colors of each dimension value. The color should be a valid CSS color.

**Do the following:**

1. Select applicable dimension under **Data > Dimensions** in the property panel.
2. Enter the color code string under Node color and press Enter. The chart will update.
   - For example: To use the color Aqua (#00ffff) set the color code string to ="#00ffff". You can also set
the node colors using an expression in the Expression editor (fx).

Node padding and width
You can set both the vertical distance between nodes ("node padding") and the horizontal width of chart nodes ("node width").

Do the following:

1. Click **Presentation** under **Appearance** in the property panel.
2. Move applicable slide button of the Node padding and/or Node width sliders to adjust node settings.

Limitations
For information about general limitations, see Limitations (page 435).

Trellis container
You can use the Trellis container to show a trellis chart based on a master visualization. The trellis chart shows a grid of the same chart for different dimension values. You can use the trellis chart to compare metrics for different groups of data. The Trellis container is included in the Visualization bundle.

*Trellis chart based on a bar chart of sales data, shown for different product categories*
Creating a trellis chart

You can create a trellis chart on the sheet you are editing. The chart that you want to repeat for different dimension values must be a master visualization.

Do the following:

1. Create the chart that you want to repeat for different dimension values and save it as a master visualization.
2. In the assets panel, open Custom objects > Visualization bundle and drag a Trellis container object to the sheet.
3. Select which master visualization to show in Appearance > Trellis options > Base visualization in the property panel.
4. Select the dimension that you want to use as the first grid dimension in Data > Dimensions.
5. Optionally, add a second grid dimension to create a grid with one dimension in each axis.

You will now see a grid of charts, each based on the grid dimensions you selected.

Troubleshooting

I do not see a grid of charts, and receive this message: Too many dimension values!

Possible cause

There are more dimension values than the maximum number of charts allowed in the grid.

Proposed action

You can increase the number of charts allowed in Appearance > Trellis options > Maximum number of charts.

Changing the appearance of the chart

You can customize your chart with one or more features.

Setting the number of columns

You can set the number of columns in the chart grid with Appearance > Trellis options > Number of columns.
Setting the y-axis range of charts
You can select which y-axis range to show for the charts in the trellis chart with **Appearance > Trellis options > Auto range.**

- **On** will show the same range for all charts. This is the best option if you want to compare values between different charts.
- **Off** will show an optimized range for each chart.

Show border
You can show a border for the trellis chart with **Appearance > Trellis options > Border.** You can adjust width, color and style. It is also possible to define a custom border.

Slide mode
You can view the charts in slide mode instead of a grid by setting **Appearance > Trellis options > Slide mode** to **On.** In slide mode, you view one chart at a time. You can scroll between the charts.

Best practices for creating the master visualization
Here are some tips for creating a master visualization that will work well in a trellis chart:

- Show the title in the master visualization. In the trellis chart, the title is replaced with the grid dimension value of each chart.
- If you use expressions: create a label to hide the set expression.
- If you are using a combo chart: use only one axis, and set the minimum and maximum of the y-axis.
- If you are using a box plot: set the minimum and maximum of the y-axis.
- If you are using a scatter plot: set the x-axis.
- If you are using a map: use advanced mode, and set the layer color and title.

Using advanced mode
You can use advanced mode to specify where to insert set analysis and dimension values in the master visualization. Activate it by setting **Appearance > Trellis options > Advanced mode** to **On.**

You can use the following placeholders in formulas in the master visualization. They will be replaced in the trellis chart by the corresponding values:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Replaced by value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(vDim)$</td>
<td>Dimension Name</td>
</tr>
<tr>
<td>$(vDimValue)$</td>
<td>Dimension Value</td>
</tr>
<tr>
<td>$(vDimSet)$</td>
<td>[Dimension Name]=('Dimension Value')</td>
</tr>
<tr>
<td>$(vDimSetFull)$</td>
<td>&lt;[Dimension Name]=('Dimension Value'&gt;)</td>
</tr>
</tbody>
</table>

Limitations
For information about general limitations, see *Limitations (page 435).*
Unsupported visualizations
You cannot use the following visualizations in a trellis chart:

- Filter pane
- Histogram

Multi KPI visualizations with embedded master visualizations
It is not possible to use a Multi KPI chart that contains an embedded master visualization.

Selecting by dimension
If you make a selection on the dimension that is used as grid dimension in the trellis chart, the selection is not reflected in the trellis chart.

Example:
You have a filter pane with countries, and a trellis chart with country as the first grid dimension. When you select a country in the filter pane, the trellis chart will still show a chart for each country and ignore the selection.

Variance waterfall chart
You can use the variance waterfall chart (Variance waterfall) to show the variance between two measures over the different values of a dimension. The variance waterfall chart is included in the Visualization bundle.

You need to use two measures, start value and end value, and one bridge dimension.

Variance waterfall chart showing spending over fiscal quarters

Creating a variance waterfall chart
You can create a variance waterfall chart on the sheet you are editing.
Do the following:

1. In the assets panel, open Custom objects ➤ Visualization bundle and drag a Variance waterfall object to the sheet.
2. Click the Add dimension button to select the bridge dimension.
3. Click the first Add measure button to select the measure to use as start value.
4. Click the second Add measure button to select the measure to use as end value.

The variance waterfall chart is now displayed with one bar for the start value measure and one bar for the end value measure. Between the measure bars you will see the variance for each value of the bridge dimension.

Changing the appearance of the chart

You can customize the appearance of your chart.

Labels

You can turn off value labels by setting Appearance ➤ Presentation ➤ Value labels to Off.

Legend

You can customize the legend labels by setting Appearance ➤ Presentation ➤ Labels to Custom. You can set a custom text for the following legend labels:

- Start value (Start value)
- End value (End value)
- Positive variance (Positive label)
- Negative variance (Negative label)

You can also hide the legend by setting Appearance ➤ Colors and legend ➤ Show legend to Off or change the position of the legend with Appearance ➤ Colors and legend ➤ Legend position.

Example of a variance waterfall chart

In this simple example we will show how quarterly sales numbers contribute to sales compared to budget.

Dataset

The dataset we use contains sales numbers and budgeted sales for each quarter. You can paste it into a text file and load it in Qlik Sense.

```plaintext
Quarter,Sales,Budget
Q1,9,10
Q2,14,12
Q3,12,12
Q4,18,14
```

Visualization

You can now create a variance waterfall chart.

- Add Quarter as dimension.
- Add sum(budget) as the first measure.
• Add \( \text{sum(sales)} \) as the second measure.

The variance waterfall chart is created. We have adjusted the labels and colors in the example.
You can clearly see that Q1 had sales below budget, but the year ended with sales over budget, and that Q4 was the largest contribution.

**Variance waterfall chart showing spending over fiscal quarters**

![](chart.png)

**Limitations**

For information about general limitations, see *Limitations (page 435).*

- It is not possible to use a variance waterfall chart in a Trellis container.
- You need to use the same number format for both measures to get correct number format for the dimension variance bars.

**Word cloud chart**

The Word cloud chart (*Word cloud chart*) lets you visualize text data. Text values are displayed with their size based on a measure value. The measure can be anything you want to measure against, for example: times used, alphabetically, by importance, or by context. You can customize your chart with different shapes, fonts, layouts, and color schemes. It is included in the Visualization bundle.
3 Visualizations

A word cloud chart displaying food items in different sizes and colors.

Requirements
Word cloud charts must have one dimension and one measure.

When to use it
A word cloud chart lets you visualize and identify the importance of a value against a measure. The more important the value is against the measure, the larger it displays in the cloud.

Creating a word cloud chart
You can create a word cloud on the sheet you are editing.

Do the following:

1. In the assets panel, open **Custom objects > Visualization bundle** and drag a **Word cloud chart** object onto the sheet.
2. Click the **Add dimension** button and select the dimension.
3. Click the **Add measure** button to select the measure of the chart.

Once a dimension and a measure have been selected, the word cloud chart displays automatically.

Changing the appearance of the word cloud
You can customize your word cloud with one or more features.
Changing the orientation
You can set the number of orientations with Appearance > Design > Orientations in the properties panel. You can set an integer from 1 to 10.

- 1 will display all words in the same direction, set with Appearance > Design > Start angle.
- 2 will display words in two orientations, Appearance > Design > Start angle and Appearance > Design > End angle.
- 3-10 will display words in the same number of orientations between Appearance > Design > Start angle and Appearance > Design > End angle.

Example:

![Image of a word cloud chart displaying food items in different orientations.]

A word cloud chart displaying food items in different orientations.

Adjusting the start and end angles
You can adjust the starting point (angle) parameter of the word cloud under Appearance > Design > Start angle, and the end point under Appearance > Design > End angle in the properties panel. The angles can have positive or negative numbers.

Changing font size
You can set maximum word font sizes under Appearance > Design > Font max size and the minimum under Appearance > Design > Font min size in the properties panel.

If you set a large font size, this can result in the larger words not being displayed in the chart as they do not fit.
Changing scale
The word could chart scale can be either in linear or in log scale. Select scale **Linear** or **Log** under Appearance > Design > Scale in the properties panel. Only positive values can be used for the log scale. Zero or negative values return nothing.

**Setting custom ranges**
You can also specify a range of colors or select from a predefined color scheme.

**Do the following:**

1. Click Appearance > Design in the properties panel.
2. Ensure that the Enable color range is set to On (default).
3. Click the color palette beside From, and choose a color.
4. Click the color palette beside To, and choose a color.

You can set your own color range by clicking the easel symbol in the color palette, and selecting a color. You can also enter a color code string in the field next to the easel symbol. The colors should be valid CSS colors.

**Do the following:**

1. Click Appearance > Design in the properties panel.
2. Move the Enable custom range slide button to the left to turn the option off.
3. Select a color scheme under Scale color.

![Word Cloud Chart](image)

*A word cloud chart displaying food items in different sizes and colors.*
3 Visualizations

Formatting numbers
It is possible to format the measure value. Different formatting can be applied to the same value, for example as money, date, duration. The chart updates to reflect the changed number type.

Do the following:

1. Click Data > Measures in the properties panel and click a measure.
2. Select applicable number formatting form the Number formatting menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto when further configuring the chart.

Limitations
For information about general limitations, see Limitations (page 435).

- The word cloud chart can handle maximum of 100 words per entry.
- Words that take up more space than the chart are not displayed. You can adjust the font size to show more values, but we do not recommend that you use fields with long text values.
- Word cloud charts cannot be used in Qlik NPrinting reports.

3.7 Creating and editing visualizations
You create visualizations from predefined charts, fields, or custom objects. Once added to your sheet, you can edit and refine your visualizations. You must be in Edit mode to be able to add or edit visualizations.

Creating visualizations
You create visualizations by dragging the chosen type of visualization onto the sheet from the assets panel and configuring its properties settings. For instructions on creating specific types of visualizations, see that visualization type in Visualizations (page 129).

Do the following:

1. Drag the visualization from the assets panel onto the sheet, or double-click the visualization.
2. Add dimensions and measures to the visualization.
   You can add dimensions and measures using the buttons on the visualization. Or you can drag a field from the Fields tab of the assets panel, and then select to use it as a dimension or measure. The number of dimensions and measures that are required depends on which visualization you selected.
3. Adjust the presentation: for example sorting, coloring, or labeling.
   For more information, see Changing the appearance of a visualization (page 526).

You can also add a visualization by copying visualizations. This is useful if you want to use existing visualization settings in another visualization type. For more information, see Copying a visualization from an existing visualization (page 519)
3 Visualizations

Custom objects are added in a similar manner. You start creating a visualization by dragging a visualization extension or a widget onto the sheet. For more information, see Creating a visualization using a custom object (page 518).

You can use containers to save space on your dashboard, by quickly switching between tabs with different visualizations.

The types of data you have in your tables and fields impacts whether they can be used as dimensions or measures.

- Dimensions determine how the data in a visualization is grouped. For example: total sales per country or number of products per supplier. For more information, see Dimensions (page 65).
- Measures are calculations used in visualizations, typically represented on the y-axis of a bar chart or a column in a table. Measures are created from an expression composed of aggregation functions, such as Sum or Max, combined with one or several fields. For more information, see Measures (page 68).

Creating visualizations with assistance

Insight Advisor offers two methods for assisted visualization creation.

- You can use Insight Advisor search-based analysis to let generate visualizations based on your searches or selections. You can then choose to add these visualizations to your sheets.
- You can create visualizations using Insight Advisor chart suggestions by dragging a field onto the sheet from the assets panel and then dragging additional fields that you want in the visualization onto the first field. Qlik Sense then creates a suggested visualization based on the fields selected for the visualization. For more information, see Creating visualizations using Insight Advisor chart suggestions (page 508).

Editing visualizations

After creating a visualization, you may want to make adjustments to improve how it conveys information to users. For example, you can change the data used, or adjust the appearance of the visualization. You can add more dimensions or measures for further depth of information, or remove some to improve clarity, and declutter a visualization.

The data in a visualization can be changed. For example, you might correct an invalid dimension or measure, or unlink a measure from a master measure so you can modify it without changing the master measure. For more information, see Changing the data of a visualization (page 521).

The appearance of a visualization can be edited to improve design and enhance understanding. There are a number of different ways you can adjust the appearance of your visualizations:

- Colors: Coloring is one of the best ways to highlight values in your visualizations. Qlik Sense provides a range of different coloring options. For example, you can assign specific colors to the distinct values in a master dimension to ensure that those values use the same colors across all your visualizations. For more information, see Coloring a visualization (page 534).
- Sorting: The sorting of your dimensions and measures helps ensure that content is presented in a logical and understandable manner.
3 Visualizations

For more information, see *Change the sorting of a visualization* (page 531).

- Titles and labels: Titles and labels can be changed for clarity and detail. For example, in a pie chart showing sales by region, you could add an expression providing the total sales sum. For more information, see *Changing the appearance of a visualization* (page 526).
- Presentation: Different visualizations have different options that can be adjusted to enhance the display of data. For example, you can set bars in a bar chart to display as grouped or stacked, as well as vertically or horizontally. For more information, see *Changing the appearance of a visualization* (page 526).

You can convert a visualization into another visualization type, and preserve your settings. For more information, see *Converting a visualization to another kind of visualization* (page 554).

You edit visualization properties in the properties panel.

**Do the following:**

1. Click ✒ Edit sheet in the toolbar.
   The properties panel for the sheet opens to the right. (If it is hidden, click Show properties in the lower right-hand corner.)
2. Click the visualization that you want to edit.
   The properties panel now shows the properties of the visualization.
3. Make your changes in the properties panel.
4. Click ✔ Done editing in the toolbar.

**Best practices for designing visualizations**

**Decluttering your apps**

Too much information in an app makes it difficult to see what is important. Today’s modern user interface style is a cleaner, simpler, flatter style of design. A simplified design subtly guides the reader and allows them to stay focused.

**Less is more**

Users often try to include too much information in one app. Line charts with several measures can be confusing and difficult to interpret. Try creating several smaller visualizations to spread this information out onto the page. It also allows the reader to efficiently compare and contrast visualizations that are side-by-side. You can also use alternative dimensions and measures to allow the reader to quickly switch between measures without overcrowding a visualization. For more information, see *Changing the data of a visualization* (page 521).

There are number of different ways you can improve the aesthetics and functionality of your app. Depending on your audience and what data you want to highlight, the way you design your visualization may have a serious impact on the reader’s interpretation of the data.
Know your limits

Consumers of your visualizations may be working with limited screen space or resolution. Qlik Sense uses responsive design to address these limitations. However, if screen space or resolution is too limited, certain design accommodations are necessary. These can include:

- A subset of data being displayed in bar charts and line charts. When the number of dimension values exceeds the width of the visualization, a mini chart with a scroll bar is displayed.
- Collapsed menus for selecting data filters. When the number of dimension values exceeds the space available for the filter pane, the menu is collapsed. App consumers have to click on the dimension name in the title of the filter pane to open a new pane. They can then make their selections in the new pane. Additionally, when there is limited space, dimension names may appear as ellipses in filter pane titles. App consumers have to click on the ellipses to view the name of the filter pane.
- Truncated names in chart legends. Names that are too long for the space available for dimensions and measures are truncated. An ellipses is added to the end of truncated name. App consumers can hover their mouse pointer over the truncated name to view the complete name.
- Missing legends, labels and titles.

App consumers can expand visualizations to address some of these issues. However, we recommend that you test your apps on devices where the apps may be consumed. You can also use various tools to test, such as responsive design mode in Firefox (Ctrl + Shift + M). If necessary, you can move visualizations to new sheets, reduce the amount of data shown in visualizations, and so on.

Color accessibility

The spectrum of colors is narrower for people who have color-based visual impairment. They may interpret your visualization differently than you intended.

For example, some people see the colors red and green more as yellow or brown. This form of red-green color vision deficiency is the most common. This is worth noting since red often carries a negative connotation in data visualizations, especially in finance.

A red or green KPI status can be confusing. You can use shapes with colors as performance indicators to make your designs more accessible. For example, use a red empty circle to denote bad, a green full circle for good, and a triangle as a warning symbol that only appears when a KPI status is at an unacceptable level.

Lines, bars, and pie slices can be difficult to distinguish when the colors are distorted.

For more information, see Changing the appearance of a visualization (page 526).

Filter and icon placement

Filters and icons are an essential part of data visualization, but it can be difficult to know where to place them or how to sort them. You can often anticipate where the user will begin to read based on a few well-established design principles.

Left placement

Several popular websites use left-side navigation tiles and filters. This is due to the fact that many languages read from left to right. As a result, the left-side of the screen is where these readers look most frequently. Users who are scanning for content tend to gravitate toward the left side of the screen. The farther to the right
objects are, the less users will look at them. If all your filters and icons are stacked vertically on the left, it gives them equal weight.

Alternately, with languages where text is written right to left, the opposite of this is true. This should be kept in mind if your apps are translated into these languages.

Top placement
Another common placement option for icons and filters is along the top of an app. By not placing filters or icons on the left it gives more space for larger visualizations with distracting menus. When filters and icons are placed above visualizations they are also seen as separate from the content below. This can help show the reader that you are prioritizing the filters or icon. If all your filters and icons are side-by-side at the top, the one furthest to the left carries more weight and is prioritized by the reader.

For more information, see *Structuring an app using sheets (page 9).*

Information hierarchy
Sometimes you want your reader to prioritize certain visualizations over others. You can show hierarchy of information by using a few key design best practices. For example, you can use different sizes to emphasize some visualizations. Larger information is seen as more important: by increasing the font or chart size, you can show the reader where to look first.

Page placement also plays a part in information hierarchy. The information at the top of a page is perceived as more important than information at the bottom of the page because it is read first. Information on the first page is perceived as more important than information on the last page.

Adding context to KPIs
KPIs are a great way to communicate some of the big ideas inside your app. However, KPI values do not provide any context to the numbers and calculations that are happening behind the scenes. A green light next to a KPI does not tell the reader if the goal was barely achieved, or if you greatly surpassed it.

To help bring context to your KPIs, include supporting information next to the value in smaller text. For example, you can compare the current KPI value with the value from the previous year. You can also add a small bar chart without axes or values to provide information about the current trend.

For more information, see *KPI properties (page 215).*

Avoid the pitfalls of data visualization
To experience the benefits of data visualization you must avoid the pitfalls. Here are some common ones:

Color abuse
Do not overdo colors. Be aware that the wrong color in the wrong place might cause confusion rather than clarity. Also, the same color may mean different things in different parts of the world.

Misuse of pie charts
Avoid having pie charts side by side to compare. Try not to squeeze too much information into them.
3 Visualizations

Visual clutter
Too much information defeats the purpose of clarity. Use a maximum of nine KPIs, and remove all visual clutter.

Style over substance
A beautiful visualization is not necessarily the most effective. Use design best practices at all times.

Bad data
Spot and correct issues with your data before you present it. Do not let your visualization take the blame for bad information.

Creating visualizations with Insight Advisor
Insight Advisor provides search-based analysis for exploring your data and creating visualizations. Insight Advisor uses the Qlik cognitive engine to create visualizations based on app fields and master items.

Insight Advisor search-based analysis is available from Insights in the Analyze tab. You can also open Insight Advisor when you load data into your app.

**Insights menu option**

You can search Insight Advisor to display visualizations. Insight Advisor creates new Insights charts and displays existing visualizations from your sheets. Insight Advisor can also generate visualizations from your data set without a search query. Insight Advisor can analyze your app data and create charts of potential interest.

Insight Advisor relies on the Qlik cognitive engine and a logical model of your data to create visualizations. The logical model contains the relationships and uses of fields in your data model. By default, Insight Advisor builds a logical model by learning from precedents from the app and published apps with similar data. When **Insights** opens, Insight Advisor examines the app and learns precedents based on how fields and master items are used. Insight Advisor also learns from user interactions with Insights charts. For more information, see Building logical models with precedent-based learning (page 504).

You can also create your own custom logical model for the app. Business logic lets you to define the relationship and use of data in your logical model. When business logic is enabled, precedent-based learning is disabled.

Users can access Insight Advisor in the hub with Insight Advisor Chat.
Navigating Insight Advisor

*Insights* contains options for creating and editing visualizations. Insight Advisor supports keyboard navigation.

*Insight Advisor search-based analysis in an app.*

A: Fields and master items

Insights charts are built using fields 📊 and master items ⚙️. You can select these assets to create a search query.

If the app is published, only master items are available.

B: Insights search field

You can enter your search query here, either by entering asset names or using natural language. If you used a natural language query, you can click 🕵️‍♂️ to view the filters generated from your query.

C: Insights charts

These are the Insights charts created by Insight Advisor. Insight Advisor indicates the number of results and breaks them down into:
3 Visualizations

- How many results are found.
- How many charts already exist in your sheets.
- How many charts are newly generated by Insight Advisor.

Insights charts can be added to existing or new sheets. An Insights chart can also be downloaded as an image, PDF, or as an Excel spreadsheet containing the data used in that chart.

*Using Insights charts (page 503)*

**D: Properties panel**

The properties panel contains options for editing Insights charts and changing the precedents you have set in Insight Advisor.

In **General properties**, you can view and edit your charts and the precedents you have set for generating insights. For more information, see *Managing precedents in General properties (page 504).*

In **Insight properties**, you can edit an Insights chart and view details. You can see the **Analysis type** used to create the chart. Click 🎨 to learn more about the analysis type used. For more information, see *Editing Insights charts in Insight properties (page 503).*

*Searching with Insight Advisor*

When you enter your search query, Qlik Sense generates relevant Insights charts using field names, field values, and master items. You can query Insight Advisor in three ways:

- Entering a natural language query, such as *Show me Product by Revenue in Sweden.*

*Qlik Sense supports English natural language queries.*

> If your Qlik Sense deployment includes access to a SaaS editions of Qlik Sense tenant, administrators can enable additional support for French, Russian, and Spanish. English is used by default for browsers not set to a supported language. The language used for queries can be changed by selecting a new language from the **Language** button. For more information, see *Enabling multi-language natural language queries in Qlik Sense Enterprise on Windows.*

For guidelines on using natural language in your searches, see *Using natural language with Insight Advisor (page 505).*

- Choosing fields and master items to use in the query, either by entering their name or selecting them.
- If your browser's voice-to-text capability is supported in Insight Advisor, clicking the microphone icon to ask Insight Advisor your query.

*Insight Advisor supports Google Chrome voice-to-text capabilities for asking queries.*

Qlik Sense Desktop does not support voice-to-text capabilities for queries.

Google Chrome voice-to-text capabilities are not supported with iOS devices.
Insight Advisor uses the fields or terms you specify. It may use additional fields in the generated visualizations. Insight Advisor uses any precedents you have given it for hiding charts, setting fields as dimensions or measures, or excluding fields from analysis. In Qlik Sense Enterprise, Insight Advisor can use precedents learned from other published apps if they use a similar or identical data model.

For natural language queries, Insight Advisor tries to find a matching Insight chart result. If one is found, it shows related results as well. If no matching results can be found, Insight Advisor shows possibly related results. You can click ☰ to view how Insight Advisor generated results from your search query.

If you receive the following error message: "Unable to generate insights - Please try again later," you might not meet the CPU requirements for Insight Advisor.

Using Insights charts

You can expand a chart by selecting it or clicking ▶️. You can then make selections in it. Selections apply to all Insights charts. Selections made in charts from your sheets are kept when you open Insights. Selections do not affect the charts created by Insight Advisor.

If an Insights chart is new, you can add it to your sheets. If the chart exists in a sheet, you can click the sheet name at the bottom of the chart to go to that sheet.

You can view additional options by clicking ⋆. The following options are available:

- **Full screen**: Expand a chart to make selection.
- **Edit insight properties**: Edit the Insights chart to change dimension, measures, and the chart type. Editing Insights charts in Insight properties (page 503)
- **Add to sheet...**: Add the chart to a new or existing sheet.
- **Download**: Download the insights chart as an image, PDF, or data.
- **Hide**: Hide charts that you do not want Insight Advisor to use again. You can view the charts hidden from your current search query in General properties.

Hide is not available in apps using business logic.

Editing Insights charts in Insight properties

You can edit Insights charts by selecting an Insights chart and clicking 🔎. The following properties are available in Insight properties:

- **Chart type**: Select a different chart type. For an outline of the alternate chart types available for the different analyses, see Insight Advisor analysis types (page 506).
- **Dimensions** and **Measures**: Change the fields used as Dimensions or as Measures. You can change the measure aggregation. You can reorder measures or dimensions by dragging them Dimensions and measures from Insights charts can be added to your master items. Click a dimension or measure and click Add new.
If you specified filters in a natural language query, such as specific field values, you can modify them as well.

- **Details**: View information about why the chart was generated and the precedents Insight Advisor has learned from a chart. By selecting details, you can change or reject them. You can set fields as dimensions or measures or exclude fields from future analysis. You can hide charts from future analysis by selecting **We suggested a chart for this combination of data** and clicking **Hide this chart**.

- **Analysis period**: Change which period from business logic calendar periods is applied to the chart.

  **Analysis period** is only available when business logic is enabled and calendar periods have been created for the app.

Insight Advisor can learn from your preferences for that chart if you add it to a sheet or click **Learn** after editing the chart. Precedents set by a user only apply to that user's instance of Insight Advisor.

### Managing precedents in General properties

In **General properties**, you can view and edit your hidden and learned charts and the precedents you have set for generating Insight Advisor charts.

**General properties** are not available when business logic is enabled.

The following properties are available:

- **Hidden charts** contains charts you have hidden from queries. You can click ![Show chart](https://example.com) to show the chart again in queries.

- **Learned charts** contains charts you selected **Learn** on after editing. You can delete learned charts by clicking ![Delete chart](https://example.com).

- **Your defined preferences** shows all the preferences Insight Advisor has learned. You can delete preferences by clicking ![Delete preference](https://example.com).

You can clear all hidden charts, learned charts, and preferences by clicking **Clear all**.

### Limitations

Insight Advisor has the following limitations:

- In published apps, only master items are available for use in Insight Advisor. Insight Advisor Chat can use fields from published apps when creating Insights charts. If you go to Insight Advisor using from **Explore this further**, your search may not be available.

### Building logical models with precedent-based learning

By default, Insight Advisor uses precedent-based learning to construct the logical model used to interpret data and provide insights.
Insight Advisor can analyze an app to see how fields are used to create charts. The Qlik Precedents Service analyzes apps whenever Insights is opened in the app. The app analysis service examines how data fields and master items are used in charts. It does not examine the data in the fields, however. This teaches precedents for making aggregations, dimensions, and measures from app data. Insight Advisor can use precedents learned from other published apps if they use a similar or identical data model. In unpublished apps, Insight Advisor can use precedents learned from published apps.

App analysis is enabled for all published apps with Insight Advisor. You can disable Insight Advisor in an app if you do not want Insight Advisor to learn precedents from that app.

You can customize the logical model of your app using business logic. When using a customized logical model, precedent-based learning and precedent features of Insight Advisor are disabled.

Disabling Insight Advisor

Do the following:

1. In your app, navigate to App overview.
2. Click 
3. Select Enable Insights in app.

Using natural language with Insight Advisor

Insight Advisor supports natural language searches, such as Show me Product Inventory for Japan under 2500.

Natural language queries support three kinds of filters:

- Time: A unit of time or date. For example, Show me 2019 Sales.
- Category: A value from one of the dimensions. For example, Show me Sales by Product for Sweden.
- Measure: A value or values from a measure. For example, Show me Sales for Sweden by Product under 1K.

You can search for facts, comparisons, and rankings. Facts are statements such as What are my sales, or Show expenses over time for 2019. You can ask for a comparison by adding vs or compare to your query. For example, Compare sales to expenses over time. You can ask for rankings by adding top to your query. For example, Show me top 10 product by sales for 2020.

Qlik Sense supports English natural language queries.

If your Qlik Sense deployment includes access to a SaaS editions of Qlik Sense tenant, administrators can enable additional support for French, Russian, and Spanish. English is used by default for browsers not set to a supported language. The language used for queries can be changed by selecting a new language from the Language button. For more information, see Enabling multi-language natural language queries in Qlik Sense Enterprise on Windows.
Natural language searches need to reference field names and values in your data model. You can also tag master items with synonyms using tags on your master items. Use the format `alt:<term>` in synonym tags. If you wanted to use `cities` as a synonym, you would tag the master item `alt:cities`. For more information, see Tagging master items (page 105).

For more information about natural language queries, see Qlik Sense Natural Language Query features.

### Insight Advisor analysis types

Insight Advisor provides results using a wide range of analysis types. These analysis types provide best practice visualizations when generating insights.

Different analysis types are used depending on the inputs of the query and the characteristics of your data. The Qlik cognitive engine determines the best analysis type for your query depending on the available data. The following table describes the analysis types. Not all conditions for each analysis type are listed. The table also lists charts potentially available as alternatives when editing an Insights chart.

<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Description</th>
<th>Dimensions</th>
<th>Measures</th>
<th>Charts</th>
<th>Alternative charts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fact</strong></td>
<td>Specific aggregated totals.</td>
<td>0</td>
<td>1-2</td>
<td>KPI</td>
<td>None</td>
</tr>
<tr>
<td><strong>Values</strong></td>
<td>List of specified dimensions and measures values as a table.</td>
<td>0-10</td>
<td>0-10</td>
<td>Table</td>
<td>None</td>
</tr>
<tr>
<td><strong>Rank</strong></td>
<td>Ranking of dimension values by a measure, with optional grouping.</td>
<td>1-2</td>
<td>1</td>
<td>Bar chart, Pivot table</td>
<td>Pie chart, Funnel chart, Word cloud, Multi KPI</td>
</tr>
<tr>
<td><strong>Breakdown</strong></td>
<td>Breakdown of a measure by multiple dimensions.</td>
<td>2-3</td>
<td>1</td>
<td>Treemap, Bar chart, Table</td>
<td>Bar chart, Sankey chart, Heatmap, Mekko chart, Distribution plot</td>
</tr>
</tbody>
</table>
## 3 Visualizations

<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Description</th>
<th>Dimensions</th>
<th>Measures</th>
<th>Charts</th>
<th>Alternative charts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map distribution</td>
<td>Breakdown of measures by multiple geographic dimensions.</td>
<td>1-2</td>
<td>1-2</td>
<td>Map</td>
<td>None</td>
</tr>
<tr>
<td>Overview</td>
<td>Overview of a measure by multiple dimensions.</td>
<td>1-2</td>
<td>1</td>
<td>Distribution plot</td>
<td>None</td>
</tr>
<tr>
<td>Contribution</td>
<td>Provides a rank with a cumulative contribution (Pareto chart).</td>
<td>1</td>
<td>1</td>
<td>Combo chart</td>
<td>Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Combo chart</td>
</tr>
<tr>
<td>Year-to-date</td>
<td>Breakdown of a measure (this year from last year) by a dimension.</td>
<td>1</td>
<td>1</td>
<td>Bar chart</td>
<td>Bar chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sankey chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Heatmap</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Mekko chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Distribution plot</td>
</tr>
<tr>
<td>Trend</td>
<td>Performance of a measure over time, optionally broken down by a dimension with low cardinality.</td>
<td>1 date/time dimension and optionally 1 other dimension</td>
<td>1-3</td>
<td>Line chart</td>
<td>Variance waterfall chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Area chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Distribution plot</td>
</tr>
<tr>
<td>Process control chart</td>
<td>Provides an indication of a measures performance over time relative to the mean (sigma).</td>
<td>1 date/time dimension</td>
<td>1</td>
<td>Line chart</td>
<td>None</td>
</tr>
<tr>
<td>Comparison</td>
<td>Compare two measures over a dimension.</td>
<td>1</td>
<td>2</td>
<td>Scatter plot</td>
<td>Multi KPI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Scatter plot</td>
</tr>
<tr>
<td>Correlation</td>
<td>Provides the relative correlation between 2 measures over up to 2 optional dimensions.</td>
<td>0-2</td>
<td>2</td>
<td>KPI Distribution plot</td>
<td>None</td>
</tr>
</tbody>
</table>
## Visualizations

<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Description</th>
<th>Dimensions</th>
<th>Measures</th>
<th>Charts</th>
<th>Alternative charts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster (K-Means)</td>
<td>Provides a comparison between 2 measures over a dimension while clustering the results with KMeans.</td>
<td>1</td>
<td>2</td>
<td>Scatter plot</td>
<td>None</td>
</tr>
</tbody>
</table>

### Creating visualizations using Insight Advisor chart suggestions

Qlik Sense offers a wide range of visualizations to use with your data. Deciding on the correct chart type can be challenging when creating your first Qlik Sense app.

Insight Advisor chart suggestions enable you to select data fields and let Insight Advisor choose the dimensions, measures, and visualization types. As you add or remove fields, the suggested visualization adjusts itself based on your changes. You can customize a suggested visualization with a focused set of properties.

If you started a visualization, enabling **Chart suggestions** will change your visualization to a suggested visualization.

> **Important**: If you enable **Chart suggestions** and then disable them, you will lose changes made to your visualization. You can restore your old visualization by undoing the changes. However, if you navigate away from Sheet view or make changes in the assets panel, you will not be able to undo and restore your visualization.

### Creating a new visualization using chart suggestions

**Do the following:**

1. Click **Edit sheet** in the toolbar.
   The assets panel opens on the left-hand side.
2. From **Fields**, drag and drop a field into your sheet.
   Fields suggested as dimensions are added as tables or histograms. Fields suggested as measures are added as KPIs.
   To add fields as filter panes hold the shift key when you drag and drop the field.
3. Add additional fields by doing one of the following:
   - Drag and drop a field onto the visualization created from the first field, or on **Suggest** on the right-hand side.
     Qlik Sense determines if the field should be used as a dimension or as a measure, and which measure aggregation to use.
   - Click **Add** on the properties panel and select a field.
   - Drag and drop a field on **Drop item here** under **Dimensions** or **Measures**.

---

Create apps and visualizations - Qlik Sense, February 2021
3 Visualizations

The visualization will change as fields are added to it.
4. Optionally, remove unwanted fields.
5. Click Done.

Changing an existing visualization using chart suggestions
You change an existing visualization by adding fields or removing unwanted fields. Enabling Chart suggestions in the properties panel on the right-hand side changes the selected visualization to a chart suggestion based on the fields of the visualization. You can change the suggestions made by Qlik Sense. For example you can:

- Drag fields between Dimensions and Measures to change how a field is used. Moving a field to Dimensions removes its aggregation. Moving a field to Measures assigns it an aggregation.
- Choose a different aggregation for a field used as a measure. Your aggregation choice will be used whenever you use this field as a measure, while Chart suggestions is enabled.
- Use Change chart type to choose a different type of chart from the one suggested.

Adjusting the settings when using chart suggestions
You can adjust the settings in the properties panel for Data and Appearance. The properties panel for visualizations created with chart suggestions contains a focused set of properties settings. Disabling Chart suggestions brings back access to all available properties. For descriptions of the available fields see the visualization properties topics in Visualizations (page 129).

Limitations when using chart suggestions
- You cannot enable Chart suggestions for a master visualization.
- You cannot enable Chart suggestions for filter panes, histograms or maps.
- Charts with Chart suggestions enabled are not supported in Qlik NPrinting reports. To include charts created using chart suggestions in Qlik NPrinting reports, disable Chart suggestions.
- You can only change the aggregation of a measure when its label is the default label.
- You cannot drag a master dimension to Measures. You cannot drag a master measure to Dimensions.
- You can only drag a field from Measures to Dimensions if its expression is simple. For more information on how to use expressions in visualizations see Using expressions in visualizations (page 110).

Guidelines for visualizations, fields, and naming
There are certain conventions and limitations you need to be aware of when working with Qlik Sense. For example: the maximum number of characters to use in names, descriptions, and expressions, as well as characters reserved for use by Qlik Sense only.
Max number of visualizations

The maximum number of visualizations there can be on a sheet is limited to the number of cells on a sheet: 288 (24x12). The maximum practical number will be less than this because of the limited use for visualizations that are made up of only 1 cell.

Upper limits on name lengths

The following limits apply to the number of characters that can be used in various situations in Qlik Sense:

<table>
<thead>
<tr>
<th>Situation</th>
<th>Upper limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names (title, dimension, footnote…)</td>
<td>Max 255 characters.</td>
</tr>
<tr>
<td>Descriptions</td>
<td>Max 512 characters.</td>
</tr>
<tr>
<td>Expressions</td>
<td>Max 64,000 characters.</td>
</tr>
<tr>
<td>Tags</td>
<td>Max 31 characters per tag and max 30 tags per master item.</td>
</tr>
<tr>
<td>Text &amp; image chart:</td>
<td>Max 12,000 characters.</td>
</tr>
</tbody>
</table>

Naming conventions

You can refer to a number of entities by their names in Qlik Sense, such as:

- Fields
- Dimensions
- Measures
- Variables
- Bookmarks

Some characters are reserved for system purposes in Qlik Sense. To avoid potential errors, avoid using the following characters in names:

- :
- =
- [ 
- ]
- {
- }
- $
- 
- '
- ' 
- '

If you use long names for your dimensions and measures they will be displayed truncated. "..." will be shown to denote that part of the name is hidden.
Max number of characters in expressions
The maximum number of characters that can be written in a visualization expression is 64,000. If you attempt to build an expression with more than this number, the expression will be truncated.

Conventions for number and time formats
In many interpretation and formatting functions it is possible to set the format for numbers and dates by using a format code. This topic describes the conventions used to format a number, date, time, or time stamp. These conventions apply both to script and chart functions.

Number formats
To denote a specific number of digits, use the symbol "0" for each digit.
To denote a possible digit to the left of the decimal point, use the symbol ".#".
To mark the position of the thousands separator or the decimal separator, use the applicable thousands separator and the decimal separator.

The format code is used for defining the positions of the separators. It is not possible to set the separator in the format code. Use the DecimalSep and ThousandSep variables for this in the script.

It is possible to use the thousand separator to group digits by any number of positions, for example, a format string of "0000-0000-0000" (thousand separator="") could be used to display a twelve-digit part number as "0012-4567-8912".

Examples:

<table>
<thead>
<tr>
<th>Number format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># ###0</td>
<td>describes the number as an integer with a thousands separator. In this example &quot; &quot; is used as a thousands separator.</td>
</tr>
<tr>
<td>###00</td>
<td>describes the number as an integer without a thousands separator.</td>
</tr>
<tr>
<td>0000</td>
<td>describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.</td>
</tr>
<tr>
<td>0.000</td>
<td>describes the number with three decimals. In this example &quot;.&quot; is used as a decimal separator.</td>
</tr>
</tbody>
</table>

Special number formats
Qlik Sense can interpret and format numbers in any radix between 2 and 36 including binary, octal and hexadecimal. It can also handle roman formats.
## Special number formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary format</td>
<td>To indicate binary format the format code should start with (bin) or (BIN).</td>
</tr>
<tr>
<td>Octal format</td>
<td>To indicate octal format the format code should start with (oct) or (OCT).</td>
</tr>
<tr>
<td>Hexadecimal format</td>
<td>To indicate hexadecimal format the format code should start with (hex) or (HEX). If the capitalized version is used A-F will be used for formatting (for example 14FA). The non-capitalized version will result in formatting with a-f (for example 14fa). Interpretation will work for both variants regardless of the capitalization of the format code.</td>
</tr>
<tr>
<td>Decimal format</td>
<td>The use of (dec) or (DEC) to indicate decimal format is permitted but unnecessary.</td>
</tr>
<tr>
<td>Custom radix format</td>
<td>To indicate a format in any radix between 2 and 36 the format code should start with (rxx) or (Rxx) where xx is the two-digit number denoting the radix to be used. If the capitalized R is used letters in radices above 10 will be capitalized when Qlik Sense is formatting (for example 14FA). The non-capitalized r will result in formatting with non-capital letters (for example 14fa). Interpretation will work for both variants regardless of the capitalization of the format code. Note that (r02) is the equivalent of (bin), (R16) is the equivalent of (HEX), and so on.</td>
</tr>
<tr>
<td>Roman format</td>
<td>To indicate roman numbers the format code should start with (rom) or (ROM). If the capitalized version is used capital letters will be used for formatting (for example MMXVI). The non-capitalized version will result in formatting with lower cap letters (mmxvi). Interpretation will work for both variants regardless of the capitalization of the format code. Roman numbers are generalized with minus sign for negative numbers and 0 for zero. Decimals are ignored with roman formatting.</td>
</tr>
</tbody>
</table>

### Examples:

#### Examples of special number formats

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>num(199, 'bin')</td>
<td>returns 11000111</td>
</tr>
<tr>
<td>num(199, 'oct')</td>
<td>returns 307</td>
</tr>
<tr>
<td>num(199, 'hex')</td>
<td>returns c7</td>
</tr>
<tr>
<td>num(199, 'HEX')</td>
<td>returns C7</td>
</tr>
<tr>
<td>num(199, 'r02')</td>
<td>returns 11000111</td>
</tr>
<tr>
<td>num(199, 'R16')</td>
<td>returns c7</td>
</tr>
<tr>
<td>num(199, 'R36')</td>
<td>returns 5J</td>
</tr>
<tr>
<td>num(199, 'rom')</td>
<td>returns cxcix</td>
</tr>
<tr>
<td>num(199, 'ROM')</td>
<td>returns CXCIX</td>
</tr>
</tbody>
</table>
## Dates

You can use the following symbols to format a date. Arbitrary separators can be used.

### Symbols to format a date

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>To describe the day, use the symbol &quot;D&quot; for each digit.</td>
</tr>
<tr>
<td>M</td>
<td>To describe the month number, use the symbol &quot;M&quot;. Use &quot;M&quot; or &quot;MM&quot; for one or two digits. &quot;MMM&quot; denotes short month name in letters as defined by the operating system or by the override system variable <code>MonthNames</code> in the script. &quot;MMMM&quot; denotes long month name in letters as defined by the operating system or by the override system variable <code>LongMonthNames</code> in the script.</td>
</tr>
<tr>
<td>Y</td>
<td>To describe the year, use the symbol &quot;Y&quot; for each digit.</td>
</tr>
<tr>
<td>W</td>
<td>To describe the weekday, use the symbol &quot;W&quot;. &quot;W&quot; will return the number of the day (for example 0 for Monday) as a single digit. &quot;WW&quot; will return the number with two digits (e.g. 02 for Wednesday). &quot;WWW&quot; will show the short version of the weekday name (for example Mon) as defined by the operating system or by the override system variable <code>DayNames</code> in the script. &quot;WWWW&quot; will show the long version of the weekday name (for example Monday) as defined by the operating system or by the override system variable <code>LongDayNames</code> in the script.</td>
</tr>
</tbody>
</table>

### Examples: (with 31st March 2013 as example date)

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>YY-MM-DD</td>
<td>describes the date as 13-03-31.</td>
</tr>
<tr>
<td>YYYY-MM-DD</td>
<td>describes the date as 2013-03-31.</td>
</tr>
<tr>
<td>YYYY-MM-DD</td>
<td>describes the date as 2013-Mar-31.</td>
</tr>
<tr>
<td>DD MMMM YYYY</td>
<td>describes the date as 31 March 2013.</td>
</tr>
<tr>
<td>M/D/YY</td>
<td>describes the date as 3/31/13.</td>
</tr>
<tr>
<td>W YY-MM-DD</td>
<td>describes the date as 6 13-03-31.</td>
</tr>
<tr>
<td>WWW YY-MM-DD</td>
<td>describes the date as Sat 13-03-31.</td>
</tr>
<tr>
<td>WWWW YY-MM-DD</td>
<td>describes the date as Saturday 13-03-31.</td>
</tr>
</tbody>
</table>
3 Visualizations

Times
You can use the following symbols to format a time. Arbitrary separators can be used.

Symbols to format a time

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>h</td>
<td>To describe the hours, use the symbol &quot;h&quot; for each digit.</td>
</tr>
<tr>
<td>m</td>
<td>To describe the minutes, use the symbol &quot;m&quot; for each digit.</td>
</tr>
<tr>
<td>s</td>
<td>To describe the seconds, use the symbol &quot;s&quot; for each digit.</td>
</tr>
<tr>
<td>f</td>
<td>To describe the fractions of a second, use the symbol &quot;f&quot; for each digit.</td>
</tr>
<tr>
<td>tt</td>
<td>To describe the time in AM/PM format, use the symbol &quot;tt&quot; after the time.</td>
</tr>
</tbody>
</table>

Examples: (with 18.30 as example time):

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>hh:mm</td>
<td>describes the time as 18:30</td>
</tr>
<tr>
<td>hh:mm:ss.ff</td>
<td>describes the time as 18.30.00.00</td>
</tr>
<tr>
<td>hh:mm:tt</td>
<td>describes the time as 06:30:pm</td>
</tr>
</tbody>
</table>

Time stamps
The same notation as that of dates and times above is used in time stamps.

Examples: (with 31th March 2013 18.30 as example time stamp):

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>YY-MM-DD hh:mm</td>
<td>describes the time stamp as 13-03-31 18:30.</td>
</tr>
<tr>
<td>M/D/Y hh.mm.ss.fff</td>
<td>describes the time stamp as 3/31/13 18.30.00.0000.</td>
</tr>
</tbody>
</table>

Using system fields in a visualization
You can use system fields in a visualization. System fields are created by Qlik Sense when the data load script is generated, and include information about the fields and tables in the loaded data. A system field begins with "$", and you need to reference it by typing the field name including the "$" manually. You can use a system field to create a dimension either as a master item or from the properties panel.

Preview of a dimension based on a system field.
A system field added as dimension in the properties panel.

Using alternate states for comparative analysis

If you want to perform comparative analysis you can use alternate states in Qlik Sense. Alternate states allow you to make different selections on the same dimension, and compare the selections in a single visualization or in two or more visualizations side by side.

You can use alternate states in visualizations in two different ways:
3 Visualizations

- Applying a state to the visualization. This connects the selection of the visualization to the selection of the state.
- Using states in the set expression of a measure. This is useful to compare measure values of different states.

Creating alternate states

You can create a new alternate state under **Alternate states** in **Master items**:

1. Select **Create new**.
2. Provide a name for the new state. There are some naming limitations:
   - Do not use $, 0, or 1 as a state name.
   - Do not use a state name starting with $ or __ followed by a number, for example, $3.
   - Do not use a state name already used as a bookmark name.

You have now created a new alternate state that you can use to perform comparative analysis. Typically you would want to create another new state to compare the two states.

Applying alternate states to sheets and visualizations

You can apply a state to a visualization, or a sheet. If you apply a state to a sheet, all visualizations on the sheet inherit the state unless you apply another state to a specific visualization. When you apply a state to a visualization, it reflects the selections made in the state. Any selections you make will be applied to the state and be reflected in other visualizations that have the same state applied.

The easiest way to apply an alternate state is dropping it on a sheet or a visualization, and then selecting **Apply state**.

You can also apply an alternate state with the **State** setting in the property panel:

- For a sheet, you find the setting under **Alternate states**.
- For a visualization, you find the setting under **Appearance > Alternate states**.

You can select:

- Any alternate state defined in **Master items**.
- **<inherited>**, in which case the state defined for the sheet is used.
- **<default state>**, which represents the state where no alternate state is applied.

Using alternate states in visualizations

Besides applying a state to a visualization you can also use alternate states in the set expression of a measure. This is useful when you want to compare measure values for different dimension selections side by side.

You can set the alternate state as an identifier in the set expression. If you want to use the measure $sum(Sales)$ in your visualization, for example a bar chart, with a state called **Group1** you use the following expression as measure:

$\text{Sum}([\text{Group1}]\text{Sales})$
To compare with a different state called Group2, you can create another measure with the expression Sum((Group2)Sales).

The bar chart will now show sales for the selection in Group1 side by side with sales for Group2.

### Getting information about the selection of an alternate state

You can see the selections of different states in the selections bar.

You may also want to be able to use information about which, and how many selections are made in an alternate state in labels or titles of visualizations. You can use the following chart functions with the state_name parameter to return selections associated with the specified state name:

- `GetCurrentSelections()` to return all current selections.
- `GetFieldSelections()` to return current selections of a field.
- `GetSelectedCount()` to return the number of selected values in a field.

### Expanding variables in alternate states

You can specify which state to use when expanding a variable. Changes in a specific state do not affect variable values that are expanded in another state. If you do not specify a state, the variable is expanded in the default state.

#### Example:

If you have a state named MyState, and a variable named vMyVar:

- `${vMyVar}` expands the variable in the default state.
- `(${MyState} vMyVar)` expands the variable in the MyState state.

### Limitations

It is not possible to add visualizations to master items if you have set the state of the visualization to any other value than `<inherited>`.

### Comparative analysis example

In this example we want to be able to compare the sales numbers of product lines for different selections of sales regions. We want to select the regions we compare dynamically, either as single regions or a combination of regions.

### Dataset and app

If you want to follow this example, you need to download the Qlik Sense Tutorial - Building an App to get the dataset. If you have completed the tutorial you can use the app you created. Otherwise you need to create an app, add all six data files in the Tutorials source folder, and associate them using automatic recommendations in the data manager.

### Create alternate states

For this example we need two alternate states. In Master items > Alternate states:

---

Create apps and visualizations - Qlik Sense, February 2021
1. Create a new state called Group 1.
2. Create a new state called Group 2.

You have now created the two alternate states we need in this example.

Create filter panes for selection
1. Add a filter pane with the field Region.
2. Edit the label of the filter pane to say =StateName(). This is to make it easier to tell them apart, as the state is not indicated in the filter pane. The StateName() function returns the state that is applied to the function.
3. Drop the state Group 1 on the filter pane and select Apply state.
4. Add another filter pane with the field Region.
5. Edit the label of the second filter pane to say =StateName().
6. Drop the state Group 2 on the second filter pane and select Apply state.

You have now created the two filter panes that are used to control the selections of each of the two states. When you make a selection in the Group 1 filter pane, the same selection is applied to the state Group 1 which is reflected in all visualizations connected to that state.

Create a bar chart for analysis
1. Create a master item measure with name Group1Sales.
   Set Expression to sum({[Group 1]}[Sales]).
   This expression sums the sales for all selections in the Group 1 state.
   Set Label expression to 'Sales &GetCurrentSelections(chr(13)&chr(10), '=' , ',' ,9,'Group 1').
   We use a label expression to be able to show the current selection of the state as a label in the chart, instead of the default label.
2. Create another master item measure with name Group2Sales.
   Set Expression to sum({[Group 2]}[Sales]).
   Set Label expression to 'Sales &GetCurrentSelections(chr(13)&chr(10), '=' , ',' ,9,'Group 2').
3. Add a bar chart to the sheet.
4. Set the Product Line field as dimension.
5. Add the measures Group1Sales and Group2Sales.

You have now created a bar chart that shows the sales by product line for the two groups of regions selected in the filter panes. When you make a new selection in one of the filter panes, the corresponding measure value changes according to the new selection.

Discovery
You can now make selections in Group 1 and Group 2, and see the results of the selected combinations of regions in the bar chart.

Creating a visualization using a custom object
You can enhance your apps with custom-objects.

Custom objects that are available are:
3 Visualizations

- visualization extensions
- widgets
- object bundles supplied by Qlik:
  - Dashboard bundle (page 418)
  - Visualization bundle (page 434)

You can find custom objects in the assets panel under Custom objects when you are editing a sheet.

You can build your own visualization extensions and widgets in the Dev Hub.

For the Dev Hub, see Dev Hub.

Adding a custom object to the sheet

You start creating a visualization by dragging a visualization extension or a widget onto a sheet.

Do the following:

1. Click Edit sheet in the toolbar.
2. Click in the panel on the left-hand side to expand custom objects.
3. Drag a visualization extension or a widget onto the sheet.
   You can drop it in an empty location on the sheet, split the area of an existing visualization into two, or replace an existing visualization.

   If you double-click a custom object, it is added to the sheet immediately.

4. Change the required settings for the custom object in the properties panel. The required settings are defined by the extension developer, this can be dimensions, measures, or other settings.

You now have a complete visualization that you can start using while exploring the data in the app.

Copying a visualization from an existing visualization

You can copy a visualization:

- Within the same sheet
- Between sheets in the same app
- Between sheets belonging to different apps.

For a copied visualization to work in a different app, the same dimensions and measures have to be a part of the target app as well.

Do the following:

1. While editing a sheet, click on the item you want to copy.
   The item is highlighted.
2. On the edit bar, click 📚.
3. To insert the item on another sheet, navigate to the sheet via the sheet navigator.
4. Click 📚 to paste the item.

The copied item is added to the sheet.

### Creating time-aware charts

Time-aware charts are visualizations that use a continuous scale to provide a complete and accurate view of time-based data. That is, when you enable continuous scaling on the x-axis in a chart with date fields, data points are separated from each other by a distance relative to their associated time. As well, the axis labels are evenly separated whether or not there is data for that point and the chart view is compressed to avoid scrolling.

**Continuous scale is supported for line charts, bar charts, and combo charts.**

A continuous scale is most commonly used with date fields such as:

- Second
- Minute
- Hour
- Week
- Month
- YearMonth
- Quarter
- YearQuarter
- Year
- Date
- Timestamp
Adding a continuous scale

Do the following:

1. In sheet view, click Edit sheet in the toolbar.
2. Click the line chart that you want to edit.
3. In the properties panel, click the Appearance tab.
4. In the X-axis section, check Use continuous scale. The chart is compressed and the data points and labels are readjusted.

Making selections in a time-aware chart

When navigating a time-aware chart, you can zoom into a smaller time span to take snapshots of the data displayed and select data values. Selections made on a time axis using range selection select all data values (even those that are not visible). Selections made on the measure axis or using lasso selections only select visible values.

Changing the data of a visualization

The data displayed within a visualization can be changed after the visualization is created.

For example, you may want to add additional dimensions or measures to a chart to add depth to the existing data. Alternatively, you may need to correct an invalid dimension or measure.

Adding dimensions and measures to a visualization

You can add multiple dimensions and measures to a visualization to add depth to the data displayed.

Addition dimensions and measures enabled you to view more information in a single visualization. For example, the image below contains a visualization with the measure Sales and a dimension Month.

*Line chart with the measure Sales.*
You can add a second measure, *Gross Sales*. The example line chart now gives use more context by enabling a comparison of *Gross Sales* to *Sales*.

*Line chart with the measures Sales and Gross Sales.*

**Do the following:**

1. In the properties panel, click the **Data** tab.  
   The **Data** tab is expanded.
2. In the **Dimensions** or **Measures** section, click **Add** to add a dimension or measure.
A dialog with a text box opens. Below the text box all available dimensions or measures are listed, grouped into Dimensions or Measures (that is master items) and Fields.

3. Start typing in the text box.
A list of matching fields and dimensions or measures is displayed.

You can also create a dimension by entering an expression directly in the text box, or by clicking \( \text{\texttt{\textbf{fx}}} \) to create a dimension in the expression editor.

If no measure is displayed, you need to create one. You can enter an expression directly in the text box, or you can click \( \text{\texttt{\textbf{fx}}} \) to create a measure in the expression editor.

4. Select the dimension or measure that you want to use.

The dimension or measure is added to the visualization. The new dimension or measure settings are shown in the properties panel.

Adding alternative dimensions and measures to a visualization

Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration. You can toggle which of your dimensions and measure are displayed using the exploration menu of a visualization.

You can add alternative dimensions and measure to all chart types but changing alternative dimension and measures in the visualization can only be done in bar, line and combo charts. Only alternative dimensions can be changed in the pie charts visualization and only alternative measures in scatter plots.

Alternative dimensions and measures enable you to conserve space on your sheets. Rather than make multiple similar visualizations of the same type, you can use alternative dimensions and measure with a single visualization. You can then switch between the displayed dimensions and measures. For example, if you wanted to see total sales by product category and total sales by product subcategory, you could add product category as a dimension and product subcategory as an alternate dimension in the same visualization.

Alternative dimensions and measure enable you to have more dimensions and measures associated to a visualization that the display limit. Many visualizations have limitations on how many dimensions and measures that can be displayed at the same time. A line chart with two or more measures can only have one dimension, and a line chart with two dimensions can only have one measure. Alternative dimensions and measures enable you to exceed that limit.

Alternative dimensions and measures can be added like normal dimensions and measures in the properties pane. You can also drag dimensions and measures in the Data section of the properties panel into the Alternative dimensions or Alternative measures section.
3 Visualizations

Do the following:

1. In the properties panel, click the Data tab. The Data tab is expanded.
2. In the Dimensions or Measures section, click Add alternative. A dialog with a text box opens. Below the text box all available dimensions or measures are listed, grouped into Dimensions or Measures (that is master items) and Fields.
3. Start typing in the text box. A list of matching fields and dimensions or measures is displayed.

   You can also create a dimension by entering an expression directly in the text box, or by clicking $\mathbf{fx}$ to create a dimension in the expression editor.

   If no measure is displayed, you need to create one. You can enter an expression directly in the text box, or you can click $\mathbf{fx}$ to create a measure in the expression editor.

4. Select the dimension or measure that you want to use.

The alternate dimension or measure is added to the visualization.

Editing data in a visualization

You can edit and adjust the data in a visualization. You may need to edit an existing dimension or measure to adjust it to create a stronger visualization or correct an invalid dimension or measure. You may also want to edit a master item in a visualization to change the master item across all visualizations.

Invalid dimensions and measures

Dimensions and measures are invalid when the associated expression cannot be interpreted by Qlik Sense.

If you create an invalid dimension or edit an existing one so that it becomes invalid, the dimension is presented in the properties panel as dimmed with a red hue and the text Invalid dimension to indicate that the dimension is invalid. If you use an invalid dimension in a visualization, the visualization cannot be displayed.

If you create an invalid measure or edit an existing one so that it becomes invalid, the Expression text box under Measures in the properties panel is presented with a red border to indicate that the measure is invalid.

Editing a dimension

You can edit dimensions in the properties panel. If you want to edit a master item, you must first unlink the dimension from the master item. In the properties panel, click the dimension that you want to edit. Dimensions have the following properties:

- **Field**: Start typing the field name to display a list of matching fields to choose from. You can also click $\mathbf{fx}$ to open the expression editor, where you can create a calculated dimension.
• **Label**: Enter a name for the dimension.

• **Include null values**: When this is checked, the visualization will include the null values of the dimension, presented as a gap or a dash, depending on the type of visualization. For example, if you have sales figures but do not have any information about what company the figures belong to, the figures will be added to the measure value for the null value dimension.

• **Limitation**: You can limit the number of dimension values that are displayed.

• **Show others**: When you have set a limitation for the number of dimension values displayed, you have an option to summarize the measure values for the remaining dimensions by selecting **Show others**.

**Editing a measure**

You can edit measures in the properties panel. If you want to edit a master item, you must first unlink the measure from the master item. In the properties panel, click the measure that you want to edit. Measures have the following properties:

• **Expression**: Enter the expression. You can also click \( \text{fx} \) to open and use the expression editor.

• **Label**: Enter a name for the measure. The label is not automatically updated when you make changes in **Expression**.

• **Number formatting**: Set the number formatting for the measure values. The options **Number** and **Date** offer custom formatting options for defining your own format pattern.

**Editing master items**

Dimensions and measures that are linked to a master item are displayed with a \( \mathcal{M} \) in the properties panel. If you want to edit a linked dimension or measure, you have two options: either updating the master item in the assets panel, or unlinking the item and making the changes in the properties panel. An update of the master item is reflected in all linked items.

Even if linked items cannot be edited in the properties panel, you still have a few settings that can be edited. These are related to the presentation of the items.

A visualization that is linked to a master item is displayed with a \( \mathcal{M} \) on the sheet. You can edit a linked visualization, either by editing the master item or by unlinking the visualization. The unlinked visualization is independent of the master item and can be edited, but it can still contain dimensions or measures that are linked to master items.

**Deleting dimensions and measures**

In the properties panel, you can delete a dimension or measure. Long-touch or right-click the dimension or measure and select **Delete** in the dialog. Alternatively, click the dimension or measure and click **Delete**. If you delete an instance of a master item, the master item is still available in the assets panel.

You can undo a deletion by clicking \( \text{undo} \). Changing which sheet you are viewing will prevent you from undoing your deletion.
Unlinking from a master item
If you want to make changes to a dimension or measure that is linked to a master dimension or master measure, you must first unlink it from the master item. The dimension or measure in your visualization is then independent with no connection to the master item in the assets panel.

Unlinking from the properties panel
A linked dimension or measure that is used in a visualization can be unlinked from the properties panel.

Do the following:
1. Click Edit sheet. The properties panel opens on the right-hand side.
2. Select the visualization on the sheet. The properties for the selected visualization are displayed in the properties panel.
3. Under Data, locate and click the dimension or measure. A linked dimension or measure is indicated by the symbol \( \bigcirc \). 
4. Click \( \bigcirc \). A dialog is displayed that you are about to unlink from a master item.
5. Click OK. The dimension or measure used in the visualization can now be edited and the changes will not affect any other dimensions or measures.

\[\text{You can only unlink from a single dimension, not to a drill-down dimension.}\]

Changing the appearance of a visualization
The Appearance section in the properties panel offers several options to set and modify the appearance of a visualization.

Many of the settings have Auto options that support an optimal presentation of the visualization, taking into account the number of dimensions and measures and the type of data used. Normally, you do not need to change these settings, unless you have a special reason for doing so, for example, when space is very limited.

Appearance can be affected by the sorting of the dimensions and measures.

General
Show titles: On by default in all visualizations except filter panes and text & image visualizations. Filter panes have the name of each dimension, and in most cases do not need any additional title. The text & image visualization includes an editing toolbar with many options to format the text, and therefore the title field can be used for other purposes.
**Title, Subtitle, and Footnote:** Apart from the obvious use of title, subtitle, and footnote as text fields, you can use these fields to also display an expression, which provides additional information that complements the measure in the visualization. You could, for example, show the totals in the title field, so that the totals of the selected values are always available.

**Example:**

In the following image, the total sales are calculated and used in the title. When a selection is made, the total sales are updated accordingly.

![Total Sales: $104.9M](image)

The following string was used to add the *Total Sales* expression to the field **Title**:

`'=Total Sales: $'& Round(Sum(Sales)/1000000, 0.1) & 'M'.`

Because the title field is primarily a text field, it is necessary to start the string with an equals sign (=), to signify that the strings contains an expression.

Because 'Total Sales: $' is a text string when it is used in an expression, the string must be surrounded by single quotation marks.

`&` is used to concatenate the string and the expression.

`Round(Sum(Sales)/1000000, 0.1)` is the expression. The aggregation `Sum(Sales)` is divided by 1000000 and the function `Round(x, 0.1)` reduces the number of decimals to one.

`& 'M'`, finally, concatenates the expression with the unit M for million.

For the title there are three options for adding an expression:
3  Visualizations

- Directly in the title field of a visualization. Start the string with an equals sign (=).
- Directly in the box Title under Appearance in the properties panel. Start the string with an equals sign (=).
- Through the expression editor in the box Title. Click \( \text{fx} \) to open the expression editor. No equals sign is needed.

For the subtitle and footnote only the last two options are available.

**Show details:** Hide by default. When set to Show, users can click \( \text{1} \) when analyzing to view details such as descriptions measures and dimensions.

**Presentation**

Many of the presentation settings only apply to a certain visualization.

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Set the bars to be displayed grouped or stacked, vertically or horizontally.</td>
</tr>
<tr>
<td>Box plot</td>
<td>Select to show whisker ticks and grid lines. You can show the visualization vertically or horizontally.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>Select to show point, background or both. You can show the visualization vertically or horizontally.</td>
</tr>
<tr>
<td>Gauge</td>
<td>Set the gauge to be displayed as a radial or a bar. You can set range limits and use segments with limits.</td>
</tr>
<tr>
<td>Histogram</td>
<td>Select to show grid lines.</td>
</tr>
<tr>
<td>Line chart</td>
<td>Set the line chart to be displayed as a line or an area.</td>
</tr>
<tr>
<td>Pie chart</td>
<td>Set the pie chart to be displayed as a pie or a donut.</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>Turn on/off navigation. Set the size of the bubbles in a scatter plot. Set the compression resolution for large data sets in scatter plot.</td>
</tr>
<tr>
<td>Table</td>
<td>Set the totals to be displayed at the top, bottom, or not at all.</td>
</tr>
<tr>
<td>Treemap</td>
<td>Set the headers, labels, overlay labels, and leaf values. Select to show the data values.</td>
</tr>
</tbody>
</table>

**Example:**

A bar chart with two dimensions is by default presented with the bars grouped.
Let us assume that you want to compare the total monthly quantity for these years. Then it would be a good idea to switch to a stacked bar chart.

In the properties panel, under **Appearance > Presentation** there is an option **Stacked**.

With stacked bars it is easier to compare the quantity between different months.

Now it is quite easy to compare the quantities per month. There is a legend to display the years.

Under **Colors and legend. Show legend** is set to **Auto**, which means that the legend is displayed when there is enough space. In the properties panel, you can also set where to display the legend and whether to display the legend title.

*There is only data for the first half of 2013 (red bars).*
Colors and legend

The Colors and legend section of the properties panel sets your color and legend options. Qlik Sense automatically colors visualizations as they are added to your sheets. As a best practice, it is recommended to add or change colors only when it serves as purpose in the visualization. Too many colors or indistinct color choices can make visualizations less clear.

You can manually set the colors and legends by deselecting the Auto option and selecting your color preferences. Qlik Sense enables you to color your visualizations by:

- Single color
- Multiple colors
- Dimension
- Measure
- Master items
- Expression

For more information on different visualization coloring options, see Coloring a visualization (page 534). For examples of each of these methods of coloring visualizations and the settings used can be found, see Example 1: Coloring by a dimension in the visualization (page 550).

X-axis and Y-axis

For both the y-axis and the y-axis, you have options for deciding what combination of labels and title to display, as well as their orientation and position. Sometimes it may feel unnecessary to have labels and/or title, because the visualization is self-explanatory and then it would be good to be able to hide them. Furthermore, when you create a visualization that is very small, for example, three by three squares, the labels are automatically hidden.
Range: The measure axis (usually the y-axis) has an option to set the range of the axis. By default, the range is adjusted according to the highest positive or the lowest negative measure value, but if, for example, a single measure value is much larger than all the other values, you may want to set a range that is suitable for the lower values. In the properties panel, under Appearance > Y-axis <measure name>, there is a button for Range, which is set to Auto. Click the button to switch to Custom. Now you can set the range for Max, Min, or both. In a bar chart, the bars that are out of the range are cut diagonally to indicate that they are out range. In a line chart, only the parts that are within the range are visible.

Change the sorting of a visualization
You can change the sorting order of dimensions and measures so that your data is presented in the way you intend.

Most visualizations have a Sorting section in the properties panel where you can put the cursor on the drag bars and drag the dimension or measure to rearrange the sorting order. In visualizations without a sorting section, you can still adjust the sorting to some extent.

In the following screenshot, the primary sorting is on the measure Gross Sales.

A bar chart with that sorting order will look as follows.

Since there are two measures, Gross Sales and Sales, the bars are by default grouped. Gross Sales is presented first, because it has sorting priority 1. If you were to drag Sales to the top of Sorting, the first bar would be Sales and the second bar Gross Sales.
To sort by Year, instead, you need to drag Year to the top in **Sorting**. The bar chart is then updated and sorted by Year.

In bar charts with multiple dimensions, sorting is locked to the first dimension. This dimension is what groups and stacks are based on, and sorting on a different dimension or a measure would break up these groups in an undesirable way. If you still want to sort by the measure value, try using the option **Sort by expression** on the first dimension under **Sorting**.

**Sorting in the dimensions and measures sections**

Although it is primarily under **Sorting** that you set the sorting order, you can also adjust the order in the properties panel section **Data** under **Dimensions** and **Measures**. In **Dimensions**, you can change the priority order between the different dimensions by dragging them, and, likewise, in **Measures**, you can drag the measures to change the sorting order. Put the cursor on the drag bars and drag the dimension or measure to rearrange the order. Changes are reflected in the visualization.

**Internal sorting**

Apart from setting the sorting order between dimensions and measures, you can also set the internal sorting order, under **Sorting**.

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following table shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

**Sorting options:**

- Sort by expression (Enter an expression to sort by. Only available for dimensions.)
- Sort numerically
- Sort alphabetically

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.
If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

Default sorting
By default, the dimensions and measures are sorted in the order they were added, with the most recently added item last. Each dimension is sorted internally in the most common way for that type of data. Numbers are sorted numerically, ascending. Text is sorted alphabetically, ascending.

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>By default, a bar chart with one measure and one dimension is presented with vertical bars sorted descending on the measure. When a dimension has less than 10 values, the sorting is by dimension, alphabetically.</td>
</tr>
<tr>
<td>Box plot</td>
<td>By default, a box plot is sorted by the center line. You can also sort by first whisker, box start, box end or last whisker.</td>
</tr>
<tr>
<td>Combo chart</td>
<td>Sorted by the first item added, either the dimension or the measure.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>By default, a distribution plot is sorted by the outer dimension.</td>
</tr>
<tr>
<td>Filter pane</td>
<td>By default, data in filter panes is presented ascending.</td>
</tr>
<tr>
<td>Gauge</td>
<td>A gauge only uses a single measure value, the first one under Measures.</td>
</tr>
<tr>
<td>Histogram</td>
<td>The histogram does not have any sorting section.</td>
</tr>
<tr>
<td>KPI</td>
<td>By default, the first added measure becomes the main value.</td>
</tr>
<tr>
<td>Line chart</td>
<td>By default, a line chart is sorted by the dimension.</td>
</tr>
<tr>
<td>Map</td>
<td>A map layer can only have one dimension. Sorting is used to determine the order points or areas are added to the map.</td>
</tr>
<tr>
<td>Pie chart</td>
<td>A pie chart uses one measure and one dimension. By default, a pie chart is sorted by the measure in descending order.</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>The scatter plot does not have any sorting section, but the order of the measures decides where they are used. The first measure is used on the x-axis, the second measure is used on the y-axis, and the third (optional) measure is used for the bubble size (it is used to set the color on large data sets) in the scatter plot. You can only have one dimension in a scatter plot.</td>
</tr>
</tbody>
</table>
3 Visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>By default, the column presents the dimensions and measures in the order they were added. Sorting order of rows: By default, the table is sorted in ascending order by the first dimension or measure under <strong>Sorting</strong>. You can temporarily change the sorting by clicking the header of the row you want to sort on. One click - ascending order, two clicks - descending order.</td>
</tr>
<tr>
<td>Text &amp; image</td>
<td>The text &amp; image visualization does not have any sorting section, but you can drag the measure tokens in the visualization to change the order.</td>
</tr>
<tr>
<td>Treemap</td>
<td>The treemap does not have any sorting section. The sorting is automatically by measure size.</td>
</tr>
</tbody>
</table>

**Coloring a visualization**

Qlik Sense automatically colors visualizations as they are added to your sheets. You can manually set the colors in your visualizations to meet your requirements or preferences.

Color options for most visualizations are set in the properties panel, in **Appearance > Colors and legend**. By selecting **Custom**, you can manually apply colors to your visualizations using the following methods:

- Color by single color
- Color by multiple colors
- Color by dimension
  Dimension fields can also be dragged and dropped from the assets panel onto a visualization to color the visualization by dimension (if supported by the visualization type).
- Color by measure
  Measure fields can also be dragged and dropped from the assets panel onto a visualization to color the visualization by measure (if supported by the visualization type).
- Color by expression

Tables and pivot tables can only be colored by expression. Options for coloring tables and pivot tables are found in the properties panel in **Data**.

If you want to keep colors consistent for dimensions or measures between different visualizations, you can assign specific colors to master items in your library. Most visualizations will use any colors assigned to master items automatically. In cases where a visualization uses both a master dimension and a master measure with assigned colors, the color assigned to the master dimension is used by default. You can select which master item color to use or disable master item colors entirely.

For more information, see **Assigning colors to master items (page 98)**.

You can also assign colors to individual master dimension values to ensure the colors of different values are consistent across visualizations.

For more information, see **Assigning colors to master dimension values (page 101)**.
To keep visualizations clear when you manually set colors, you should select colors for accessibility and only use different colors when they serve a purpose.

Color by single color
When you color by single color, one color is used for all objects in the chart. Coloring by a single color is best used for visualizations, such as bar or line charts, with a single dimension and measure.

If you have a master dimension or master measure that has a color assigned to it, you can color the visualization by that single color. In cases where a visualization uses both a master dimension and a master measure with assigned colors, the color assigned to the master dimension is used by default. You can select which master item color to use or disable master item colors entirely.

The following options are available when **Single color** is selected from **Colors in Appearance > Colors and legend**:

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use library colors</td>
<td>Select to use master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization. This option is available when a master dimension or master measure used in the visualization has a color assigned to it.</td>
</tr>
<tr>
<td>Color</td>
<td>Select a color using the color picker. You can select a color from the default palette, enter a hex value for a color, or select a color from a color wheel.</td>
</tr>
</tbody>
</table>

Color by multiple colors
When you have multiple measures in a visualization, you can select **Multicolor** to color each measure with a different color. Qlik Sense offers a 12 color and a 100 color palette to apply to the visualization. By default, **12 colors** is selected as the color scheme dimensions.

If you are using master measures in your visualization, you can also choose to use them in your visualization. When a visualization is colored by master measures, master measures will use their assigned colors and any other measures are assigned colors from the **12 colors** scheme.

The following options are available when **Multicolor** is selected from **Colors in Appearance > Colors and legend**:
3 Visualizations

Options for color by multiple colors

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use library colors</td>
<td>Select to use master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization. This option is available when a master dimension or master measure used in the visualization has a color assigned to it.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>Select the color scheme used in the visualization. The following schemes are available:</td>
</tr>
<tr>
<td></td>
<td>12 colors: The colors are reused when there are more than 12 values. The 12 colors in this color scheme can all be distinguished by people with a color vision deficiency.</td>
</tr>
<tr>
<td></td>
<td>100 colors: The colors are reused when there are more than 100 values. Not all of the 100 colors can be distinguished by people with a color vision deficiency.</td>
</tr>
</tbody>
</table>

Color by dimension

When you color a visualization by a dimension, all values in the visualization are colored by the corresponding values in the dimension field selected. By default, the visualization is colored by the primary dimension of the visualization, but you can select other dimensions. Qlik Sense offers a 12 color and a 100 color palette. By default, **12 colors** is set as the palette for color by dimensions.

If you are using a master dimension, you can color the visualization using the colors assigned to the distinct values of that dimension.

Coloring by dimension is useful when you want to keep track of related information in your visualizations, such as coloring multiple charts by the dimension of *Region* to clearly see the values related to each region in each chart.

The following options are available when **By dimension** is selected from **Colors** in **Appearance > Colors and legend**:

Options for color by dimension

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Dimension</td>
<td>Select the dimension used to color this visualization with this field. By default, if you have already selected a dimension for the visualization, it is set with that dimension. Click ▼ to select a different dimension. You can enter an expression by clicking ▶ to open the expression editor</td>
</tr>
<tr>
<td>Persistent colors</td>
<td>When selected, colors persist between selection states. If cleared, colors will be changed and reassigned for different dimension values as selections are made in the visualization.</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color scheme</strong></td>
<td>Select the color scheme used in the visualization. The following schemes are available:</td>
</tr>
<tr>
<td><strong>12 colors</strong>:</td>
<td>The colors are reused when there are more than 12 values. The 12 colors in this color scheme can all be distinguished by people with color vision deficiency.</td>
</tr>
<tr>
<td><strong>100 colors</strong>:</td>
<td>The colors are reused when there are more than 100 values. Not all of the 100 colors can be distinguished by people with color vision deficiency.</td>
</tr>
<tr>
<td><strong>Library colors</strong></td>
<td>Select to use master dimension color values.</td>
</tr>
<tr>
<td></td>
<td>This option is available when a master dimension is used in the visualization.</td>
</tr>
</tbody>
</table>

**Color by measure**

When you color a visualization by a measure, all values in the visualization are colored by a gradient or class based on the values in the selected measure. By default, the visualization is colored by the primary measure of the visualization, but you can select another measure. There are four available color schemes.

Coloring by measure is useful when you want to clearly see objects colored by their corresponding measure value.

The following options are available when **By measure** is selected from Colors in Appearance > Colors and legend:

#### Options for color by measure

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Measure</strong></td>
<td>Select the measure used to color this visualization. By default, if a measure has been added to the visualization, that measure is selected. Click ▼ to select a measure. You can enter an expression by clicking 📊 to open the expression editor</td>
</tr>
<tr>
<td><strong>Color scheme</strong></td>
<td>Select the color scheme used in the visualization. The following schemes are available:</td>
</tr>
<tr>
<td><strong>Sequential gradient</strong>:</td>
<td>The transition between the different color groups is made using different shades of colors. High measure values have darker hues.</td>
</tr>
<tr>
<td><strong>Sequential classes</strong>:</td>
<td>The transition between the different color groups is made using distinctly different colors.</td>
</tr>
<tr>
<td><strong>Diverging gradient</strong>:</td>
<td>Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a map. Low and high values have dark colors, mid-range colors are light.</td>
</tr>
<tr>
<td><strong>Diverging classes</strong>:</td>
<td>Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.</td>
</tr>
</tbody>
</table>
### Visualizations

<table>
<thead>
<tr>
<th>UI Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reverse colors</strong></td>
<td>Select this option to switch which colors are used for low values and which colors are used for high values in the selected color scheme.</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>Set the measure value ranges used to color the visualization. When set to <strong>Auto</strong>, Qlik Sense creates ranges based on the detected minimum and maximum values. When set to <strong>Custom</strong>, Qlik Sense automatically creates ranges based on user-defined minimum and maximum values. You must enter values or expressions that calculate those values in the fields <strong>Min</strong> and <strong>Max</strong>. You can enter an expression by clicking $\text{fx}$ to open the expression editor.</td>
</tr>
</tbody>
</table>

**Color by expression**

Coloring by expression applies colors to a visualization based on a user-defined expression. This enables you to use expressions to define both the colors used and the values upon which the colors are applied in a visualization. You could, for example, use an expression to set conditional colors in a chart.

The following options are available when **By expression** is selected from **Colors in Appearance > Colors and legend**:

<table>
<thead>
<tr>
<th>UI Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expression</strong></td>
<td>Enter an expression by clicking $\text{fx}$ to open the expression editor. For more information, see <em>Examples (page 541)</em>.</td>
</tr>
<tr>
<td><strong>The expression is a color code</strong></td>
<td>Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients.</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>Enter the label to appear for the legend. <strong>This expression is a color code</strong> must be cleared.</td>
</tr>
</tbody>
</table>

Create apps and visualizations - Qlik Sense, February 2021
### Visualizations

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color scheme</td>
<td>Color scheme sets the colors used in the visualization. The following color schemes are available:</td>
</tr>
<tr>
<td></td>
<td><strong>Sequential gradient:</strong> The transition between the different color groups is made using different shades of colors. High measure values have darker hues.</td>
</tr>
<tr>
<td></td>
<td><strong>Sequential classes:</strong> The transition between the different color groups is made using distinctly different colors.</td>
</tr>
<tr>
<td></td>
<td><strong>Diverging gradient:</strong> Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a map. Low and high values have dark colors, mid-range colors are light.</td>
</tr>
<tr>
<td></td>
<td><strong>Diverging classes:</strong> Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.</td>
</tr>
<tr>
<td>Reverse colors</td>
<td>When selected, the color scheme is reversed.</td>
</tr>
<tr>
<td>Range</td>
<td>This setting sets the value ranges for coloring results in the visualization.</td>
</tr>
<tr>
<td></td>
<td><strong>Auto:</strong> Qlik Sense creates ranges based on the detected minimum and maximum values.</td>
</tr>
<tr>
<td></td>
<td><strong>Custom:</strong> Qlik Sense automatically creates ranges based on user-defined minimum and maximum values. You must enter values or expressions that calculate those values in the fields Min and Max. You can enter an expression by clicking ( \text{\textdollar} ) to open the expression editor</td>
</tr>
<tr>
<td></td>
<td>This expression is a color code must be cleared.</td>
</tr>
</tbody>
</table>

**Color by expression in table visualizations**

Expressions can be used to color table and pivot table backgrounds and text. This enables you to use expressions to define both the colors used and the conditional values upon which the colors are applied in a visualization. You could, for example, use expressions to change text and background colors depending on the values within different table cells.

The following options are available in **Data** for coloring table and pivot table visualizations:
## 3 Visualizations

### Options for coloring table and pivot table visualizations

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background color expression</td>
<td>Enter an expression by clicking $\text{fx}$ to open the expression editor. The text color automatically changes to white when a dark background color is used.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Examples</em> (page 541).</td>
</tr>
<tr>
<td>Text color expression</td>
<td>Enter an expression by clicking $\text{fx}$ to open the expression editor. If you use the same expression as in the background color, the text will not be visible.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Examples</em> (page 541).</td>
</tr>
</tbody>
</table>

### Color by expression

Coloring by expression sets colors using a user-defined expression. When coloring by expression, you can define both what colors to use and which values to use them with, enabling more control over how colors are used in the visualization.

For example, you might highlight values of particular interest, or differentiate between values within different value ranges. Coloring by expression can also be used to color a visualization by values not included within a visualization, such as coloring products and the sum of their monthly sales by the country of origin for the product.

When you select to color **By expression**, you can chose to either use the expression as a color code or to define how **By measure** color options are applied to the visualization using an expression.

The following visualizations support color by expression:

- Bar chart
- Combo chart
- Line chart
- Map
- Pie chart
- Pivot table
- Scatter plot
- Table
- Treemap

---

*Legend selection is not available in a visualization when coloring by expression. Visualizations that are colored by expression with a color code do not support legends.*
Coloring by expression as a color code

By default, if you choose to color by expression, **The expression is a color code** is enabled. If you have this option selected, your expression must include a color code in a supported expression format to define the colors to use. Using this method provides you with manual control over visualization colors as well as the conditions for the colors being used in a visualization. With tables and pivot tables, you can use expressions to define the background color and the text color of columns.

> When coloring by expression, objects in visualizations are colored gray if the expression contains errors or if objects in the visualization have multiple colors they could be assigned in the expression.

Examples

Here are a few examples to show what you can do with expressions by color.

**Example: Coloring by random color range**

\[\text{argb}(255, \text{rand}() \times 255, \text{rand}() \times 255, \text{rand}() \times 255)\]

This example uses ARGB color. It starts with alpha value that sets full opacity, and then uses the \(\text{rand}()\) function to generate random values for the red, green, and blue colors, creating a random color.

**Example: Coloring by single measure value**

\[\text{if}((\text{sum}(\text{[Budget Amount]})) > 1000000, \text{'cornflowerblue'}, \text{magenta})\]

In this example, there is a condition. If \(\text{sum}(\text{[Budget Amount]})\) is greater than 1 million, the corresponding measure values will be colored 'cornflowerblue', otherwise they will be colored magenta.

'cornflowerblue' is the color keyword for the color \(\text{rgb}(100, 149, 227)\).

magenta() is the Qlik Sense color function that generates a magenta color.

**Example: Coloring by single measure value using an aggregated expression**

\[\text{if}(\text{avg}(\text{Value}) > \text{avg}(\text{Total} \text{aggr}(\text{avg}(\text{Value}), \text{Name})), \text{Blue}(), \text{Brown}())\]

In this example, there is a condition. If the \(\text{avg}(\text{Value})\) value is greater than the aggregated \(\text{avg}(\text{Value})\) value of the entire table, then the corresponding measure value is colored blue. If the \(\text{avg}(\text{Value})\) value is less than the aggregated \(\text{avg}(\text{Value})\) value of the entire table, then the corresponding measure value is colored brown.

**Example: Coloring by multiple measure values**

\[\text{if}(\text{Sum}(\text{Sales}) > 3000000, \text{'green'}, \text{if}(\text{Sum}(\text{Sales}) > 2000000, \text{'yellow'}, \text{if}(\text{Sum}(\text{Sales}) > 1000000, \text{'orange'}, \text{red}()))))\]
In this example, there are multiple conditions. If \( \text{Sum(Sales)} \) is greater than 3,000,000, then corresponding measure values will be colored green. If \( \text{Sum(Sales)} \) is between 2,000,000 and 3,000,000, then the corresponding measure values will be colored yellow. If \( \text{Sum(Sales)} \) is between 1,000,000 and 2,000,000, the corresponding measure values will be colored orange. All other measure values will be colored red.

**Example: Coloring by multiple dimensions**

\[
\text{if}([\text{CompanyName}] = 'A Corp', \text{rgb}(100, 149, 227), \text{if}([\text{CompanyName}] = 'B Corp', \text{rgb}(100, 149, 200), \text{if}([\text{CompanyName}] = 'C Corp', \text{rgb}(100, 149, 175), \text{if}([\text{CompanyName}] = 'D Corp', \text{rgb}(100, 149, 150), \text{'grey'})))
\]

In this example, the expression is used to define a RGB color for each specific dimension value in the field CompanyName.

**Example: Coloring table object font and background by measure value.**

\[
\text{if}(\text{Sum}([\text{Sales}]) < 10000, \text{red}, \text{green})
\]

\[
\text{if}(\text{Sum}([\text{Sales}]) > 200000, \text{gold}, )
\]

In this example, two expressions are used to color the background and text of the Sales column. Measure values in Sales that are lower than $10000 have a red background color, all other values have a green background. In addition, the values that are higher than $200000 have the text color 'gold'.
Coloring by expression without a color code

You can color by expression without a color by disabling **The expression is a color code** when you enable coloring by expression. In this method of coloring, the expression is used to evaluate to a numeric value that is plotted against a **By measure** chart gradient, treating the expression like a measure when coloring by measure.

> When coloring by expression, objects in visualizations are colored gray if the expression contains errors or if objects in the visualization have multiple colors they could be assigned in the expression.

**Example:**

\[
100*\text{Sum}([\text{Sales Margin Amount}])/\text{Sum}([\text{Sales Amount}])
\]

In this example, charts would have **By measure** color gradients applied to them based on the profit margin percentile calculated in the expression.

**Supported expression formats**

The following formats are supported when you create your expressions.

**RGB**

With RGB colors you enter an integer value between 0 and 255 (or an expression that evaluates to such a value) for each of the colors red, green, and blue. The resulting color is produced by adding the three colors together.

**Example:**

\[
rgb(0,0,255)
\]

This example generates the color blue. Many of the RGB colors have a corresponding keyword in plain text that can be used instead of the RGB code. If you use 'blue' as expression, you would get exactly the same color. Hexadecimal numbers are also supported, and the color blue has the string '#0000ff'.

**ARGB**

The ARGB color model has the same support as the RGB color model, but extends it with an additional alpha value to set the opacity of a color.

**Example:**

\[
argb(125,0,0,255)
\]

The first value (125), sets the alpha value. The value 0 generates full transparency and the value 255 full opacity.
HSL

In HSL, the color is defined by a hue value, a saturation value, and a luminosity value. You use values between 0 and 1. Hue is represented as an angle of the color circle (that is, the rainbow represented in a circle). Saturation is full with the value 1 and a shade of gray with the value 0. Lightness with the value 1 is white, and black with the value 0. The value 0.5 is commonly used.

Example:

\[ \text{hsl}(0, 0.5, 0.5) \]

This example generates a red color with medium saturation and lightness.

Color keywords

Qlik Sense supports W3C recommended color keywords. With color keywords, specific colors are defined by a name which corresponds to a RGB hex value. Enter the color name in the expression to use the color.

Use the following links to find out more about W3C color keywords:
- [http://www.w3.org/TR/CSS21/syndata.html#value-def-color](http://www.w3.org/TR/CSS21/syndata.html#value-def-color)

Example:

'cornflowerblue'

This example generates a blue color with the hex value of #6495ed and a RGB value of (100, 149, 237).

Qlik Sense color functions

The following color functions can be used in expressions when coloring by expression.

- black()
- darkgray()
- lightgray()
- white()
- blue()
- lightblue()
- green()
- lightgreen()
- cyan()
- lightcyan()
- red()
- lightred()
- magenta()
- lightmagenta()
Creating an expression
You create expressions for colors in the properties panel.

Do the following:

1. In the properties panel, open Appearance > Colors and legend.
2. Click the Colors button to switch to Custom.
3. In the drop-down list, select the option By expression.
   An expression text box is opened.
4. Enter your expression in the text box, or click $\text{fx}$ to open the expression editor.

If the expression is valid, the visualization is updated.

Visualization support for coloring methods
Not all Qlik Sense visualizations support the same coloring options. Additionally, some visualization types have specific behaviors or limitations when using certain coloring methods.

Color methods supported by visualizations and their limitations are determined primarily by the kinds of data the visualizations display. For example, visualizations that only support displaying measures cannot be colored by dimension or through using master dimensions.

**Color method support by visualization**
The following table outlines color method support by visualization type.

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Single</th>
<th>Multicolor</th>
<th>Master measure</th>
<th>Master dimension</th>
<th>Dimenson</th>
<th>Measure</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Box plot</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Combo chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Filter pane</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Gauge</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Histogram</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>KPI</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Line chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Visualization coloring limitations and behaviors

Different visualizations have different behaviors with the methods of setting color in visualizations. This section outlines specific considerations when coloring different visualizations.

**Line chart**

Line charts do not support coloring by measure if they have two or more dimensions.

**Map**

Colors assigned to master dimensions that contain geopoint data or area data (polygons of geopoints) cannot be used to color a map.

**Pie chart**

Pie charts do not use master item colors when Auto is selected under Colors and legend.

### Examples of visualization color settings

You can use a number of different methods to control the use of colors in your visualizations.

You can manually apply colors to your visualizations using the following methods:

- Color by single color
- Color by multiple colors
- Color by dimension
- Color by measure
- Color by expression

In the example dashboard below, each method of setting colors has a corresponding visualization. This section outlines each example as well as the specific settings used in the properties panel.
Color by single color

Visualizations can be colored with a single user-defined color. Colors can be selected from a palette or color wheel or by entering a hex color code.

In this example visualization, a single color has been applied to the line chart.

Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and Single color. Color set as hex value `4477aa`.

Color by multiple colors

Visualizations with multiple measures can have different colors applied to each measure. When a visualization is colored using Multicolor, colors are automatically applied from a default color scheme of 12 colors or 100 colors.
In this example visualization, multiple colors have been applied to the measures of Expense Amount and Budget in the line chart.

2. Color by multiple colors

![Line chart with multiple colors](image)

**Properties panel settings**

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and Multicolored.
- **Color scheme**: Set to 12 colors.

**Color by master item**

Colors can be kept consistent across visualizations for dimensions or measures through setting colors in master items. When set to use master item colors, visualizations will use all colors associated to the master items in the visualization. Master item colors can be used when Color is set to Single color or Multicolor.

In these example visualizations, both the bar chart and line chart share a master measure, Revenue, that is colored orange. In each visualization, the same assigned color is used for each instance of Revenue. The line chart is colored by a second master measure, Expense Amount, which is colored blue.
Master measure settings

For this visualization, the following settings were applied to the master measures in Edit measure:

- **Color:** Hex color set as f8981d for Revenue and 4477aa for Expense Amount.

For more information, see Assigning colors to master items (page 98).

Properties panel settings

For the bar chart, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors:** Set to Custom and Single color.
- **Use library colors:** Set to enabled.

For the line chart, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors:** Set to Custom and Multicolor.
- **Use library colors:** Set to enabled.

For more information, see Bar chart properties (page 144) and Line chart properties (page 221).

Color by measure

When a visualization colored by measure, sequential or diverging gradients or classes are applied to values in the chart based on the values of the selected measure. Visualizations can be colored by measures within the visualization or they can be colored with measures associated to values in the visualization.

In this example, this bar chart is colored by the measure used in the visualization, Revenue. A diverging gradient has been applied to the values in the chart based on the Revenue value for each dimension value.
4. Color by measure

Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and By measure. The measure selected is Revenue.
- **Color scheme**: Set to Diverging gradient.
- **Reverse colors**: Set to enabled.
- **Range**: Set to Auto.

For more information, see *Bar chart properties (page 144)*.

Color by dimension

When a visualization is colored by dimension, each value within the visualization is assigned a color based on an associated value from the coloring dimension. When colored by dimension, colors are automatically applied from a default palette set of 12 or 100 colors.

Example 1: Coloring by a dimension in the visualization

In this example, the line chart is colored by the dimension of the different sales representatives, using the 100 colors scheme. Each sales representative has their own distinct color in the visualization.
**Line chart colored by dimension**

**Properties panel settings**

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and By dimension. The dimension Sales Rep Name is selected.
- **Persistent colors**: Set to enabled.
- **Color scheme**: Set to 100 colors.

For more information, see Line chart properties (page 221).

**Example 2: Coloring by a dimension not included in the visualization**

In this example, the bar chart is colored by the dimension of Region, using the 12 colors scheme. The bar for each sales representative is colored by the region in which they work.
Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and By dimension. The dimension Region is selected.
- **Persistent colors**: Set to enabled.
- **Color scheme**: Set to 12 colors.

Color by expression

You can use expressions to set specific colors to appear with specific values, enabling conditional coloring of values in your visualizations. When a visualization is colored by expression, you define the colors and how the colors are applied to values within the expression.

Example 1: Color by expression in a table

In this example, the table visualization uses two expressions, one for the background color and one for the text. These expressions apply conditional colors to the background and text based on which rows contain the top 10 and bottom 10 values for Revenue.
6. Color by expression

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homebound</td>
<td>$1,263,085.68</td>
</tr>
<tr>
<td>Icon Site Builders</td>
<td>$9,420.32</td>
</tr>
<tr>
<td>Kari &amp; Associates</td>
<td>$7,364.12</td>
</tr>
<tr>
<td>Livermore Laboratories (LSLI)</td>
<td>$90,151.75</td>
</tr>
<tr>
<td>MATRIX</td>
<td>$512,901.49</td>
</tr>
<tr>
<td>Pacific Matica</td>
<td>$24,625.51</td>
</tr>
<tr>
<td>Ra Co Amo</td>
<td>$1,293,542.53</td>
</tr>
<tr>
<td>Ready-to-Run</td>
<td>$98,191.57</td>
</tr>
<tr>
<td>Remedy</td>
<td>$226,538.83</td>
</tr>
<tr>
<td>Reuters Usability Group</td>
<td>$45,384.54</td>
</tr>
<tr>
<td>RFI Corporation</td>
<td>$1,772,832.86</td>
</tr>
<tr>
<td>Satronix</td>
<td>$126,630.22</td>
</tr>
</tbody>
</table>

Properties panel settings

For this visualization, the following properties were set in the properties panel under **Data > Columns**:

- **Background color expression**: `if(Rank(Sum([Sales Quantity]*[Sales Price])) <= 10, 'honeydew', if(Rank(-Sum([Sales Quantity]*[Sales Price])) <= 10, 'mistyrose', ))`
- **Text color expression**: `if(Rank(Sum([Sales Quantity]*[Sales Price])) <= 10, 'green', if(Rank(-Sum ([Sales Quantity]*[Sales Price])) <= 10, 'red', ))`

To learn more about table properties, see Table properties (page 372).

Example 2: Color by expression in a chart

In this example, the bar chart uses an expression to assign specific colors to different values in the **Customer** field.
6. Color by expression

For this visualization, the following properties were set in the properties panel under **Appearance > Colors and Legends**:

- **Colors**: Set to Custom and By expression.
- **Expression**: Set to if([Customer] = 'Fill It', rgb(100, 149, 227), if([Customer] = 'Hetrick Systems', rgb(100, 149, 200), if([Customer] = 'Icon', rgb(100, 149, 175), if([Customer] = 'J. S. Lee Associates', rgb(100, 149, 150), 'grey'))).
- **This expression is a color code**: Set to enabled.

Converting a visualization to another kind of visualization

You can convert from one visualization type to another by dragging a chart from the assets panel on the left-hand side onto the visualization that you want to convert.

All properties that the original visualization has are transferred to the new type. The new visualization uses the dimensions, measures, and settings that are applicable to that visualization type. If a visualization requires an additional primary dimension or measure, the first listed alternative dimension or measure is used by default. If no alternative dimensions or measures exist and one is required the new visualization, you will be prompted to add one.

All properties from the original visualization are saved, even if they are not available or visible in the new visualization. This means that properties can become available again if you decide to convert to yet another visualization type where those properties are used.
Do the following:

1. While editing a sheet, drag a new chart from the assets panel onto the visualization that you want to convert. The shortcut menu opens.
2. Select the conversion option.

The new visualization is displayed, using the data from the original visualization.

**When you convert to a new visualization type, some of the settings from the original visualization may not be optimal for the new visualization, for example, the sorting order. Therefore, you may need to make some changes in the properties panel, so that the new visualization is displayed as you want.**

**You cannot convert to or from a map or a text & image visualization, nor can you convert a master visualization.**

**Embedding a visualization or a sheet in a web page**

You can integrate Qlik Sense visualizations or sheets into an iframe element on a web page with the Single Integration API. This could for example be a web page on your intranet. You select which visualization or sheet to embed, and make some settings to customize selections, interaction and appearance. Then you can copy the iframe code containing the URL of the object and add it to your web page.

The embedded object will be subject to the same access rules as the original object and app. This means that anyone who wants to view the embedded object must have:

- Access to Qlik Sense.
- Access to the app. If the app is unpublished (in My work), you are the only one with access.
- Access to the sheet. If the sheet is unpublished (in My sheets) in a published app, you are the only one with access.
- Access to any bookmark used for selection. Private bookmarks will be applied for you, but not for anyone else.
- Same access to the data used in the selection as you, if section access is used to restrict data access.

**Embedding a sheet**

You can embed a sheet in your web page.

**Do the following:**

1. Click Embed sheet in the global menu.
2. Customize selections, appearance and interaction options for the embedded sheet.
3. Click **Open preview in new tab** to see a preview of the embedded sheet.
4. Click **Copy**.

You now have the iframe code of the sheet in your clipboard, ready to add to your web page.

### Embedding a visualization

You can embed a visualization in your web page.

**Do the following:**

1. Right-click on the visualization or click the hover menu.
2. Select **Share**. Then choose **Embed link**.
3. Customize selections, appearance and interaction options for the embedded visualization.
4. Click **Open preview in new tab** to see a preview of the embedded visualization.
5. Click **Copy**.

You now have the iframe code of the visualization in your clipboard, ready to add to your web page.

### Setting appearance and interaction

You can customize how you can interact with the embedded object.

- **Allow interaction**
  You can select if you want the user to be able to interact with the embedded object.

- **Enable context menu**
  You can select if you want the context menu to be available when the embedded object is right-clicked.

- **Language**
  You can select which language to use in menus for the embedded object.

- **Theme**
  You can select which theme to use for the embedded object.

### Selections in the embedded object

You can choose if the user can make selections in the embedded object, and which selection state to show in the embedded object.

- **Use current selections**
  You can select to use the current selections in the app.

- **Show selections bar**
  You can select to show the selections bar above the sheet.

- **Clear app selections on refresh**
  You can select to clear all selections made in the app when the object is rendered.

- **Apply bookmark**
  You can select to apply a bookmark and use the selections defined in the bookmark.
3 Visualizations

When the page containing the embedded object is rendered, the initial selection state is defined by the order of execution and your settings.

1. Clear app selections on refresh
2. Apply bookmark
3. Use current selections

When you make selections in the embedded object, they will be replicated in the app. If you select **Clear app selections on refresh**, for example, and use the embedded object, selections are cleared in the app.

You can use **Open preview in new tab** to preview the embedded object, and interact without affecting selections in the app.

Limitations of embedded objects

- **Embed sheet** and **Embed chart** features are not available on devices with a small screen.
- The URL is limited to 2083 characters due to browser limitations. If your URL is too long, this is most likely due to a large number of individual selections.

You can create a bookmark with the same set of selections, and apply the bookmark. This will create a shorter URL.

3.8 Troubleshooting - Creating visualizations

This section describes problems that can occur when creating visualizations in Qlik Sense.

I cannot find the fields in the assets panel

I can find **Charts** and **Master items** in the assets panel, but not **Fields**.

Possible cause

You are working with a published app. Some content is not available in the assets panel in a published app.

My chart is not sorted correctly

I set my chart to sort automatically on the dimension, but the results are not sorted correctly.

Possible cause

The dimension is an expression with a result that has a different data type than the data fields used in the expression.
Proposed action
Change sorting of the dimension to Custom, and select a sorting option that matches the result of the expression. For example, if your expression concatenates two fields to a string, like `Month(salesDate)&’/’&Day(salesdate)`, select to sort alphabetically.

My calendar measures display incorrect aggregations in visualizations
When I use my calendar measures in visualizations, I see incorrect aggregation results. For example, calendar measures created from identical fields and aggregations but different time ranges may display identical totals.

Possible cause
The table containing the aggregated field is not associated to the table containing the date field, preventing accurate aggregation of the field by the selected time ranges.

Proposed action
Create an association between the table containing the aggregated field and the table containing the date field. If there is no association possible, in Data manager, add a table that includes a date field that has an association to the table containing the aggregated field.

There are no time ranges to select in Create calendar measures
When I have a date field selected in the Create calendar measures dialog try to create calendar measures from a field, there are no time ranges to select in the Create calendar measures dialog.

Possible cause
The selected date field does not have the correct time flags to work with calendar measures. If you have no valid date fields, you cannot create calendar measures. If you have at least one valid date field, all date fields will be available in Date field. However, only those with the correct time flags set in autoCalendar enable the selection of time ranges from the Time Range drop-down list.

Proposed action
Select a date field that uses autoCalendar. If you are unsure which calendar is associated to your date field, date fields in the Field section of the Assets panel display which calendar it uses when clicked.

My date field selected for calendar measures does not use the correct calendar
I have two calendars to which I have manually added time flags. My time flags have the same names as those in autoCalendar, making both qualified for use with calendar measures. However, only one of my calendars has the same definition for the time flags as autoCalendar. I have a date field associated to both calendars. When I try to create calendar measures using that date field, the calendar with the correct names but different definitions than autoCalendar is used.
Possible cause
In cases where a date field is associated to multiple calendars and each calendar has the correctly named time flags set in it, calendar measures uses the first qualified calendars defined in your data load script.

Proposed action
Move the script section containing the calendar you want to use with calendar measures before other qualified calendars in your data load script.

I cannot edit a variable value
I cannot edit a variable that is listed in the variables overview.

Possible cause
The variable is defined in the script.

Proposed action
Edit the variable in the script, using the data load editor, or delete the variable from the script, using the data load editor, to make the variable editable from the variables overview.

For more information, see Editing a variable (page 121)

You cannot rename a variable.

The map is placing the locations in my location field incorrectly
When I add a location field to a layer in my map, the locations do not display in the correct places.

Possible cause
The map does not have enough context to locate the locations in your field. This can happen when a location in the field shares a name with a number of other possible locations on the map.

Proposed action
Set Scope for Location in your layer to Custom and enter additional information. Alternatively, qualify your location field using an expression that contains additional fields with relevant geographic information. If your location field contained cities and you had Country and State fields, you could use [city]&', &[State]&', & [Country].

No map is displayed
I am using Qlik Geoanalytics server, the background map is not displayed.
Possible cause

Your browser cannot access qlikcloud.com or your firewall settings or proxies prevent the use of JavaScript from qlikcloud.com.

Proposed action

Visit the status page from your browser.

If your browser cannot access qlikcloud.com contact your system administrator for assistance.

If the page prints "ok" then your browser can access qlikcloud.com. Make sure that JavaScript from qlikcloud.com is allowed.

Do the following:

- Add https://*.qlikcloud.com as a trusted site. (recommended)
- Enable JavaScript from untrusted sites. (not recommended)

Error message: The data contains invalid geometries that could not be shown on the map. Review your data for errors and try again.

I loaded geoshapes from a KML file to Qlik Sense. When I try to add the field to my map, an error message tells me that my data contains invalid geometries that could not be shown on the map.

Possible cause

There is an error in your geometries that is preventing Qlik Sense from displaying them on the map or your geometry data may be in an invalid format.

Proposed action

Review your geometry data for errors and try again.

Error message: The following locations could not be found:
<locations>. Review the values in your data and try again.

I added my location field to my map and I received an error messaging telling me locations in my location field could not be found.

Possible cause

Qlik Sense could not find the location. There may be a spelling error in the name or the location is not available in the Qlik Sense location database.

Proposed action

Review the values in your data for errors and try adding the field again. If a location cannot be found, you can alternatively manually add it using coordinates for points or geoshapes for areas.
Error message: The following locations could not be located: <locations>. Review the values in your data and try again.

I added a location field to my layer and I received an error message telling me that certain locations in my location field could not be located.

**Possible cause**
Qlik Sense could not find the location. There may be a spelling error in the name or the location is not available in the Qlik Sense location database.

**Proposed action**
Review the values in your data for errors and try adding the field again. If a location cannot be found, you can alternatively manually add it using coordinates for points or geoshapes for areas.

Error message: The following locations had more than one result: <locations>. Set a custom scope to clarify which locations to display.

I added a location field to my layer and I received an error message telling me that certain locations in my field had more than one possible result on the map.

**Possible cause**
One or more locations in your location field are ambiguous, with multiple possible locations on your map.

**Proposed action**
Set Scope for Location in your layer to Custom and enter additional information. Alternatively, qualify your location field using an expression that contains additional fields with relevant geographic information. If your location field contained cities, you, such as: [city]&', '&[County]&', '&[State].

Error message: Some lines could not be shown because of invalid data in the width expression. Review your data for errors and try again.

I entered a field or expression to control the width of the lines on my map and I received an error message telling me that certain lines have invalid data.

**Possible cause**
There is an error in your width expression that is preventing Qlik Sense from displaying specific lines on the map.

**Proposed action**
Your expression may contain non-numeric values. Review your data for errors and try again.
Error message: Some density points could no be shown because of invalid data in the weight expression. Review your data for errors and try again.

I entered a field or expression to control the density of the points on my map and I received an error message telling me that certain densities have invalid data.

Possible cause
There is an error in your weight expression that is preventing Qlik Sense from displaying specific densities on the map.

Proposed action
Your expression may contain non-numeric values. Review your data for errors and try again.

I added an image background layer and cannot see my image
I added an image background layer to my map visualization, but I cannot see it on the map.

Possible cause
Depending on the projection of your map and the scale of the image, the map may be too zoomed out to see the image.

Proposed action
Do one of the following:
- In Map settings, enable Auto-zoom. Add a layer containing location data that would put it over the same area as your image background layer.
- In Presentation, enable Show debug info. The map now includes coordinates for the center of the displayed area.